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FOREWORD

The Government of India has set an ambitious target of imparting skills to 30 crores people, one out of every

four Indians, by 2020 to help them secure jobs as part of the National Skills Development Policy. Industrial

Training Institutes (ITIs) play a vital role in this process especially in terms of providing skilled manpower.

Keeping this in mind, and for providing the current industry relevant skill training to Trainees, ITI syllabus

has been recently updated with the help of  Media Development Committee members of various stakeholders

viz. Industries, Entrepreneurs, Academicians and representatives from ITIs.

The National Instructional Media Institute (NIMI), Chennai, has now come up with instructional

material to suit the revised curriculum for Desktop Publishing Operator - Trade Theory- NSQF Level -

3 (Revised 2022) in IT & ITES Sector under Annual pattern. The NSQF Level - 3 (Revised 2022)  Trade

Theory will help the trainees to get an international equivalency standard where their skill proficiency and

competency will be duly recognized across the globe and this will also increase the  scope of recognition

of prior learning. NSQF Level - 3 (Revised 2022) trainees will also get the opportunities to promote life long

learning and skill development.  I have no doubt that with NSQF Level - 3 (Revised 2022)  the trainers and

trainees of ITIs, and all stakeholders will derive maximum benefits from these Instructional Media Packages

IMPs and that NIMI's effort will go a long way in improving the quality of Vocational training in the country.

The Executive Director & Staff of NIMI and members of Media Development Committee deserve appreciation

for their contribution in bringing out this publication.

Jai Hind

Directorate General of Training

Ministry of Skill Development & Entrepreneurship

Government of India.

         New Delhi - 110 001
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PREFACE

The National Instructional Media Institute (NIMI) was established in 1986 at Chennai by then Directorate

General of Employment and Training (D.G.E & T), Ministry of Labour and Employment, (now under Directorate

General of Training, Ministry of Skill Development and Entrepreneurship) Government of India, with technical

assistance from the Govt. of Federal Republic of Germany. The prime objective of this Institute is to develop

and provide instructional materials for various trades as per the prescribed syllabi under the Craftsman and

Apprenticeship Training Schemes.

The instructional materials are created keeping in mind, the main objective of Vocational Training under

NCVT/NAC in India, which is to help an individual to master skills to do a job. The instructional materials are

generated in the form of Instructional Media Packages (IMPs). An IMP consists of Theory book, Practical

book, Test and Assignment book, Instructor Guide, Audio Visual Aid (Wall charts and Transparencies) and

other support materials.

The trade practical book consists of series of exercises to be completed by the trainees in the workshop.

These exercises are designed to ensure that all the skills in the prescribed syllabus are covered. The trade

theory book provides related theoretical knowledge required to enable the trainee to do a job. The test and

assignments will enable the instructor to give assignments for the evaluation of the performance of a trainee.

The wall charts and transparencies are unique, as they not only help the instructor to effectively present a

topic but also help him to assess the trainee's understanding. The instructor guide enables the instructor to

plan his schedule of instruction, plan the raw material requirements, day to day lessons and demonstrations.

IMPs also deals with the complex skills required to be developed for effective team work. Necessary care

has also been taken to include important skill areas of allied trades as prescribed in the syllabus.

The availability of a complete Instructional Media Package in an institute helps both the trainer and

management to impart effective training.

The IMPs are the outcome of collective efforts of the staff members of NIMI and the members of the Media

Development Committees specially drawn from Public and Private sector industries, various training institutes

under the Directorate General of Training (DGT), Government and Private ITIs.

NIMI would like to take this opportunity to convey sincere thanks to the Directors of Employment & Training

of various State Governments, Training Departments of Industries both in the Public and Private sectors,

Officers of DGT and DGT field institutes, proof readers, individual media developers and coordinators, but for

whose active support NIMI would not have been able to bring out this materials.

Chennai - 600 032      EXECUTIVE DIRECTOR
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INTRODUCTION
TRADE PRACTICAL

The trade practical manual is intended to be used in practical workshop. It consists of a series of practical

exercises to be completed by the trainees during the course. These exercises are designed to ensure that all

the skills in compliance with NSQF LEVEL - 3 (Revised 2022)  syllabus are covered.

The manual is divided into Twelve modules.

The skill training in the shop floor is planned through a series of practical exercises centered around some

practical project. However, there are few instances where the individual exercise does not form a part of project.

While developing the practical manual, a sincere effort was made to prepare each exercise which will be easy to

understand and carry out even by below average trainee. However the development team accept that there is a

scope for further improvement. NIMI looks forward to the suggestions from the experienced training faculty for

improving the manual.

TRADE THEORY

The manual of trade theory consists of theoretical information for the  Course of the  Desktop Publishing

Operator  Trade Theory NSQF Level - 3 (Revised 2022)  in IT & ITES. The contents are sequenced according to

the practical exercise contained in NSQF LEVEL -3 syllabus on Trade Theory attempt has been made to relate

the theoretical aspects with the skill covered in each exercise to the extent possible. This correlation is

maintained to help the trainees to develop the perceptional capabilities for performing the skills.

The trade theory has to be taught and learnt along with the corresponding exercise contained in the manual

on trade practical. The indications about the corresponding practical exercises are given in every sheet of

this manual.

It will be preferable to teach/learn trade theory connected to each exercise at least one class before performing

the related skills in the shop floor. The trade theory is to be treated as an integrated part of each exercise.

The material is not for the purpose of self-learning and should be considered as supplementary to class room

instruction.

Module 1 Computer Fundamentals

Module 2 Windows Accessories

Module 3 MS - Office

Module 4 Networking Concept

Module 5 Printer and Scanner

Module 6 Adobe Indesign

Module 7 Adobe Illustrator

Module 8 Adobe Photoshop

Module 9 CorelDraw

Module 10 Cloud Computing

Module 11 Publishing Content

Module 12 Publish Content in Bilingual
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CONTENTS

Module 1 : Computer Fundamentals

1.1.01 Fundamentals of Computer 1

1.1.01A Safety Practice and signs 9

1.1.02-03 Introduction of  Computer 1 11

1.1.04 Function of Motherboard and processors 15

1.1.05 Various Input & Output Devices and there Features 19

Module 2 : Windows Accessories

1.2.06-08 Windows Accessories and Difference Document & text File 2 27

Module 3 : MS - Office

1.3.09 Introduction of Typing Tutor 32

1.3.10 -12 Introduction MS - Office create, save and print in MS word 3 33

1.3.13 - 25 Formatting character, paragraph and mail merge 37

1.3.26 - 30 M.S Excel - Using formulas 45

1.3.31 - 36 Powerpoint Presentation 52

Module 4 : Networking Concept

1.4.37 - 42 Network Concepts,to plogies and Network Components 4 56

1.4.43 - 48 Concept of Internet and Social networking concepts 72

Module 5 : Printer and Scanner

1.5.49 Types of Scanner and Setting 5 82

1.5.50 -54 Various printer and fax and their settings 87

Module 6 : Adobe Indesign

1.6.55 - 59 Features and Benefits of Adobe Indesign & Pagemaker 6 95

1.6.60 - 62 Indesign tools and versions 100

Module 7 : Adobe Illustrator

1.7.63 - 65 Adobe Illustrator install and working for matting 107

1.7.66 Features of illustrator 116

1.7.67 Adobe Illustrator features and versions 7 118

1.7.68 - 69 Adobe Illustrator various design format 121

Module 8 : Adobe Photoshop

1.8.70 - 72 Photoshop & Coreldraw Features & Versions 128

1.8.73 - 76 Concept of colour & font style 134

1.8.77 Photoshop tools 8 138

1.8.78 - 80 Photoshop menu bar 147

1.8.81- 83 Photoshop create and formatting document 152

 Lesson No. Title of the Lesson Learning Page

Outcome No.
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Module 9 : CorelDraw

1.9.84-85 Formatting and system Requirement of Coreldraw 9 159

1.9.86 -87 Various versions of Coreldraw and Features 161

1.9.88 -92 Basics of Coreldraw and various Tools and uses 163

1.9.93 Vector & Bitmap, and colour pattern 172

1.9.94 Coreldraw Screen and page setup 175

Module 10 : Cloud Computing

1.10.95 Introduction to cloud computing 178

1.10.96-97 Cloud function and web hosting 10 184

1.10.98-99 Various online tools in cloud computing 187

1.10.100 Types of online tools and use 195

Module 11 : Publishing Content

1.11.101-103 Requires publishing content 201

1.11.104 Classify  publishing  content 11 203

1.11.105-106 Types of Printing Technology 205

1.11.107 Types of Publishing Content 208

1.11.108-109 Incorrect versions of Publishing 209

Module 12 : Publish Content in Bilingual

1.12.110-112 Need for publishing content in media 212

1.12.113 Method of Publishing Content 12 213

1.12.114-116 Tools for Multilingual Content 215

1.12.117-119 Types of Binding process 218

  Lesson No. Title of the Lesson Learning Page No.

Outcome
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1 Install and setup operating system and related software in a computer 1.1.01 - 1.1.05

following safety precautions. (NOS:SSC/N3022)

2 Create, format, edit text file, document file and BMP file by using 1.2.06 - 1.2.08

different Accessories of Windows. (NOS:SSC/N3022)

3 Create, edit, format and enhance document, work with spreadsheet 1.3.09 - 1.3.36

application and design presentation. (NOS:SSC/N3022)

4 Familiarize with the Networking concept including sharing of different 1.4.37 - 1.4.48

resources, use of Internet, accessing/ browsing, downloading and

e-mailing and practice network security. (NOS:SSC/N3022)

5 Install and setup scanner and scan the documents and images. 1.5.49 - 1.5.54

(NOS:SSC/N9489)

6 Create, edit, format and develop page combining text and graphics 1.6.55 - 1.6.62

using page makeup Adobe InDesign application software.

(NOS:SSC/N2702)

7 Create Illustrations and Graphics using Adobe Illustrator. 1.7.63 - 1.7.69

(NOS:SSC/N9490)

8 Create, format, edit and develop images using Adobe Photoshop 1.8.70 - 1.8.83

software. (NOS:SSC/N9491)

9 Draw, edit, format and develop graphics design using Corel draw 1.9.84 - 1.9.94

application software. (NOS:SSC/N9492)

10 Online cloud storage and backup. (NOS:SSC/N9493) 1.10.95- 1.10.100

11 Establish Requirements for Publishing Content. (NOS:SSC/N9494) 1.11.101- 1.11.109

12 Publish Contents using bilingual software. (NOS:SSC/N9495) 1.12.110- 1.12.119

LEARNING / ASSESSABLE OUTCOME

On completion of this book you shall be able to

S.No. Learning Outcome     Ex.No
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SYLLABUS

Duration Reference Learning

Outcome

Professional Skills

(Trade Practical)

with Indicative hours

Professional Knowledge

(Trade Theory)

Install and set up

operating system and

related software in a

computer following safety

precautions. (NOS:SSC/

N3022)

1.Identify different parts of computer

and attached different input and

output devices with the system. (7

hrs)

2. Install and configure Windows OS

and application software. (11 hrs)

3. Manipulate folder/files. Use printer,

scanner and their peripheral

devices. (7 hrs)

4. Identify different icons of Windows

and use the icons to operate the

machine. (7 hrs)

5. Customize Windows by using

control panel. (8 hrs)

Fundamentals of computers Safe

working practices, Safety rules and

safety signs.Types and working of fire

extinguishers.Scope of the DTPO

trade.Introduction to computer

components, Introduction to computer

system, Concepts of hardware and

software.Function of motherboard

components and various

processors.Various Input/ Output

devices in use and their features.(12

hrs)

Professional

Skill 40 Hrs;

Professional

Knowledge

12 Hrs

Professional

Skill 40 Hrs;

Professional

Knowledge

12 Hrs

Create, format, edit text

file, document file and

BMP file by using

different Accessories of

Windows. (NOS:SSC/

N3022)

6. Practice to create text file by

Notepad and edit file by using

different menu under notepad. (7

hrs)

7. Practice to create Document file

in Wordpad, and edit and format

file by using different tools available

under Wordpad. (14 hrs)

8. Practice to create basic symbols

by using MS Paint and format the

drawing by using different tools

available. (19 hrs)

Introduction to different basic

Accessories under MS Window.

Introduction of the basic features of

document file. Discuss the difference

between document file and text

file.Give the basic idea about image

file including BMP and other format.(12

hrs)

Professional

Skill 86

Hrs;

Professional

Knowledge

22 Hrs

Create, edit, format and

enhance document,

work with spreadsheet

application and design

presentation. (NOS:SSC/

N3022)

MS WORD (45 Hrs)

9. Practice typing using open source

typing tutor. (4 hrs)

10.Open MS Word and familiarize

with basic word

components. (2 hrs)

11. Practice creating, saving and

renaming word documents. (2 hrs)

12. Use templates to create New

Word document. (2 hrs)

13. Edit document using basic

character formatting and

paragraph formatting

tools. Create font style

and color scheme (2 hrs)

14. Practice to create and format

Tables including Table Formatting

Tool. (3 hrs)

15. Practice to create page layout

including insert column by using

Page Formatting. (2 hrs)

MS Office

Introduction of Typing tutor Software

and its different options to improve

typing speed, understand about typing

software, typing Tutor tools. State what

is MS Office, brief what is MS Word

and starting steps, explain various

screen blocks of MS Word, explain

procedures to create, save, print a

document.

Explain how to create a new

document, save and print. Explain the

concept of font style and color scheme

State how to edit, format text and

document styles brief using tables

inside word document with data,

explain how to create styles in a

document and save for future use, brief

the mail merge processing. Features

& Functions of Microsoft Excel,

formulas and Functions. Move Around

in Excel 2010. conditional Formatting,
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(xi)

16. Use Auto Correct tool and

customize Auto correct option. (2

hrs)

17. Insert Header/Footer, symbols,

Equations, Page Number, Foot

Note, End Note, Citation, pictures

including Clip arts. (2 hrs)

18. Format Header/Footer, Picture by

using respective formatting tool. (2

hrs)

19. Enhance document by adding

Page/ Paragraph border, shading

and enhancement features like

include pictures within document

in proper place. (3 hrs)

20. Use hyperlink, bookmark, cross

reference within document and also

establish link with other formatted

file. (2 hrs)

21. Use spell check, grammar,

translate, synonyms, thesaurus. (2

hrs)

22. Use mail merge tool. Use

conditional Mail Merge, External

Data Source. Practice Letters,

Label & Envelop printing using Mail

Merge. (3 hrs)

23. Practice to create, record and

execute Macro. (2 hrs)

24. Practice of using shortcut keys in

Word Processor. (2 hrs)

25. Practice on editing bilingual

software. (8 hrs)

MS Excel. (23 hrs)

26. Perform sorting, formatting, pattern

recognition. (4 hrs)

27. Use Toolbar and Translator Option.

(3 hrs)

28. Use Data file for exercises. (4 hrs)

29. Perform Locking cells + dropdown

menu. (4 hrs)

30. Perform Conditional formatting,

Freeze Panes, Filter function, AND

function, IF function, Nested IF

function (8 hrs)

MS Powerpoint (18 hrs)

31. Fundamental Tools- the

PowerPoint ribbon (2 hrs)

32. Formatting Text in PowerPoint (3

hrs)

33. Insert Objects in a PowerPoint

Presentation (2 hrs)

34. How to Create, Edit, Resize and

Format PowerPoint Tables (3 hrs)

35. PowerPoint Animations and slide

link Excel Spreadsheet Data.

Introduction to Power Point and its

advantages.Creation of slide shows

Fine tuning of presentations (22 hrs)
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transition (4 hrs)

36. Action buttons and rehearse

timing. (4 hrs)

Professional

Skill 62 Hrs;

Professional

Knowledge

16 Hrs

Familiarize with the

Networking concept

including sharing of

different resources, use of

Internet, accessing/

browsing, downloading

and e-mailing and

practice network security.

(NOS:SSC/N3022)

37. Install network printer.(4 hrs)

38. Use of file and printer sharing in

peer-to-peer connection.(7 hrs)

39. Browse the Internet for

information (use at least 3

popular browsers).(4 hrs)

40. Practice to create and use e-

mail for communication with

attachment, priority setting,

address book.

(11 hrs)

41. Communicate with text, video

chatting and social networking

sites. (4 hrs)

42. Use online dictionary, translation

software, storage space, share

files with e-mail links. (4 hrs)

43. Download manager, download &

upload YouTube files, google map

& earth etc. (3 hrs)

44. Update windows & other software.

(4 hrs)

45. Configure Outlook, mail service in

mobile phones. Use tools like

Skype, Google etc. (11 hrs)

46. Download different Publishing file

and install it in local machine. (3

hrs)

47. Download different type of suitable

image and insert within publication.

(3 hrs)

48. Practice and follow Network & WiFi

Security protocols. (4 Hrs)

Introduction to Computer

Networks Necessity and advantages.

Client Server and peer to peer

networking concepts. Network

topologies. Introduction to LAN, WAN

and MAN. Network components, viz.

Modem, Hub, Switch, Router, Bridge,

Gateway etc., Network Cables,

Wireless networks and Bluetooth

technology. Introduction to www,

Concept of internet, web browsers,

internet servers and search engines.

Concepts of Domain naming Systems

and email communication.

Introduction to video chatting tools and

social networking concepts. Concept

on various network security protocols.

(16 hrs)

Professional

Skill 18 Hrs;

Professional

Knowledge

8 Hrs

Install and setup scanner

and scan the documents

and images. (NOS:SSC/

N9489)

49. Scan the file and save to the

desired destination on the

computer. (2 hrs)

50. Load photo paper into the main

input tray. (3 hrs)

51. Print the photo, Page setup. (3

hrs)

52. Different setting of printer. (3 hrs)

53. Size or Paper Size menu in

Advanced Options or on the

Features tab. (4 hrs)

54. Some newer printers options. (3

hrs)

Scanner

How to scan on a Windows computer

Different setting of scanner How to

print from a USB or wirelessly-

connected HP printer Different setting

of printer Sending and receiving fax,

multifunction printers Modify the fax

settings. (8 hrs)

Professional

Skill 86 Hrs;
Create, edit, format and

develop page combining

text and graphics using

55. Manage workspaces, windows,

Status bar, and panels in Adobe

InDesign. (7 hrs)

Adobe InDesign List the benefits of

using Adobe InDesign. Classify the

features of Adobe PageMaker. Explain
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(xiii)

56. Set up pages and layouts in

InDesign. (7 hrs)

57. Modify Paragraph and Character

text styles, using the Find/Change

dialog box. (11 hrs)

58. Perform basic Table functions in

InDesign (creating, selecting,

editing, inserting, deleting,

navigating, moving, copying, etc.).

(12 hrs)

59. Operate major InDesign tools, font

style and color scheme (Pencil

tool, Corner Options dialog box,

Live Corners tool, Gradient tool,

and the Gradient Panel). (12 hrs)

60. Compare various coloring

techniques in InDesign (using

imported graphics, Eyedropper

tool, Swatches panel, spot and

process colors, Blend Colors and

Modes). (12 hrs)

61. Perform export functions in

InDesign. (12 hrs)

62. Use print functions in InDesign. (12

hrs)

Professional

Knowledge

20 Hrs

page makeup Adobe

InDesign application

software. (NOS:SSC/

N2702)

the concept of font style and color

scheme Compare the features of

Adobe InDesign and Adobe

PageMaker. Compare the features of

different Adobe InDesign versions. (20

hrs)

Professional

Skill 62 Hrs;

Professional

Knowledge

24 Hrs

Create Illustrations and

Graphics using Adobe

Illustrator. (NOS:SSC/

N9490)

63. Design logos. (7 hrs)

64. Create vector illustrations. (7 hrs)

65. Turn photographs into vector

artwork. (7 hrs)

66. Develop a Professional Iconic Logo

Designs. (7 hrs)

67. Develop a Professional

Typographic Logo

Design. (8 hrs)

68. Develop Professional Vintage

Logo Designs. (8 hrs)

69. Designing vector graphics,

typefaces, or layouts. (18 hrs)

Adobe Illustrator

Summarize the system requirements

for installing and working with

formatting software.List the benefits of

using Adobe Illustrator. Compare the

features of different Adobe InDesign

versions. Adobe Illustrator includes

Logo Design, Graphic design,

Photoshop, Illustration, Vector

Graphics, Character design and User

experience design. (24 hrs)

Professional

Skill 130

H r s ;

Professional

Knowledge

36 Hrs

Create, format, edit and

develop images using

Adobe Photoshop

software. (NOS:SSC/

N9491)

70. Apply photo editing/ inserting

features in Photoshop. (4 hrs)

71. Practice the use of tools panel

(Selection tools, Crop and slice

tools, measuring tools, font style

and color scheme, retouching

tools, painting tools, Drawing and

type tools, Navigation tools and

advanced tools in latest version.

(20 hrs)

72. Practice the process of setting

up Layers, duplicating Layer

Masks and

Photoshop layers. (4 hrs)

73. Apply Layer Comps, Layer Styles,

Layers panel, Patch tool, and

Adobe Photoshop Discuss the benefits

of using Adobe Photoshop and

CorelDraw. Classify the features of

CorelDraw and Adobe Photoshop.

Compare the features of various Adobe

Photoshop and CorelDraw versions.

Explain the concept of font style and

color scheme. Introduction of tools

panel (Selection tools, Crop and slice

tools, measuring tools, Retouching

tools, Painting tools, Drawing and type

tools, Navigation tools. Introduction to

Menu bar, Arrange, layout, Effects,

Bitmap etc. Create, format, edit and

develop images using Photoshop

Software. (36 hrs)
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(xiv)

Place command to modify

background and layers. (4 hrs)

74. Practice creating samples from

all visible layers and changing

transparency preferences. (7 hrs)

75. Practice to use of Menu bar,

Arrange, layout,Effects, Bitmap

etc (18 hrs)

76. Select various Interface options

(Colour Theme, Auto-Show

Hidden Panels, Show Tool Tips,

Enable Text Drop Shadows, and

Show Transformation Values). (8

hrs)

77. Use various tips and tricks in

Photoshop (w.r.t Frames,

interactive zoom feature, layer

mask, and Switch lasso). (8 hrs)

78. Practice creating, zooming,

adjusting, and panning operations

on Photoshop images, using

Rulers, Guides, and Grids. (8 hrs)

79. Compare different Palettes for

adjusting colour. (8 hrs)

80. Manipulate different shapes. (8

hrs)

81. Operate Photoshop tools (Magic

Wand, Lasso tools, Warp, Symbol

Sprayer, Dodge, Burn, Sponge,

Clone Stamp, etc.). (11 hrs)

82. Practice editing Selections

(adding, subtracting, inversing,

and drawing Selections) and

deselecting objects in Photoshop.

(11 hrs)

83. Perform layer style operations

(working with pre-set and custom

layer styles and creating images

using the Layer Masking) in

Photoshop. (11 hrs)

Professional

Skill 130

H r s ;

Professional

Knowledge

36 Hrs

Draw, edit, format and

develop graphics design

using Corel draw

application software.

(NOS:SSC/N9492)

84. Manage workspaces, windows,

toolbars, and the toolbox in

CorelDraw. (8 hrs)

85. Perform basic CorelDraw

functions related to Lines,

Shapes, Curves, and Outlines.

(12 hrs)

86. Compare basic CorelDraw

operations related to Objects and

Nodes. (11 hrs)

87. Demonstrate basic CorelDraw

operations related to Colour

management, filling of objects,

Transparency, and Special

Effects. (11 hrs)

CorelDraw Compare Formatting and

Design operations. List the system

requirements for installing and working

with CorelDraw software.Discuss the

benefits of using CorelDraw.Compare

the features of various CorelDraw

versions.Introduction to tools panel

(Pick tools, shape tools, zoom tools,

curve tools, smart drawing tools,

rectangle tools, ellipse tools, object

tools, shape tools, text tools,

interactive tools, eyedropper tools,

outline tools, fill tools, interactive fill

tools and advanced tools in latest

version). Difference between Vector and

Bitmap images, CMYK, RGB, and
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(xv)

88. Practice the use tools panel and

color scheme (Pick tools, shape

tools, zoom tools, curve tools,

smart drawing tools, rectangle

tools, ellipse tools, object tools,

shape tools, text tools, interactive

tools, eyedropper tools, outline

tools, fill tools, interactive fill tools

and advanced tools in latest

version). (32 hrs)

89.Apply basic Text functions (adding,

manipulating, and formatting text,

managing fonts in various

languages, etc.) in CorelDraw. (11

hrs)

90. Practice the setting of orientation,

paper size, toolbar, property bar,

status bar, standard bar. (11 hrs)

91. Use basic Template and Style

functions in CorelDraw. (11 hrs)

92. Practice basic CorelDraw

operations on various files and file

formats (importing, exporting,

optimizing, size reduction, etc.).

(12 hrs)

93. Prepare CorelDraw files for print

service providers. (11 hrs)

Pantone colours. Introduction to

orientation, paper size, toolbar,

property bar, status bar, standard bar.

(36 hrs)

Professional

Skill 62

H r s ;

Professional

Knowledge

18 Hrs

Online cloud storage and

backup. (NOS:SSC/

N9493)

94. Create instance on cloud on

amazon/azure/google. (7 Hrs)

95. Create bucket/ storage space on

cloud (amazon / azure / google).

(7 Hrs)

96. Install apache server & IIS

server, configure apache server

and IIS server. (7 Hrs)

97. Perform Domain registration,

panel management. (7 Hrs)

98. Perform Domain-registration of

any domain name. (8 Hrs.)

99. Configure domain name to

hosting accounts. (19 Hrs.)

100. Host your webpages. (8 Hrs.)

Introduction to cloud computing.

What is Cloud servers and types of

cloud server? Introduction of Cloud

storage and it types (amazon, google

drive & MS azure storage/OneDrive).

Definition, function and features of Web

servers, Types of web servers apache,

IIS etc. What is Hosting, procedure of

web hosting. Online tools- google

forms, google sheets, google drive

Google class room, Moodle, Chamilo,

Open edX, Totara Learn, Canvas. (18

Hrs)

Professional

Skill 62

H r s ;

Professional

Knowledge

18 Hrs

Establish Requirements

for Publishing Content.

(NOS:SSC/N9494)

101. Solve requirement-related

issues by contacting key

people in Publishing,

Preproduction, and Production

teams. (7 hrs)

102. Summaries the

consequences of publishing

incorrect versions of content.

(3 hrs)

103. Determine, if you have the

correct versions of all content

Requirement of publishing content

Categories content that requires

publishing. Classify all requirements

of the publication content. Different

kinds of publishing contents, Types of

Printing technology. (Letterpress,

Offset lithography, Screen printing,

Gravure printing, Flexography printing)

Digital printing Technology Discuss

issues, if any, concerning

requirements. Summaries the
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(xvi)

Professional

Skill 62 Hrs;

Professional

Knowledge

16 Hrs

for publications. (7 hrs)

104. Demonstrate methods of

establishing publication

requirements. (7 hrs)

105. Perform recommended

techniques of establishing

requirements in standard

templates and formats. (8 hrs)

106. Report issues, as per priority,

to appropriate people. (8 hrs)

107. Compare correct and

incorrect versions of content.

(7 hrs)

108. Assess the risks associated

with establishing

requirements incorrectly or

inadequately. (8 hrs)

109. Analyse scenarios that may

arise, if incorrect versions of

content are published. (7 hrs)

consequences of publishing incorrect

versions of content. (18 Hrs)

Publish Contents using

bilingual software.

(NOS:SSC/N9495)

110. Use standard templates and

tools while converting content

into draft publications. (3 hrs)

111. Practice escalating design-

related issues to the

supervisor. (3 hrs)

112. Solve design-related issues

by incorporating the

requester's/user's feedback/

inputs. (3 hrs)

113. Design and format content

as per established

requirements. (7 hrs)

114. Modify designed and

formatted content as per

client’s review. (8 hrs)

115. Convert designed, formatted,

and validated content, into

draft publication, after

incorporating feedback from

the Quality Assurance team

(Pre-press department). (7

hrs)

116. Demonstrate standard

methods for publishing

content. (8 hrs)

117. Produce publication outputs

in specific formats required by

production teams. (8 hrs)

118. Combine the latest

publications to update the

organisation’s database. (8

hrs)

119. Comply with the industrial

standards while publishing

content. (7 hrs)

Publishing contents in Bilingual

software Summaries the need for

publishing content. Classify the media

recommended for publishing content.

Compare various methods of

publishing content. Prepare a list of

publishing requirements obtained from

the requester. Tools for Creating &

Managing Multilingual Content – email,

ftp, notepad, Unicode fonts, MS office,

pdf reader/creator, adobe creative

cloud, translation memory, wordpress

and social media What is Binding,

Types of binding and process. (Sewn

binding- A strong, durable binding

where inside pages are sewn together

in sections. Glued binding. Also

known as Perfect binding PUR-glued,

Lay-flat binding, Spiral, Wire-o. Saddle-

stitched, the process of assembling

and securing written or printed pages

within a cover.) (18 hrs)
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1

IT & ITES Related Theory for Exercise 1.1.01

DTPO - Computer Fundamentals

Fundamentals of computer

Objectives: At the end of this lesson you shall be able to

•	 define	and	classify	computers
• list the advantages and limitations of computers 

• list the applications of computer

•  describe the voltages and currents in the computer.

Computer	-	Definitions
A computer is an electronic machine, operating under 

the control of instructions stored in its own memory that 

can accept data (input), manipulate the data according 

to specified rules (process), produce results (output), 
and store the results for future use.

Technically, a computer is a programmable machine. 

This means it can execute a list of programmed 

instructions and respond to new instructions that it is 

given.

History of Computer

Charles babbbage’s machine

The working principles of today’s computers were 

provided by an English mathematician Charles Babbage 

around 1833’s invented a machine called the “Analytical 

Engine”. A machine which could calculate and print 

tables of functions using limited techniques. 

The Analytical Engine had four parts. A mill, which was 

the section which did the calculations, essentially the 

CPU; the store, were the information was kept recorded, 

essentially the memory; the reader, which would allow 

data to be entered using punched cards, essentially the 

keyboard, and the printer.

Hence, Charles Babbage is considered as the “Father 

of the Computer” as in fig-1.

The generations of computers are characterized by a 

major technological development that fundamentally 

changed the way computers operate, resulting in 

increasingly smaller, cheaper, more powerful and more 

efficient and reliable devices. The various generations 
of computers are listed below:

First Generation (1946-1954): In 1946 the digital 

computer using electronic valves (Vacuum tubes) 

are known as first generation computers. The first 
‘computer’ to use electronic valves i.e. vacuum tubes. 

The high cost of vacuum tubes prevented their use for 

main memory. They stored information in the form of 

propagating sound waves.

The vacuum tube consumes a lot of power. These 

computers were large in size and writing programs 

on them was difficult. Some of the computers of this 
generation were:

Mark I :The IBM Automatic Sequence Controlled 

Calculator (ASCC), called the Mark I by Harvard 

University, was an electro-mechanical computer. 

Mark I is the first machine to successfully perform a long 

services of arithmetic and logical operation. Mark I is 

the First Generation Computer.

ENIAC: It was the first electronic computer built in 1946 
at University of Pennsylvania, USA by John Eckert 
and John Mauchy. It was named Electronic Numerical 
Integrator and Calculator (ENIAC). The ENIAC was 
30-50 feet long, weighted 30 tons, contained 18,000 
vacuum tubes, 70,000 resisters, 10,000 capacitors and 

required 150,000 watts of electricity. Today computer 
is many times as powerful as ENIAC, still size is very 
small.

EDVAC: It stands for Electronic Discrete Variable 

Automatic Computer and was developed in 1950. 
The concept of storing data and instructions inside 

the computer was introduced here. This allowed 

much faster operation since the computer had rapid 

access to both data and instructions. The EDVAC was 

a   with automatic addition, subtraction, multiplication, 

programmed division and automatic checking with an 

ultrasonic serial memory.

EDSAC: It stands for Electronic Delay Storage 
Automatic Computer and was developed by M.V. 

Wilkes at Cambridge University in 1949.  The EDSAC 
is the first stored-program computer. The EDSAC 

Fig 1
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2

performed computations in the three millisecond range. 

It performed arithmetic and logical operations without 

human intervention.

This machine marked the beginning of the computer 

age.

UNIVAC-1: It stands for Universal Automatic 

computer and it was the First commercial computer 

developed by   United States In 1951. The machine 
was 25 feet by 50 feet in length, contained 5,600 tubes, 
18,000 crystal diodes, and 300 relays. It utilized serial 

circuitry, 2.25 MHz bit rate, and had an internal storage 
capacity 1,000 words or 12,000 characters.

The UNIVAC was used for general purpose computing 

with large amounts of input and output. The UNIVAC 
was also the first computer to come equipped with a 
magnetic tape unit and was the first	computer	to	use	
buffer	memory.
Limitations of First Generation Computer

Followings are the major drawbacks of First generation 

computers.

• They used valves or vacuum tubes as their main 

electronic component. 

• They were large in size, slow in processing and had 

less storage capacity.

• They consumed lots of electricity and produced lots 

of heat. 

• Their computing capabilities were limited. 

• They were not so accurate and reliable.

• They used machine level language for programming. 

• They were very expensive.

Second Generation (1955-1964): The second-
generation computer used transistors for 

CPU components  and ferrite cores for main 

memory&magnetic disks for secondary memory. They 

used high-level languages such as FORTRAN (1956), 

ALGOL (1960) & COBOL (1960 - 1961). Input Output 

(I/O)processor was included to control I/O operations.

Manufacturing cost was also very low. Thus the size of 

the computer got reduced considerably. 

It is in the second generation that the concept of 

Central Processing Unit (CPU), memory, programming 

language and input and output units were developed. 

Some of the second generation computers are IBM 
1620, IBM 1401,CDC 3600.

Features

• Transistors were used instead of Vacuum Tube.

• Processing speed is faster than First Generation 

Computers (Micro Second)

• Smaller in Size (51 square feet)

• The input and output devices were faster.

Third Generation (1964-1977): By the development 

of a small chip consisting of the capacity of the 300 

transistors.These Integrated Circuits (IC)s are 

popularly known as Chips. 

A single IC has many transistors, registers and 

capacitors built on a single thin slice of silicon. So it is 
quite obvious that the size of the computer got further 

reduced. Some of the computers developed during this 
period were IBM-360, ICL-1900, IBM-370, and VAX-

750. Higher level language such as BASIC (Beginners 

All purpose Symbolic Instruction Code) was 

developed during this period.   

Computers of this generation were small in size, low 

cost, large memory and processing speed is very high. 

Very soon ICs were replaced by LSI (Large Scale 

Integration), which consisted about 100 components. 

An IC containing about 100 components is called LSI 

as in (Fig 2).

• They used Integrated Circuit (IC) chips in place of 

the transistors.

• Semi conductor memory devices were used.

• The size was greatly reduced, the speed of 

processing was high, and they were more accurate 

and reliable.

• Large Scale Integration (LSI) and Very Large Scale 
Integration (VLSI) were also developed. 

• The mini computers were introduced in this 

generation. 

• They used high level language for programming.

Fourth Generation (1978 - present): An IC containing 

about 100 components is called LSI (Large Scale 
Integration) and the one, which has more than 1000 

such components, is called as VLSI (Very Large Scale 
Integration).

It uses large scale Integrated Circuits(LSIC) built on a 
single silicon chip called microprocessors. Due to the 

development of microprocessor it is possible to place 

computer’s centralprocessing unit(CPU) on single chip. 

These computers are called microcomputers.

Later very large scale Integrated Circuits(VLSIC) 
replaced LSICs. Thus the computer which was occupying 
a very large room in earlier days can now be placed on 

a table. Main memory used fast semiconductors chips 

up to 4 M bits size. Some of the Fourth generation 
computers are IBM PC, Apple-Macintosh, etc.

Hard disks were used as secondary memory. 

Keyboards, dot matrix printers etc. were developed. 

Operating System (OS)-such as MS-DOS, UNIX, 
Apple’s Macintosh were available. Object oriented 

language, C++ etc were developed.

Fig 2
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Features 

• They used Microprocessor (VLSI) as their main 
switching element. 

• They are also called as micro computers or personal 

computers.

• Their size varies from desktop to laptop or palmtop. 

• They have very high speed of processing; they are 

100% accurate, reliable,   diligent and versatile.

• They have very large storage capacity.

Fifth Generation (PRESENT AND FUTURE): 5th 
generation computers use ULSI (Ultra-Large Scale 
Integration) chips. Millions of transistors are placed in a 

single IC in ULSI chips. 
64 bit microprocessors have been developed during 

this period.. Memory chips and flash memory up to 1 
GB, hard disks up to 600 GB & optical disks up to 50 GB 
have been developed (Fig ).

Fifth generation computing devices, based on Artificial 
Intelligence, are still in development, though there are 

some applications, such as voice recognition, that are 

being used today.

Artificial Intelligence is the branch of computer science 
concerned with making computers behave like humans. 

The term was coined in 1956 by John McCarthy at 
the Massachusetts Institute of Technology. Artificial 

intelligence includes:

• Games Playing: Programming computers to play 

games such as chess and checkers

• Expert Systems: Programming computers to make 

decisions in real-life situations (for example, some 
expert systems help doctors diagnose diseases 

based on symptoms)

• Natural Language: Programming computers to 

understand natural human languages

• Neural Networks: Systems that simulate intelligence 
by attempting to reproduce the types of physical 

connections that occur in animal brains

• Robotics: programming computers to see and hear 

and react to other sensory stimuli

GENERATION ELECTRONIC 

COMPONENT 

 

ADVANTAGES DISADVANTAGES

First Vaccum tube 

 

Helped in calculation

and computational work

•  Big size

•  Very  costly

•  Slow speed
•  Low accuracy

•  Low storage

•  High power   requirements

•  High heat  generation

•  High failure rate

•  Used machine language

•  No operating system

Second Transistor •  Smaller size
•  Less cost

•  Better speed

• Low power consumpt and 

less heat generation

• Better storage capacity

• Better accuracy and

more reliability

•  Need air conditioning
•  Constant maintenance

•  No operating systems
•  Later stage computers used assembly   

languages

Third Integrated 

Circuits(IC)

small & medium 

scale

•  Better in all aspects

   compared to I & II

•  Used operating  systems

   and high level language

•  Initial problem withmanufac turers 

•   No insight obtained into internal working

VLSI or 
Microprocessor

•  Low cost

•  Excellent speed and 

reliability

•  Computers close to man

Less powerful than main frame computers

Fig 3

Table - 1
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Fifth (Knowledge 

Information 

Processing 

Systems)

ULSI or Bio-Chips •   Very cheap

•   Super speeds
•   Very high storage      

capacity

•   Highly sophisticated OS
•   posses intelligence and 

decision making ability

New low level language needed

	Classification	of	computers
Computers are classified according to the following 
criteria:

• Principle of Operation

• Computing Power, Memory Capacity and cost

• Technological Development

• Principle of operation  

• Analog computer

• Digital Computer

• Hybrid Computer

Analog Computer

It is a computer that measures continuously changing 

physical quantities such as current, temperature, 

pressure etc. and converts them into quantities 

which can be used as data for computation. As these 

computers deal with continuously varying quantities 

they will give only approximate results. Its output is 

usually displayed on a meter or scale. Analog computer 

has low memory and fewer functions. These are used 

for engineering and scientific applications.

• Thermometer 

• Speedometer 

• Analog clock

Digital Computer

A digital computer works with digital data. Digital 

computer uses binary number system. Binary 

number system consists of only two digits ‘0’ and ‘1’. 

A digital computer represents data in digital signals. 

A ‘0’ represents OFF and a ‘1’ represents ON. Digital 
computer performs arithmetic and logical operations on 

data. It gives output in digital form.

Digital computers are very fast. These computers can 

store results. They have large Memory (that is data 

storing capacity). Today most of the computers used in 

offices and homes are Digital computers.

The digital computers are further divided into the 

following two groups:

• Special purpose computers

• General purpose computers

Special Purpose Computers: It is a computer designed 

to solve specific type of problem. The computers used 
in ships and aircrafts, etc.

General Purpose computers: It is a computer 

designed to solve a wide variety of problems, A General 

purpose Computer can store different programs and 
process them.

The differences between analog and digital computers 
are listed in table 2

Analog Computers Digital Computers

• Analog Computers Work on continuous values.

• Analog Computers have low memory.

• Analog computers have Slow speed.

• Analog computers are less reliable.

• Analog computers used in engineering  

• Analog computers are used to calculate / measure 

analog quantities like speed and temperature. 

• Analog computers provide less accurate results.

• Normally Analog Computers are specific purpose

• Normally Analog Computers are specific purpose

• Examples of Analog computers are: thermometer, 

analog clock, speedometer etc.

• Digital computers Work on discrete values.

• Digital computers have a very large memory

• Digital computers have fast speed.

• Digital computers are more reliable.

• Digital computers are used in all fields of life.science 
and medical fields.

• Digital computers are used to calculate 

mathematical and logical operations. It can solve 

addition, subtraction, division, multiplication and 

other mathematical and statistical operations.

• Digital computers provide 100% accurate results.

• Digital Computers are general purpose

• Digital Computers are general purpose

• Examples of digital computers are: Personal 

Computer, laptops, smart phones etc.

Table - 2
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Hybrid Computer (Fig 4)

A hybrid computer is a combination of both analog and 

digital computer. Hybrid computer can handle both 

analog and digital data. A hybrid computer combines 

the best characteristics of both the analog and digital 

computer. It can accept data in both analog and digital 

form.

Applications

Hybrid computer devices are used in hospitals that may 

calculate patient’s heart function, temperature and blood 

pressure etc. This calculation may be converted into 

numbers and shown in digital form. For example, The 

Vital Signs Monitoring unit also called (VSM) in short. It 
has Blood Pressure monitor, ECG monitor, respiratory 

monitor, and is also used for monitoring anesthesia.

• Hybrid computers are also used in spaceships and 

missile system.

• Hybrid Computer Machines are generally used in 

scientific applications

• Hybrid computers are used for controlling industrial 

processes.

Computers	are	classified	on	the	basis	of	computing	
power, memory capacity and cost.

-  Microcomputer or Personal Computer.

-  Mini Computer.

-  Mainframe Computer.

-  Super Computer.

Micro Computers

Micro computer is also called personal computer.It was 

introduced in 1970. Examples of personal computers 

are

PC and Apple Macintosh. The major types of personal 

computers are desktop computer and portable computer.

Desktop Computer

These computers can easily fit on a table or desktop, 
hence the name. These computers come in two models 

or casings. In Desktop model, the system unit is placed 

on the desktop or table. Monitor is placed on the system 

unit. In Tower model, both monitor and system unit are 

placed on the table as in (Fig 5).

Portable computer

Portable is a personal computer that can be carried 

from one place to other easily. Notebook computer and 
handheld computer (smart phone) are examples of 

portable computers. Notebook computer is also called 
laptop computer. Laptop computers are very small in 

size and can be placed easily on lap.

Lap top computer or notebook computer

The laptop computer or notebook computer will be as 

shown in Fig 6 and 7. It is also called as tower model 

computer.

Palmtop Computer/Digital Diary /Notebook /PDAs:

A handheld computer (like smart phone) is also portable. 

Hand held computer is known as palmtop computer.

Fig 4

Fig 5

Fig 6

Fig 7
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Palmtops have no keyboard but the screen serves both 

as an input and output device. It easily fits in the hand 
of the user.

Uses of Micro Computer

 The PC is the most common type of computer used in 

the office. It is now widely used in many homes. These 
are also used for business and engineering application.

Mini Computer

Mini computers were introduced in the 1960s. 

Minicomputer is larger and more powerful computer 

than personal computer. It can execute five million 
instructions per second. It generally consists of two or 

more process ors.

Minicomputer can serve up to 4000 connected users 

simultaneously. It is normally accessed by users via 

personal computer or terminal. A device with a monitor 

and keyboard is called terminal. It is also known as 

dumb terminal. It has no processing power and cannot 

work as stand-alone computer.

Uses of Mini Computer

Mini computers are often used by small and medium-
sized companies to provide centralized store of 

information.

Mainframe Computer

Mainframe computers were introduced in 1975. A 
mainframe computer is a very large computer in size. It 

is processors. It is designed to perform multiple tasks for 

multiple users at the same time. Mainframe computers 

can serve up to 50,000 users at the same time.

The users access a mainframe computer through 

terminal or personal computer. A typical mainframe 

computer can execute 16 million instructions per 

second. Some of the main computers models are

• NEC 610

• DEC 10 

Uses of Mainframe Computer

Mainframe computers are used primarily by corporate 

and governmental organizations for critical applications, 

bulk data processing such as senses, industry and 

consumer statistics, and transaction processing.

Super computer

Super computers were introduced in 1980s. Super 
computer is the fastest computer. Super computer is the 
biggest in size and the most expensive in price than any 

other computers. 

It is the most sophisticated, complex and advanced 

computer. It has a very large storage capacity. It can 

process trillions of instructions in one second. Super 
Computer is the fastest and most powerful computer 

of a time. Supercomputers are very expensive. 
Supercomputers are used for highly calculation-
intensive tasks. Super computers are also used for 
specialized applications that require immense amounts 

of mathematical calculations. 

Applications of Super Computer

• Weather forecasting, 

• Animated graphics like in Hollywood movies,

• Fluid dynamic calculations

• Nuclear energy research

• Space science 

• Weapon and missile design

• Petroleum exploration, and etc.

The main difference between a supercomputer and a 
mainframe is that a supercomputer channels all its power 

into executing a single program as fast as possible, 

whereas a mainframe uses its power to execute many 

programs concurrently. The modern super computer 

consists of thousands of microprocessors. Super 
computer uses high-speed facilities such as satellite for 
online processing. 

Advantages of computers

• A computer has a very high processing speed with 

high reliability.

• Large volume of information can be stored in 

the memory any particular data/program can be 

retrieved immediately.

• Solution to a complicated problem is possible at a 
very high speed.

• Processing of large volume of data saves a lot of 

clerical work which reduces the processing cost.

• Computers perform operations efficiently at 
environments where presence of human being is not 

possible such as furnace, poisonous atmosphere, 

vacuum, unmanned satellite, etc.

Limitation of computers

• High initial cost.

• Input information has to be prepared in the form 

of statements called program which requires a 

considerable amount of knowledge.

• usage of computers will be economical only when 

there is clerical data processing for large volume of 

data and are repetitive in nature

• It is a merely a machine it cannot correct errors on its 

own.

Functions of Computers

All computers are made up of following basic units as 

shown in Fig 8. They are as follows:-

• Input Unit

• Central processing Unit (CPU)

 a) Arithmetic Logic Unit(ALU) 

 b) Control Unit (CU)

• Memory

• Output Unit

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.1.01
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Input Unit

Computers need to receive data and instruction in order 

to solve any problem. Therefore we need to input the 

data and instructions into the computers. The input unit 

consists of one or more input devices. Keyboard is the 

one of the most commonly used input device. 

Input devices perform the following functions.

• Accept the data and instructions from the outside 

world.

• Convert it to a form that the computer can understand. 

• Supply the converted data to the computer system 
for further processing.

Central Processing Unit (CPU) (Fig 8) 

The central processing unit (CPU) is the electronic brain 

of the computer as in Fig 9. The CPU in a personal 

computer is usually a single chip. It organizes and 

carries out instructions that come from either the user 

or from the software. The processor is made up of many 

components. CPU performs the following functions:

• It performs all calculations.

• It takes all decisions.

• It controls all units of the computer.

Two typical components of a CPU are the following:

The arithmetic logic unit (ALU), which performs 

arithmetic and logical operations.

The control unit (CU), which extracts instructions from 

memory and decodes and executes them, calling on the 

ALU when necessary.

Memory

Memory refers to the physical device used to store the 

program or data on the temporary or permanent basis 

for use in a computer or other digital electronic device.

There are two types of memory in computer. 

• Primary Memory

• Secondary Memory

Output Unit

Output unit receive the informations from the processing 

unit and provide the results in human readeable form.

Output Devices

The some of the output devices are

• Monitor

• Printer

• Plotter

• Speaker

Applications of computers

Science: Scientists have been using computers to 
develop theories and to analyse and test the data. The 

high speed and accuracy of the computer allow different 
scientific analyses to be carried out. They can be used 
to generate detailed studies of how earthquakes affect 
buildings or pollution affects weather pattern. Satellite-
based applications have not been possible without the 

use of computers. Moreover, it would not be possible to 

get the information of the solar system and the cosmos 

without computers.

Education: Computers have also revolutionized the 

whole process of education. Currently, the classrooms, 

libraries and museums are efficiently utilizing computers 
to make the education much more interesting. Unlike 

recorded television shows, computer-aided education 
(CAE) and computer-based training (CBT) packages 
are making learning much more interactive.

Medicine and Health Care: There has been an 

increasing use of computers in the field of medicine. 

Fig 8

Fig 9
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Now, doctors are using computers right from 
diagnosing the illness to monitoring a patient’s status 

during complex surgery. By using automated imaging 

techniques, doctors are able to look inside a person’s 

body and can study each organ in detail (e.g. CT scans 

or MRI scans), which was not possible few years 

ago. There are several examples of special-purpose 
computers that can operate within the human body 

such as cochlear implant, a special kind of hearing aid 

that makes it possible for deaf people to hear.

Engineering/Architecture/Manufacturing:The 

architects and engineers are extensively using 

computers in designing and drawings. Computers can 

create objects that can be viewed from all the three 

dimensions. By using techniques like virtual reality, 

architects can explore houses that have been designed 

but not built. The manufacturing factories are using 

computerized robotic arms to perform hazardous jobs. 

Besides, computer-aided manufacturing (CAM) can 
be used in designing the product, ordering the parts 

and planning production. Thus, computers help in 

coordinating the entire manufacturing process.

Entertainment: Computers are finding greater use 
in entertainment industry. They are used to control 

the images and sounds. The special effects, which 
mesmerize the audience, would not have been possible 

without the computers. In addition, computerized 

animation and colourful graphics have modernized the 

film industry.

Communication: E-mail or electronic mail is one of 
the communication media in which computer is used. 

Through e-mail, messages and reports are passed 
from one person to one or more persons with the aid 

of computer and telephone line. The advantage of this 

service is that while transferring the messages it saves 

time, avoids wastage of paper and so on. Moreover, 

the person who is receiving the messages can read the 

messages whenever he is free and can save it, reply it, 

forward it or delete it from the computer.

Business Application: This is one of the important 

uses of the computer. Initially, computers were used 

for batch-processing jobs, where one does not require 
the immediate response from the computer. Currently, 

computers are mainly used for real-time applications (like 
at the sales counter) that require immediate response 

from the computer. There are various concerns where 

computers are used such as in business forecasting, 

to prepare pay bills and personal records, in banking 

operations and data storage, in various types of life 

insurance business and as an aid to management. 

Businesses are also using the networking of computers, 

where a number of computers are connected together 

to share the data and the information. Use of e-mail and 
the Internet has changed the ways of doing business.

Publishing: Computers have created a field known 
as desktop publishing (DTP). In DTP, with the help 

of computer and a laser printer one can perform the 

publishing job all by oneself. Many of the tasks requiring 

long manual hours such as making table of contents 

and index can be automatically performed using the 

computers and DTP software.

Banking: Computers are extensively used in the 

field of banking and finance. People can use the ATM 
(automated teller machine) services 24 hours a day to 

deposit and withdraw cash. When different branches of 
the bank are connected through computer networks, 

the inter branch transactions such as cheque and draft 

can be performed without any delay.

Railway Reservation System

Using this system, the user can perform following 

operations through online. (web site: www.irctc.co.in)

• search the train and its timings

• check seats and birth availability

• booking and cancelling tickets

• status of PNR (Passenger Name Record)

Telephone / Electricity Board Billing:

The users can do the following operations through 

online by using this system. (Web site: portal.bsnl.in - 
BSNL)

• Register the telephone / electricity board number

• Check and pay the bill amount

• Register the complaints

E-Governance

E-Governance implies technology driven governance. 
E-Governance is the application of Information and 
Communication Technology (ICT) for delivering 

government services, exchange of information 

communication transactions, integration of various 

stand-alone systems and services between 
Government-to-Citizens (G2C), Government-to-
Business(G2B),Government-to-Government( G2G) as 
well as back office processes and interactions within the 
entire government frame work.

E-Governance covers  all the sectors with a view to 
providing hassle free, transparent and efficient service 
to the common man (both in urban and rural areas).

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.1.01
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IT & ITES Related Theory for Exercise 1.1.01A

DTPO -  Computer Fundamentals

Safety practice and signs

Objectives: At the end of this lesson you shall be able to

• safe Practicing Workplace 

• rules for worksplace safety

• safety signs

• scope of DTPO Trade and lab safety

Safe Practicing Workplace

The following features are helpful in implementing safe 

work practices at workplace:

• Induction training for new employees.

• Training on communication and teamwork during 

normal and emergency situation.

• Training on fire safety and emergency procedures.

• Training on hazard identification, risk control, use of 
personal protection equipment (PPE) and first aid.

• Observation of ergonomics to reduce injuries to 

workers.

• Use and maintenance of appropriate tools for work 

and keeping them in good working condition.

• Handling, application, labelling and storage of 

hazardous and non-hazardous materials so the 
workers are not exposed to danger.

• Housekeeping, cleaning and waste disposal 

considering environment safety and health (ESH).

Safe Practicing Workplace

• Preventing workplace incidents is everyone’s job, 

and your personal safety is your responsibility.

 Everyone has a role in making sure a workplace is 

safe, from the administrative assistant who gets the 

boxes of newly delivered office supplies unpacked 
promptly to the warehouse foreman who makes sure 

every person on the line gets a break. When you 

take charge of your own safety, it creates a safer 

place for all employees.

• Dress appropriately, from clothing to footwear.

 Keeping arms and legs covered, avoiding dangling 

jewelry or ties, and wearing closed-toe shoes can go 
a long way in minimizing common workplace injuries 

and accidents. When and where applicable, always 

wear personal protective equipment (PPE), and 

inspect it for damage before and after use, so that it 

can be repaired or replaced promptly.

• Keep work areas neat and tidy.

 At the beginning and end of each shift, clear away 

trash, pick up cords and cables, and put office 
supplies away. Gather any materials you’ll need to 

complete your work. This will avoid losing things 

as well as having to bend or stretch unnecessarily, 

trying to reach objects that are misplaced or out of 

reach.

• Follow the rules.

 Don’t cut corners or take unnecessary risks. 

Workplace safety rules are often developed in 

response to hazard and risk assessments. They are 

by nature designed to minimize the chances that an 

employee will be injured while carrying out assigned 

tasks.

• Report workplace accidents or safety incidents.

 Always report incidents to your supervisor promptly 

so that the appropriate steps can be taken. These 

can include getting care for an injured employee, 

fixing the problem that caused the injury, or ensuring 
regulatory, state or federal reporting compliance.

• Know and follow emergency procedures.

 In order to safely and effectively manage 
emergencies, it’s imperative that all employees are 

trained in and follow emergency procedures. This 

helps safety coordinators and emergency services 

get a handle on a situation and determine the best 

way to bring it under control.

• Lift, bend, and stretch with care to avoid injury.

 Musculoskeletal problems caused by poor technique 

when picking up boxes or stretching to reach objects 

is a common cause of workplace injury. If you’re not 

sure how to best lift, bend or stretch at work, ask 

your supervisor or company safety officer.

• Don’t operate tools or machinery that you haven’t 

been trained for.

 While some tools or equipment may seem pretty 

intuitive, it’s always best to avoid using items unless 

you’ve been trained in proper handling. This is for 

your safety as well as the safety of those around 

you.

• Avoid drugs and alcohol at work.

 Not only can drugs and alcohol affect your motor 
skills, they can also impair your judgment and ability 

to communicate. Even prescription drugs can have 

a serious effect on your ability to handle machinery 
and tools safely.

• Take breaks appropriately.

 Being well-rested helps employees maintain 
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the focus and situational safety awareness that 

contribute to workplace safety. In some places, work 

breaks may be established according to contract; 

in others, it’s on the employees to work out breaks 

among themselves.

Safety signs

• Red

 • Prohibition sign

 • Dangerous behaviour; stop; shutdown; evacuate

• Yellow / Amber

 • Warning sign

 • Be careful; take precautions; examine

• Blue

 • Mandatory sign

 •  Specific behaviour or action; wear protective 
equipment

• Green

 • Emergency escape / First-aid sign

• The money is good if you are known in the industry

• Work from home

Job	Profile	/	Tasks
DTP Operator:

• Working to a design brief from the client or designer

• Using DTP software to design each page of the 

publication

• Selecting and formatting, the size and style of type, 
column width and spacing

• Selecting and checking colors

• Scanning and editing photographs and other images.

Desktop Publisher

• Do  proof read to see if there are any errors and 

make necessary changes

• Operate desktop publishing software and equipment 

to design, and produce a print-ready copy

• Use monitors for visual presentation while working 

and instructing and feedback throughout process, 

for making  necessary modifications

• Store copies of publications in every possible way to 
avoid misplacement

Skill Sets

• Have excellent computer skills and knowledge

• Be creative, with an eye for good design

• Be able to prioritize a varied workload

• Work well under pressure and to strict deadlines

• Enjoy doing artistic work.

Work Value

• Dedication

• Commitment

• responsibility

Current Job Scenario

Desktop publishers can earn up to Rs. 10000 per month. 

They may earn more than this depending on what kind 

of clients and projects they are working on.

Top Recruiters

• Hospital

• School

• other large and small businesses.

Fig 1

 • Doors; exits; escape routes; equipment and 

facilities

Scope DTPO Trade :

Scope and Opportunities

• DTP operators work includes publishing, graphic 

design, advertising, printing and reprographics 

companies. Some DTP operators are self-employed.

• There are opportunities in India but more opportunities 

abroad.  In spite of high employmentopportunities 

the job market is highly competitive.

Lifestyle & Social Status

• Its indoor job

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.1.01 a
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IT & ITES Related Theory for Exercise 1.1.02-03

DTPO - Computer Fundamentals

Introduction of  computer

Objectives: At the end of this lesson you shall be able to

• computer components

• introduction to Computer System

• concepts of Hardware and Software

Computer Components

A computer device is made up of various elements 

which help in its effective functioning and processing. 
There are five basic components of the computer 
which help in making this processing of data easier and 

convenient.

1 Input Unit

2 Output Unit

3 Memory Unit

4 Control Unit

5 Arithmetical and Logical Unit

To have a better understanding of the Fundamentals of 

Computer.

The exterior of any computerised device may look 

different and may also have varied features, but the 
basic components remain the same for their functioning.

Input Unit

• A computer will only respond when a command is 

given to the device. These commands can be given 

using the input unit or the input devices. 

• The data entered can be in the form of numbers, 

alphabet, images, etc. We enter the information using 

an input device, the processing units convert it into 

computer understandable languages and then the 

final output is received by a human-understandable 
language.

Output Unit

• When we command a computer to perform a task, 

it reverts for the action performed and gives us a 

result. This result is called output. There are various 

output devices connected to the computer. The most 

basic of which is a monitor. Whatever we write using 

a keyboard or click using a mouse, is all displayed 

on the monitor.

• Thus, the output unit gives us the final result once 
the entire processing is done within the mechanism 

of a device.

• To get a list of computer input and output devices 

and the function of the various I/O devices.

Memory Unit

• When we enter the data into the computer using an 

input device, the entered information immediately 

gets saved in the memory unit of the Central 

Processing Unit (CPU). Because of the presence 

of some existing programming, the Memory Unit 

transmits the data further to the other parts of the 

CPU.

Control Unit

• This is the core unit which manages the entire 

functioning of the computer device. It is one of the 

most essential components of the computer system.

• The Control Unit collects the data entered using the 

input unit, leads it on for processing and once that is 

done, receives the output and presents it to the user. 

It can be said to the centre of all processing actions 

taking place inside a computer device.

• Basically, the instructions taken, interpretation of 

entered data, issuing signals to execute the data 

and then finally retrieving the data is all done in the 
Control Unit.

• As the name suggests, all the mathematical 

calculations or arithmetic operations are performed 

in the Arithmetic and Logical Unit of the CPU. 

• It can also perform actions like a comparison 

of data and decision-making actions. The ALU 
comprises circuits using which addition, subtraction, 

multiplication, division and other numerical based 

calculations can be performed.

Arithmetic and Logical Unit

• All these three units are elements of CPU and 

together help in the efficient working and processing 
of data. It is also known as the “Brain of Computer” 

and no action can be conducted by a device 

without the execution and permission of the Central 

Processing Unit.

Central Processing Unit (CPU)

The Central Processing Unit is the core of any computer 

devices. It comprises three major components of the 

computer which have been discussed above:

• Memory Unit

• Control Unit

Introduction to Computer System

 Input-Process-Output Model

Computer input is called data and the output obtained 

after processing it, based on user’s instructions is 

called information. Raw facts and figures which can 
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Fig 1

be processed using arithmetic and logical operations 

to obtain information are called data.

The processes that can be applied to data are of 

two	types	−
• Arithmetic	 operations	 − Examples include 

calculations like addition, subtraction, differentials, 
square root, etc.

• Logical	operations	− Examples include comparison 

operations like greater than, less than, equal to, 

opposite, etc.

Fig 2

or programs that make the computer function using 

these hardware parts are called software. We 

cannot see or touch software. Both hardware and 

software are necessary for working of a computer.

Characteristics of Computer

To understand why computers are such an 

important part of our lives, let us look at some of its 

characteristics −

• Speed − Typically, a computer can carry out 3-4 
million instructions per second.

• Accuracy − Computers exhibit a very high degree 
of accuracy. Errors that may occur are usually due to 

inaccurate data, wrong instructions or bug in chips – 

all human errors.

• Reliability − Computers can carry out same type 
of work repeatedly without throwing up errors due to 

tiredness or boredom, which are very common among 

humans.

• Versatility − Computers can carry out a wide range 
of work from data entry and ticket booking to complex 

mathematical calculations and continuous astronomical 

observations. If you can input the necessary data with 

correct instructions, computer will do the processing.

• Storage Capacity − Computers can store a very 
large amount of data at a fraction of cost of traditional 

storage of files. Also, data is safe from normal wear and 

tear associated with paper.

Concepts of Hardware and Software

Hardware

The term hardware refers to mechanical device that 

makes up computer. Computer hardware consists 

of interconnected electronic devices that we can use 

to control computer’s operation, input and output. 

Fig 3

The corresponding figure for an actual computer 
looks something like this –

The	basic	parts	of	a	computer	are	as	follows	−
• Input Unit − Devices like keyboard and mouse 

that are used to input data and instructions to the 

computer are called input unit.

• Output Unit − Devices like printer and visual display 
unit that are used to provide information to the user 

in desired format are called output unit.

• Control Unit − As the name suggests, this unit 
controls all the functions of the computer. All devices 

or parts of computer interact through the control unit.

• Arithmetic Logic Unit − This is the brain of the 
computer where all arithmetic operations and logical 

operations take place.

• Memory − All input data, instructions and data interim 
to the processes are stored in the memory. Memory 

is of two types – primary memory and secondary 

memory. Primary memory resides within the CPU 

whereas secondary memory is external to it.

Control unit, arithmetic logic unit and memory are 

together called the central processing unit or CPU. 

Computer devices like keyboard, mouse, printer, 

etc. that we can see and touch are the hardware 

components of a computer. The set of instructions 

Examples of hardware are CPU, keyboard, mouse, 

hard disk, etc.

Hardware Components

Computer hardware is a collection of several 

components working together. Some parts are essential 
and others are added advantages. Computer hardware 

is made up of CPU and peripherals as shown in image 

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.1.02-03
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below.

Software

A set of instructions that drives computer to do stipulated 

tasks is called a program. Software instructions are 
programmed in a computer language, translated into 

machine language, and executed by computer. Software 
can be categorized into two types −

• System software

• Application software

System Software

System software operates directly on hardware devices 
of computer. It provides a platform to run an application. 

It provides and supports user functionality. Examples 

of system software include operating systems such as 

Fig 4 Fig 5

Fig 6

Windows, Linux, Unix, etc.

Application Software

An application software is designed for benefit of users 

to perform one or more tasks. Examples of application 

software include Microsoft Word, Excel, PowerPoint, 

Oracle, etc.

Sl.No.  Software    Hardware

1 It is a collection of programs to bring 

computer hardware system into 

operation.

It includes physical components of computer system.

2 It includes numbers, alphabets, 

alphanumeric symbols, identifiers, 
keywords, etc.

It consists of electronic components like ICs, diodes, registers, 

crystals, boards, insulators, etc.

3 Software products evolve by adding 
new features to existing programs to 

support hardware.

Hardware design is based on architectural decisions to make it 

work over a range of environmental conditions and time.

4 It will vary as per computer and its 

built-in functions and programming 
language.

It is mostly constructed for all types of computer systems.

5 It is designed and developed by 

experienced programmers in high-
level language.

The hardware can understand only low-level language or 
machine language.

6 It is represented in any high-level 
language such as BASIC, COBOL, C, 
C++, JAVA, etc.

The hardware works only on binary codes 1’s and 0’s.

7 The software is categorized as 

operating system, utilities, language 

processor, application software, etc.

The hardware consists of input devices, output devices, 

memory, etc.

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.1.02-03
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Booting

Starting a computer or a computer-embedded device 
is called booting. Booting takes place in two steps −

• Switching on power supply

• Loading operating system into computer’s main  

 memory

• Keeping all applications in a state of readiness in  

 case needed by the user

The first program or set of instructions that run when 
the computer is switched on is called BIOS or Basic 

Input Output System. BIOS is a firmware, i.e. a 

piece of software permanently programmed into the 

hardware.

If a system is already running but needs to be re-
started, it is called rebooting. Rebooting may be re-
quired if a software or hardware has been installed 

or system is unusually slow.

There are two types of booting –

Fig 7

•	 Cold	Booting		/	Hard	Booting−	When the system 

is started by switching on the power supply it is called 

cold booting. The next step in cold booting is loading of 

BIOS.

• Warm Booting / Soft Booting − When the system 
is already running and needs to be restarted or reboot-
ed, it is called warm booting. Warm booting is faster 

than cold booting because BIOS is not reloaded.

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.1.02-03
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IT & ITES Related Theory for Exercise 1.1.04

DTPO - Computer Fundamentals

Function of motherboard and processors

Objectives: At the end of this lesson you shall be able to

• functions of Motherboard Components

• various Processor

Functions of Motherboard Components

Definition	of	the	Motherboard	:
• A motherboard is the main circuit board inside a 

computer that connects the different parts of a com-
puter together. It has sockets for the CPU, RAM and 

expansion cards and it also hooks up to hard drives, 

disc drives and front panel ports with cables and 

wires.

• Motherboard is also known as a mainboard, planar 

board or logic board, system board, mobo or MB. It 

links all the individual parts of a computer togeth-
er and also, allows the CPU to access and control 

these separate parts. Other than bridging internal 

components, the motherboard ports also allows you 

to connect external devices to the computer. Such 
external devices would include the monitor, speak-
ers, headphones, microphone, keyboard, mouse, 

modem and other USB devices.
The functions of a computer motherboard are as 

follows:

• The motherboard acts as the central backbone of a 

computer on which other modular parts are installed 

such as the CPU, RAM and hard disks.

• The motherboard is also responsible to distribute 

power to the various components of the computer.

• They are also used in the coordination of the various 

devices in the computer and maintain an interface 

among them.

Motherboard Components and Connectors

• A typical Asus P5N32-E SLI motherboard with 
constituent components is given below: (Fig 1)

• PCI SLOT (Peripheral Component Interconnect):

 PCI slots are used to Insert or install Add-on cards, 
such as LAN cards, Sound cards, Capture cards and 
TV tuner cards. There are usually anywhere from 1 

to 6 PCI slots available on the motherboard(above 

board has 2 PCI slots. ), they have decreased in 

number and are being replaced by the PCI Express 

1x slots.

•  PCI-E 16x Slot :the most common slot for Graphics 

cards, the PCI Express 16x slots provides 16 

separate lanes or data transfer. These are the 16x 

speed versions, which are currently the fastest. PCI-
E16x allows up to 4 GB/s of peak bandwidth per 

direction, and up to 8 GB/s concurrent bandwidth.

• PCI-E 1x Slot : Single slot - In the PCIe 1.x 
generation, each lane (1x) carries 250 MB/s 
compared to 133 MB/s for the PCI slots. These can 

be used for expansion cards such as Sound Cards, 
or Ethernet Cards.

• Northbridge: This allows communication between 

the CPU and the system memory and PCI-E slots. It 
is a focal Point of Motherboard and It is also called 

as Memory Controller Hub.

• ATX 12V 2X and 4 Pin Power Connection : This 

is one of two power connections that supply power 

to the .motherboard This connection will come from 

your Power Supply.
• CPU-Fan Connection: This is where the CPU fan 

will connect. Using this connection over one fof the 

power supply will allow the motherboard to control 

the speed of the fan, based on the CPU temperature.

• Socket: This is where the CPU will plug in. The 

orange bracket that is surrounding it is used for high 

end heat sinks. It helps to support the weight of the 

heat sink.

• DIMM slots: DIMM’s are by far and away the most 

used memory types in today’s computers. They vary 

in speeds and standards however and they need 

to match up to what your motherboard has been 

designed to take. The four standards of DIMM’s 

being used at the moment are SDR (Single Data 
Rate), DDR (Double Data Rate), DDR2 and DDR3. 

The speeds of memory can vary between 66Mhz to 

1600Mhz.

• ATX Power Connector: This is the second of 

two power connections. This is the main power 

connection for the motherboard, and comes from the 

Power Supply.

Fig 1
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Fig 2

• IDE connectors or PATA connectors : IDE full form

is Integrated Device Electronics. it supports IDE

devices, such as Hard disks and CD and DVD drives.

Most drives today come with SATA connections.

• Southbridge: This is the controller for components

such as the PCI slots, onboard audio, and USB
connections.

• SATA Connections : SATA full form is Serial
Advanced Technology Attachment. These are

connect with serial ATA devices, such as Hard disk

drives and CD or DVD drives.

• Front Panel Connections: this is where we will

hook in the connections from the case. These are

mostly the different lights on the case, such as power
on, hard drive activity etc.

• FDD Connection: The FDD is the Floppy Disk

controller. Floppy Drive Connector is used to connect

floppy drives. It supports two floppy drives.

• External USB Connections: There are usually a

couple of these ports located on each motherboard

used for connecting pen drives and external hard

drives, like Ipods or Mp3 players.

• CMOS battery :This is the motherboard’s battery,

which is used to power the south bridge and the

BIOS to save the setting, data and time.

Different	 Types	 Of	 Motherboard	 Ports	 And	 Their	
Functions Explained

• The below figure shows the connector side of the
Motherboard:

• RJ-45 (Registered Jack 45) LAN port : This port

allows connection to a Local Area Network (LAN)
through a network hub using a RJ-45 cable.

• Analog Audio port :This port connects a tape, CD,

DVD player or other audio soures.

• VGA Port(Video Graphics Array) :VGA cables

carry an analog signal as opposed to a digital signal

(ones and zeroes). Using higher frequencies, it’s

possible to reach a relatively high range of video

resolutions. However, video quality directly responds

to cable quality, and doubly so on higher resolutions.

Due to this, the quality of a VGA image can variate

notable across different makes of cables.

• USB (Universal Serial Bus) 2.0 Ports: There are

usually a couple of these ports located on each

motherboard used for connecting pen drives and

external hard drives, like Ipods or Mp3 players.•

PS/2 Keyboard Port (purple) :This port is for a

PS/2 keyboard

• PS/2 mouse port (green):This port is for a PS/2
mouse.

• 1394a Port : this port is used to connect to any

firewire device. FireWire has largely been supplanted
by USB. Some professional audio hardware still
uses FireWire, though; you may also occasionally

find higher-speed IEEE 1394b headers, but they are
even rarer.

• Optical S/PDIF Used for sound connections to home

audio recievers or powered PC speakers with optical

connections.

• eSATA port(External Serial Advanced Technology 

Attachment): It is an external interface for SATA
technologies. It competes with FireWire 400 and

universal serial bus (USB) 2.0 to provide fast data
transfer speeds for external storage devices.

• HDMI	 Connector(High-Definition	 Multimedia
Interface):HDMI is a digital interface for transmitting

audio and video data in a single cable. It is supported

by most HDTVs and related components, such as

DVD and Blu-ray players, cable boxes, and video
game systems.

• DVI (Digital Visual Interface) connector : It is

used to send digital information from a computer to

a digital display, such as a flat-panel LCD monitor.

• North Bridge : The northbridge typically handles

communications among the CPU, in some cases

RAM, and PCI Express (or AGP) video cards, and

the southbridge. Northbridge is directly connected to
AGP video, thus providing higher transfer rates.

• South Bridge : The southbridge is one of the two

chips in the core logic chipset on a personal computer 

(PC) motherboard, the other being the northbridge.

The southbridge typically implements the slower

capabilities of the motherboard in a northbridge/

southbridge chipset computer architecture. A

southbridge chipset handles all of a computer’s I/O

functions, such as USB, audio, serial, the system
BIOS, the ISA bus, the interrupt controller and the
IDE channels.

Various Processor

Introduction :

The processor is defined as a logic circuit or simple 
chip which reacts to fundamental instructions and input 

processes to operate the computer. The important 

purposes of a processor are getting, decoding, 

processing, executing and writing back as feedback 

to the instructions of the chip. The processor is termed 

as the brain of any electronic systems that incorporate 

into a laptop, computers, smartphones, and embedded 
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systems. The control unit and arithmetic logic unit are 

the two significant components of the processors.

The logic functions can be addition, multiplication, 

subtraction and division whereas the control unit 

manages the traffic flow which follows the operation or 
command according to the input instruction.

What is Processor

Definition – Processor is known as “Microprocessor“, 

and it likes as small type of chip that is placed in the 

computers and another electronics components. 

Processor can manage all instructions such as 

arithmetical, logical, input/output (I/O) and other 

basic instructions, which are created by hardware or 

operating system. Its main job role is to obtain input 

from input devices and then produce the accurately 

result on the output devices. Now these days, more 
advance processors are available in the market, which 

are capable to control trillions of instructions in per 

second.

CPU types

In Types of CPU, CPU is expanded as a central 

processing unit which is the main and central processor 

in the electronic circuitry located inside the system. 

It executes commands according to the computer 

program. It performs fundamental arithmetic logic, input 

and output operations, control circuits that follow the 

program fed in the computer. The term CPU is known 

as a processor which comprises of the control unit 

and process unit differentiating the core elements of a 
computer apart from the external devices like I/O circuitry 

and main memory. The trending CPU is now available 

in the form of microprocessors which comprises unit 

metal-dioxide-semiconductor in the integrated circuits. 
An integrated chip comprises CPU along with peripheral 

interfaces, memory chips, microcontrollers, and other 

systems on the chip. Few systems employ multiple core 

processor enclosed in a single socket termed as CPU 

cores.

Types of CPU

The CPU is a vital element that manages all the 

calculations and commands which are transferred to 

other components of the computer and its peripherals. 

The rapid speed of CPU obeys to command of the input 

program. The components are dependent and powerful 

when linked to the CPU. So it is necessary to choose 
the right one and program it accordingly. The leading 

manufacturers of CPU are AMD and Intel. In the past, 

the processors are employed to find the right and robust 
processor.

The Intel 486 is rapid than 386, but after introducing the 

Pentium processor, all the processors are named like 

Duron, Celeron, Pentium, and Athlon. The various types 

of the processor are built in different architecture like 64 
bit and 32 bit with maximum speed and flexible capacity. 
The major types of CPU are classified as single-core, 
dual-core, Quad-core, Hexa core, Octa-core, and Deca 
core processor which is explained below.

Single-core CPU

It is the oldest type of CPU which is available and 

employed in most of the personal and official computers. 
The single-core CPU can execute only one command at 
a time and its not efficient in multi-tasking. It signifies that 
there is a markable declination in performance if more 

than a single application is executed. If one operation 

is started, the second process should wait until the first 
one is finished. But if it is fed with multiple operations, 
the performance of the computer is drastically reduced. 

The performance of a single-core CPU is based on its 
clock speed by measuring its power.

Dual-core CPU

It is a single CPU that comprises of two strong cores 

and functions like dual CPU acting like one. Unlike the 

CPU with a single core, the processor must switch back 

and forth within a variable array of data streams and if or 

more thread is executed, the dual-core CPU manages 
the multitasking effectively. To utilize the dual-core CPU 
effectively, the running programs and operating system 
should have a unique code called simultaneous multi-
threading technology embedded in it. Dual-core CPU is 
rapid than a single core but it is not robust as quad-core 
CPU

Quad-core CPU

The quad-core CPU is a refined model of multiple 
core CPU features and design with four cores on a 

single CPU. Similar to dual-core CPU, that divides 
the workload in between the cores, and quad-core 
enables for effective multitasking. It doesn’t signify any 
single operation which is four times faster rapid than 

others. Unless the applications and program executed 

on it by SMT code will fasten the speed and becomes 
unnoticeable. Such types of CPU are used in people 
who need to execute multiple different programs at the 
same time as gamers, series of supreme commander 

that is optimized in multiple core CPU.

Hexa Core processors

It is another multiple core processor which is available 

with six cores and can execute the task which works 

rapidly than the quad-core and dual-core processors. 
For users of the personal computer, the processors of 

Hexacore is simple and now the Intel is launched with 

Inter core i7 in 2010 with Hexa core processor. But here 

the users of smartphones use only quad-core and dual-
core processors. Nowadays, smartphones are available 
with hexacore processors.

Octa-core processors

The dual-core is built with two cores, four cores are 
built-in quad-core, Hexa comes with six cores where the 
octa processors are developed with eight independent 

cores to execute an effective task that is efficient and 
even acts rapidly than quad-core processors. Trending 
octa-core processors comprises of a dual set of quad-
core processors that divides different activities between 
the various types. Many times, the minimum powered 

core sets are employed to produce advanced tasks. If 
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there is any emergency or requirement, the rapid four 

sets of cores will be kicked in. In precise, the octa-core 
is perfectly defined with dual-code core and adjust it 
accordingly to give the effective performance.

Deca-core processor

The processor with double core comprises two cores, 

4 cores are available with quad cores, six cores are 

available in hexacore processors. Deca-core is available 
with ten independent systems that are deployed to 

execute and manage the task that is successful than 

other processors that are developed until now. Owning 

a PC, or any device made with a deca-core processor 
is the best option. It is faster than other processors and 

very successful in multi-tasking. Deca-core processors 
are trending with its advanced features. Most of 

the smartphones are now available with Deca core 

processors with low-cost and never become outdated. 
Surely, most gadgets in the market are updated with 
new processors to give more useful purposes to people.

Mainstream processors of CPU

The mid-range processors are called mainstream 
processors which is comparatively larger and manages 

high-performance tasks like video editing, 3D gaming, 
and other multimedia oriented applications. It is similar 

to budget-friendly processors that are implemented 
to execute the fundamental task in a cost-effective 
method. Such a CPU can be easily managed to operate 
office programs, photo editing, web browsing, and other 
basic tasks.

32-bit CPU

• This are the older processor .32-bit processor has a 
structure that can process instructions less efficiently

• 32-bit processor can handle less instruction at one 
time

• 32-bit processor can only handle 4GB of memory

• Even though a 32-bit processor can handle up to 
4GB of memory, having that much memory on a 32-
bit processor will not make it perform quicker.

64-bit CPU

• 64-bits is larger than 32-bits, that means that a 64-bit 
processor can handle more instructions in one load.

• 64-bit processor which can handle up to 17 billion 
GB) of memory or RAM.
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IT & ITES Related Theory for Exercise 1.1.05

DTPO - Computer Fundamentals

Various input & output devices and there features

Objectives: At the end of this lesson you shall be able to

• various Input  devices and their uses

• various output  devices and their uses

• various memory

Various Input Devices and their uses

• Keyboard

• Mouse

• Joy Stick

• Light pen

• Track Ball

• Scanner

• Graphic Tablet

• Microphone

• Magnetic Ink Card Reader(MICR)

• Optical Character Reader(OCR)

• Bar Code Reader

• Optical Mark Reader(OMR)

Keyboard

Keyboard is the most common and very popular input 

device which helps to input data to the computer. The 

layout of the keyboard is like that of traditional (Fig 1) 

typewriter, although there are some additional keys 

provided for performing additional functions.

Keyboards are of two sizes 84 keys or 101/102 keys, 

but now keyboards with 104 keys or 108 keys are also 

available for Windows and Internet.

Mouse

Mouse is the most popular pointing device. (Fig 2) It is a 

very famous cursor-control device having a small palm 
size box with a round ball at its base, which senses 

the movement of the mouse and sends corresponding 

signals to the CPU when the mouse buttons are pressed.

Generally, it has two buttons called the left and the right 

button and a wheel is present between the buttons. A 

mouse can be used to control the position of the cursor 

on the screen, but it cannot be used to enter text into 

the computer.

S.No Keys & Description

1 Typing Keys

These keys include the letter keys (A-Z) and digit keys (09) which generally give the same layout as that 
of typewriters.

2 Numeric Keypad

It is used to enter the numeric data or cursor movement. Generally, it consists of a set of 17 keys that are 

laid out in the same configuration used by most adding machines and calculators.
3 Function Keys

The twelve function keys are present on the keyboard which are arranged in a row at the top of the 

keyboard. Each function key has a unique meaning and is used for some specific purpose.
4 Control keys

These keys provide cursor and screen control. It includes four directional arrow keys. Control keys also 

include Home, End, Insert, Delete, Page Up, Page Down, Control(Ctrl), Alternate(Alt), Escape(Esc).

5 Special Purpose Keys

Keyboard also contains some special purpose keys such as Enter, Shift, Caps Lock, Num Lock, Space 
bar, Tab, and Print Screen.

Fig 1
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Advantages

• Easy to use

• Not very expensive

• Moves the cursor faster than the arrow keys of the 

keyboard.

Joystick

 Joystick is also a pointing device, which is used to 
move the cursor position on a monitor screen. It is a 

stick having a spherical ball at its both lower and upper 

ends. The lower spherical ball moves in a socket. The 

joystick can be moved in all four directions. (Fig 3)

The function of the joystick is similar to that of a mouse. 

It is mainly used in Computer Aided Designing (CAD) 

and playing computer games.

Light Pen

Light pen is a pointing device similar to a pen. It is used 

to select a displayed menu item or draw pictures on the 

monitor screen. It consists of a photocell and an optical 

system placed in a small tube. (Fig 4)

When the tip of a light pen is moved over the monitor 

screen and the pen button is pressed, its photocell 

sensing element detects the screen location and sends 

the corresponding signal to the CPU.

Track Ball

Track ball is an input device that is mostly used in 

notebook or laptop computer, instead of a mouse. This 

is a ball which is half inserted and by moving fingers on 
the ball, the pointer can be moved. (Fig 5)

Since the whole device is not moved, a track ball 
requires less space than a mouse. A track ball comes in 

various shapes like a ball, a button, or a square.

Scanner

Scanner is an input device, which works more like a 
photocopy machine. It is used when some information 

is available on paper and it is to be transferred to the 

hard disk of the computer for further manipulation. (Fig 

6)

Scanner captures images from the source which are 
then converted into a digital form that can be stored on 

the disk. These images can be edited before they are 

printed.

Fig 2

Fig 3

Fig 4

Fig 5

Fig 6

Fig 7
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Digitizer

Digitizer is an input device which converts analog 

information into digital form (Fig 7). Digitizer can convert 

a signal from the television or camera into a series of 

numbers that could be stored in a computer. They can 

be used by the computer to create a picture of whatever 

the camera had been pointed at.

Digitizer is also known as Tablet or Graphics Tablet as 

it converts graphics and pictorial data into binary inputs. 

A graphic tablet as digitizer is used for fine works of 
drawing and image manipulation applications.

Microphone

Microphone is an input device to input sound that is 

then stored in a digital form. (Fig 8)

The microphone is used for various applications such 

as adding sound to a multimedia presentation or for 

mixing music.

Magnetic Ink Card Reader (MICR)

MICR input device is generally used in banks as there 

are large number of cheques to be processed every day 

OCR scans the text optically, character by character, 

converts them into a machine readable code, and stores 

the text on the system memory.

Bar Code Readers

Bar Code Reader is a device used for reading bar coded 

data (data in the form of light and dark lines). Bar coded 

data is generally used in labelling goods, numbering the 

books, etc. It may be a handheld scanner or may be 

embedded in a stationary scanner. (Fig 11)

Bar Code Reader scans a bar code image, converts 

it into an alphanumeric value, which is then fed to the 

computer that the bar code reader is connected to.

Optical Mark Reader (OMR)

OMR is a special type of optical scanner used to 

recognize the type of mark made by pen or pencil.  

(Fig 12) It is used where one out of a few alternatives is 

to be selected and marked.

Fig 8

Fig 9

Fig 10

Fig 11

Fig 12

(Fig 9) The bank’s code number and cheque number 

are printed on the cheques with a special type of ink that 

contains particles of magnetic material that are machine 

readable.

This reading process is called Magnetic Ink Character 

Recognition (MICR). The main advantages of MICR is 

that it is fast and less error prone.

Optical Character Reader (OCR)

OCR is an input device used to read a printed text.  

(Fig 10)

It is specially used for checking the answer sheets of 

examinations having multiple choice questions.

Following are some of the important output devices 

used in a computer.

• Monitors

• Graphic Plotter

• Printer
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Various Output  Devices and their uses

Monitors

Monitors, commonly called as Visual Display Unit 

(VDU), are the main output device of a computer. It 

forms images from tiny dots, called pixels that are 

arranged in a rectangular form. The sharpness of the 

image depends upon the number of pixels.

There are two kinds of viewing screen used for monitors.

• Cathode-Ray Tube (CRT)

• Flat-Panel Display

Cathode-Ray Tube (CRT) Monitor

The CRT display is made up of small picture elements 

called pixels. (Fig 13) The smaller the pixels, the better 

the image clarity or resolution. It takes more than one 

illuminated pixel to form a whole character, such as the 

letter ‘e’ in the word help.

A finite number of characters can be displayed on a 
screen at once. The screen can be divided into a series 

of character boxes - fixed location on the screen where 
a standard character can be placed. Most screens are 

capable of displaying 80 characters of data horizontally 

and 25 lines vertically.

There	are	some	disadvantages	of	CRT	−
• Large in Size

• High power consumption

Flat-Panel Display Monitor

The flat-panel display refers to a class of video 
devices that have reduced volume, weight and power 

requirement in comparison to the CRT. (Fig 14) You 

can hang them on walls or wear them on your wrists. 

Current uses of flat-panel displays include calculators, 
video games, monitors, laptop computer, and graphics 

display.

Printers

Printer is an output device, which is used to print 

information on paper.

There are two types of printers −

• Impact Printers

• Non-Impact Printers

Impact Printers

Impact printers print the characters by striking them on 

the ribbon, which is then pressed on the paper.

Characteristics of Impact Printers are the following −

• Very low consumable costs

• Very noisy

• Useful for bulk printing due to low cost

• There is physical contact with the paper to produce 

an image

These printers are of two types −

• Character printers

• Line printers

Character Printers

Character printers are the printers which print one 

character at a time.

These are further divided into two types:

• Dot Matrix Printer(DMP)

• Daisy Wheel

Dot Matrix Printer

In the market, one of the most popular printers is Dot 

Matrix Printer. (Fig 15) These printers are popular 

Fig 13

Fig 14

Fig 15
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because of their ease of printing and economical price. 

Advantages

• Inexpensive

• Widely Used

• Other language characters can be printed

Disadvantages

• Slow Speed

• Poor Quality

Daisy Wheel

Head is lying on a wheel and pins corresponding to 

characters are like petals of Daisy (flower) (Fig 16) it is 
called Daisy Wheel Printer. These printers are generally 

used for word-processing in offices that require a few 
letters to be sent here and there with very nice quality.

Advantages

• More reliable than DMP

• Better quality

• Fonts of character can be easily changed

Disadvantages

• Slower than DMP

• Noisy

• More expensive than DMP

Line Printers

Line printers are the printers which print one line at a 

time. (Fig 17)

These	are	of	two	types	−
• Drum Printer

• Chain Printer

Drum Printer

This printer is like a drum in shape hence it is called 

drum printer. The surface of the drum is divided into a 

number of tracks. Total tracks are equal to the size of 

the paper, i.e. for a paper width of 132 characters, drum 

will have 132 tracks. A character set is embossed on the 

track. Different character sets available in the market 
are 48 character set, 64 and 96 characters set. One 

rotation of drum prints one line. Drum printers are fast in 

speed and can print 300 to 2000 lines per minute.

Advantages

• Very high speed

Disadvantages

• Very expensive

• Characters fonts cannot be changed

Chain Printer

In this printer, a chain of character sets is used, hence 

it is called Chain Printer. A standard character set may 

have 48, 64, or 96 characters. (Fig 18)

Fig 16

Fig 17

Fig 18

Advantages

• Character fonts can easily be changed.

• Different languages can be used with the same 
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printer.

Disadvantages

• Noisy

Non-impact Printers

Non-impact printers print the characters without using 
the ribbon. These printers print a complete page at a 

time, thus they are also called as Page Printers.

These printers are of two types −

• Laser Printers

• Inkjet Printers

Characteristics of Non-impact Printers

• Faster than impact printers

• They are not noisy

• High quality

• Supports many fonts and different character  size

Laser Printers

These are non-impact page printers. They use laser 
lights to produce the dots needed to form the characters 

to be printed on a page. (Fig 19)

They make less noise because no hammering is d    one 

and these have many styles of printing modes available. 

Color printing is also possible. Some models of Inkjet 
printers can produce multiple copies of printing also.

Advantages

• High quality printing

• More reliable

Disadvantages

• Expensive as the cost per page is high

• Slow as compared to laser printer

Various Memory

Memory :

Memory is the electronic holding place for the instructions 

and data a computer needs to reach quickly. It’s where 

information is stored for immediate use. Memory is one 

of the basic functions of a computer, because without it, 

a computer would not be able to function properly.

Types of computer memory

In general, memory can be divided into primary and 

secondary memory.

Primary memory

Cache memory This temporary storage area, known as 

a cache, is more readily available to the processor than 

the computer’s main memory source. It is also called 

CPU memory because it is typically integrated directly 

into the CPU chip or placed on a separate chip with a 

bus interconnect with the CPU.

• RAM. The term is based on the fact that any storage 

location can be accessed directly by the processor.

• Dynamic RAM. DRAM is a type of semiconductor 

memory that is typically used by the data or program 

code needed by a computer processor to function.

• Static RAM. SRAM retains data bits in its memory 

for as long as power is supplied to it. Unlike DRAM, 

which stores bits in cells consisting of a capacitor and 

a transistor, SRAM does not have to be periodically 
refreshed.

Fig 19

Fig 20

Advantages

• Very high speed

• Very high quality output

• Good graphics quality

• Supports many fonts and different character size

Disadvantages

• Expensive

• Cannot be used to produce multiple copies of a 

document in a single printing

Inkjet Printers

Inkjet printers are non-impact character printers 
based on a relatively new technology. (Fig 20) They 

print characters by spraying small drops of ink onto 

paper. Inkjet printers produce high quality output with 

presentable features.
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• Double Data Rate SDRAM. DDR SRAM is SDRAM 
that can theoretically improve memory clock speed 

to at least 200 MHz.

• Double Data Rate 4 Synchronous Dynamic 

RAM. DDR4 RAM is a type of DRAM that has a 

high-bandwidth interface and is the successor to its 
previous DDR2 and DDR3 versions. DDR4 RAM 

allows for lower voltage requirements and higher 

module density. It is coupled with higher data rate 

transfer speeds and allows for dual in-line memory 
modules (DIMMS) up to 64 GB.

• Rambus Dynamic RAM. DRDRAM is a memory 

subsystem that promised to transfer up to 1.6 billion 

bytes per second. The subsystem consists of RAM, 

the RAM controller, the bus that connects RAM to 

the microprocessor and devices in the computer that 

use it.

• Read-only memory. ROM is a type of computer 

storage containing nonvolatile, permanent data that, 

normally, can only be read and not written to. ROM 

contains the programm ing that enables a computer 

to start up or regenerate each time it is turned on.

• Programmable ROM. PROM is ROM that can be 

modified once by a user. It enables a user to tailor a 
microcode program using a special machine called 

a PROM programmer.

• Erasable PROM. EPROM is programmable read-
only memory PROM that can be erased and re-used. 
Erasure is caused by shining an intense ultraviolet 

light through a window designed into the memory 

chip.

• Electrically erasable PROM. EEPROM is a 

user-modifiable ROM that can be erased and 
reprogrammed repeatedly through the application of 

higher than normal electrical voltage. Unlike EPROM 

chips, EEPROMs do not need to be removed from 

the computer to be modified.

• Virtual memory. A memory management technique 

where secondary memory can be used as if it were 

a part of the main memory. Virtual memory uses 

hardware and software to enable a computer to 

compensate for physical memory shortages by 

temporarily transferring data from RAM to disk 

storage.

Secondary Memory :

Hard Disk

A hard disk is a computer’s permanent storage device. 

(Fig 21) It is a non-volatile disk that permanently 
stores data, programs, and files, and cannot lose store 
data when the computer’s power source is switched 

off. Typically, it is located internally on computer’s 
motherboard that stores and retrieves data using one or 

more rigid fast rotating disk platters inside an air-sealed 
casing. It is a large storage device, found on every 

computer or laptop for permanently storing installed 

software, music, text documentation, videos, operating 

system, and data until the user did not delete.

Floppy Disk

A floppy disk is a secondary storage system that 
consisting of thin, flexible magnetic coating disks 
for holding electronic data such as computer files.  
(Fig 22). It is also known as Floppy Diskette that comes in 

Fig 21

Fig 22

Fig 23

three sizes like 8 inches, 5.5 inches and 3.5 inches. The 
stored data of a floppy disk can be accessed through the 
floppy disk drive. It is the oldest type of portable storage 
device, which can store data up to 1.44 MB. Since most 
programs were larger, that required multiple floppy 
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diskettes to store large amounts of data. Therefore, it is 

not used due to very low memory storage.

CD (Compact Disc)

A CD is an optical disk storage device, stands for 

Compact Disc. (Fig 23) It is a storage device used to 

store various data types like audio, videos, files, OS, 
Back-Up file, and any other information useful to a 
computer. The CD has a width of 1.2 mm and 1.2 mm 

thickness, which can store approximately 700 MB of 

data size. It uses laser light to read and write data from 

the CDs.

Types of CDs

• CD-ROM (Compact Disc Read Only Memory): 

It is mainly used for bulk size mass like audio 

CDs, software and computer games at the time of 

manufacture. Users can only read data, text, music, 

videos from the disc, but they cannot modify or burnt 

it.

• CD-R (Compact Disc Recordable): The type of 

Compact Disc used to write once by the user; after 

that, it cannot be modified or erased.
• CD-RW (Compact Disc Rewritable): It is a 

rewritable CD disc, often used to write or delete the 

stored data.

DVD Drive/Disc

DVD is an optical disc storage device, stands for Digital 

Video Display or Digital Versatile Disc. (Fig 24) It has 

the same size as a CD but can store a larger amount of 

data than a compact disc. It was developed in 1995 by 
Sony, Panasonic, Toshiba and Philips four electronics 
companies. DVD drives are divided into three types, 

such as DVD ROM (Read Only Memory), DVD R 

(Recordable) and DVD RW (Rewritable or Erasable). 

It can store multiple data formats like audio, videos, 

images, software, operating system, etc. The storing 

capacity of data in DVD is 4.7 GB to 17 GB.

Blu Ray Disc (BD)

Blu Ray is an Optical disc storage device used to 

store a large amount of data or high definition of video 
recording and playing other media files. It uses laser 
technology to read the stored data of the Blu-ray Disk. It 

can store more data at a greater density as compared to 

CD/ DVD. For example, compact discs allow us to store 

700 MB of data, and in DVDs, it provides up to 8 GB of 

storage capacity, while Blu-ray Discs provide 28 GB of 
space to store data.

Pen Drive

A pen drive is a portable device used to permanently 

store data and is also known as a USB flash drive.  
(Fig 25) It is commonly used to store and transfer the 
data connected to a computer using a USB port. It does 
not have any moveable part to store the data; it uses 

an integrated circuit chip that stores the data. It allows 

the users to store and transfer data like audio, videos, 

images, etc. from one computer to any USB pen drive. 
The storing capacity of pen drives from 64 MB to 128 

GB or more.

SD Card:

SD Card stands for Secure Digital Card. It is most 
often used in portable and mobile devices such as 

smartphones and digital cameras. (Fig 26) You can 

remove it from your device and see the things stored in 

it using a computer with a card reader.

There are many memory chips inside the SD card that 
store the data; it does not have moving parts. SD cards 
are not created equal, so they may differ from each 
other in terms of speed, physical sizes, and capacity. 

For example, standard SD cards, mini SD cards, and 
micro SD cards.

Fig 24

Fig 25

Fig 26
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IT & ITES Related Theory for Exercise 1.2.06-08

DTPO - Windows Accessories

Windows	accessories	and	difference	document	&	text	file
Objectives: At the end of this lesson you shall be able to

•	 windows	operating	system
•	 different	basic	accessories
•	 explain	about	wordpad
•	 difference	between	wordpad	file	and	Notepad
•	 explain	about	paint	Brush

Windows	 Operating	 System:	 An operating system 

is a software	programme	 required	 to	manage	 and	
operate	a	computing	device like smartphones, tablets, 

computers, supercomputers, web servers, cars, network 

towers, smartwatches, etc. It is the operating system 

that eliminates the need to know coding language to 

interact with computing devices.

Main	Components	of	Windows:	The main components 

of the Windows Operating System are the following:

•  Configuration and maintenance
•  User interface

•  Applications and utilities

•  Windows Server components

•  File systems

•  Core components

•  Services

•  DirectX

•  Networking

•  Scripting and command-line

•  Kernel

•  NET Framework

•  Security

•  Deprecated components and apps

•  APIs

When coming to GUI components, we have the following 

as the main components: (Fig 1)

• Desktop

It is the very first screen that you will see once the 
windows start. Here you will see “My Computer”, 

“My Documents”, “Start Menu”, “Recycle Bin”, and 

the shortcuts of any applications that you might have 

created.

• Taskbar

At the bottom, you will see a row which is known as 

the taskbar. It has the currently running applications, 

you can also pin applications that you frequently use by 

using an option Pin to Taskbar”.

• Start	Menu
This is located in the bottom left corner of Windows OS 

GUI. This is the place where the user can search for any 

setting and for any application for their use. Users can 

uninstall or repair applications from the control panel. 

The user can do a lot of activities just by searching 

through the start menu.

• My	Computer
When you double click on “My Computer” menu, it will 

let you navigate between your different computer drives 
and the control panel tools. You can see and manage 

the contents that are inside your drive.

• Recycle	Bin
When you delete an item from any of your drives by 

making use of “delete” button or even by simply clicking 

right clicking and selecting “delete” option, it is not 

deleted completely, instead, it is moved to “Recycle 

Bin” folder of Windows. You can recover your content 

if you have deleted it by mistake from here or if you 

choose to delete the items from here, it will get deleted 

permanently. Should you wish to delete the item in first 
go itself without moving it to recycle bin, you can use the 

key “Shift+Del”

Features	of	Windows
The main Features of Windows:

• Windows Search: We can have numerous files 
and contents located on our system and sometimes 

we may run out of memory about the exact location 

of our file. Windows Search is a search function 
included with Windows that allows the user to search 

their entire computer

• Windows File Transfer: We may have the need 

to transfer in or transfer out the files and contents 
from our machine to other devices such as other 

computers or mobiles and tablets. We can do this by 

using an Easy Transfer Cable, CDs or DVDs, a USB 

flash drive, wireless Bluetooth, a network folder, or 
an external hard disk.

Fig 1
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• Windows Updates: Windows includes an automatic 

update feature with the intended purpose of keeping 

its operating system safe and up-to-date.

• Windows taskbar: At the bottom most part of your 

windows, you will see a row which is known as the 

taskbar. It has the currently running applications, you 

can also pin applications that you frequently use by 

using an option Pin to Taskbar”. The taskbar is the 

main navigation tool for Windows

• Remote	 Desktop	 Connection: This feature of 

windows allows you to connect to another system 

and work remotely on another system.

Advantages and Disadvantages of Windows

Now we are going to explore the advantages and 

disadvantages of Windows.

Advantages

• Desktop as well as tablet-friendly OS

• Switch between applications is very easy

• Not much technical knowledge is required to operate 

windows

• Windows OS is the dominant OS and enjoys more 

than 90% of Market share

• MS OS have a great support community and it also 

has the largest number of applications

• Microsoft provides a powerful set of Enterprise 

focused Operating System, Applications and the 

services making it the most dominant player in the 

OS market.

• More gaming

Disadvantages

There are privacy and security concerns and incidents 

and they are widespread. Linux OS is by far most secure 

OS ever built.

• Cost for upgrade

• Windows OS attracts a large number of virus 

programs due to its largest market share and easy 

to breach paradigm

• Windows OS is not that much of touch-friendly.

Different	Basic	Accessories
Window accessories:-

Window Accessories Group is a very important part of 

the window, very important tools are available inside 

Window Accessories, which we can use according to 

our need. Inside the Window Accessories Group, a 

list of many facilities is displayed so that we can do 

Simple Type. Can apply some special characters, can 

calculate Mathematics, can manage the performance of 

your computer, although there are many tools inside the 

Window Accessories Group, but some important tools 

are as follows.

• Character Map

• Calculator

• Notepad

• word pad

• Remote Desktop Connection

• Paint

• Math input panel

• snipping tool

• disk clean up

• disk defragment

Character Map:-

• There is such a facility in Character Map Window 

Accessories, using which we can know which key or 

key combination has been determined in which font. 

It contains all those keys/fonts which are not given 

on the keyboard.

• Start button→ All program→ Window accessories→ 
Character Map

Calculator:-
• We use this tool available in Window Accessories to 

do arithmetic and scientific calculations. To run the 
calculator, a normal calculator is displayed on the 

screen, which we run with the help of a mouse so 

that we can do Mathematical Sums very easily. This 

is an important tool of our Windows

• Start button→ All program→ Window accessories→ 
calculator

Note	Pad:-
• Note Pad is the Window’s Text Editor Program, we 

use it to create a text file in the window, the extension 
(.txt) of the file created inside it is that there is some 
limit to the text in this text editor.This is a very 

important tool for Windows accessories.

• Start button→ All programs→ Window accessories→ 
notepad

Word Pad:-

• Word Pad is also called a Word Processor, it is also 

a text editor program, it is an advanced form of note 

pad. You can change the size of the font in it, we 

can fix the date and time, it is an important tool of 
Window Accessories.

• Start button→ All program→ Window accessories→ 
word pad

Remote	Desktop	Connection:-
• Remote Desktop Connection In this, we can get 

help by connecting remotely to the person sitting far 

away, that is, the person sitting far away can operate 

our computer, in this, we can connect from one 

computer to another computer and take any help or 

help anyone. Is

• Start button→ All program→ Window accessories→ 
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remote desktop connection

Paint:-

• The Paint Tool present in the Window Accessories 

Group is very important, with the help of this tool we 

can make pictures, sketches and maps etc. In this, 

with the help of many tools, we can paint a good 

type.

• Start button→ All program→ Window accessories→ 
paint

Math	input	panel:-
• Math input panel is a part of window accessories. 

Math input panel has come into use from windows. It 

is used to convert any word or character to any Digit 

of Math. For example, if we made ‘s’ on Friends-

math input panel, then it will convert to ‘5’. Any word 

is made with the help of mouse on the Math input 

panel.

• Start button→ All program→ Window accessories→ 
Math input panel

Snipping Tool:-

• Snipping tool is also an important tool of Window 

Accessories, with the help of this we can take Screen 

short (SS) of any object of the screen, with the help 

of this tool we can take Screen short in the same 

way as we take in our phone.

• Start button→ All program→ Window accessories→ 
snipping tool

Disk	cleanup:-
• Disk cleanup is one of the most important tools of 

window accessories, with the help of this we can 

clean many things like junk files, cookies from our 
PC, due to this the performance of our computer 

becomes faster.

• Start button→ All program→ Window accessories→ 
System tool→ disk cleanup

Disk	defragment:-
• Disk defragment is a tool of window accessories, it 

is used to arrange the saved file or folder in the hard 
disk, it is used to eliminate the free space on the disk 

drive and organize the file & folder.

• Start button→ All program→ Window accessories→ 
System tool→ defragment

Explain	About	Wordpad
Like many word processors, WordPad allows users to 

create, format, save and print documents. WordPad 

comes with most PC operating systems, starting with 

Windows 95. While WordPad does not have the power 

of more sophisticated word processors such as Word, 

it does have enough power to create basic documents. 

With the release of Windows 7, WordPad has been 

overhauled and includes several new features.

User Interface

WordPad in Windows 7 uses the updated Microsoft user 

interface called the Ribbon. This toolbar runs across the 

top of the WordPad screen and separates commands 

by tabs and groups. Previous versions of WordPad 

used the standard drop-down menu toolbar.

Formatting	Options
Previous versions of WordPad had a limited ability to 

format text. In the updated WordPad, select the text 

you want to change and click the “Home” tab. In the 

Font group, select a different font, type size or color. 
You can also add bullets, highlighting and change 

text alignment. You can change the margins of your 

document by clicking the “WordPad Menu” button and 

selecting “Page Setup.”

Graphics

You can now add graphics to a WordPad document. In 

the Home tab, go to the Insert group. Click on “Picture” 

to add a photograph or another saved image to a 

document. To add a Paint drawing (another operating 

system tool), click on “Paint Drawing.”

Search and Replace

WordPad does not contain a spell check, thesaurus or 

grammar assistance. It can search and replace text by 

clicking on the Home tab and going to the Editing group. 

You can find words in the text by clicking “Find,” or 
replace them by clicking “Replace.” As with most word 

processors, you can cut, copy and paste text around a 

document.

View

Another new feature in WordPad is zoom. In previous 

versions, if you wanted to see a close-up view of a 

document, you had to print it out. In Windows 7’s 

WordPad, you can view the document up close or from 

far away by clicking on the “View” tab and then clicking 

one of the options in the Zoom group to increase or 

decrease the document view. You can also add the 

status bar to WordPad in the View tab area so you can 

get more information about a document or change the 

word wrap settings.

File	Formats
WordPad can open and save files in the text (TXT), 
Rich Text Format (RTF), Word document (DOCX), and 

Open Document Text (ODT), according to Microsoft. 

Files opened from Word 2007 and 2010 may not appear 

the same in WordPad since it does not have all the 

capabilities of Word.

Difference	between	Wordpad	file	and	Notepad
As per the names, it looks like they both are the same, 

but somehow they vary differences in their feature and 
functions as they both are included in the Microsoft 

Windows operating system.
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Fig 2

Difference	between	WordPad	and	NotePad	:

NotePad WordPad

It is a simple and easy tool for basic plain text entry It is simple and easier than MS Word

It can be used for doing a couple of different ways It is an easy tool for doing simple tasks

It is made for to create the documents only It is made for formatting and printing the documents

It is a text editor program It is a word processor program

It is just a  simple text editor that does not include any 

formatting options into it.

It helps in creating the documents which include 

graphics and various text formatting options  into it

It is a text editor that is included with the windows 

operating system

It is also a text editor which is included with the windows 

operating system.

It was launched by Microsoft in the year 1983 It was launched by Microsoft along with Windows 95

Notepad is a text editor WordPad is a basic word processor.

Notepad can only save text as it is better for creating 

webpages

It helps in saving the text with the basic formatting like 

font styles and sizes etc.

It  can only save documents as .txt files only It can be saved as .txt and .rtf Rich Text Format files 
both

Images and other graphics options are not added to 

this

Images and other graphic options can be added to this.

The files like Rich text formats Wordpad are cannot be 
opened into it

Any notepad file can be opened with this

It includes the options like files, edit, view, format, and 
helps options only into it

It includes more options which are easily available in it

It does not include any formatting options as no 

formatting of the text is done into it. It only focuses on 

creating the text files only.

It includes the formatting options into it like italic, bold, 

font style and size, etc.

It  is a good choice for creating webpages or HTML 

documents and writing the basic computer programs 

also

It  is a good choice for writing papers or creating 

documents that you want to print

It is also helpful for removing formatting from the 

text which is copied and which you wanted to paste 

somewhere else as a plain text

As it supports the bullets into it which is helpful for 

making lists

Just paste the text into Notepad, copy it again from 

Notepad, and you have completely unformatted text

You can use Wordpad to open an unformatted tect 

document and add whatever formatting you want

Explain	About	Paint	Brush:	Microsoft Paint is a basic 

computer graphics program found on most personal 

computers using a Windows operating system. (Fig 2) 

Images created within MS Paint are typically saved as 

GIF, Windows bitmap, PNG, TIFF or JPEG files. Origi-
nally, MS Paint only allowed users to create black and 

white images, but now users can paint in a full array of 

colors with simple, user friendly tools.

Select

• The “Select” tools look like a star or rectangle outlined 

with hashed lines. The star shape is the “Free-Form 

Select” tool that allows you to select part of a picture 

that is any shape. The button with the image of a 

rectangle lets you select a rectangular area within an 

image.
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Eraser

• Under the star “Select” tool is the “Eraser” tool. This 

allows you to erase small areas of the image by 

dragging the mouse pointer over the part you wish 

to eliminate.

Fill Tool

• The “Fill Tool” looks like a jar that has paint spilling 

out of it. When you select an area of your image with 

the left mouse button, the foreground color will fill 
with a color. When you select an area of your image 

with the right mouse button, the background of the 

image will fill with a color.

Pick Color

• The button with the image of an eyedropper is the 

“Pick Color” tool. This allows you select an object 

whose color you want to copy and use the color 

elsewhere in the image.

Magnifier
• Next to the “Pick Color” button is the “Magnifier” 

button, which looks like a magnifying glass. Selecting 

this tool will allow you to zoom in an out of an image.

Pencil	and	Brush
•  The button with an image of a pencil in it is the “Free-

Form Line” tool. It allows you to draw lines by clicking 

and dragging your computer mouse.

• The image of the paintbrush next to the image of the 

pencil is the “Brush” tool. Use this to brush a thick 

line on your image with different brush shapes.

Airbrush
• The “Airbrush” tool’s button has the image of a paint 

can in it. This tool allows you to “spray” an area of 

your image with a color of your choice.

Text

• The “Text” tool is next to the image of the paint can, 

and has the letter “A” on it. Use this to type text 

directly onto your picture.

Rectangle

• The “Rectangle” tool has an image of a rectangle 

drawn with a solid line on the button. Use this tool to 

draw rectangles in your picture.

Polygon

• The “Polygon” tool is next to the “Rectangle” tool. 

This tool allows you to make several lines at different 
angles to form the shape of a polygon.

Ellipse	and	Rounded	Rectangle
• The bottom left tool with the shape of an oval in 

it is the “Ellipse” tool. Make circles and ovals by 

selecting this tool and dragging the computer mouse 

diagonally after clicking on a place in your image.

• Draw a rectangle with rounded corners by selecting 

the last tool in MS Paint. Use the “Rounded 

Rectangle” tool in the same manner you would the 

“Ellipse” tool.
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IT & ITES Related Theory for Exercise 1.3.09

DTPO	-	MS	-	Office

Introduction of typing tutor

Objectives: At the end of this lesson you shall be able to

• explain of Typing Tutor

•	 different	Option	to	Improve	Typing	Speed
• about Typing Tools

Typing Tutor :-

A typing tutor is a tool that is designed to help the user 

to enhance their typing skills. This can be done by 

taking lessons, playing games, or giving a typing test 

repeatedly.

Typing Tutor Software

There are many software available to help the user 

improve their typing skills by conducting many activities 

or tests. Some typing tutor software and their features 

are given below, out of which some are available for 

free, and some are paid.

Typing Master for Windows

Typing Master is a typing tutor for Windows to help 

develop your speed and accuracy. (Fig 1)

• The Introduction and Beginner courses helps to 

learn the position of keys on the keyboard. After 

completing this course, you will know which finger to 
use to hit each key without looking at the keyboard. 

The course also covers upper-case letters, special 

symbols, and the numeric pad.

• The Experienced course helps to improve your typing 

speed by memorizing frequently used syllables and 

words.

• The Advanced course helps you to perfect the skills 

acquired by typing an actual text.

• The Testing course tests your touch typing skills.

Tools: Typing Master 10 typing tutor provides excellent 

tools to thoroughly test your typing skills - and prove 

them to others. You can complete tests up to 30 minutes 

long and choose from a variety of texts with different 
levels of difficulty.
You can complete the test as many times as you like 

and view detailed results for each test round. Then just 

choose your best result and print out a detailed test 

diploma to prove your skills.

Advanced Test Library

Set freely your test duration and choose from a large 

number of test texts.

Real-Life	Test	Environment
Intelligent progress highlight, text wrapping and ability 

to correct errors provide a fluent typing experience.
Detailed Results: See your test results immediately, 

view your difficult keys and see what kind of typing errors 
you made. All your results are automatically saved.

Printable	Test	Certificate:	Select your best test result 

and print out a detailed test certificate to prove your 
typing skills.

Typing Analysis Widget: Analyze your typing while 

working and train weaknesses with customized 

exercises.

Complete	 Touch	 Typing	 Courses:	 Learn to touch 

type by completing over 10 hours of interactive study 

material.

Customized	 Review:	 While training Typing Master 

detects those problem areas that need extra practice 

and creates additional tailor made exercises for them.

Typing	Games
Play our fun typing games to see how far your typing 

skills will take you.

Fig 1

Typing Master – Features

Typing Master comes with multiple features and aims at 

doubling your typing speed. 

• Customized exercises, more than 10 hours of 

content

• Step by step approach to professional keyboarding

• Train difficult words and keys
• Vision based learning

• Detailed and customized review of the performance

• Skill tests to monitor progress

• Games to have all the fun while learning

• Typing Meter to measure and analyze typing habits

• Typing analysis widget

Different	Option	to	Improve	Typing	Speed
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Introduction	to	MS	Office:	Microsoft Office (or simply 
Office) is a family of server software, and services 
developed by Microsoft. It was first announced by 
Bill Gates on August 1, 1988, in Las Vegas. The first 
version of Office contained Microsoft Word, Microsoft 
Excel, and Microsoft PowerPoint. Over the years, 

Office applications have grown substantially closer with 
shared features such as a common spell checker, data 

integration etc. Office is produced in several versions 
targeted towards different end-users and computing 
environments. The original, and most widely used 

version, is the desktop version, available for PCs 

running the Windows, Linux and Mac OS operating 

systems.

Microsoft Office is a suite of desktop productivity 
applications that is designed specifically to be used 
for office or business use. It is a proprietary product of 
Microsoft Corporation and was first released in 1990. 
Microsoft Office is available in 35 different languages 
and is supported by Windows, Mac and most Linux 

variants. It mainly consists of Word, Excel, PowerPoint, 

Access, OneNote, Outlook and Publisher applications.

Microsoft Office was primarily created to automate the 
manual office work with a collection of purpose-built 
applications.

Each of the applications in Microsoft Office serves as 
specific knowledge or office domain such as:
1 Microsoft Word: Helps users in creating text 

documents.

2 Microsoft Excel: Creates simple to complex data/
numerical spreadsheets.

3 Microsoft PowerPoint: Stand-alone application for 
creating professional multimedia presentations.

4 Microsoft Access: Database management 
application.

5 Microsoft Publisher: Introductory application for 
creating and publishing marketing materials.

6 Microsoft OneNote: Alternate to a paper notebook, it 
enables an user to neatly organize their notes.

Important	 Features	 of	 Ms-Word:	 Ms-Word not only 

supports word processing features but also DTP 

features. Some of the important features of Ms-Word 

are listed below:
i Using word you can create the document and edit 

them later, as and when required,

by adding more text, modifying the existing text, deleting/
moving some part of it.

ii Changing the size of the margins can reformat 

complete document or part of text.

iii Font size and type of fonts can also be changed. 

Page numbers and Header and Footer can be 
included.

iv Spelling can be checked and correction can be 

made automatically in the entire document. Word 

count and other statistics can be generated.

v Text can be formatted in column style as we see in 

the newspaper. Text boxes can be made.

vi Tables can be made and included in the text.

vii Word also allows the user to mix the graphical 

pictures with the text. Graphical pictures can either 

be created in word itself or can be imported from 

outside like from Clip Art Gallery.

viii Word also has the facility of macros. Macros can be 

either attached to some function/special keys or to a 
tool bar or to a menu.

ix It also provides online help of any option.

MS Word: Follow these simple steps to open MS Word 

on your personal computer:
Start → All Programs → MS Office → MS Word.
Uses of MS Word: MS Word enables users to do write-

ups, create documents, resumes, contracts, etc. (Fig 1) 

Fig 1

Fig 2

IT & ITES Related Theory for Exercise 1.3.10-12

DTPO	-	MS	-	Office

Introduction	MS	-	office	create,	save	and	print	in	MS	word
Objectives: At the end of this lesson you shall be able to

•	 explain	MS	Office
• brief MS Word

• about typing tools

This is one of the most commonly used programs under 

the Office suite.
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Features of MS Word

Now let us read more about the features and components 

of an MS Word doc file in detail.
The image given below shows the different elements 
and categories which are available in MS Word doc: 

(Fig 2)

• Home
This has options like font colour, font size, font style, 

alignment, bullets, line spacing, etc. All the basic 

elements which one may need to edit their document is 

available under the Home option.
• Insert

Tables, shapes, images, charts, graphs, header, footer, 

page number, etc. can all be entered in the document. 

They are included in the “Insert” category.

• Design

The template or the design in which you want your 

document to be created can be selected under the 

Design tab. Choosing an appropriate tab will enhance 

the appearance of your document.

• Page Layout

Under the Page Layout tab comes options like margins, 

orientation, columns, lines, indentation, spacing, etc.

• References

This tab is the most useful for those who are creating a 

thesis or writing books or lengthy documents. Options 

like citation, footnote, table of contents, caption, 

bibliography, etc. can be found under this tab.

•  Review

Spell check, grammar, Thesaurus, word count, 

language, translation, comments, etc. can all be tracked 

under the review tab. This acts as an advantage for 

those who get their documents reviewed on MS Word.

Apart from all the above-mentioned features, the page 

can be set in different views and layouts, which can be 
added and optimised using the View tab on the Word 

document. Margins and scales are also available for the 

benefit of the users.

Fig 3

Create	a	document 
1 On the File tab, click New

Fig 4

2 Select blank document. (Fig 3)

Add	and	format	text
• Place the cursor and type some text.

• To format, select the text and then select an option: 
Bold, Italic, Bullets, Numbering, and more.(Fig 4)

Add	Pictures,	Shapes,	SmartArt,	Chart,	and	more
• Select the Insert tab.

• Select what you want to add:

Fig 5

• Tables - select Table, hover over the size you want, 

and select it.

• Pictures - select Pictures, browse for pictures from 

your computer, select a stock image, or even search 

Bing.

• Shapes - select Shapes, and choose a shape from 

the drop-down.

• Icons - select Icons, pick the one you want, and 

select Insert.

• 3D Models - select 3D Models, choose from a file or 
online source, go to the image you want, and select 

Insert.

• SmartArt - select SmartArt, choose a SmartArt	
Graphic, and select OK.

• Chart - select Chart, select the chart you want, and 

select OK.

• Screenshot - select Screenshot and select one 

from the drop-down.

Save	a	document
Step 1: Start a new document in Word and type your  

 text.

Step 2: Click File in the top left-hand corner of the  
 screen.(Fig 5)

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.3.10-12

©
 N

IM
I 

N
O
T
 T

O
 B

E
 R

E
P
U
B
L
IS

H
E
D



35

Step 3: From the menu, choose Save.(Fig 6)

Step 4:

A ‘Save’ dialogue box will come up. At the top  a n d 

at the left-hand side in the list of folder options, it will 

show the folder where you’ll be saving the document.

(Fig 7)If you wish to change this folder, navigate through 

the folders on the left-hand side of the dialogue box to 

choose the one where you want to save your document.

Fig 6 Fig 7

Fig 8

Step 5:

Word will automatically give your document a name, 

based on the first few words of your text. If you don’t like 
the one given, once you have chosen the destination 

folder, type a name for your document in the ‘File name’ 

box. Come up with a name that is concise but will allow 

you to find the document easily again. (Fig 8)
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Step 6:

Once you have typed in the name of your document, 

click Save.

Fig 9

Step 7: Your document will now have a name, which 

will be shown at the very top of your document screen. 

If you make changes to your document and then save 

them after it has been saved originally, the dialogue box 

will not come up again. It will just save your changes 

without any visual notification being shown.

Step 8: The ‘Save As’ menu – the link to which is on the 

left-hand side of the ‘File’ dialogue box, beneath ‘Save’ 

– is used to save an existing document under another 

name. This is helpful if you’ve made changes to your 

document and then want to save the changes, but also 

keep the original document in its original format and 

under its original name. (Fig 9)

Print	a	Document
• Click the File tab.

• Click Print. (Fig 10)

• Examine the print preview on the right side of the 

screen to ensure the document appears correct.

• Select the correct printer by clicking the Printer list 

arrow and selecting it from the list.

• Adjust the printer settings using the options below 

the printer, described in the following table.

• Set the number of copies in the Copies text field.

• Click Print. (Fig 11)

The document is sent to the printer.

Fig 10

Fig 11
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IT & ITES Related Theory for Exercise 1.3.13 - 25

DTPO	-	MS	-	Office	

Formatting	character,	paragraph	and	mail	merge.
Objectives: At the end of this lesson you shall be able to

• explain the concept of font

•	 edit	and	format	text
• create a style 

•	 table	and	formatting
•	 mail	merge	option

Concept of Font

Change the Font

Changing a font itself will have the greatest effect on the 
appearance of text.

• Select the text you want to change.

• Click the Font list arrow on the Home tab.
You can also click the Font list arrow on the Mini Toolbar 

that appears when text is selected. (Fig 1)

• Select a new font from the list.

The text is now set in the selected font.

When changing fonts, be sure to choose the right font 

for the tone of your document. Don’t use casual script 

fonts in a professional document, and also avoid using 

too many fonts at once.

Fig 1

Font Type Examples Description

Serif Times New Roman, Garamond, 

Cambria, Georgia, Palatino

Serifs are small details at the ends of some letter 

strokes, meant to improve legibility. Suitable for 

both header and body text.

Sans Serif Arial, Calibri, Helvetica, Verdana, 
Trebuchet MS

Sans serif fonts lack the small details at ends of 

letter strokes, leading to a plainer look. Suitable for 

both header and body text.

Script Brush Script, Zapfino, Lucida 
Handwriting

These fonts are meant to mimic handwriting, 

either calligraphic or casual. Useful in very specific 
designs, but unsuitable for body text and most 

headers.

Monospace Courier New, Consolas, American 

Typewriter

All letters and symbols use the exact same amount 

of space. Useful when displaying computer code, 

or when precise horizontal alignment between 

lines is important.

Change	the	Font	Size
Changing the font size helps differentiate between titles, 
headers, and body text.

• Select the text.

• Click the Font Size list arrow on the Home tab.  
(Fig 2)

• Select a font size.

The font size changes.

Click the	 Increase	Font	Size	or	Decrease	Font	Size 

buttons to increase or decrease by one point at a time. 

(Fig 2)

Font size is measured in points (pt) that are 1/72 of an 
inch. The larger the number of points, the larger the font.

Change the Font Color

You may need to change font color to make text stand 

out, comply with brand standards, or add visual appeal.

• Select the text you want to change.

• Click the Font Color list arrow.

You can also click the Font Color list arrow on the Mini 

Toolbar. (Fig 3)

• Select a new color.
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Fig 2

If you don’t like any of the available theme colors, select 

More Colors to display the Colors dialog box. (Fig 3)

Fig 3

Apply	Bold,	Italic,	or	an	Underline
In addition to changing font type, size, and color, you can 

also enhance the text further by using other features in 

the Font group like bold, italic, or underline.

• Select the text you want to change.

• Select Bold, Italics, or Underline. (Fig 4)

Shortcuts:

• To bold: Ctrl + B

• To italicize: Ctrl + I

• To underline: Ctrl + U

The effect is applied.

Fig 4

Change the Case

If you want to change the case of a block of text, you 

don’t need to retype the whole thing. You can easily 

change the case of selected text with the Change Case 

menu.

With	 the	 text	 selected,	 click	 the	 Change	 Case	
button. (Fig 5)

• Select a case option:

• Sentence case

• lowercase

• UPPERCASE

• Capitalize Each Word

• tOGGLE cASE

Clear	Formatting
If you change your mind and want to remove all 

formatting from text, you can easily clear all formatting 

at once.

• With the text selected, click Clear All Formatting.
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Creating	a	new	Style	from	an	example
If you’ve already got some text formatted just the way 

you want it, you can use it to create a new Style. The 

easiest way is to select the text you want the Style to 

emulate, right-click and select Styles, then select Create 

a Style: (Fig 7)

The extra formatting is removed, and the text is reset to 

the default style.

You’ll get this dialog box:

You could simply click OK here, but I want modify the 

style so, click modify option. (Fig 8)

Fig 5

Fig 6

Fig 7

Fig 8

Fig 9

We get the dialog box (Fig 9) change the paragraph 

& character styles and style name and then click ok 

button.

Insert Table in MS Word

Table is a versatile tool of MS Word. It allows you to 

organize your information, i.e. you can align text, 

present numerical data and create forms and calendar. 

The steps to insert table are given below;

• Place the cursor where you want to insert the table

• Select the Insert tab (Fig 10)

• In Tables group click the Table command

• It displays different options to insert the table

• Select the desired option to insert the table

Convert Text to Table

• Select the text

• Select the Insert tab

• In Tables group click the Table command

• Select the ‘Convert Text to Table’ option;  (Fig 11)

• It displays a dialog box

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.3.13-25

©
 N

IM
I 

N
O
T
 T

O
 B

E
 R

E
P
U
B
L
IS

H
E
D



40

Add Row in Table

If you want to increase or add a new row in your table, 

you can follow the steps given below;

• Place the cursor in a row above or below which you 

want to add row

• Right click the mouse

• A menu appears

• Place the arrow over Insert option

• It will display a menu. (Fig 13)

• As required select ‘Insert Rows Above’ or ‘Insert 

Fig 10

Fig 11

• In ‘Separate text at’ section select the desired option 

(Fig 12)

• Click OK, the text will convert to a table

Fig 12

Fig 13

Rows Below’

Add	Column	in	Table
If you want to increase or add a new column in your 

table, you can follow these steps;

• Place the cursor in the column adjacent to which you 

want to add the column

• Right click the mouse

• It displays a menu (Fig 14)

• Place the arrow over Insert option

Fig 14

• It shows a list of commands

• As required select ‘Insert Columns to the Right’ or 

‘Insert Columns to the Left’

Delete	Column	or	Row	in	Table
The table command also allows you to delete a column 
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or row in your table. You can delete the unwanted 

columns or rows by following these steps;

• Select the column or row of the table

• Right click the mouse

Word allows you to customize tables as per your 

requirement. You can modify your table in different 
ways, i.e. you can choose a table style, table design, 

draw borders. The steps to modify a table are given 

below;

• Select the table

• Two new tabs Design and Layout appear on the 

• A menu appears. (Fig 15)

• As required select ‘Delete Columns’ or ‘Delete Rows’

Modify Table

Fig 15

Ribbon

• On Design tab you will see three groups of commands 

to modify table; Table Style Options, Table Styles 

and Draw Borders; (Fig 16)

• Layout tab has six groups of commands to format 

table; (Fig 17)

Fig 16

Mail Merge

Fig 17

Similar documents containing similar text to be sent to 

a number of persons. These documents also have a 

typical common layout. Invitation letters sent to guests 

have a more-or-less common content and layout. Only 

the names of the recipients are different in these letters. 
One obvious way to generate such letters is to type all 

of them individually, putting the same amount of effort 
again and again. Another solution could be to copy the 

same block of text again and again onto the new letters. 

The names and addresses etc., which are different from 

each letter, can be entered separately in the documents. 

Though this method saves a lot of effort, it still requires 
proper caution. There should be a way where these 

kinds of documents can be prepared automatically. This 

task can be easily automated if we use the mail merge 

feature of a word processor. So, it is time we learnt the 

mail-merge feature of the word.

Components	of	mail	merge:
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The three main components of the merging process are 

the main document, the data source, and the merged 

document.

• The main document contains the main body of your 

letter, field names, and merges instructions. The 
basic information within the main document remains 

equivalent.

• The data source (or Recipients’ list) stores the 

knowledge that changes for every document. This 

information is inserted in the main document one by 

one. An example of the data source is a name and 

address list from which the program gets what you 

want to include in the main document.

• The merged document contains the main text from 

the main document and data from a data source.

Steps	for	mail	merge
Step 1:

• Open MS Word and click on the command sequence: 
Mailings tab → Start mail merge group → Select 
recipients button → Type new List. (Fig 17)

• A dialog namely “New Address List” will pop up(as 

shown in the below image). Type here the desired 

data under the given headings. To add a new record, 

click on the “New Entry” button at the bottom of the 

dialog and click OK when you are done. (Fig 18)

Step 2: Prepare Master Letter

The second step is to prepare our master letter for use 

Fig 18

Fig 19
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in the mail merge.  Before we enter all the letter text 

we’d like to link this Word file to our list of names.

• Create a blank word document.

• Click Mailings tab → Start Mail Merge group → Start 
Mail Merge → Letters command. (Fig 19)

• Then click the Mailings tab → Start Mail Merge 
group →  Select Recipients button → Use Existing 

create a space. (Fig 22)

Then do this again and choose FirstName, followed by a 

Fig 20

Fig 21

List command. (Fig 20)

• Now we can start typing the letter.

• Now we would like to add the name and address and 

other details for the people on the list.

• Mailings tab→ Write & Insert Field group → Insert 
Merge Field button. (Fig 21)

• A pop-down will appear showing all the table 

headings, so choose Title and press the spacebar to 

Fig 22

Fig 23

space (i.e., press only spacebar key and no other key); 

then choose LastName but this time press the Enter key 

to create a new line. Then repeat the steps to choose 

the Address field, and press enter key.

Step 3:

Before we actually carry out the merge, we must first 
preview what the merged letters will look like.

• Mailings tab→ Preview Results group → Preview 
Results button. (Fig 23)

• Once we are happy with the preview, you can carry 

out the actual mail merge.

Fig 24

• To do this you click the Mailings tab →  Finish group 
→ Finish & Merge button and choose Edit Individual 
Documents.

• In the Merge to New Document panel, click All to 

create a separate letter for each person on the 

Names list. (Fig 24) Word then creates a fresh 

document with as many pages as there are names 

on your list, and every page contains a wonderfully 

merged letter with all the correct individuals’ details. 

(Fig 25)

 We can save this with an appropriate name such as 

ABC. docs (Fig 26)
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Fig 25

Fig 26
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IT & ITES Related Theory for Exercise 1.3.26 - 30

DTPO	–	MS	-	Office

M.S	Excel	-	Using	formulas.	
Objectives: At the end of this lesson you shall be able to

• explain MS excel

• features  & functions

•	 conditional	formatting
•	 link	Spreadsheet	Data

An Introduction to MS Excel

MS Excel is a commonly used Microsoft Office 
application. It is a spreadsheet program which is used 

to save and analyse numerical data.

In computer terms, Excel is a spreadsheet application 

in Microsoft Office Pack. It is one of the most using 
Applications in business industries. We can store any 

kind of the data in the spreadsheets in the Excel Range 

or Excel Cells. We can also insert Images, Shapes, 

Charts, Pivot Tables in the Excel Sheets to understand 

the data.

What is MS Excel?

MS Excel is a spreadsheet program where one can 

record data in the form of tables. It is easy to analyse 

data in an Excel spreadsheet. The image given below 

Fig 1

represents how an Excel spreadsheet looks like:

Open MS Excel

To open MS Excel on your computer, follow the steps 

given below:

• Click on Start

• Then All Programs

• Next step is to click on MS Office

• Then finally, choose the MS-Excel option

Alternatively, you can also click on the Start button and 

type MS Excel in the search option available.

Cell :-

A spreadsheet is in the form of a table comprising rows 

and columns. The rectangular box at the intersection 

point between rows and columns forms a cell. Given 

below is an image of a cell:

Cell Address

The cell address is the name by which is cell can be 

addressed. For example, if row 5 is interested in column 
H, then the cell address is H5.

Excel	terminology	and	components
Excel has its own terminology for its components, which 

new users may not immediately find understandable. 
Some of these terms and components include the 

following:

• Cell. A user enters data into a cell, which is the 

intersection of a column and row.  

• Cell reference. This is the set of coordinates where 

a cell is located. Rows are horizontal and numbered 

whereas columns are vertical and assigned a letter.
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• Active cell. This is the currently selected cell, 

outlined by a green box.

• Workbook. This is an Excel file that contains one or 
more worksheets

• Worksheet. These are the different documents 
nested within a Workbook.

• Worksheet	 tab.	These are the tabs at the bottom 

left of the spreadsheet.

• Column	 and	 row	 headings. These are the 

numbered and lettered cells located just outside of 

the columns and rows. Selecting a header highlights 

the entire row or column.

• Formula. Formulas are mathematical equations, 

cell references or functions that can be placed inside 

a cell to produce a value. Formulas must start with 

an equal “=” sign.

• Formula	bar. This is the long input bar that is used 

to enter values or formulas in cells. It is located at the 

top of the worksheet, next to the “fx” label.

• Address bar. This bar located to the left of the 

formula bar shows the number and letter coordinates 

of an active cell. 

• Filter. These are rules a user can employ to select 

what rows in a worksheet to display. This option is 

located on the top right of the home bar under “Sort 

& Filter.” An auto filter option can be selected to 
show rows that match specific values.

• AutoFill. This feature enables users to copy data to 

more than one cell automatically. With two or more 

cells in a series, a user can select both cells and 

drag the bottom right corner down to autofill the rest 
of the cells.

• AutoSum. This feature enables users to add multiple 

values. Users can select the cells they want to add 

and press the Alt and Equal keys. There is also a 

button to enable this feature on the top right of the 

home page, above “Fill” and to the left of “Sort & 

Filter.”

• PivotTable. This data summarization tool sorts and 

calculates data automatically. This is located under 

the insert tab on the far left.

• PivotChart. This chart acts as a visual aid to the 

PivotTable, providing graph representations of the 

data. It is located under the middle of the insert 

page, next to maps.

Fig 2

• Source data. This is the information that is used to 

create a PivotTable.

Menus of MS Excel

Various editing and formatting can be done on an Excel 

spreadsheet. Discussed below are the various features 

of MS Excel. 

The image below shows the composition of features in 

MS Excel:

• Home
• Comprises options like font size, font styles, font 

colour, background colour, alignment, formatting 

options and styles, insertion and deletion of cells and 

editing options

 Insert

• Comprises options like table format and style, 

inserting images and figures, adding graphs, charts 
and sparklines, header and footer option, equation 

and symbols

Page Layout

• Themes, orientation and page setup options are 

available under the page layout option
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 Formulas
• Since tables with a large amount of data can be 

created in MS excel, under this feature, you can add 

formulas to your table and get quicker solutions 

 Data

• Adding external data (from the web), filtering options 
and data tools are available under this category

 Review

• Proofreading can be done for an excel sheet (like 

spell check) in the review category and a reader can 

add comments in this part 

 View

• Different views in which we want the spreadsheet to 
be displayed can be edited here. Options to zoom in 

and out and pane arrangement are available under 

this category

Fig 3

For those willing to learn more about MS Excel, can 

refer to the video given below and understand every 

small aspect of this program in detail.

Features of  MS Excel

MS Excel is widely used for various purposes because 

the data is easy to save, and information can be added 

and removed without any discomfort and less hard 

work.

Given	below	are	a	few	important	benefits	of	using	
MS Excel:

• Easy To Store Data: Since there is no limit to 

the amount of information that can be saved in a 

spreadsheet, MS Excel is widely used to save data or to 

analyse data. Filtering information in Excel is easy and 

convenient.

• Easy To Recover Data: If the information is written 

on a piece of paper, finding it may take longer, however, 
this is not the case with excel spreadsheets. Finding 

and recovering data is easy.

• Application	 of	 Mathematical	 Formulas: Doing 

calculations has become easier and less time-taking 

with the formulas option in MS excel

• More Secure: These spreadsheets can be password 

secured in a laptop or personal computer and the 

probability of losing them is way lesser in comparison to 

data written in registers or piece of paper.

• Data at One Place: Earlier, data was to be kept in 

different files and registers when the paperwork was 
done. Now, this has become convenient as more than 

one worksheet can be added in a single MS Excel file.

• Neater	 and	 Clearer	 Visibility	 of	 Information: 
When the data is saved in the form of a table, analysing 

it becomes easier. Thus, information is a spreadsheet 

that is more readable and understandable.

Conditional	Formatting
Conditional formatting is a feature in Microsoft Excel 

that allows you to apply specific formatting to your cells 
according to certain criteria. It enables you to make 

sense of your data and spot significant trends.

Highlight Cells Using Conditional Formatting :-

highlighting the cells that have a value greater than 350. 
Execute the following steps:

• Select the range of cells you want to apply the 

highlight. (Fig 4)

Fig 4
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• On the Home tab, under Styles Group, click 
Conditional Formatting. (Fig 5)

• Click Highlight Cells Rules > Greater Than (Fig 6)

• Click Clear Rules > Clear Rules from Selected Cells 
(Fig 9)

• Enter the desired value and select the formatting 

style. (Fig 7)

• Click OK

Result: (Fig 8)

Clear	Formatting
To clear the formatting rules, follow these steps:

• Select the range of cells where conditional formatting 

is applied.

• Go to Home tab > Styles Group > Conditional 
Formatting

Conditional	Formatting	With	Formulas
Formulas th-at apply conditional formatting must 

evaluate in true or false.

• Select the range of cells where you want to apply 

conditional formatting. (Fig 10)

• On the Home tab, under Styles Group, click 
Conditional Formatting.

• Click New Rule. (Fig 11)

• Select ‘Use a formula to determine which cells to 

format‘.

• Enter the formula. (Fig 12)

Fig 5 Fig 9

Fig 10

Fig 11

Fig 6

Fig 7

Fig 8
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• Mention the number of lowest records you want to 

highlight. (Fig 16)• Select a formatting style and click OK.

Result: (Fig 13)

Highlight	Bottom	Items
Conditional Formatting can also be used to fetch the top 

and bottom items in your sheet. Suppose you want to 

get the five lowest pay rates among the given pay rates. 
Execute the following steps to do that: 

• Select the range of cells where you want to apply 

conditional formatting. (Fig 14)

• On the Home tab, under Styles Group, click 
Conditional Formatting.

• Click Top/Bottom rules > Bottom 10 Items (Fig 15)

• Click OK. (Fig 17)

Find Duplicate Values in Range of Cells

You can highlight the duplicate values in a range of cells 

using conditional formatting. To implement that, follow 

these steps:

Fig 12

Fig 13

Fig 14

Fig 15

Fig 16

Fig 17
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• Select the range of cells. (Fig 18)

• On the Home tab, go to Styles Group > Conditional 
Formatting.

• Select Highlight Cells Rules > Duplicate values.  
(Fig 19)

Result: (Fig 20)

Data	Bars	in	Conditional	Formatting
Data bars in Excel are used to visualize the range of 

cells. The longer bar represents a higher value. To add 

the data bars, follow these steps:

• Select the range of cells. (Fig 21)

Result:  (Fig 23)

Color	Scales	in	Conditional	Formatting
Color Scales in Excel make the visualization of values 

in a range of cells very easy. To add a color scale, follow 

these steps:

• Select the range of cells.

• On the Home tab, go to Styles Group > Conditional 
Formatting.

• Click Color Scales and select a subtype. (Fig 24)

Result: (Fig 25)

• On the Home tab, go to Conditional Formatting > 
Data Bars and select a subtype. (Fig 22)

Fig 18

Fig 19

Fig 20

Fig 21

Fig 22

Fig 23

Fig 24

Fig 25
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• The red color represents the minimum value in the 

range. 

• The yellow color represents the median value.

• The green color represents the maximum value.

• All the other values are colored proportionally.

Icon	Sets	in	Conditional	Formatting
Excel Conditional Formatting icon sets are used to 

visualize the data with the help of shapes, arrows, 

check marks, and other objects. To add an icon sets, 

follow these steps:

• Select the range of cells.

• On the Home tab, go to Styles Group > Conditional 
Formatting.

• Click Icon Sets and select a subtype. (Fig 26)

Result: (Fig 27)

Fig 26

Fig 27
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IT & ITES Related Theory for Exercise 1.3.31- 36

DTPO	-	MS	-	Office

Powerpoint Presentation

Objectives: At the end of this lesson you shall be able to

• Explain MS PowerPoint

• Features  in PowerPoint

• Create New Presentation

• Fine tuning of Presentations

Power Point

Microsoft PowerPoint is a powerful slide show 

presentation program. It is a standard component of 

the company’s Microsoft Office suite software, and is 
bundled together with Word, Excel, and other office 
productivity tools. The program uses slides to convey 

information rich in multimedia. The term slide refers to 

the old slide projector, which this software effectively 
replaces.

What can you do with PowerPoint

PowerPoint gives you the ability to share your 

presentation with others in real time on the web. You 

would supply the user with a link to the presentation. 

After selecting the link, the user(s) will be able to follow 

you and your presentation online.

• Custom animation

• Add photos, videos and sound effects
• Save as a webpage

• Print presentations as handouts

• Embed YouTube videos

Advantages

• Quick	 and	 easy: the basic features are easy to 

master and can make you appear to be organized, 

even if you are not.

• Simple	 bullet	 points: it can reduce complicated 

messages to simple bullet points. Bullet points are 

a good basis for a presentation and remind the 

speaker of main points and the organization of the 

message.

• Easy	to	create	a	colorful,	attractive	design: using 

the standard templates and themes, you can create 

something visually appealing,even if you do not have 

much knowledge of basic graphic design principles.

• Easy	 to	 modify: when compared to other visual 

aids such as charts, posters, or objects, it is easy to 

modify.

• Easily re-order presentation: with a simple drag 

and drop or using key strokes, you can move slides 

to re-order the presentation.

• Audience	 Size: PowerPoint slides are generally 

easier to see by a large audience when projected 

than other visual aids.

• Easy to present: you can easily advance the slides 

in the presentation one after another with a simple 

key stroke while still maintaining eye contact with the 

audience.

• No need for Handouts: they look good visually and 

can be easily read if you have a projector and screen 

that is large enough for the entire room.

Create a presentation

• Open PowerPoint.

• In the left pane, select New. (Fig 1)

• Select an option:
• To create a presentation from scratch, select Blank 

Presentation.

Fig 1

• To use a prepared design,select one of the templates.

• To see tips for using PowerPoint, select Take a Tour, 

and then select Create, .

Add a slide

• In the thumbnails on the left pane, select the slide 

you want your new slide to follow.

• In the Home tab, in the Slides section, select New 
Slide.

Fig 2
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• In the Slides section, select Layout, (Fig 2) and then 

select the layout you want from the menu

Add	and	format	text
• Place the cursor inside a text box, and then type 

something. (Fig 3)

• Select the text, and then select one or more options 

from the Font section of the Home tab, such as 

Font,	 Increase	 Font	 Size,	 Decrease	 Font	 Size,	
Bold,	Italic,	Underline,	etc.

Fig 3

• To create bulleted or numbered lists, select the text, 

and then select Bullets or Numbering.
Add	a	picture,	shape,	and	more
• Go to the Insert tab.

• To add a picture:

• In the Images section, select Pictures.

• In the Insert	 Picture	 From menu, select the 

source you want.

• Browse for the picture you want, select it, and 

then select Insert.

• To add illustrations:

• In the Illustrations section, select Shapes,	
Icons,	3D	Models,	SmartArt,	or Chart.

• In the dialog box that opens when you click one 

of the illustration types, select the item you want 

and follow the prompts to insert it.

Fonts:

Use a good font, like Arial as opposed to Times New 

Roman - it’s easier to read on screen and will speed 

up your fine-tuning process. Use fewer types of font 
all through the PPT to make your own viewing of it 

easier. Other types of fonts which are commonly used 

in presentations these days are the Sans-Serif fonts 

like Calibri, Arial, and Verdana. Another commonly used 

Serif font favored by designers is Georgia.

Colors:

Time and again, we keep hearing that colors play an 

important role in presentations. You go wrong in picking 

right colors, your whole presentation will end up being a 

mess. Play it safe, go with brand colors and do not mix 

them up with default colors. Did you know that choosing 

the right colors for your presentation, can make or break 

a deal for you?

Alignment:
Aligning shapes in your slides is another quick way to 

polish your presentation. If there are multiple shapes in 

Fig 4

a slide, make sure (i) to align, maybe aligning them top, 

bottom or just the way you want and (ii) distribute them 

equally either horizontal or vertical. (Fig 4)

Indentation:

If there are bullet points, the line spacing and font sizes 

of the first and second bullet should not be the same. 

Fig 5

The bigger the font size, more is the spacing. Use the 

Indentation and Spacing precise measurement to get 

the required spacing [Click	on	the	text	>	Paragraph	>	
Indentation and Spacing] (Fig 5)

Usage	of	SmartArt:
If there is a need for a diagram or a flow chart, you 

Fig 6

can simply insert SmartArt graphics from the Insert tab  

(Fig 6) and choose the graphic that best fits your need. 
But do beware…we do not recommend you do this 

often. Not a professional practice to use SmartArt in 

your presentation.
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Usage	of	Images:
If there is a need for inserting images in a slide, make 

sure to keep it simple. Pick up images that align with the 

content to make it look visually appealing. An image, as 

we all know it, speaks a thousand words. But…it is also 

essential to know how to pick the right image for your 

presentations to convey the right message.

Transition in slides:

Fig 7

One faster step where we can make the slide look good 

and effective is through a simple transition that you can 
apply to the slides. (Fig 7) To apply a transition, go to 

the Transitions tab and choose any transition which 

suits the slides.

So, when you are running out of time, rushing to a 

meeting, do not worry.

You don’t need to be a designer to make your slides 

visually appealing. These quick ways will be of help to 

you anytime.

FINE TUNING PRENTATION of MS PowerPoint

There are multiple features that are available in MS 

PowerPoint which can customise and optimise a 

presentation.

• Slide Layout

Multiple options and layouts are available based on 

Fig 8

which a presentation can be created. This option is 

available under the “Home” section and one can select 
from the multiple layout options provided. (Fig 8)

The image below shows the different slide layout options 
which are available for use:

Fig 9

•	 Insert	–	Clipart,	Video,	Audio,	etc.
Under the “Insert” category, multiple options are 

available where one can choose what feature they want 

to insert in their presentation. This may include images, 

audio, video, header, footer, symbols, shapes, etc.  

(Fig 9) 

• Slide Design

MS PowerPoint has various themes using which 

background colour and designs or textures can be 

added to a slide. This makes the presentation more 

colourful and attracts the attention of the people looking 

at it.

This feature can be added using the “Design” category 

Fig 10

mentioned on the homepage of MS PowerPoint. 

Although there are existing design templates available, 

in case someone wants to add some new texture 

or colour, the option to customise the design is also 

available. (Fig 10) Apart from this, slide designs can 

also be downloaded online.

Refer to the below for slide design:

•	 Animations
During the slide show, the slides appear on the screen 

one after the other. In case, one wants to add some 

animations to the way in which a slide presents itself, 

they can refer to the “Animations” category.

Fig 11
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The different animation styles available on PowerPoint 
are: (Fig 11)

Apart from all these options; font size, font style, font 

colour, word art, date and time, etc. can also be added 

to a PPT.

Uses of PowerPoint Presentation

PowerPoint presentations are useful for both personal 

and professional usage. Given below are a few of the 

major fields where PPT is extremely useful:

• Education – With e-learning and smart classes

being chosen as a common mode of education

today, PowerPoint presentations can help in making

education more interactive and attract students

towards the modified version of studying

• Marketing – In the field of marketing, PowerPoint
presentations can be extremely important. Using

graphs and charts, numbers can be shown more

evidently and clearly which may be ignored by the

viewer if being read

• Business – To invite investors or to show the

increase or decrease in profits, MS PowerPoint can
be used

• Creating	 Resumes – Digital resumes can be

formed using MS PowerPoint. Different patterns,
photograph, etc. can be added to the resume

• Depicting Growth – Since both graphics and text

can be added in a presentation, depicting the growth

of a company, business, student’s marks, etc. is

easier using PPT
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IT & ITES Related Theory for Exercise 1.4.37- 42

DTPO - Networking Concept

Network concepts,to plogies and network components 

Objectives: At the end of this lesson you shall be able to

• necessity and advantages

• client server and peer to peer networking concepts

• network topologies

• Introduction to LAN, WAN and MAN

• Network components

Necessity and advantages

What is Computer Network

A computer network is a set of devices (often referred 

to as nodes) connected by communication links. A node 

can be a computer, printer, or any other device capable 

of sending or receiving data from the other node/device 

through the network.

Computer Network Criteria

• Performance

• Reliability

• Security

Performance

It can be measured in many ways and depends on the 

number of factors

• Number of users

• Type of transmission medium

• Response time

• Transit time

• Hardware

• Software

Reliability

• Frequency of failure

• The recovery time of a network after a failure.

• Catastrophe

Security

As data is being travelled from node to node through the 

network to reach its final destination, during that time 
it can be tampered or can be stolen so the security of 

information is the top priority.

Network security issues include protecting data 

from the following

• Unauthorized access

• Viruses

Advantages of Computer Network

There are many advantages of computer network and 

benefits of computer networking, some of them are 
File sharing, Resource sharing, Better connectivity and 

communications is briefly explained below.

• File sharing: Fundamental goals of a computer 

network is to allow file sharing and remote file 
access.

Server-Client model: Client-server model is a 

distributed application framework. The server is a 

master system which stores the data and provides the 

processing service. A client is a user system which 

accesses the data from the server and can perform 

processing in its system or in a server system.

Resource sharing: All the resources such as printers, 

modems, scanners and fax machines etc can be shared 
by all the system in a computer network.

Better connectivity and communications: A computer 

network allows all the user or computers at a different 
location to communicate easily, widely used example is 
email, video conference etc.

Need of computer network

Computer networks have become invaluable to 

organizations as well as individuals. Some of its 

main uses are Internet access, eCommerce, 

Entertainment, VoIP is briefly explained below.
• Internet access: We can easily access information 

all because of the internet which provides a variety 

of information and communication facilities, using 

standardized communication protocols.

eCommerce: also known as electronic commerce, 

refers to buying or selling product, service etc through 

the internet. It has been one of the world most profitable 
business in the world which is only possible of a 

computer network.

Entertainment: It includes games, online video 

streaming and many other which is only possible 

because of the computer network.

VoIP: Through Voice over Internet protocol, telephone 

calls are made digitally using Internet Protocols instead 

of the regular analog phone lines.

Disadvantages of Computer Network

There are many disadvantages of computer network 

of computer networking.

 • Lack of data security and privacy due to the huge 

number of the user accessing the internet from every 

corner of the earth, handling data is a challenging task 
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and data can be stolen which violate the privacy of the 

user.

Presence of computer viruses and the malware: 

A virus can easily spread through an interconnected 

workstation or over the internet which can damage or 

steal the data from the computer system in a computer 

network.

Client server and peer to peer networking concepts

What is Client Server Network?

Definition
A client server architecture is a computing model 

wherein the server hosts, delivers, and manages most 

of the resources and services requested by the client. 

(Fig 1) 

It is also known as the networking computing model or 

client server network as all requests and services are 

delivered over a network. The client server architecture 

or model has another(other) system(s) connected over 

a network where resources are shared among the 

different computers.

Recognized as one of the most weirdly used networking 

models, the client server network model, generally, 

includes many clients or workstations interconnected in 

a network with a central server. While the server acts 

as a powerful system that stores all the data on it, the 

Fig 1

client functions as a machine that requests specific 
information from the server.

Client Server Network Example

One of the most popular examples of the client server 
architecture is the World Wide Web consortium. In this, 

internet users, people like us, act as clients requesting 

information from the servers, and the servers respond 

with the specifically requested information.

Advantages

Some of the advantages of the client server network are 

as follows:

• As a centralized network, the client-server network 

has complete leverage to control the processes and 

activities within the network.

• It gives flexibility to users to access files residing in 
the central storage from anywhere. 

• It provides a good user interface and ease of 

handling files. 

• Resources can be easily shared over the client-

server network.

What is Peer-to-Peer network?

Definition
Peer-to-peer network involves two or more computers 

that pool various peripheral resources such as printers 

and DVD players. (Fig 2) Such shared resources are 

available on every computer in the network. In a peer-

to-peer network, each computer behaves as the client 

as well as the server, and it communicates with the 

other computers directly.Get 

This type of network is preferably used by SMBs that 

work without the need of a central server. All connected 

computers of the system work as nodes and allow 

seamless file sharing. Such a network is easy to set up 
and only needs a Wi-Fi connection or an Ethernet cable 

Fig 2

for its setup.

Peer-to-Peer Network Example

Torrent is one of the most popular examples of peer-to-
peer networks. In this type of network, all computers are 

connected to the internet where resources shared by 

any one computer can be downloaded by others.

Another widely used example of peer-to-peer network is 
the local area network (LAN,) which is usually preferred 

by small offices for the purpose of resource sharing.

Advantages

Some of the major advantages of peer-to-peer network 

are as follows:

• Each device connected to the peer-to-peer network 

provides and receives resources from other nodes in 

the network.

• Resources are shared seamlessly between different 
devices.

• Being a part of a peer-to-peer network, resources, 

such as printers, are easily shared between the 

nodes in the network.

• The setup of a peer-to-peer network is easily 

established with the help of specialized software.
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Difference	Between	Peer-to-Peer	Network	and	Client	Server	Network

Parameters Client Server Network Peer-to-Peer Network

Data It has a centralized server to store all 

data.

Each peer in the network has its own data.

Service

When the client sends a request 

asking for specific information, the 
server responds with a service.

Each node in this network can make a request and 

also respond for the services.

Focus It primarily focuses on information 

sharing.

Its primary focus is on connectivity.

Differentiation This network has a dedicated server 

and a specific client.
There is no differentiation between client and 
server. Each node acts as a client as well as a 

server.

Stability It is a more stable network and is 

easily scalable. Hence, it is preferred 

by large organizations.

The stability of this network is reduced if more 

peers are added. Hence, it is generally preferred by 

SMBs.

Security It is a secured network because the 

server can authenticate a client’s 

access to any part of the network.

As the number of peers increases, the network 

becomes less secure and the vulnerability of the 

network increases.

Performance The performance remains unaffected 
with the increase in clients because 

the server does the heavy lifting.

In case of a large peer-to-peer network, 

performance is likely to reduce because the 

resources are shared.

Cost It is costlier to set up as compared to a 

peer-to-peer network.

It is not very expensive to set up.

Network topologies

Topology defines the structure of the network of how 
all the components are interconnected to each other. 

There are two types of topology: physical and logical 

topology.

Physical topology is the geometric representation of all 

the nodes in a network. (Fig 3)

Fig 3

Fig 4

• Each node is either connected to the backbone cable 

by drop cable or directly connected to the backbone 

cable.

• When a node wants to send a message over the 

network, it puts a message over the network. All 

the stations available in the network will receive the 

message whether it has been addressed or not.

• The backbone cable is considered as a “single 

lane” through which the message is broadcast to all 

Bus Topology
• The bus topology is designed in such a way that all 

the stations are connected through a single cable 

known as a backbone cable.(Fig 4)
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case of a server malfunction, other systems continue 

to operate.

Now that you have a good understanding of both the 

topics, let us now learn some of the key differences	
between peer-to-peer network and client server 

network.
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the stations.

• The most common access method of the bus 

topologies is CSMA (Carrier Sense Multiple Access).

 Advantages of Bus topology:

• Low-cost cable: In bus topology, nodes are directly 

connected to the cable without passing through a 

hub. Therefore, the initial cost of installation is low.

• Moderate data speeds: Coaxial or twisted pair 
cables are mainly used in bus-based networks that 

support upto 10 Mbps.

• Familiar technology: Bus topology is a familiar 

technology as the installation and troubleshooting 

techniques are well known, and hardware 

components are easily available.

• Limited failure: A failure in one node will not have 

any effect on other nodes.

Disadvantages of Bus topology:

• Extensive cabling: A bus topology is quite simpler, 

but still it requires a lot of cabling.

• Difficult	 troubleshooting: It requires specialized 

test equipment to determine the cable faults. If any 

fault occurs in the cable, then it would disrupt the 

communication for all the nodes.

• Signal interference: If two nodes send the 

messages simultaneously, then the signals of both 

the nodes collide with each other.

• Reconfiguration	 difficult: Adding new devices to 

the network would slow down the network.

• Attenuation: Attenuation is a loss of signal leads 

to communication issues. Repeaters are used to 

regenerate the signal.

Ring Topology

Fig 5

Fig 6

• Ring topology is like a bus topology, but with 

connected ends. (Fig 5)

• The node that receives the message from the 

previous computer will retransmit to the next node.

• The data flows in one direction, i.e., it is unidirectional.

• The data flows in a single loop continuously known 

as an endless loop.

• It has no terminated ends, i.e., each node is 

connected to other node and having no termination 

point.

• The data in a ring topology flow in a clockwise 
direction.

Advantages of Ring topology:

• Network Management: Faulty devices can be 

removed from the network without bringing the 

network down.

• Product availability: Many hardware and software 

tools for network operation and monitoring are 

available.

• Cost: Twisted pair cabling is inexpensive and easily 
available. Therefore, the installation cost is very low.

• Reliable: It is a more reliable network because the 

communication system is not dependent on the 

single host computer.

Disadvantages of Ring topology:

• Difficult	 troubleshooting: It requires specialized 

test equipment to determine the cable faults. If any 

fault occurs in the cable, then it would disrupt the 

communication for all the nodes.

• Failure: The breakdown in one station leads to the 

failure of the overall network.

• Reconfiguration	 difficult: Adding new devices to 

the network would slow down the network.

• Delay: Communication delay is directly proportional 

to the number of nodes. Adding new devices 

increases the communication delay.

Star Topology

• Star topology is an arrangement of the network in 

which every node is connected to the central hub, 

switch or a central computer. (Fig 6)

• The central computer is known as a server, and the 

peripheral devices attached to the server are known 

as clients.
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• Coaxial cable or RJ-45 cables are used to connect 
the computers.

• Hubs or Switches are mainly used as connection 

devices in a physical star topology.

• Star topology is the most popular topology in network 

implementation.

Advantages of Star topology

• Efficient	 troubleshooting: Troubleshooting is 

quite efficient in a star topology as compared to 
bus topology. In a bus topology, the manager has 

to inspect the kilometers of cable. In a star topology, 

all the stations are connected to the centralized 

network. Therefore, the network administrator has to 

go to the single station to troubleshoot the problem.

• Network control: Complex network control features 
can be easily implemented in the star topology. Any 

changes made in the star topology are automatically 

accommodated.

• Limited failure: As each station is connected to the 

central hub with its own cable, therefore failure in 

one cable will not affect the entire network.

• Familiar technology: Star topology is a familiar 

technology as its tools are cost-effective.

• Easily expandable: It is easily expandable as new 
stations can be added to the open ports on the hub.

• Cost	 effective: Star topology networks are cost-

effective as it uses inexpensive coaxial cable.

• High data speeds: It supports a bandwidth of 

approx 100Mbps. Ethernet 100BaseT is one of the 
most popular Star topology networks.

Disadvantages of star topology 

• Cost	 effective: Star topology networks are cost-

effective as it uses inexpensive coaxial cable.

switch goes down, then all the connected nodes will 

not be able to communicate with each other. (Fig 7)

• Cable: Sometimes cable routing becomes difficult 
when a significant amount of routing is required.

Tree topology

• Tree topology combines the characteristics of bus 

topology and star topology.

• A tree topology is a type of structure in which all 

the computers are connected with each other in 

hierarchical fashion.

• The top-most node in tree topology is known as a 

root node, and all other nodes are the descendants 

of the root node.

• There is only one path exists between two nodes for 
the data transmission. Thus, it forms a parent-child 

hierarchy.

Advantages of Tree topology

• Support for broadband transmission: Tree 

topology is mainly used to provide broadband 

transmission, i.e., signals are sent over long 

distances without being attenuated.

• Easily expandable: We can add the new device to 

the existing network. Therefore, we can say that tree 
topology is easily expandable.

• Easily manageable: In tree topology, the whole 

network is divided into segments known as star 

networks which can be easily managed and 

maintained.

• Error detection: Error detection and error correction 

are very easy in a tree topology.

• Limited failure: The breakdown in one station does 

not affect the entire network.

• Point-to-point wiring: It has point-to-point wiring for 

individual segments.

Disadvantages of Tree topology

• Difficult	troubleshooting: If any fault occurs in the 

node, then it becomes difficult to troubleshoot the 
problem.

• High cost: Devices required for broadband 

transmission are very costly.

• Failure: A tree topology mainly relies on main bus 

cable and failure in main bus cable will damage the 

overall network. 

• Reconfiguration	 difficult: If new devices are 

added, then it becomes difficult to reconfigure.

Mesh topology

• Mesh technology is an arrangement of the network 

in which computers are interconnected with each 

other through various redundant connections.(Fig 8)

• There are multiple paths from one computer to 

another computer.

Fig 7

• High data speeds: It supports a bandwidth of 

approx 100Mbps. Ethernet 100BaseT is one of the 
most popular Star topology networks.

• A Central point of failure: If the central hub or 
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Fig 8

• It does not contain the switch, hub or any 

central computer which acts as a central point of 

communication.

• The Internet is an example of the mesh topology.

• Mesh topology is mainly used for WAN 

implementations where communication failures are 

a critical concern.

• Mesh topology is mainly used for wireless networks.

Where n is the number of nodes that represents the 

network. (Fig 9)

Advantages of Mesh topology:

are high that reduces the efficiency of the network.

Hybrid Topology

• The combination of various different topologies is 
known as Hybrid topology. (Fig 10)

• A Hybrid topology is a connection between different 

Fig 9

Fig 10

Reliable: The mesh topology networks are very reliable 

as if any link breakdown will not affect the communication 
between connected computers.

Fast Communication: Communication is very fast 

between the nodes.

Easier	 Reconfiguration: Adding new devices would 

not disrupt the communication between other devices.

Disadvantages of Mesh topology

• Cost: A mesh topology contains a large number 

of connected devices such as a router and more 

transmission media than other topologies.

• Management: Mesh topology networks are very 

large and very difficult to maintain and manage. If 
the network is not monitored carefully, then the 

communication link failure goes undetected.

• Efficiency: In this topology, redundant connections 
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links and nodes to transfer the data.

• When two or more different topologies are combined 
together is termed as Hybrid topology and if similar 

topologies are connected with each other will not 

result in Hybrid topology. For example, if there exist 
a ring topology in one branch of ICICI bank and bus 

topology in another branch of ICICI bank, connecting 

these two topologies will result in Hybrid topology.

Advantages of Hybrid Topology

• Reliable: If a fault occurs in any part of the network 

will not affect the functioning of the rest of the 
network.

• Scalable: Size of the network can be easily 

expanded by adding new devices without affecting 
the functionality of the existing network.

• Flexible: This topology is very flexible as it can 
be designed according to the requirements of the 

organization.

• Effective: Hybrid topology is very effective as it can 
be designed in such a way that the strength of the 

network is maximized and weakness of the network 
is minimized.

Disadvantages of Hybrid topology

• Complex design: The major drawback of the Hybrid 

topology is the design of the Hybrid network. It is 

very difficult to design the architecture of the Hybrid 
network.

• Costly Hub: The Hubs used in the Hybrid topology 

are very expensive as these hubs are different from 
usual Hubs used in other topologies.

• Costly infrastructure: The infrastructure cost 

is very high as a hybrid network requires a lot of 

cabling, network devices, etc.

Introduction to LAN, WAN and MAN
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A computer network is a group of computers linked to 

each other that enables the computer to communicate 

with another computer and share their resources, data, 

and applications.

A computer network can be categorized by their size. 

A computer network is mainly of four types: (Fig 11)

• LAN(Local Area Network)

• PAN(Personal Area Network)

• MAN(Metropolitan Area Network)

• WAN(Wide Area Network)

LAN(Local Area Network)

Fig 12

• Local Area Network is a group of computers 

connected to each other in a small area such as 

building, office. (Fig 12)

• LAN is used for connecting two or more personal 

Fig 13

• Personal Area Network is a network arranged within 

an individual person, typically within a range of 10 

meters. (Fig 13)

• Personal Area Network is used for connecting the 

computer devices of personal use is known as 

Fig 14

Personal Area Network.

• Thomas Zimmerman was the first research scientist 
to bring the idea of the Personal Area Network.

• Personal Area Network covers an area of 30 feet.

• Personal computer devices that are used to develop 

the personal area network are the laptop, mobile 

phones, media player and play stations.

There are two types of Personal Area Network:

• Wired Personal Area Network

• Wireless Personal Area Network

Wireless Personal Area Network: Wireless Personal 

Area Network is developed by simply using wireless 

technologies such as WiFi, Bluetooth. It is a low range 

network. (Fig 14)

Wired Personal Area Network: Wired Personal Area 

Network is created by using the USB.
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Fig 11

computers through a communication medium 

such as twisted pair, coaxial cable, etc.

• It is less costly as it is built with inexpensive 
hardware such as hubs, network adapters, and 

ethernet cables.

• The data is transferred at an extremely faster rate 
in Local Area Network.

• Local Area Network provides higher security.

PAN(Personal Area Network)

Examples Of Personal Area Network:

• Body Area Network: Body Area Network is a 

network that moves with a person. For example, a 
mobile network moves with a person. Suppose a 

person establishes a network connection and then 

creates a connection with another device to share 

the information.

• Offline	Network: An offline network can be created 
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Fig 15

Fig 16

inside the home, so it is also known as a home 

network. A home network is designed to integrate 

the devices such as printers, computer, television 

but they are not connected to the internet.

• Small	Home	Office: It is used to connect a variety 

of devices to the internet and to a corporate network 

using a VPN

MAN(Metropolitan Area Network)

• A metropolitan area network is a network that covers 

a larger geographic area by interconnecting a 

different LAN to form a larger network. (Fig 15)
• Government agencies use MAN to connect to the 

citizens and private industries.

• In MAN, various LANs are connected to each other 

through a telephone exchange line.
• The most widely used protocols in MAN are RS-232, 

Frame Relay, ATM, ISDN, OC-3, ADSL, etc.

• It has a higher range than Local Area Network(LAN).

Uses of Metropolitan Area Network:

• MAN is used in communication between the banks 

in a city.

• It can be used in an Airline Reservation.

• It can be used in a college within a city.

• It can also be used for communication in the military.

WAN(Wide Area Network)

• A Wide Area Network is a network that extends 
over a large geographical area such as states or 

countries. (Fig 16)

• A Wide Area Network is quite bigger network than 

the LAN.

• A Wide Area Network is not limited to a single 

location, but it spans over a large geographical area 

through a telephone line, fibre optic cable or satellite 
links.

• The internet is one of the biggest WAN in the world.

• A Wide Area Network is widely used in the field of 
Business, government, and education.

Examples of Wide Area Network:

• Mobile Broadband: A 4G network is widely used 

across a region or country.

• Last mile: A telecom company is used to provide the 

internet services to the customers in hundreds of 

cities by connecting their home with fiber.

• Private network: A bank provides a private network 

that connects the 44 offices. This network is made 
by using the telephone leased line provided by the 

telecom company.

Advantages of Wide Area Network:

Following are the advantages of the Wide Area Network:

• Geographical area: A Wide Area Network provides 

a large geographical area. Suppose if the branch of 

our office is in a different city then we can connect 
with them through WAN. The internet provides a 

leased line through which we can connect with 

another branch.

• Centralized data: In case of WAN network, data is 

centralized. Therefore, we do not need to buy the 

emails, files or back up servers.

• Get	 updated	 files: Software companies work on 

the live server. Therefore, the programmers get the 

updated files within seconds.

• Exchange messages: In a WAN network, 

messages are transmitted fast. The web application 

like Facebook, Whatsapp, Skype allows you to 

communicate with friends.

• Sharing of software and resources: In WAN 

network, we can share the software and other 

resources like a hard drive, RAM.

• Global business: We can do the business over the 

internet globally.

• High bandwidth: If we use the leased lines for 

our company then this gives the high bandwidth. 

The high bandwidth increases the data transfer 

rate which in turn increases the productivity of our 

company.

Disadvantages of Wide Area Network:

The following are the disadvantages of the Wide Area 

Network:

• Security issue: A WAN network has more security 

issues as compared to LAN and MAN network as all 

the technologies are combined together that creates 

the security problem.

• Needs Firewall & antivirus software: The data is 
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transferred on the internet which can be changed or 

hacked by the hackers, so the firewall needs to be 
used. Some people can inject the virus in our system 

so antivirus is needed to protect from such a virus.

• High Setup cost: An installation cost of the WAN 

network is high as it involves the purchasing of 

routers, switches.

• Troubleshooting problems: It covers a large area 

so fixing the problem is difficult.

Internet work

• An internetwork is defined as two or more computer 
network LANs or WAN or computer network 

segments are connected using devices, and they 

are configured by a local addressing scheme. This 
process is known as internet working.

• An inter connection between public, private, 

commercial, industrial, or government computer 

networks can also be defined as internet working.

• An internet working uses the internet protocol.

• The reference model used for internet working is 

Open System Inter connection (OSI).

Types of Internet work:

• Extranet: An extranet is a communication network 
based on the internet protocol such as Transmission 

Control protocol and internet protocol. It is 

used for information sharing. The access to the 

extranet is restricted to only those users who have 
login credentials. An extranet is the lowest level 
of internetworking. It can be categorized as MAN, 

WAN or other computer networks. An extranet 
cannot have a single LAN, atleast it must have one 

connection to the external network.

• Intranet: An intranet is a private network based on 

the internet protocol such as Transmission Control 

protocol and internet protocol. An intranet belongs 

to an organization which is only accessible by the 

organization’s employee or members. The main 

aim of the intranet is to share the information and 

resources among the organization employees. An 

intranet provides the facility to work in groups and 

for teleconferences.

Intranet advantages:

• Communication: It provides a cheap and easy 

communication. An employee of the organization 

can communicate with another employee through 

email, chat.

• Time-saving: Information on the intranet is shared 

in real time, so it is time-saving.

• Collaboration: Collaboration is one of the 

most important advantage of the intranet. The 

information is distributed among the employees of 

the organization and can only be accessed by the 

authorized user.

• Platform independency: It is a neutral architecture 

as the computer can be connected to another device 

with different architecture.

• Cost	 effective: People can see the data and 

documents by using the browser and distributes the 

duplicate copies over the intranet. This leads to a 

reduction in the cost.

Transmission modes

• The way in which data is transmitted from one device 

to another device is known as transmission mode.

• The transmission mode is also known as the 

communication mode.

• Each communication channel has a direction 

associated with it, and transmission media provide 

the direction. Therefore, the transmission mode is 

also known as a directional mode.

• The transmission mode is defined in the physical 
layer.

The Transmission mode is divided into three categories: 

(Fig 17)

• Simplex mode

• Half-duplex mode

Fig 17

Fig 18

• Full-duplex mode

Simplex mode

• In Simplex mode, the communication is unidirectional, 
i.e., the data flow in one direction. (Fig 18)

• A device can only send the data but cannot receive it 

or it can receive the data but cannot send the data.
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• This transmission mode is not very popular as mainly 

communications require the two-way exchange of 
data. The simplex mode is used in the business field 
as in sales that do not require any corresponding 

reply.

• The radio station is a simplex channel as it transmits 
the signal to the listeners but never allows them to 

transmit back.
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• Keyboard and Monitor are the examples of the 
simplex mode as a keyboard can only accept the 
data from the user and monitor can only be used to 

display the data on the screen.

• The main advantage of the simplex mode is that the 
full capacity of the communication channel can be 

utilized during transmission.

Advantage of Simplex mode:

• In simplex mode, the station can utilize the entire 
bandwidth of the communication channel, so that 

more data can be transmitted at a time.

Disadvantage of Simplex mode:

• Communication is unidirectional, so it has no inter-

communication between devices.

Half-Duplex mode

• In a Half-duplex channel, direction can be reversed, 
i.e., the station can transmit and receive the data as 

well. (Fig 19)

• Messages flow in both the directions, but not at the 
same time.

• The entire bandwidth of the communication channel 

Fig 19

Basis for 

comparison

Simplex mode Half-duplex mode Full-duplex mode

Direction of 

communication

In simplex mode, the 
communication is 

unidirectional.

In half-duplex mode, the 
communication is bidirectional, 

but one at a time.

In full-duplex mode, the 
communication is bidirectional.

Send/Receive A device can only send the 

data but cannot receive it 

or it can only receive the 

data but cannot send it.

Both the devices can send and 

receive the data, but one at a 

time.

Both the devices can send 

and rece      ive the data 

simultaneously.

Performance The performance of half-

duplex mode is better than 
the simplex mode.

The performance of full-duplex 
mode is better than the half-

duplex mode.

The Full-duplex mode has 
better performance among 

simplex and half-duplex 
mode as it doubles the 

utilization of the capacity of the 

communication channel.

Example Examples of Simplex 
mode are radio, keyboard, 

and monitor.

Example of half-duplex is 
Walkie-Talkies.

Example of the Full-duplex 
mode is a telephone network.

mode. In Walkie-talkie, one party speaks, and 

another party listens. After a pause, the other speaks 

and first party listens. Speaking simultaneously 
will create the distorted sound which cannot be 

understood.

Advantage of Half-duplex mode:

• In half-duplex mode, both the devices can send 
and receive the data and also can utilize the entire 

bandwidth of the communication channel during the 

transmission of data.

Disadvantage of Half-Duplex mode:

• In half-duplex mode, when one device is sending the 
data, then another has to wait, this causes the delay 

in sending the data at the right time.

Full-duplex mode

• In Full duplex mode, the communication is bi-
directional, i.e., the data flow in both the directions. 
(Fig 20)

• Both the stations can send and receive the message 

simultaneously.

• Full-duplex mode has two simplex channels. One 
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is utilized in one direction at a time.

• In half-duplex mode, it is possible to perform the 
error detection, and if any error occurs, then the 

receiver requests the sender to retransmit the data.

• A Walkie-talkie is an example of the Half-duplex 

Fig 20

channel has traffic moving in one direction, and 
another channel has traffic flowing in the opposite 
direction.

Differences	 b/w	 Simplex,	 Half-duplex	 and	 Full-
duplex mode 

• The most common example of the full-duplex mode is a telephone network. When two people are communicating 
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with each other by a telephone line, both can talk 

and listen at the same time.

Advantage of Full-duplex mode:

• Both the stations can send and receive the data at 

the same time.

Disadvantage of Full-duplex mode:

• If there is no dedicated path exists between the 
devices, then the capacity of the communication 

channel is divided into two parts.

Network components

Modem

• A modem is a hardware device that allows the 

computer to connect to the internet over the existing 
telephone line. (Fig 21)

• A modem is not integrated with the motherboard 

Fig 21

Fig 22

rather than it is installed on the PCI slot found on the 

motherboard.

• It stands for Modulator/Demodulator. It converts the 

digital data into an analog signal over the telephone 

lines.

Based on the differences in speed and transmission rate, 
a modem can be classified in the following categories:

• Standard PC modem or Dial-up modem

• Cellular Modem

• Cable modem

Hub

A Hub is a hardware device that divides the network 

devices will check whether the request belongs to them 

or not. If not, the request will be dropped. (Fig 22)

The process used by the Hub consumes more 

bandwidth and limits the amount of communication. 

Nowadays, the use of hub is obsolete, and it is replaced 

by more advanced computer network components such 

as Switches, Routers.

Fig 23

Switch

A switch is a hardware device that connects multiple 

devices on a computer network. (Fig 23) A Switch 

contains more advanced features than Hub. The Switch 

contains the updated table that decides where the data 

is transmitted or not. Switch delivers the message to 

the correct destination based on the physical address 

present in the incoming message. A Switch does not 

broadcast the message to the entire network like the 

Hub. It determines the device to whom the message 

is to be transmitted. Therefore, we can say that switch 

provides a direct connection between the source and 

destination. It increases the speed of the network.

Fig 24

Router

• A router is a hardware device which is used to 

connect a LAN with an internet connection. It is 

used to receive, analyze and forward the incoming 

packets to another network. (Fig 24)

• A router works in a Layer 3 (Network layer) of the 

OSI Reference model.

• A router forwards the packet based on the information 

available in the routing table.

• It determines the best path from the available paths 
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connection among multiple devices. When computer 

requests for some information from a network, it first 
sends the request to the Hub through cable. Hub will 

broadcast this request to the entire network. All the 
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Fig 25

Fig 26for the transmission of the packet.

Advantages Of Router:

• Security: The information which is transmitted to the 

network will traverse the entire cable, but the only 

specified device which has been addressed can 
read the data.

• Reliability: If the server has stopped functioning, 

the network goes down, but no other networks are 

affected that are served by the router.

• Performance:Router enhances the overall 

performance of the network. Suppose there are 

24 workstations in a network generates a same 

amount of traffic. This increases the traffic load on 
the network. Router splits the single network into two 

networks of 12 workstations each, reduces the traffic 
load by half.

Bridge

• Network range

Bridges are used to connect two sub networks that use 

interchangeable protocols. It combines two LANs to 

form an extended LAN. The main difference between the 
bridge and repeater is that the bridge has a penetrating 

efficiency.

Working of Bridges

A bridge accepts all the packets and amplifies all of them 
to the other side. (Fig 25) The bridges are intelligent 

devices that allow the passing of only selective 

packets from them. A bridge only passes those packets 

addressed from a node in one network to another node 

in the other network.

A	bridge	performs	in	the	following	aspect	−
• A bridge receives all the packets or frame from both 

LAN (segment) A and B.

• A bridge builds a table of addresses from which it 

can identify that the packets are sent from which 

LAN (or segment) to which LAN.

• The bridge reads the send and discards all packets 

from LAN A sent to a computer on LAN A and that 

packets from LAN A send to a computer on LAN B 

are retransmitted to LAN B.

• The packets from LAN B are considered in the same 

method.

Types of Bridges

There are generally two types of bridges which are as 

follows − (Fig 26)

Transparent Bridges

It is also called learning bridges. Bridge construct its 

table of terminal addresses on its own as it implements 

connecting two LANs. It facilitates the source location to 

create its table. It is self-updating. It is a plug and plays 

bridge.

Source Routing Bridge

This sending terminal means the bridges that the frames 

should stay. This type of bridge is used to prevent 

looping problem.

Uses of Bridges

The	main	uses	of	bridges	are	−
• Bridges are used to divide large busy networks  

 into multiple smaller and interconnected networks  

 to improve performance.

• Bridges also can increase the physical size of a  

 network.

• Bridges are also used to connect a LAN segment  

 through a synchronous modem relation to another  

 LAN segment at a remote area.

Gateway

A gateway is a network node that forms a passage 

between two networks operating with different 
transmission protocols. (Fig 27) It acts as the entry – 

exit point for a network since all traffic that flows across 
the networks should pass through the gateway. Only 

the internal traffic between the nodes of a LAN does not 
pass through the gateway.

Features of Gateways

• Gateway is located at the boundary of a network and 

manages all data that inflows or outflows from that 
network.

• It forms a passage between two different networks 
operating with different transmission protocols.

• A gateway operates as a protocol converter, providing 

compatibility between the different protocols used in 
the two different networks.

• The feature that differentiates a gateway from other 
network devices is that it can operate at any layer of 
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thus simplifying data communication.

• Internet-To-Orbit Gateway (I2O) − It connects 
devices on the Internet to satellites and spacecraft 

orbiting the earth. Two prominent I2O gateways are 

Project HERMES and Global Educational Network 

for Satellite Operations (GENSO).

• IoT Gateway − IoT gateways assimilates sensor 
data from IoT (Internet of Things) devices in the 

field and translates between sensor protocols before 
sending it to the cloud network. They connect IoT 

devices, cloud network and user applications.

• VoiP Trunk Gateway − It facilitates data transmission 
between plain old telephone service (POTS) devices 

like landline phones and fax machines, with VoIP 
(voice over Internet Protocol) network.

Network	Cable	Types	and	Specifications
To connect two or more computers or networking 

devices in a network, network cables are used. There 

are three types of network cables; coaxial, twisted-pair, 
and fiber-optic.

Coaxial cable

This cable contains a conductor, insulator, braiding, and 

sheath. The sheath covers the braiding, the braiding 

Fig 27

the OSI model.

• It also stores information about the routing paths of 

the communicating networks.

• When used in enterprise scenario, a gateway node 

may be supplemented as proxy server or firewall.

• A gateway is generally implemented as a node with 

multiple NICs (network interface cards) connected 

to different networks. However, it can also be 
configured using software.

• It uses packet switching technique to transmit data 

across the networks.

Types of Gateways

On basis of direction of data flow, gateways are broadly 
divided into two categories −

• Unidirectional Gateways − They allow data to flow 
in only one direction. Changes made in the source 

node are replicated in the destination node, but not 

vice versa. They can be used as archiving tools.

• Bidirectional Gateways − They allow data to flow in 
both directions. They can be used as synchronization 

tools.

On basis of functionalities, there can be a variety of 

gateways, the prominent among them are as follows −

• Network Gateway − This is the most common type 
of gateway that provides as interface between two 

dissimilar networks operating with different protocols. 
Whenever the term gateway is mentioned without 

specifying the type, it indicates a network gateway.

• Cloud Storage Gateway − It is a network node or 
server that translates storage requests with different 
cloud storage service API calls, such as SOAP (Simple 

Object Access Protocol) or REST (Representational 

State Transfer).It facilitates integration of private 

cloud storage into applications without necessitating 

transfer of the applications into any public cloud, 

Fig 28

covers the insulation, and the insulation covers the 

conductor.

The following image shows these components. (Fig 28)

Sheath

This is the outer layer of the coaxial cable. It protects 
the cable from physical damage.

Braided shield

This shield protects signals from external interference 
and noise. This shield is built from the same metal that 

is used to build the core.

Insulation

Insulation protects the core. It also keeps the core 

separate from the braided shield. Since both the core 

and the braided shield use the same metal, without this 

layer, they will touch each other and create a short-

circuit in the wire.

Conductor
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The conductor carries electromagnetic signals. Based 

on conductor a coaxial cable can be categorized into 
two types; single-core coaxial cable and multi-core 
coaxial cable.

Fig 29

Fig 30

A single-core coaxial cable uses a single central metal 
(usually copper) conductor, while a multi-core coaxial 
cable uses multiple thin strands of metal wires. The 

following image shows both types of cable.(Fig 29)

Coaxial cables in computer networks

The coaxial cables were not primarily developed for 
the computer network. These cables were developed 

for general purposes. They were in use even before 

computer networks came into existence. They are still 
used even their use in computer networks has been 

completely discontinued.

At the beginning of computer networking, when there 

were no dedicated media cables available for computer 

networks, network administrators began using coaxial 
cables to build computer networks.

Because of its low cost and long durability, coaxial 
cables were used in computer networking for nearly 

two decades (the 80s and 90s). Coaxial cables are no 
longer used to build any type of computer network.

Specifications	of	coaxial	cables
Coaxial cables have been in use for the last four 
decades. During these years, based on several 

factors such as the thickness of the sheath, the metal 

of the conductor, and the material used in insulation, 

hundreds of specifications have been created to specify 
the characteristics of coaxial cables.

•  Coaxial cable uses RG rating to measure the 
materials used in shielding and conducting cores.

• RG stands for the Radio Guide. Coaxial cable mainly 
uses radio frequencies in transmission.

• Impedance is the resistance that controls the signals. 

It is expressed in the ohms.

• AWG stands for American Wire Gauge. It is used to 

measure the size of the core. The larger the AWG 

size, the smaller the diameter of the core wire.

Twisted-pair cables

The twisted-pair cable was primarily developed for 

computer networks. This cable is also known as 

Ethernet cable. Almost all modern LAN computer 

networks use this cable.

This cable consists of color-coded pairs of insulated 

copper wires. Every two wires are twisted around each 

other to form pair. Usually, there are four pairs. Each pair 

has one solid color and one stripped color wire. Solid 

colors are blue, brown, green, and orange. In stripped 

color, the solid color is mixed with the white color.

Based on how pairs are stripped in the plastic sheath, 

there are two types of twisted-pair cable; UTP and STP. 

(Fig 30)

In the UTP (Unshielded twisted-pair) cable, all pairs 

are wrapped in a single plastic sheath.

In the STP (Shielded twisted-pair) cable, each pair is 

wrapped with an additional metal shield, then all pairs 

are wrapped in a single outer plastic sheath.

Similarities	and	differences	between	STP	and	UTP	
cables

• Both STP and UTP can transmit data at 10Mbps, 

100Mbps, 1Gbps, and 10Gbps.

• Since the STP cable contains more materials, it is 

more expensive than the UTP cable.

• Both cables use the same RJ-45 (registered jack) 
modular connectors.

• Both cables can accommodate a maximum of 1024 
nodes in each segment.

• The STP provides more noise and EMI resistance 

than the UTP cable.

• The maximum segment length for both cables is 100 
meters or 328 feet.

The following image shows both types of twisted-pair 

cables.

To learn how twisted-pair cables are used in the LAN 

network, you can check the following tutorial.

Fiber optic cable

This cable consists of a core, cladding, buffer, and 
jacket. The core is made from thin strands of glass or 
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plastic that can carry data over a long distance. The 

core is wrapped in the cladding; the cladding is wrapped 

in the buffer, and the buffer is wrapped in the jacket.

• Core carries the data signals in the form of light.

• Cladding reflects light back to the core.

• Buffer protects the light from leaking.

• The jacket protects the cable from physical damage.

Fiber optic cable is completely immune to EMI and RFI. 

This cable can transmit data over a long distance at the 

highest speed. It can transmit data up to 40 kilometers 

at the speed of 100Gbps.

Fig 31

Fiber optic uses light to send data. It reflects light from 
one endpoint to another. Based on how many beams of 

light are transmitted at a given time, there are two types 

of fiber optical cable; SMF and MMF. (Fig 31)

SMF	(Single-mode	fiber)	optical	cable
This cable carries only a single beam of light. This is 

more reliable and supports much higher bandwidth and 

longer distances than the MMF cable. This cable uses 

a laser as the light source and transmits 1300 or 1550 

nano-meter wavelengths of light.

MMF	(multi-mode	fiber)	optical	cable
This cable carries multiple beams of light. Because of 

multiple beams, this cable carries much more data than 

the SMF cable. This cable is used for shorter distances. 

This cable uses an LED as the light source and transmits 

850 or 1300 nano-meter wavelengths of light.

Wireless

Wireless connection to internet is very common these 

days. Often an external modem is connected to the 
Internet and other devices connect to it wirelessly. This 

eliminated the need for last mile or first mile wiring. There 
are two ways of connecting to the Internet wirelessly – 

Wi-Fi and WiMAx.

Wi-Fi

Wi-Fi is the acronym for wireless fidelity. Wi-Fi 
technology is used to achieve connection to the Internet 

without a direct cable between device and Internet 

Service Provider. Wi-Fi enabled device and wireless 

router are required for setting up a Wi-Fi connection.

These are some characteristics of wireless Internet 

connection − (Fig 32)

Fig 32

• Range of 100 yards

• Insecure connection

• Throughput of 10-12 Mbps

If a PC or laptop does not have Wi-Fi capacity, it can be 

added using a Wi-Fi card.

The physical area of the network which provides Internet 

access through Wi-Fi is called Wi-Fi hotspot. Hotspots 

Fig 33

can be set up at home, office or any public space like 
airport, railway stations, etc. Hotspots themselves are 

connected to the network through wires.

Bluetooth

Bluetooth wireless technology is a short range 

communications technology intended to replace the 

cables connecting portable unit and maintaining high 

levels of security. (Fig 33) Bluetooth technology is 

based on Ad-hoc technology also known as Ad-hoc 

Pico nets, which is a local area network with a very 

limited coverage.

History of Bluetooth

WLAN technology enables device connectivity to 

infrastructure based services through a wireless carrier 

provider. Bluetooth specification details the entire 
protocol stack. Bluetooth employs Radio Frequency 

(RF) for communication. It makes use of frequency 

modulation to generate radio waves in the ISM band.

The usage of Bluetooth has widely increased for its 

special features.
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• Bluetooth offers a uniform structure for a wide range 
of devices to connect and communicate with each 

other.

• Bluetooth technology has achieved global 

acceptance such that any Bluetooth enabled device, 

almost everywhere in the world, can be connected 

with Bluetooth enabled devices.

• Low power consumption of Bluetooth technology 

and an offered range of up to ten meters has paved 
the way for several usage models.

• Bluetooth offers interactive conference by 
establishing an adhoc network of laptops.

• Bluetooth usage model includes cordless computer, 

intercom, cordless phone and mobile phones.
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IT & ITES Related Theory for Exercise 1.4.43-48

DTPO - Networking Concept

Concept of internet and social networking concepts

Objectives: At the end of this lesson you shall be able to

• introduction to WWW and concept of internet

• explain web browser, internet server and search engine

•	 define	concept	of	domain	naming	system	and	e-mail	communication
• explain video chatting tool and social networking concept

•	 define	Various	network	security	protocols

Introduction of World Wide Web

WWW (World Wide Web) is part of the internet 

that contains linked text, image sound, and video 
documents. It is also define as an information space 
where documents and other web resources are 

identified by URLs, interlinked by hypertext links, and 
can be accessed via the Internet.

The World Wide Web or Web is basically a collection of 

information that is linked together from points all over 

the world. It is also abbreviated as WWW.

•  World wide web provides flexibility, portability,  
and user-friendly features.

• It mainly consists of a worldwide collection of 

electronic documents (i.e, Web Pages).

•  It is basically a way of exchanging information 
between computers on the Internet.

•  The WWW is mainly the network of pages consists 

of images, text, and sounds on the Internet which 
can be simply viewed on the browser by using the 

browser software.

•  It was invented by Tim Berners-Lee.

 Brief History of WWW

•  In 1989, London born Timothy Berners-Lee came up 

with the idea of the web as a way to share

•  Files with others. The idea for the web came 

while Berners-Lee was working for the European 

Organization for Nuclear Research (CERN). 

Scientists by trade, Berners-Lee and others inside 

CERN were looking for ways to transmit information 

between each other electronically. To do so, they 

created a set of tools including a language (html), 

a browser and other utilities which allowed them to 

establish communication.

•  The first web browser was invented in 1990 by 
Sir Tim Berners-Lee. His browser was called 

WorldWideWeb and later renamed Nexus. 
Many others were soon developed, with Marc 

Andreessen’s 1993 Mosaic (later called Netscape). 

Today, the major web browsers are Chrome, Safari, 

Internet Explorer, Firefox, and Edge

•  The internet was first introduced into Nigeria in the 
year 1995. It was in reality a project work by RINAF 

(Regional Information Society Network for Africa). 

It was backed up financially by UNESCO. Several 
workshops were organised in order to educate 

the Nigerian populace. the first test running was 
conducted in Obafemi Awolowo University in 1995. 

By the late 1990’s the ‘’internet ‘’ became a known 

term among the citizens of Nigeria.

Basic Terminologies of WWW

•  Websites: A collection of related web pages

•  Webpage: A webpage is a document or information 

resource on the World Wide Web which can be 

accessed using a web browser.

•  Web servers: web servers are computers that stores 

and disseminate web pages

•   Web Browser: A web browser (commonly referred 

to as a browser) is a software application for 

retrieving, presenting, and traversing (moving 

through) information resources on the World Wide 

•  Web address: A web address, also known as a URL 

(uniform resource locator), is an Internet or intranet 

name that points to a location where a file, directory 
or website page is hosted.

•   Hyperlink: A link from a hypertext file or document to 
another location or file, typically activated by clicking 
on a highlighted word or image on the screen.

•  Homepage (Main page): The introductory page of a 

website, typically serving as a table of contents for 

the site. 

•  Internet Protocol: The Internet Protocol (IP) is the 

method by which data is sent from one computer to 

another on the Internet or other network.

Protocols

•  The two general protocols of WWW are:

•  HTTP (Hypertext Transfer Protocol) is the set of rules 
for transferring files ( text, graphic images sound, 
video and other multimedia files) on the world wide 
web.

•  HTML (Hypertext Markup Language) is a computer 
language used to build web pages.

Other protocols Include:

a   TCP: Transmission Control Protocol

b   UDP: User Data-gram Protocol
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c   SMTP: Simple Mail Transfer Protocol

d   FTP: File Transfer Protocol

e   POP: Post Office Protocol

f   ICMP: Internet Control Protocol

Benefits	of	WWW
1   Availability of mainly free information

2   Facilitates rapid and interactive communication

3   It is accessible from anywhere

4   Facilitates the exchange of huge volume of data

Basic Internet Concepts

Internet

The Internet is a global network of networks connecting 

millions of users worldwide via many computer networks 

using a simple standard common addressing system 

and basic communications protocol called TCP/IP 

(Transmission Control Protocol/Internet Protocol). This 

allows messages sent over the Internet to be broken 

into small pieces, called packets, which travel over 

many different routes between source and destination 
computers.

Clients and Servers

Internet resources -- information and services -- are 

provided through host computers, known as servers. The 

server is the computer system that contains information 

such as electronic mail, database information, or 

text files. As a customer, or client, you access those 
resources via client programs (applications) which use 

TCP/IP to deliver the information to your screen in the 

appropriate format for your computer.

One important kind of client program is called a browser, 

which is used to search through information provided 

by a specific type of server. A browser helps you view 
and navigate through information on the Internet. 

Today’s most popular browsers, including Mosaic(R), 

Netscape(TM) Navigator, and the Microsoft Internet 

Explorer offer a graphical interface to the World Wide 
Web.

Client/Server	Operation
A	client/server	system	works	something	like	this:
•  A big hunk of computer (called a server) sits in some 

office somewhere with a bunch of files that people 
might want access to. This computer runs a software 

package  that listens all day long to requests over 

the wires.

•  The “server software” will then access the server  

hardware, find the requested file, send it back over  
the wires to the “client” who requested it, and then  

wait for another request from the same or another  

client.

•  Usually, the “client” is actually a software program, 

like Netscape Navigator, that is being operated by 

a person who is the one who really wants to see 

the file. The client software however, deals with 
all the underlying client/server protocol stuff and 
then displays the document (that usually means 

interpreting HTML, but we’ll get there in just a bit) to 

Fig 1

the human user.

• The whole process looks something like the figure 
below

Hypertext Documents

The WWW makes extensive use of hypertext documents 
which contain

•  Multimedia data such as text, images, sounds, video 
clips etc.

•  Links to other documents (situated anywhere on the 

web).

HTTP

•  The client/server protocol used to exchange 
hypertext documents is called HTTP (HyperText 
Transport Protocol). The main thing you need to 

know is that HTTP is a language spoken between 

your web browser (client software) and a web server 

(server software) so that they can communicate with 

each other and exchange files. (Fig 1)

•  HTTP is a “request-response” type protocol that 

specifies that a client will open a connection to a 
server then send a request using a very specific 
format. The server will then respond and close the 

connection.

HTML

•  Hypertext documents are represented using 
a specialised markup language called HTML 

(HyperText Markup Language). 

•  HTML can be easily integrated with various backend 

languages such as PHP, Node.js.

•  HTML is one of the most popular and widely used 

languages that contains numerous resources and 

has a big community.

•  HTML has a flat learning curve and it can be easily 
run on all web browsers.
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•  HTML is one of the most simple markup languages 

that you can work with.

•  HTML is open-source and completely free. 

•  The web standard for HTML is maintained by World 

Wide Web Consortium (W3C).

Web Browser

Web Browser is an application software that allows us 

to view and explore information on the web. User can 
request for any web page by just entering a URL into 

address bar.

Web browser can show text, audio, video, animation 
and more. It is the responsibility of a web browser to 

interpret text and commands contained in the web page.

Earlier the web browsers were text-based while now 
a days graphical-based or voice-based web browsers 

are also available. Following are the most common web 

browser available today

 Browser Vendor

 Internet Explorer Microsoft

 Google Chrome Google

 Mozilla Firefox Mozilla

 Netsca  Navigator Netcape  

  Communica  

  tions Corp.

 Opera Opera   

  Software

 Safari Apple

 Sea Monkey Mozilla Foun  

  dation

 K-meleon K-meleon

Internet Server

Internet Server means a single server computer used 

by Customer which enables access to the Licensed 

Software by individuals using an Intranet or the Internet, 

having a minimum configuration as set out in hardware 
specifications previously described to Customer as 
applicable to the Licensed Software to be installed and 

used upon it.

Web Server

A web server is software and hardware that uses HTTP 

(Hypertext Transfer Protocol) and other protocols to 
respond to client requests made over the World Wide 

Web. The main job of a web server is to display website 

content through storing, processing and delivering 

webpages to users. Besides HTTP, web servers also 

support SMTP (Simple Mail Transfer Protocol) and FTP 

(File Transfer Protocol), used for email, file transfer and 
storage.

Web server hardware is connected to the internet and 

allows data to be exchanged with other connected 
devices, while web server software controls how a user 

accesses hosted files. The web server process is an 
example of the client/server model. All computers that 
host websites must have web server software.

Web servers are used in web hosting, or the hosting of 

data for websites and web-based applications -- or web 

applications.

How do web servers work?

Web server software is accessed through the domain 

names of websites and ensures the delivery of the site’s 

content to the requesting user. The software side is also 

comprised of several components, with at least an HTTP 

server. The HTTP server is able to understand HTTP 

and URLs. As hardware, a web server is a computer 

that stores web server software and other files related 
to a website, such as HTML documents, images and 

JavaScript files.

When a web browser, like Google Chrome or Firefox, 
needs a file that’s hosted on a web server, the browser 
will request the file by HTTP. When the request is 
received by the web server, the HTTP server will accept 

the request, find the content and send it back to the 
browser through HTTP.

More specifically, when a browser requests a page from 
a web server, the process will follow a series of steps. 

First, a person will specify a URL in a web browser’s 

address bar. The web browser will then obtain the 

IP address of the domain name -- either translating 

the URL through DNS (Domain Name System) or by 

searching in its cache. This will bring the browser to a 

web server. The browser will then request the specific 
file from the web server by an HTTP request. The web 
server will respond, sending the browser the requested 

page, again, through HTTP. If the requested page does 

not exist or if something goes wrong, the web server will 
respond with an error message. The browser will then 

be able to display the webpage.

Multiple domains also can be hosted on one web server.

Examples of web server uses

Web servers often come as part of a larger package 

of internet- and intranet-related programs that are used 

for:

•  sending and receiving emails;

•  downloading requests for File Transfer Protocol 

(FTP) files; and

•  building and publishing webpages.

Many basic web servers will also support server-side 

scripting, which is used to employ scripts on a web server 

that can customize the response to the client. Server-

side scripting runs on the server machine and typically 

has a broad feature set, which includes database 

access. The server-side scripting process will also use 

Active Server Pages (ASP), Hypertext Preprocessor 
(PHP) and other scripting languages. This process also 

allows HTML documents to be created dynamically.
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Dynamic vs. static web servers

A web server can be used to serve either static or dynamic 

content. Static refers to the content being shown as is, 

while dynamic content can be updated and changed. A 

static web server will consist of a computer and HTTP 

software. It is considered static because the sever will 

send hosted files as is to a browser.

Dynamic web browsers will consist of a web server 

and other software such as an application server 

and database. It is considered dynamic because the 

application server can be used to update any hosted 

files before they are sent to a browser. The web server 
can generate content when it is requested from the 

database. Though this process is more flexible, it is also 
more complicated.

Common and top web server software on the market

There are a number of common web servers available, 

some including:

•  Apache HTTP Server- Developed by Apache 

Software Foundation, it is a free and open source web 

server for Windows, Mac OS X, Unix, Linux, Solaris 
and other operating systems; it needs the Apache 

license.

•  Microsoft Internet Information Services (IIS)- 

Developed by Microsoft for Microsoft platforms; it is 

not open sourced, but widely used.

•  Nginx- A popular open source web server for 

administrators because of its light resource utilization 

and scalability. It can handle many concurrent 

sessions due to its event-driven architecture. Nginx 
also can be used as a proxy server and load balancer.

•  Lighttpd- A free web server that comes with the 

FreeBSD operating system. It is seen as fast and 

secure, while consuming less CPU power.

•  Sun Java System Web Server- A free web server 

from Sun Microsystems that can run on Windows, 

Linux and Unix. It is well-equipped to handle medium 
to large websites.

Search Engine

A search engine is software accessed on the Internet 

that searches a database of information according to 

the user’s query. The engine provides a list of results 

that best match what the user is trying to find. Today, 
there are many different search engines available on the 
Internet, each with its own abilities and features. The 

first search engine ever developed is considered Archie, 
which was used to search for FTP files, and the first text-
based search engine is considered Veronica. Currently, 

the most popular and well-known search engine is 

Google. Other popular search engines include AOL, Ask.

com, Baidu, Bing, DuckDuckGo, and Yahoo.

Best search engine?

There isn’t one search engine that is better than all the 

others. Many people could argue that Google’s search 

engine is the best, and it is the most popular and well-

known. It’s so popular that people often use it as a verb 

when telling someone to search for their question.

Microsoft’s Bing search engine is also popular and used 

by many people. Bing does an excellent job of finding 
information and answering questions. Bing is also what 

powers the search in Windows 10 and the Yahoo search 

engine. 

Users concerned with privacy, enjoy using Duck Duck 

Fig 2

Go. This search engine makes its users anonymous and 

is an excellent solution for users concerned with how 
much information Google and Bing collect on their users.

Google

With over 80% of the search market share, Google is 

undoubtedly the most popular search engine. Additionally, 

Google captures almost 95% of mobile traffic. The large 
traffic potential makes Google a viable option when 
aiming to capture organic or paid search  the downside, 

of course, is almost everyone is competing for the same 

traffic.

Also keep in mind Google’s algorithm, like featured 

Fig 3

snippets, aims to fulfill users’ needs directly on Google, 
so they don’t need to click any links. These features , 

and Google’s popularity, might make it hard for you to 

capture the website traffic you want. (Fig 2)

Bing

Bing, Google’s biggest contender, rakes in 15% of U.S. 

searches and also powers Yahoo, the U.S.’s third biggest 
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search engine. Bing’s search pages look remarkably 

similar to Google’s, with the same categories and a 

Fig 4

similar white background, with blue links and green URLs. 

However, Bing additionally offers “Rewards”, a program 
that gives you points when you search or shop on the 

engine, and then allows you to redeem those points for 

gift cards, nonprofit donations, and more. (Fig 3)

Yahoo

Admittedly not the sleekest search engine interface, 

Yahoo! still manages to capture third place in our list, with 

just under 3% of the worldwide market share. Yahoo! is 

powered by Bing, so search results are incredibly similar 

between the two search engines. However, it’s still an 

important search engine in its own right, with over 600 

million total monthly users. (Fig 4)

Domain name

A domain name refers to your website address. This 

is what users type in a browser’s search bar to directly 

access your website. A domain name is unique and 

cannot be shared between different sites. For example: 
ovhcloud.com

Each website is identified by a unique set of numbers, 
called an IP address. Your computer uses these numbers 

to connect to the server where the website data is located. 

When visitors enter a domain name in their search bar, it 

sends a request to a set of Domain Name System (DNS) 

servers. The DNS then responds with the IP address 

of the website’s hosting server, making it accessible. 

Domain names were created because IP addresses are 

too complicated to remember. So, for internet users to 

access a website, it needs to be given a name.

The structure of a domain name

Explanation of its structure. Let’s take the domain name 
of the OVHcloud website as an example: www.ovhcloud.
com

•  www: this refers to the third-level domain (World Wide 

Web).

•  ovhcloud: refers to the second-level domain; this is 

the name of the site.

•  .com: this is the top-level domain (TLD), also known 

as a domain name extension

There are also sub-domains, such as our documentation 

website docs.ovh.com. The sub-domain here is “docs”. 

E-Mail Communication

Email

Electronic mail, commonly shortened to “email,” is a 

communication method that uses electronic devices to 

deliver messages across computer networks. “Email” 

refers to both the delivery system and individual 

messages that are sent and received.

Email has existed in some form since the 1970s, when 
programmer Ray Tomlinson created a way to transmit 

messages between computer systems on the Advanced 

Research Projects Agency Network (ARPANET). Modern 

forms of email became available for widespread public 

use with the development of email client software (e.g. 

Outlook) and web browsers, the latter of which enables 

users to send and receive messages over the Internet 

using web-based email clients (e.g. Gmail).

Today, email is one of the most popular methods of 

digital communication. Its prevalence and security 

vulnerabilities also make it an appealing vehicle for cyber 

attacks like phishing, domain spoofing, and business 
email compromise (BEC).

Email work

Email messages are sent from software programs and 

web browsers, collectively referred to as email ‘clients.’ 

Individual messages are routed through multiple servers 

before they reach the recipient’s email server, similar to 

the way a traditional letter might travel through several 

post offices before it reaches its recipient’s mailbox.

Once an email message has been sent, it follows several 

steps to its final destination:

1  The sender’s mail server, also called a Mail Transfer 

Agent (MTA), initiates a Simple Mail Transfer Protocol 

(SMTP) connection.

2  The SMTP checks the email envelope data — the text 
that tells the server where to send a message — for 

the recipient’s email address, then uses the Domain 

Name System (DNS) to translate the domain name 

into an IP address.

3  The SMTP looks for a mail exchange (MX) server 
associated with the recipient’s domain name. If one 

exists, the email is forwarded to the recipient’s mail 
server.

4  The email is stored on the recipient’s mail server 

and may be accessed via the Post Office Protocol 
(POP)* or Internet Message Access Protocol (IMAP). 

These two protocols function slightly differently: POP 
downloads the email to the recipient’s device and 

deletes it from the mail server, while IMAP stores the 

email within the email client, allowing the recipient to 

access it from any connected device.
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To continue the postal system analogy, imagine Alice 

writes a thank-you note to Bob. She hands the letter to 

the mail carrier (MTA), who brings it to the post office to 
be sorted. At the post office, a processing clerk (SMTP) 
verifies the address written on the envelope. If the address 
appears to be written correctly and corresponds to a 

location that can receive mail (MX server), another mail 

carrier delivers the letter to Bob’s mailbox. After picking 
up the mail, Bob might keep the note in his desk drawer, 

where he can only access it at that location (POP) or put 

it in his pocket to read at any location (IMAP).

Video Chat Tool

Video chat is a one-on-one visual communication 

between two Internet users. Skype popularized video 

chats. It lets any two people around the globe to place 

a video call to each other. For this, all they need is a 

computer, the Skype application, and a good Internet 

connection.

Targeting the enterprise world in 2010, Skype introduced 

a feature that allows five people to take part in a video 
call. Video chat uses technology to conduct live video 

as well as audio interaction among users at different 
locations. Generally, video chats are performed by 

means of computers, smartphones, or tablets.

Although video chat mainly refers to point-to-point 

interaction, as with the case of FaceTime and Skype, 

it can also be used for multipoint (one-to-many) 

interactions; one typical example is Google Hangouts.

Even though video chat is frequently used interchangeably 

with videoconferencing, there is significant overlap 
between the two terms. Generally videoconferencing 

means multi-point, video-audio interaction set up in a 

business environment, with three or more participants 

taking part.

Best Free Video Conferencing Platforms

1  Zoom

2  Google Hangouts

3  Dialpad Meetings

4  TrueConf Online

5  Skype

6  FreeConference

7  Lifesize Go

8  Slack Video Calls

9  Facebook Live

10 YouTube Live

1   Zoom

 Zoom is ideal for anyone who works remotely or 

has remote team members. Zoom is also a popular 

favorite among virtual educators. Zoom allows for 

simple, easy setup meetings or regular meetings 

in your personal meeting room. Quickly create and 

share a private meeting link with an individual or team 

and connect remote team members through video.

Features:

• Host up to 100 participants

• 1-1 and group meetings

• Unlimited meetings

• HD video and audio

• Screen sharing

• Scheduled meetings

• Private and group chat

• Host controls

2 Google Hangouts

 Google Hangouts is a simple way to connect with 

Google contacts (or those outside of your network) 

and can be used for personal or business reasons. 

Use this tool for individual conversations, team 

meetings, recorded demos, and more.

Features:

• Up to 25 video participants

• Video, audio, and messenger conversations

• Video meeting recordings

• Join calls using Google Calendar

• Screen sharing

3 Dialpad Meetings

 The free version of Dialpad Meetings is ideal for 

teams of 10 or less. The free version limits your video 

call duration to 45 minutes, so it’s ideal for shorter 

meetings. Since it allows unlimited video conferences, 

you can use this video conferencing tool for recurring 

meetings, like 1-1s or monthly team debriefs.

Features:

• Up to 10 participants

• Unlimited conferences

• Call recording

• HD Audio

• Screen and document sharing

• Mobile apps

4   TrueConf Online

TrueConf offers a free plan with up to three participants 
in video calls. This solution is great for small teams or 

individuals who need a simple tool to host video calls 

or collaborate with small groups. The collaboration 

features like remote desktop control are helpful for 

those in support who may need to help a client solve 

a problem.

Features:

• Up to three participants on team calls
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•  HD video

•  Collaboration tools (screen sharing, remote desktop 

control, recorded calls, file transfer, and shared virtual 
whiteboard)

5   Skype

  The free version of Skype works well for small teams 

with less than 10 total members. It is a good tool if you 

need a simple way to video chat from your computer, 

phone, or tablet and tend to have smaller group 

meetings or 1-1 conversations. Skype also offers 
a tool called Skype in the Classroom specifically 
designed for online education.

Features:

•  Up to 10 people on video calls

•  HD video calling

•  Screen sharing

•  Video call recording

•  Interactive video chats

•  Location sharing

6   FreeConference

  FreeConference ideal for smaller teams or meetings 

with five or fewer participants. One major perk 
of this video conferencing tool is its ease of use -- 

no downloads are required to start using it. Plus, 

moderator controls allow the individual who’s running 

the video conference to keep the meeting on track.

Features:

•  Up to 5 online meeting participants

•  Screen sharing

•  Document sharing

•  Moderator controls

•  Text chat

7   Lifesize Go

  Lifesize Go can be used by remote employees, 

remote freelancers, or those working with clients who 

rarely host larger group meetings. While they have 

plans that include solutions for bigger teams, the free 

version offers a nice amount of features for individuals 
and small group conversations.

Features:

•  Up to 8 participants

•  No restrictions on meeting length

•  Screen sharing

8   Slack Video Calls

  Slack users can take advantage of the call feature by 

simply using the command /call or clicking the phone 

icon at the top of the conversation with another Slack 

user. This is an easy way to make calls right from 

Slack if you need to ask a teammate a quick question. 

You can also Slack with up to 15 people if you start a 

call from a channel, enabling the rest of the channel’s 

members to join. This tool is good for teams looking 

for a supplementary video calling solution for small 

teams.

Features:

•  Group calls of up to 15 people

•  Individual calls

•  Messenger

9   Facebook Live

  Facebook Live is a great fit for businesses, influencers, 
or individuals who are looking to broadcast demos, 

videos, or showcase their company culture while 

streaming live. Your followers on Facebook can 

comment and chat live, you can select a custom 

audience for the video, and you can schedule videos 

ahead of time to gain excitement.

Features:

•  Broadcasts up to four hours

•  Advanced scheduling

•  Custom audiences

10  YouTube Live

  YouTube Live, like Facebook Live, is a platform for 

demonstrating a product with live Q&A, hosting an 

educational session to teach your audience while 

screen sharing or using a whiteboard, or hosting a 

live conversation with members of your team.

Features:

•  Three stream quality options (normal latency, low-

latency, ultra-low latency)

•  Added delay

•  Live questions from the audience

•  Private live streams (people can only access with the 

link)

•  Advanced scheduling

•  Live automatic captions

•  Location tags

Social Networking

The term social networking refers to the use of internet-

based social media sites to stay connected with friends, 

family, colleagues, or customers. Social networking can 

have a social purpose, a business purpose, or both, 

through sites like Facebook, Twitter, Instagram, and 

Pinterest.

Social Networking Works

Social networking involves the development and 

maintenance of personal and business relationships 

using technology. This is done through the use of social 

networking sites, such as Facebook, Instagram, and 

Twitter.
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These sites allow people and corporations to connect 

with one another so they can develop relationships and 

share information, ideas, and messages.

Social Networking Platforms

Facebook

Facebook is a social network that offers users the 
opportunity to connect with people, businesses, and 

organizations. They can post updates and respond to the 

posts of others. They can share photographs and links 

to online content. Users can chat live, and upload and 

share video.

Users can also communicate directly with each other 

via Facebook Messenger. They can join groups with like 

interests, and be notified of friends’ activities and pages 
they elect to follow.

Facebook was designed to be open and social. However, 

while the platform encourages publicly available content, 

it also has privacy controls that can restrict access to, for 

instance, friends.

Instagram

Instagram is a social network that focuses on sharing 

visual media like photos and videos. It’s similar to 

Facebook in that users create a profile and have a news 
feed. It allows users to upload media that can be edited 

with filters and organized by hashtags and geographical 
tagging. Posts can be shared publicly or with followers.

Users can browse other users’ content, view trending 

content, and follow other users. They can add others’ 

content to their personal feed. Over time, Instagram 

has added new features, such as Instagram Stories, 

Instagram Reels, and access to shopping. Like 

Facebook, Instagram encourages users to keep their 

content publicly accessible but it also lets them set 

access to approved followers only.

Instagram has its own direct messaging feature. In 

addition, Facebook Messenger has been incorporated 

by Instagram so users can direct message Facebook 

contacts while in Instagram.

Twitter

Twitter is a social network that allows people to 

communicate with short messages called tweets. Tweets 

are limited by the social platform to 280 characters. 

Users post tweets that may be useful, interesting, or 

even inflammatory for readers.

Others use Twitter to find people and companies posting 
appealing, important, or newsworthy content. Once 

users discover others who pique their interest, they can 

follow them and receive their ongoing stream of tweets 

in their feeds.

Tweeting is sometimes referred to microblogging. It’s 

distinguished by users’ ability to scan and distribute 

content quickly, conveniently, and easily. This may 

account for its popularity with those who want (or need) 

to get lots of messages out to the world and those who 

want to follow such socialistas (or vital sources of crucial 

information).

Pinterest

Pinterest is a social networking site that promotes image 

saving and sharing using a virtual pinboard. It’s an 

innovative platform that facilitates the cataloguing and 

organizing of meaningful information for individuals.

With Pinterest, account holders find images by browsing 
the web or Pinterest itself. They then pin (or save) those 

images to an online pinboard. Multiple pinboards can be 

set up and organized, based on a topic.

Once they’ve created and built their boards to catalogue 

ideas and interests, users can access them whenever 

they want. Clicking on the image reveals related 

information.

As with other social networks, Pinterest users have a 

feed that exhibits images according to their interests. 
They can interact by “liking” images, following each 

other, and posting comments. There’s also a feature that 

provides for private messaging.

Introduction to Internet Security Protocols

In today’s computer network world, internet security has 

achieved great importance. Since internet technology is 

vast and encompasses many years, there are various 

aspects associated with internet security. Various security 

mechanisms exist for specialized internet services like 
email, electronic commerce, and payment, wireless 

internet, etc. To provide the security to this internet 

various protocols have been used like SSL (Secure 

Socket Layer), TLS ( Transport Layer Security), etc.

Various Internet Security Protocols

1   SSL Protocol

  SSL Protocol stands for Secure Socket Layer 

protocol, which is an internet security protocol used for 

exchanging the information between a web browser 
and a web server in a secure manner. It provides 

two basic security services like authentication and 

confidentiality. SSL protocol has become the world’s 
most popular web security mechanism, all major web 

browsers support SSL. Secure socket layer protocol 

is considered as an additional layer in TCP/IP protocol 

suite. It is located between the application layer and 

the transport layer. SSL has three sub protocols 

namely Handshake Protocol, Record Protocol, and 

Alert Protocol.

  OpenSSL is an open source implementation of the 

Secure Socket Layer protocol. OpenSSL is subject 

to four remotely exploitable buffer overflow. Buffer 
overflow vulnerabilities allow attackers to execute 
arbitrary code on the target computer with a privilege 

level of OpenSSL process as well as providing 

opportunities for launching a denial of service attack.

2   TLS Protocol

  TLS stands for Transport Layer Security, which 

is an internet security protocol. TLS is an IETF 
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standardization initiative whose goal is to come 

out with an internet standard version of SSL. To 

standardized SSL, Netscape handed the protocol to 

IETF. The idea and implementation are quite similar. 

Transport layer security protocol uses a pseudo 

random function to create a master secret. TLS 

also has three sub protocols same as SSL protocol 

– Handshake Protocol, Record Protocol, and Alert 

Protocol. In Handshake Protocol some details are 

changed, Record Protocol uses HMAC, Alert protocol 

newly added features like record overflow, Unknown 
CA, Decryption failed, Decode error, Access denied, 

Export restrictions, Protocol version, insufficient 
security, internal error. Transport layer security is 

defined in RFC 2246.

3   SHTTP

  SHTTP stands for Secure HyperText Transfer 
Protocol, is a set of security mechanism defined for 
protecting internet traffic. It also includes data entry 
forms and internet based transaction. Services 

provided by SHTTP are quite similar to SSL protocol. 

Secure HyperText Transfer Protocol works at the 
application layer, and therefore tightly coupled with 

HTTP. SHTTP supports both authentication and 

encryption of HTTP traffic between the client and 
the server. Encryption and digital signature format 

used in SHTTP have the origins in the PEM (Privacy 

Enhanced Mail) protocol. SHTTP works at the level 

of an individual message. It can encrypt and sign an 

individual message.

4   SET Protocol

  SET Protocol stands for Secure Electronic 

Transaction protocol is an open encryption and 

security mechanism designed for protecting the 

eCommerce transaction over the internet. SET is not 

a payment system, it is a security protocol used over 

the internet for secure transaction.

The SET protocol provides the following services

•  SET provides authentication by using digital 

certificates.

•  It provides a secure communication channel among 

all parties involved in an eCommerce transaction.

•  It ensures confidentiality because the information is 
only available for parties involved in a transaction and 

that too only when and where required. (Fig 5)

The SET protocol includes the following participants

•  Cardholder: It is an authorized holder of payment 

card such as visa card, Master card.

•  Merchant: It is a specific person or organization who 
wants to sell goods and services to the cardholder.

•  Issuer: It is a financial institution which provides 
payment card to the cardholder.

•  Acquirer: It is a financial institution which has a 
relationship with merchants for processing payment 

card Authorization and payments.

•  Payment Gateway: It acts as an interface between 

SET and existing card payment networks for payment 
Authorization.

•  Certification Authority: It is an authority that is trusted 
to provide a public key certificate to cardholder, 
merchant, and payment gateways.

5   PEM Protocol

  PEM Protocol stands for privacy enhanced mail, used 

for email security over the internet. If we adopted by 

IAB ( Internet Architecture Board) to provide secure 

electronic mail communication over the internet. It 

was initially developed by the IRTF (Internet Research 

Task Force) PSRG (Privacy Security Research 

Group). Then they handed over the PEM to the IETF 

(Internet Engineering Task Force) PEM working 

group Privacy Enhanced Mail protocol is described 

in four specific documents RFC 1421, RFC 1422, 
RFC 1423, and RFC 1424. It supports cryptographic 

functions namely encryption, nonrepudiation, and 

message integrity.

6   PGP Protocol

  PGP Protocol stands for Pretty Good Privacy, which 

we developed by Phil Zimmerman. PGP protocol 

is easy to use and free including its source code 

documentation. It also supports the basic requirements 

of cryptography. However, for those organizations that 

require support, a low-cost commercial version Of 

PGP protocol is available from an organization called 

viacrypt. PGP protocol becomes extremely popular 
and more widely used as compared to PEM protocol. 

PGP protocol support cryptography like encryption, 

Non-repudiation, and message integrity.

We use different types of media to find out news, learn 
new things, and entertain ourselves. With the advance in 

technology, we can choose the type of media we want to 

use, no matter the time or place. 

So, we can hear the radio while driving to work, we can 

watch our favorite show on our phone, and we can find 
out any information and news on our laptop or mobile 

device, thanks to the Internet. Who knows where 

technology can lead us in the future.

For project communication, you have email and FTP. 

For multilingual content creation, you have Notepad, 

Unicode Fonts, Microsoft Office, PDF Reader/Creator 
and Adobe Creative Cloud. If you can live without one 

tool, it’s the TMS, since your translation vendor should 

be using one on their end. WordPress and Social Media 

to publish your multilingual content and share it with your 

multicultural audience. (Fig 6)
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Fig 5 Fig 6
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IT & ITES Related Theory for Exercise 1.5.49

DTPO - Printer and Scanner 

Types of scanner and setting 

Objectives: At the end of this lesson you shall be able to

• introduction Scanner and types of scanner

• how to scan on a windows computer

•	 different	setting	of	scanner

Introduction Scanner : 

The scanners are computer input devices, which are 

used to scan documents, images, and text files. The 
documents which are scanned are converted into a 

digital format that can be further viewed and updated 

with the help of computer and editing software.

• The scanners are computer devices that are used to 

convert hard copy into a soft copy that can be later 

modified and viewed using a computer, laptop, and 
mobile.

• To modify these soft copy special editing software 

are used like Photoshop and adobe reader.

• The scanner is a device that is designed and 

developed to scan photographs, posters, magazines, 

documents, text files, etc. and save them in a 
computer hard disk drive for further usage.

• The scanner grants permission to the computer 

system for printing documents that are converted 

into digital format.

• The scanner is self-sufficient in scanning black | 
white as well as colour images.

Different	Types	of	Scanner
• Drum Scanner

• Handheld Scanner

• Flatbed Scanner

• Optical Character Recognition

• Magnetic Ink Character Recognition

• Image Scanner

• Light Pen

• Barcode Reader

Fig 1

Drum Scanners

• They are renowned for the good quality scanning 

of documents and images. They are widely used in 
publications and the printing press. (Fig 1)

• The drum scanners consist of a photomultiplier tube 

{PMT} which is responsible and used for scanning 

images and documents.

• This photomultiplier tube {PMT} is highly sensitive to 

light.

• The drum scanner scan images in high resolutions 

all the small details included in the documents and 

images are scanned in the process.

• The image is kept on the glass tube where glass tubes 

revolve around the image to scan the document from 

all angles.

• There is a sensor mounted in the centre of the 

cylinder. This sensor divides the light coming from 
the document into 3 beams.

• After this, each beam is passed through a color filter 
to the photomultiplier tube. After coming here, the 
light is converted into an electrical signal.

Handheld Scanner

• The handheld scanners or hand scanners are small 

and compact in size devices; they are one of the 

Fig 2

popular input devices of the computer systems.               
(Fig 2)

• They are capable of scanning any size of products, 

they are less weighted therefore can be used 

accordingly.

• They are also considered as small manual scanning 

devices that is generally used with hands for manual 

scanning.

• They are used while gently scrolling over the image 

or barcode to capture the complete details related to 
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the product such as product manufacturing details, 

price, expiry date and batch number.

• They are primarily used in malls and libraries. The 
handheld or hand scanners are similar to flatbed 

Fig 3

scanners.

Flatbed Scanner

• They are the most famous and popular scanners and 

therefore widely used and accepted.  They are also 
known as desktop scanners or personal computer 

scanners. (Fig 3)

• They are primarily and extensively used in homes 

and small offices.

• Flatbed scanners have a large glass surface and a 

lid.

• These scanners work best with flat objects such 
as photos and paper, but you can also place large 

Fig 4

objects such as open books on the scanner bed.

• Some models of flatbed scanners come with built-in 
all-in-one devices that function as printers, scanners, 

copy machines, and fax machines.

Optical Character Recognition

• The OCR stands for optical character recognition. 
(Fig 4)

• OCR is a mechanical device that can convert 

images, pictures, documents, or manually written 

content into readable form.

Fig 5

• These scanned documents are later provided to the 

system for further processing like modification and 
updates using editing software like Photoshop and 

adobe reader.

Magnetic Ink Character Recognition

• MICR stands for magnetic ink character recognition. 
(Fig 5) 

• MICR is an input device of a computer system 

that is generally used in the banking sector where 

numerous cheques are handled and processed 

every day.

• The cheques contain important and sensitive 

information printed on them like cheque number, 

Fig 6

account number, name of the account holder, and 

bank id codes.

• The MICR devices are capable of reading this 

information and comparing and cross check 

previously stored detail in the banking database.

Image Scanner

• The image scanner is a digital device also an input 

device of the computer that is used to scan images, 

pictures, printed text, documents and objects and 
later convert it into a digital image. (Fig 6)

• Image scanners are used in a variety of domestic 

and industrial applications such as design, reverse 

engineering, orthotics, gaming and testing.
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Light Pen

• The light pen is a computer input device similar to a 

Fig 7

pen used to read bar codes, also capable of pointing 

at the object and characters on the monitor screen. 
(Fig 7)

• The light pen helps users modify changes in the 

drawings. It is also considered a handheld light-
sensitive device known as a “Pointing Device”.

• They are also called “Electronic Pen”.
• It is a pointing device that can be used as a computer 

mouse to point, select, and drag elements on the 

computer screen.
• It is typically used as a part of CAD (Computer-

Aided Design), where the client selects something 

on the screen.
• Modern light pens are available in wireless 

technology. Due to the contemporary development 
Fig 8

details regarding the price, item no, batch code, etc. 
(Fig 8)

• This barcode reader or barcode scanner is attached 

to the computer system. After scanning, the complete 
details of the item can be fetched on the computer 

for quick access with database administration.
• The barcode is nothing but black and white color 

parallel lines attached to any product, and a laser 

barcode reader is used to fetch the details inside the 

barcode.
• The barcode is scanned with the help and assistant 

of an optical barcode reader.
• The Optical barcode reader or barcode scanners 

are an input device of a computer system used for 

standardized identifications.
• The information is in dim lines with alphanumeric 

values that differ in width and height.
• A standard barcode scanner uses laser shaft 

technology.
• The Laser bar is relocated adjoining the bar lines of 

the standardized identifications when the Laser pillar 
moves, and it gets reflected light from the scanner 
tags.

• A touchy light detector discovers the reflected bar.
• The barcode scanner is connected to the computer 

system where alphanumeric values are stored in 

computer memory, such as a computer hard disk 

drive.
5 Uses of Scanner Devices

• The scanners are used to scan documents to the 

computer for further modifications and use.
• The documents are converted in digital format which 

can later be shared via Google drives, emails, or 

upload online on other websites.
• In modern competitive exams the answers can be 

scanned with the help of optical card reader.
• The OMR [Optical Mark Reader] is an input device of 

a computer that is primarily utilized in the examination 

for solving multiple-choice questions.
• The OMR converts these solved questions into 

machine-readable form.
• They are extensively used in libraries where 

scanners scan all important information related .
• They are used in malls, all the product sensitive 

information can be capture using them like product 

cost, manufacturing date, expiry date, batch number, 

etc.
• All in one scanner are available in the markets which 

are capable of scanning, printing.
• The modern scanners can be connected to the 

computer system using Wi-Fi, Bluetooth, Infrared, 

LAN, USB cables, TWAIN, parallel port, SCSI, etc.
• They are widely used as the qualities of scan 

documents are never compromised.

in technology, they have easily replaced their 

counterparts.
• They are plug-and-play devices that do not need 

driver’s files to install and use.
Barcode Reader

• These barcodes are scanned with the help of a 

barcode scanner or barcode reader to check the 
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Disadvantages of Scanners Computer Devices

• The major disadvantages of scanners are they are 
expensive and latest model are not readily available 

in market.

• The scanned sizes of documents are huge and 

hence eat lot of space in hard disk drive.

S.No Scanner Description

1 Drum Scanners They are considered to first use scanners. They use 
photomultiplier tubes for better performance and also for 

enhancing performance.
2 Handheld Scanner The handheld scanners or hand scanners are small and compact 

in size devices; they are one of the popular input devices of the 

computer systems.
3 Flatbed Scanner They are primarily and extensively used in homes and small 

offices.
4 Optical Character Recognition OCR is a mechanical device that can convert images, pictures, 

documents, or manually written content into readable form.
5 Magnetic Ink CharacterRecognition MICR is an input device of a computer system that is generally 

used in the banking sector where numerous cheques are handled 

and processed every day.
6 Image Scanner Image scanners are used in a variety of domestic and industrial 

applications such as design, reverse engineering, orthotics, 

gaming and testing.
7 Light Pen The light pen is a computer input device similar to a pen used 

to read bar codes, also capable of pointing at the object and 
characters on the monitor screen.

8 Barcode Reader Barcodes are scanned with the help of a barcode scanner or 

barcode reader to check the details regarding the price, item no, 

batch code, etc.

How to scan on a windows computer

• Right-click your scanner or printer, then click Start 

Scan. (Fig 9)

• Users have several options on the screen which let 

you preview the document (Fig 10) choose a color 
format (color or black and white), adjust brightness, 
set the appropriate resolution, and even choose the 

format you want to save it in: JPEG, PDF, or PNG. If 

you are satisfied with the results after reviewing the 
document, proceed to click Scan.

• Make your selections, Click Preview  to ensure 

everything looks good then click Scan.

When ready, click Scan then review the scanned 

document. (Fig 11)
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• They are heavy on maintenance and a professional 

person is needed for repairing.

• Some scanners take time for scanning documents.

• Low quality scanners reduce the quality of scanned 

images.

Function of Scanners

Fig 9

Fig 10
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Fig 12Fig 11

Different	setting	of	scanner
Use the Scanner Settings screen to temporarily change 

a scanner’s settings. If importing, use the Import Settings 
Screen that is displayed. (This screen is displayed 
when using a scan profile for Scan for ISIS. For Scan for 
Adrenaline settings, see “Scanner Properties Screen”.) 
Settings you select remain until you select another 

profile, either the current profile or another one.

Display this screen by clicking the Scanner Settings 

toolbar button in the Batch Scanning screen.

Element Description

Resolution Select the resolution at which you want images scanned when this profile is used. The 
resolutions available depend on the selected scanner. Resolution is the fineness or 
coarseness, measured in dots per inch (dpi), of an image as it is scanned. A higher resolution 
results in a better image; however, more storage space is required for high resolution image 

files.
Page Size Select the maximum page size of documents that will be scanned using this profile. Available 

page sizes depend on the selected scanner.

Dither Dither is the process of simulating shades of gray by altering the size and arrangement of 

black pixels on an image.

Brightness 

Control

Select Auto if you want the scanner to automatically adjust the brightness (lightness) of 
images during scanning. To specify a particular brightness setting, select Manual and select 
a value using the slider. The black circle indicates darker values and the white circle indicates 
lighter values. (The higher the value, the lighter the scanned images.)

Contrast Control Contrast is the range between the lightest and darkest shades in an image. A high contrast 
image has more gray shades between black and white; a low contrast image has fewer gray 

shades. Contrast determines how many gray shades are scanned. Select Auto if you want the 
scanner to automatically adjust the contrast of images during scanning. To specify a particular 
contrast setting, select Manual and select a value using the slider. The black circle indicates 
high contrast values and the white circle indicates low contrast values. (The higher the value, 
the less contrast in the scanned images.)

Advanced, More Display additional advanced options. Advanced settings are specific to the selected scanner.
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After giving your scanned document a Name, add a few 

tags to make it easier to search for later. Click Import.

Your scanned document can normally be found in 

Pictures within the scanned files folder. (Fig 12)

©
 N

IM
I 

N
O
T
 T

O
 B

E
 R

E
P
U
B
L
IS

H
E
D



87

IT & ITES Related Theory for Exercise 1.5.50-54

DTPO - Printer and Scanner

Various printer and fax and their settings

Objectives: At the end of this lesson you shall be able to

• introduction printer and types of printer

• how to print from a USB or wireless connected HP printer

•	 different	setting	of	printer
• sending and receiving fax multifunction printer and modify the fax setting

Introduction Printer

Printers are the most commonly used and popular 

output devices. They provide information in a permanent 
readable from. They produce printed output of results, 
programs and data. Prints text or image on paper called 
hard copy. The printing speed of a printer is measured 
in pages per minute (ppm).Printer resolution is often 
measured in dots per inch (dpi).

Types of Printers

Printers are classified into two categories according to 
printing technology ( working): (Fig 1)

• Impact printer

• Non -Impact Printer

Fig 1

• IMPACT PRINTER

Impact printers these Printers use an Electro-mechanical 

mechanism. An impact printer refers to all those printers 
whose printing heads touch the paper. His mechanism 
uses hammers or pins to strike against a ribbon and 

paper to print the text or image.

Types of Impact Printers

Impact printers are of two Types:

• Character Printer

• Line Printer

• CHARACTER PRINTER 

A Character printer prints a single character at a time. 
They are low speed printers. Their printing speed lies in 
the range of 10-600 character / second.

Types of Character printers

Character printers are generally of two types:-

• Daisy wheel Printer

• Dot Matrix Printer

• DAISY-WHEEL PRINTERS 

These printers use a print wheel font, which is termed 

as daisy wheel. Each petal or hammer of Daisy-Wheel 
has a character raised on it. A motor spins the wheel at 
a rapid rate. When the desired character spins to the 

Fig 2

correct position, a print hammer strikes it to produce the 

output. (Fig 2)

The speed of these Daisy-Wheel Printers normally 

ranged between 10-75 characters per second. The 
noise levels of these printers are high. These printers 
are most commonly used in electronic typewriter.

Advantages of a Daisy-Wheel Printer

• Can print letter quality characters.

• Gives fine quality output.

Disadvantages of a Daisy-Wheel Printer

• Printing speed is very slow

• Noisy

• Cannot print Graphics

• They are very costly.
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• DOT MATRIX PRINTER

These printers print each character as a pattern of dots. 
The print head is made up of a matrix of tiny needles, 

typically 9 rows with 7 columns (9 *7 matrix needles). 

Fig 3

These shapes of each character are formed in the form 

of tiny dots. (Fig 3)

The printing quality of a dot matrix printer is inferior to 

a daisy wheel printer. But the printing speed of a Dot 
Matrix Printer is range from 40 to 600 characters per 
second. Dot Matrix Printers are less expensive than 
daisy – wheel printer.

 Advantages of a dot matrix printer

Dot matrix printer over letter – quality printer is that dot 

– matrix printer can print characters in different shape, 
size and fonts.

• Dot matrix printer uses continuous paper rather than 

requiring individual sheet.

• Dot matrix printer is fast and cheep.

Fig 4

• Dot matrix printer can print charts and graphics.

Disadvantages of a dot matrix printer

• Dot matrix printers are noisy.

• Dot matrix printers do not produce high quality.

• LINE PRINTERS

Line printers are impact printers used with mini and 

mainframe computers.(Fig 4) For producing largevolume 
outputs. These printers print one line of the text at a 
time that is why known as line printer. Its printing speed 
lies in the range of 300-3000 lines per minute (LPM). 
Actually line printer prints only one character at a time 

but because of its printing speed, observer observes 

that it prints a whole line a time.

Types of Line Printers

Line Printers are of two types

• Drum Printer

• Chain Printer

• DRUM PRINTER

The drum printer consists of a cylindrical drum. Asset 
of characters are embossed on its surface to print.  
(Fig 5) A set of print hammers is associated with each 
character. As the drum rotates, the hammer wait for 

Fig  5

desired character and is activated when character 

appear in front of hammer. The hammer is placed behind 
the paper. There hammers strike the paper along with 
ribbon (ribbon is placed between hammer and drum) 
against the embossed character on the surface one 

revolution of drum is needed to print a line. As the line is 
printed the paper moves upward to print next line.

• CHAIN PRINTER

A chain containing characters is used for printing. (Fig 
6) The chain knows as print chain rotates very rapidly. 
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Fig 6

With each link of the chain is character font. Magnetically 
driven hammers are there in each print position and all 

the characters which are to be printed are received 

by the printer through processor. When the desired 
character comes in the print position the hammers strike 

the ribbon and paper against the character thus it prints 

one line at a time. It is very noisy and its speed ranges 
from 400-24000 line per minute (LPM).

• NON - IMPACT PRINTER

These printer uses ink and special electrical machines 

for producing outputs. Non – impact printers are all 
those printers whose printing heads do not touch paper. 
A non impact printer forms characters and image on a 

piece of paper without actually striking the paper.

Types of Non -Impact Printers

• Laser printer

• Inkjet printer

• Thermal printer

Fig 7

A laser beam is directed across the surface of a light 

or photosensitive drum. An image is produced, with the 
use of raster scan principal, in the form of tiny dots. The 
laser exposed areas attract toner (or ink power). There 
after the drum transfers the toner to the paper. The 
paper then moves to a fusing station where the toner is 

permanently fused on the paper with heat or pressure. 
After this the drum is discharged and cleaned and ready 

for processing the next page.

Advantages of Laser Printers

• Very high speed.

• Low noise level

• Low maintenance requirement.

• Very high quality output on ordinary paper.

• Good graphics quality (300 dpi to 1200 dpi) and 
excellent graphics capabilities.

• Supports many fonts and different character size.

• Color printing possible

Disadvantages of Laser Printers

• Very Expensive.

• Require periodic maintenance.

• INKJET PRINTERS

Inkjet printer is non impact character printer (Fig 8). It 
uses the dot matrix approach to print to print text and 

graphics. However the dots are formed by tiny droplets 

Fig 8
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• LASER PRINTERS

They print one page at a time thus laser printer is also 

referred as Page Printer. (Fig 7) A laser printer uses 
electronics, lasers, xerography and other techniques, 

which is called electro photographic technique.

of ink. They print characters by spraying small drops of 
ink onto paper. For spraying drops nozzles are used. 
Special type of ink having high iron content is used for 

forming drops. Droplets of ink are electrically charged 
after leaving a nozzle when it passes through a valve. 
The droplets are then guided to the proper position 

on the paper by electrically charged horizontally and 

vertically deflection plates.

These printers can print 40-300 CPS (character/sec.) 
and can produce multi-color printouts.

Advantages of Ink jet Printers

• High quality text and graphics.

• Produces no noise
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Disadvantages of Thermal Printers

• Its speed is slow than other impact printer and no- 

impact printers.

• Its image quality is also lower than other printer [low 

dpi (dot per inch) , bout 180 dpi].

• Ink cartridge is costly.

Fig 9

• THERMAL PRINTER

This type of printer uses a special heat sensitive paper. 
These papers have a special heat sensitive coating. 
When a spot on the special paper is heated, it becomes 

dark. A character is printed with a matrix of dots. The 
heating element is heated by electric current. We can 
also say the heat sensitive paper ass chemically treated 

paper. In this type of printer neither the ink nor the ribbon 
in involved. (Fig 9)

To print a character the printing head is moved first to the 
correct character position. Then the heating elements of 
desired character are turned on. After a short time they 
are turned off. There after the print head is moved to the 
next character. Such printers have a speed of about 200 
characters per second.

Advantages of Thermal Printers

• Low noise

• Can produce high quality color output.

Disadvantages of Thermal Printers

• Expensive

Fig 10

• Slow Speed

• Required special paper

2D and 3D Printers

• Printers are one of the common computer peripheral 

devices that can be classified into two categories that 
are 2D and 3D printers. (Fig 10) The 2D printers 
are used to print text and graphics on a paper, and 

3D printers are used to create three dimensional 

physical objects.

• One of the best enhancements in the history of 

printing technology is the 3d printer, which was 

developed by Chuck Hull in 1984. It produces 3D 
objects and items by using quality resin. It uses 
materials like plastics, polymers, metal alloys, or 

even food ingredients.

3D printer 

Generally, the design of an object starts in a computer-
aided design (CAD) software system where its 
prototype is created. Then, the computer-aided design 
system sends this prototype to the printer in STL 

(stereolithography)  file format. The printer then starts 
the process of recreating the object layer-by-layer after 
reading the prototype in cross-sections. The below 
image is a blueprint of 3d printer that is known as Flash 

Forge.

Advantages of 3D printer:

• The main advantage of a 3D printer is that it allows 

users to print objects in 3D.

• It has the ability of full customization.

• It is easy to access and cost-effective.

• It prints the documents with better quality.

• It provides users unlimited shapes and geometry.

Disadvantages of 3D printer:

• Its initial and resin costs are high.

• 3D printing is still developing technology.

• It consumes high energy around 50 to 100 more 
than injection molding.

• It includes limited materials

• The 3D printers are slow as they are limitless for 

mass customization.

Print from a USB or wireless connected HP printer

• Select the file you want to print and open the file so 
it appears on your computer screen.

• Press the Ctrl + P buttons on your keyboard at the 

same time.

• Once the printing pop-up menu appears on your 

computer screen, select the printer you intend to 

send the job to.

• If the printer is not connected, get help setting it 

up through the  HP Printers - USB Printer Setup 
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(Windows).

• For wireless printer setup and connection, get help  

connecting the printer wirelessly.

• If needed, modify your print settings. This step is 
optional.

Fig 11

• Click the Print button on screen to send the job 
into the printer print queue and wait for the job to 
complete. 

Different	setting	of	printer
• Open the Print dialog box. (Fig 11)

• Select Printer Settings from the drop-down list, and 

select the Basic settings tab.

• Click Automatic, then choose the resolution from 

the Resolution drop-down list.

Using	the	predefined	settings
The predefined settings are provided to help you 
optimize print settings for a particular kind of printout, 

such as presentation documents or images taken by a 

video or digital camera.

Follow the steps below to use the predefined settings.

• Open the Print dialog box.

• Select Printer Settings from the drop-down list, and 

select the Basic settings tab.• S e l e c t 
Advanced. You will find the predefined settings in 
the list on the right of Automatic.

• Select the most appropriate setting from the list 

according to the type of document or image you 

want to print. (Fig 12)

When you choose a predefined setting, other settings 
such as Printing Mode, Resolution, Screen, and 

Color Management are set automatically. Automatic 

(Standard)

Suitable for regular printing, especially photos.

Fig 12

Text/Graph

Suitable for printing documents that include text and 

graphs, such as presentation documents.

Graphic/CAD

Suitable for printing graphs and charts.

Photo

Suitable for printing photos.

ColorSync

Automatically adjusts printout colors to match colors on 
your screen.

Automatic (High Quality)

Suitable for regular printing that gives priority to high-

quality printing.

Advanced Text/Graph

Suitable for printing high-quality presentation documents 

that include text and graphs.

Advanced Graphic/CAD

Suitable for printing high-quality graphs, charts, and 

photos.

Advanced Photo

Suitable for printing high-quality scanned photos and 

digitally-captured images. (Fig 13)

Customizing print settings

Your printer provides for customized print settings if you 

need more control over the printout.

Follow the steps below to customize your print settings.

• Open the Basic Settings dialog box.

• Click Advanced, then click More Settings. The 
following dialog box appears.

• Open the Basic Settings dialog box.
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Fig 14

Fig 15

Fig 16

Fig 13

• Click Advanced, then click Mor e Settings. The 
following dialog box appears.

• Choose Color or Black as the Color setting

• Choose desired printing resolution from Fast (300 
dpi) or Fine (600 dpi).

•     Click OK to apply the settings and return to the Basic 

Settings dialog box.

Modifying the print layout

You can print either two or four pages onto a single 

page and to specify the printing order, automatically 

resizing each page to fit the specified paper size by 
using Layout printing. You can also choose to print 
documents surrounded by a frame.(Fig 14)

• Open the Print dialog box.

• Select Layout from the drop-down list.

• Select the number of pages you want to print on one 

sheet of paper from the drop-down list.
• Click Print to start printing.

Duplex printing

Duplex printing prints on both sides of the paper. You 
can do duplex printing manually. When printing for 
binding, the binding edge can be specified as required 
to produce the desired page order.

Doing duplex printing manually

• Open the Print dialog box.
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• Select Printer Settings from the drop-down list, and 

select the Basic settings tab.

• Select the Duplex (Manual) check box, then click 

the Duplex Settings button. (Fig 15)

• Select a Binding position from Left, Top, or Right.

• Specify the Binding Margin for the front and back 

sides of the paper.

Select whether the front or back side of the paper is to 

be printed as the Start Page. (Fig 16)

• Click Print to start printing.

After printing on one side, reload the paper into the MP 

tray with the printed surface face-down as shown below. 
Then press the  ↕ B&W Start or  ↕ Color Start button.

Note: When loading the paper, straighten it well. If 

curled paper is loaded, it may not be fed correctly.

Sending and receiving fax multifunction printer and 

modify the fax setting

Multifunction printer

A multifunction printer (also known as an MFP) is a 
piece of office equipment or machinery that serves the 
primary purpose of copying and printing documents. 
Over time, multifunction printers have been referred to 

as photocopiers, copiers, Xerox machines, and a host 

of other names.

A true multifunction printer also scans, emails, faxes, 

and can even browse the internet and print straight from 
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Fig 17

the display panel, similar to a computer.

Most multifunction printers also include finishing options 
such as stapling, folding, booklet making, and hole 

punching.

Advantages of a Multifunction Printer

Energy	Efficiency
One significant advantage of purchasing a multifunction 
printer is the fact that many efficiently use power. They 
enter energy-saving mode when not in use.

Office	Space	Efficiency
An office can replace 3-4 normal printers with one 

multifunction printer. These printers function so fast 
and efficiently that numerous teams and departments 
can use a single machine.
Workplace	Efficiency
Having one device that can print, scan, copy, and fax 

streamlines business operations, especially because 

multifunction printers complete all these print jobs fast. 
A variety	 of	 finishing	 options such as stapling and 

folding mean that projects can get completed faster 
without the need for manual finishing or having to wait 
on an external printing company to finish the job.
Multifunction printers also let businesses streamline 

processes by enabling remote printing needs. By 
printing from a wireless or mobile device, print jobs can 
be completed with ease. 
Cost	Efficiency
Multifunction printers can save your company money in 

a few ways.
Their energy efficiency not only helps the environment 
but also reduces the strain to your company’s monthly 

electricity bill. Additionally, since these printers can 
replace the need for multiple printers in the office, 
reduced overall maintenance is needed, which lowers 

service costs. Multifunction printers make it easier to 
digitize documents.
Use a Fax Machine

Sending and receiving documents with a fax machine is 

fairly easy, but if you’ve never had to use one before, it 

can be a little confusing. (Fig 17)
Set Up a Fax Machine

• First, you need to make sure your fax machine is set 

up and ready to go.
• Follow these steps to do so:

• Plug the fax machine into a power source

• Connect the phone line

• Load toner or ink

• Make sure the fax machine has paper

• Turn the fax machine on

• To check the phone line connection, pick up the fax 

machine’s phone and check for a dial tone. If you 
hear a dial tone, you should be good to go. If your fax 
machine doesn’t have a phone, connect an external 

phone to check for a dial tone.

• Once everything is set up, you can run a test to make 

sure your fax machine is ready to send and receive 

documents. Simply call the fax number, and if the fax 
machine picks up, you’re ready to get started.

Send a Fax

Follow these steps to send a fax:

• Enter the document you want to fax into the document 

feeder. If you have multiple documents, put them in 
the order that you want them to be sent

• Dial the fax number for the receiving fax machine

• Select Fax or Send to send the fax

• After sending the fax, you should receive a 

confirmation page
• Remove your documents

Receive a Fax

Receiving a fax is simple and only requires you to make 

sure your fax machine is prepared to receive and print 

documents.
• Make sure your fax machine is set up and operable

• Ensure the fax machine has enough ink/toner and  
 paper

• The fax machine phone will ring. Don’t pick it up — 
the fax machine will automatically receive and print 

the document(s)
While the sender should receive a confirmation from their 
fax machine that the fax was successfully transmitted, 

it’s always a good idea to contact them personally to 

confirm receipt.
Modify the fax setting

There are various user-selectable options available for 

setting up the Fax system on the machine. To modify 
the Fax Setup options:

• Press the [Fax] button on the Control Panel. “Ready 
to Fax” will be displayed on the Display Screen.

• Press the [Menu] button until “Fax Setup” is 

displayed.
• Press the [OK] button.
• Press the [Left] or [Right] arrow button until “Sending” 

or “Receiving” is displayed.
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• Press the [OK] button.
• Press the [Left] or [Right] arrow button until the 

required menu item is displayed.
• Press the [OK] button.
• Press the [Left] or [Right] arrow button until the 

required status is displayed, or enter the value for the 

selected option.

• Press the [OK] button.
• If necessary, repeat steps 6 through 9.
• Press the [Stop / Clear] button to return to Ready 

mode.
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IT & ITES Related Theory for Exercise 1.6.55-59

DTPO - Adobe Indesign

Features	and	benefits	of	Adobe	Indesign	&	Pagemaker
Objectives: At the end of this lesson you shall be able to

•	 benefits	of	Adobe	Indesign
•	 features	of	Adobe	Pagemaker
• explain font style and color

Indesign

Fig 1

InDesign is software for creating and editing page 

designing and layout arrangement tool used for 

arranging the contents in making posters, brochures, 

magazines, newspapers, books, presentations, and 

eBooks. It can also publish illustrations, graphs, tables, 

and other professional usages. High quality for both 

print and on-screen delivery was actually developed for 

the original magazine market; further, it has become the 

no1 application in the world for interactive developers, 

photographers, and designers to use anywhere to place 

content and images in any format. It integrates with the 

rest of the Adobe tools such as Photoshop, Illustrator 

and flashes professional users from any profession 
can design, preview, review and produce content 

quickly and efficiently. InDesign also works with word 
processors such as MS Word, Adobe InCopy to import 

text. Any designer can make interactive designs by 

using animation pre-sets and media options in InDesign 

CS6. (Fig 1)

Benefits	of	Adobe	Indesign
1	 Adobe	Indesign	offers	the	Best	output	project		
 features .

• The features that InDesign CC offers to see a design 
layout from start to finish are incredibly robust. 
Considering its output for any given project, Multiple 

Platforms Usage allows you to design a document 

with horizontal and vertical variants in layout by 

using the Layout> Alternate Layout tool or the Pages 

panel menu. Liquid Layouts also allow designers to 

layout content for different page sizes and device 
platforms.

2 Adobe Indesign produces greater quality   

 content for print and digital.

• Any designer will tell you the quality of content is 

phenomenal in InDesign. When it comes to fine-tuning 
your file’s text and graphics, the softwares editing 
capabilities are as low as a .001 degree precision. 

Not to mention the user control offered within any 
page and the manipulation of its typography, colors 

and styling.

3	 Adobe	Indesign	makes	collaboration	and		 	
	 sharing	assets	with	your	team	easy.
• CC libraries, saved on the Cloud, makes it easy for 

your teammates to create and share photos, color 

schemes, icons, logos, type styles and more! Any 

team member with Adobe CC can open and edit files 
(with your permission of course). This is a huge time-

saver and will increase your productivity.

4	 Adobe	Indesign	saves	you	time.
• Here’s just a couple features in InDesign that will 

speed up your workflow so you can deliver quicker.

• Layers—Allowing you to organize your project by 

element will keep everything organized in your doc 

and allow you to quickly switch to the piece you are 

working with.

• Pages/Master Pages—Allows you to create and 

save a page style to reference later and reuse again.

• Style Groups— Use styles again too by making use 

of paragraph, character, object and text style groups 

to save and reuse throughout your document.

5	 Adobe	Indesign	comes	with	full	support.
• As an Adobe Member, the support available to you is 

extensive. You may feel 

• The Support Community also is an online forum 

where you can ask questions, find your answers, 
learn from experts and share your knowledge.

6 Other Adobe software can be used in   

 conjuction with Indesign.

• Adobe InDesign shares a direct integration with 

other Adobe programs, like Adobe Bridge (creative 

asset manager), Adobe Photoshop or Illustrator. If 

you are searching, creating and editing images, they 

are linked within Indesign and you can quickly toggle 

back and forth between the programs while working. 

Another bonus is the built-in connection to Typekit, 

Adobe’s full free font library. Easily manipulate text 
using the font export formatting option.
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7	 You	join	the	Adobe	community.
• Adobe really is a family. Once you become an Adobe 

member you can try any other CC programs on a trial 

basis. This allows you to explore other top Adobe 

products, including Adobe Photoshop CC, Adobe 

Illustrator or Adobe Premiere Pro. You also can get 

access to their stock photo site, Adobe Stock, or 

Spark Post, which gives you unlimited social and 

branding templates. Adobe Help supplies you with 

tutorials and templates for all of its software.

8 Adobe Indesign is the Industry standard choice  

 and Trusted by professionals.

• Learn and use the #1 software by the world’s leading 
design company. Visual Persuasion offers expert 
instruction from industry professionals who live and 

breathe Adobe software. We offer a wide array of 
classes including Adobe’s most popular applications, 
one of which is InDesign CC.

Features	of	Adobe	Pagemaker
• Set up a single file for multiple versions of a 

publication, add annotations, and experiment with 

layouts by placing objects on different layers. By 
placing text and graphics on separate layers, you 

can control which objects are visible and work faster 

by turning off the graphics layer.

• Automatically reposition, resize, and reflow text 
blocks, frames, and graphics when you change 

columns, orientation, or master pages.

• Quickly lay out your publication by creating frames to 

hold text or graphics.

• Create a wide variety of documents up to 999 pages 

each.

• Set typography to professional standards with 

point-size- dependent tracking, kerning in 0.001-em 

increments, and expanded and condensed type.

• Specify and apply different page designs, such as 
margins, column guides, and backgrounds within a 

single publication.

• Speed text processing with a built-in word processor, 

spelling checker, and search-and-replace feature.

• Reliably track changes to imported text and graphics 

files.

• Crop text, graphics, and images easily into polygons, 

ovals, and rectangles.

• Easily lay out text and data in rows and columns - 
and now include color in your tables.

• Enjoy maximum flexibility with support for Adobe 
PostScript(R), PCL, and QuickDraw printers. 

Includes Print Fit view and printer styles, plus the 

ability to print nonconsecutive pages and reader's 

spreads and to designate selected objects as 

nonprinting.

• Streamline workflow with new template designs, 

instantly define grids with an enhanced Grid Manager 
Plug-in, impose pages using the Build Booklet plug-

in, and generate an automatic table of contents or 

index across multiple publications.

• Draw free-form polygons and lines, and edit points 

on existing polygons.

• Automatically align and distribute objects. Combine 

multiple elements into a unit with a single keystroke, 

and move or resize an element without having to 

separate it from the rest of the group. Easily maintain 
the relationships of layout elements with object 

locking.

• Quickly move between pages with new Go Back and 

Go Forward commands

Explain Font Style

How to choose a font

When choosing a font for a site, you should follow these 

guidelines:

use no more than four fonts on one page;

• use sans-serif fonts for main text as serifs make 

reading difficult on the screen;

• use serif fonts in the printed texts since readers 

associate them with reliability and respectability;

• use the Monospace family fonts for program code 

examples, instructions, or typewritten text;

• using custom fonts, such as Script and Fantasy, to 

design headlines and accents to attract attention 

• for headings and calls to action use larger font sizes 

than plain text.

Examples	of	fonts	in	graphic	design
• Craft fonts

Fonts on your website are a part of your brand; 

think	about	your	brand	first,	define	its	properties	
and qualities.

In	 this	 example,	 you	 can	 see	 a	 package	 of	 ice	
cream	 where	 the	 producer	 wants	 to	 highlight	

Fig 2

the naturalness of their product. (Fig 2) Fonts 

with	 imitation	of	 embossed	 letters,	 calligraphy,	
something	hand-made,	home-made, warm in the 
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atmosphere are excellent for this purpose:

Fig 3

• Handwritten fonts

Brand fonts which imitate handwriting are perceived 

as kind, open-hearted, and responsive; in this 

Fig 4

example, you can see the dog food (Fig 3)

• These fonts are also good for children's brands as 

well as for any brands where it is important to express 

care and responsiveness.  These alternative fonts 

set the informal style well. (Fig 4)

You can see other free fonts for a website on the special 

Google portal or its analogs.

Fig 5

• Serif

Serif fonts are great if you want to show commitment 

to tradition and company stability. (Fig 5) These fonts 

animate the brand with a combination of vibrant graphics 

or colors:

Colour Concepts :-

Primary	Colors
Primary colors are those you can't create by combining 

two or more other colors together. They're a lot like 

prime numbers, which can't be created by multiplying 

two other numbers together.

There	are	three	primary	colors:
• Red

• Yellow

• Blue

• Think of primary colors as your parent colors, 

anchoring your design in a general color scheme. 

Any one or combination of these colors can give 

your brand guardrails when you move to explore 

other shades, tones, and tints (we'll talk about those 

in just a minute).

• When designing or even painting with primary 

colors, don't feel restricted to just the three primary 

colors listed above. Orange isn't a primary color, for 

example, but brands can certainly use orange as 

their dominant color (as we at HubSpot know this 

quite well).

• Knowing which primary colors create orange is your 

ticket to identifying colors that might go well with 

orange — given the right shade, tone, or tint. This 

brings us to our next type of color ...

Secondary Colors

• Secondary colors are the colors that are formed by 

combining any two of the three primary colors listed 

above. Check out the color theory model above — 

see how each secondary color is supported by two 

of the three primary colors?

• There are three secondary colors: orange, purple, 

and green. You can create each one using two of 

the three primary colors. Here are the general rules 

of secondary color creation:

• Red + Yellow   =  Orange

• Blue + Red   =  Purple

• Yellow + Blue   =  Green

• Keep in mind that the color mixtures above only work 

if you use the purest form of each primary color. This 

pure form is known as a color's hue, and you'll see 

how these hues compare to the variants underneath 

each color in the color wheel below.

Tertiary Colors

• Tertiary colors are created when you mix a primary 

color with a secondary color.

• From here, color gets a little more complicated, and 

if you want to learn how the experts choose color 

in their design, you've got to first understand all the 
other components of color.
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• The most important component of tertiary colors is that 

not every primary color can match with a secondary 

color to create a tertiary color. For example, red can't 

mix in harmony with green, and blue can't mix in 

harmony with orange -- both mixtures would result in 

a slightly brown color (unless of course, that's what 

you're looking for).

• Instead, tertiary colors are created when a primary 

color mixes with a secondary color that comes next 

to it on the color wheel below. There are six tertiary 

colors that fit this requirement:

• Red + Purple  =  Red-Purple (magenta)

• Red + Orange  =  Red-Orange (vermillion)

• Blue + Purple  =  Blue-Purple (violet)

• Blue + Green  =  Blue-Green (teal)

• Yellow + Orange  =  Yellow-Orange (amber)

• Yellow + Green  =  Yellow-Green (chartreuse)

Fig 6

The Color Theory Wheel

A circle graph that charts each primary, secondary, and 

tertiary color (Fig 6) as well as their respective hues, 

tints, tones, and shades. Visualizing colors in this way 

helps you choose color schemes by showing you how 

each color relates to the color that comes next to it on a 

rainbow color scale. (As you probably know, the colors 

of a rainbow, in order, are red,	orange,	yellow,	green,	
blue,	indigo, and violet.)

When choosing colors for a color scheme, the color 

wheel gives you opportunities to create brighter, lighter, 

softer, and darker colors by mixing white, black, and 

gray with the original colors. These mixes create the 

color variants.

Hue

• Hue is pretty much synonymous with what we 

actually mean when we said the word "color." All of 

the primary and secondary colors, for instance, are 

"hues."

• Hues are important to remember when combining 

two primary colors to create a secondary color. If you 

don't use the hues of the two primary colors you're 

mixing together, you won't generate the hue of the 

secondary color. This is because a hue has the 

fewest other colors inside it. By mixing two primary 

colors that carry other tints, tones, and shades inside 

them, you're technically adding more than two colors 

to the mixture — making your final color dependent 
on the compatibility of more than two colors.

• If you were to mix the hues of red and blue together, 

for instance, you'd get purple, right? But mix a tint of 

red with the hue of blue, and you'll get a slightly tinted 

purple in return.

Shade

• You may recognize the term "shade" because it's 

used quite often to refer to light and dark versions of 

the same hue. But actually, a shade is technically the 

color that you get when you add black to any given 

hue. The various "shades" just refer to how much 

black you're adding.

Tint

• A tint is the opposite of a shade, but people don't 

often distinguish between a color's shade and a 

color's tint. You get a different tint when you add 
white to a color. So, a color can have a range of both 

shades and tints.

Tone (or Saturation)

• You can also add both white and black to a color to 

create a tone. Tone and saturation essentially mean 

the same thing, but most people will use saturation if 

they're talking about colors being created for digital 

images. Tone will be used more often for painting.

• With the basics covered, let's dive into something 

a little more complicated — like additive and 

subtractive color theory.

Additive & Subtractive Color Theory

• If you've ever played around with color on any 

computer program, you've probably seen a module 

that listed RGB or CMYK colors with some numbers 

next to the letters.

CMYK

• CMYK stands for Cyan, Magenta, Yellow, Key 

(Black). Those also happen to be the colors listed 

Fig 7
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on your ink cartridges for your printer. That's no 

coincidence. (Fig 7)

• CMYK is the subtractive color model. It's called that 

because you have to subtract colors to get to white. 

That means the opposite is true — the more colors 

you add, the closer you get to black. 

• Think about printing on a piece of paper. When you 

first put a sheet in the printer, you're typically printing 
on a white piece of paper. By adding color, you're 

blocking the white wavelengths from getting through.

• Then, let's say you were to put that printed piece of 

paper back into the printer, and print something on it 

again. You'll notice the areas that have been printed 

on twice will have colors closer to black.

• I find it easier to think about CMYK in terms of its 
corresponding numbers. CMYK works on a scale of 

0 to 100. If C=100, M=100, Y=100, and K=100, you 

end up with black. But, if all four colors equal 0, you 

end up with true white.

RGB

• RGB color models, on the other hand, are designed 

for electronic displays, including computers.

• RGB stands for Red, Green, Blue, and is based on 

the additive color model of light waves. (Fig 8) This 

means, the more color you add, the closer you get to 

white. For computers, RGB is created using scales 

Fig 8

from 0 to 255. So, black would be R=0, G=0, and 

B=0. White would be R=255, G=255, and B=255.

• When you're creating color on a computer, your 

color module will usually list both RGB and CMYK 

numbers. In practice, you can use either one to 

find colors, and the other color model will adjust 
accordingly.

• You can always convert the design to CMYK and 

make adjustments should you ever need it for printed 

materials.
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IT & ITES Related Theory for Exercise 1.6.60-62

DTPO - Adobe Indesign

Indesign tools and versions

Objectives: At the end of this lesson you shall be able to

• explain Indesign tools

•	 compare	Adobe	Indesign	and	Adobe	Pagemaker
•	 compare	Adobe	Indesign	versions

Indesign Toolbar

Fig 1
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SELECTION TOOL

 S.No                Tool Pic            Funtion of the Tool

Just like with Photoshop, the Selection Tool is your 

basic pointer tool. Select an entire object or text box 

and move it around, delete it, etc.

1

2
DIRECT SELECTION TOOL Also like Photoshop, the Direct Selection Tool only 

selects one anchor point on an object. So, if you wanted 

to move one specific anchor point, you’d use this tool. 
I typically use this in conjunction with the Add Anchor 

Point Tool.

PAGE TOOL3 The Page Tool allows you to select an entire page and 

rearrange it or resize it on your work space.

4
GAP TOOL The Gap Tool is used when you want to change the 

distribution of two objects while keeping the white space 

between them the same.

5
CONTENT COLLECTOR TOOL The Content Collector Tool allows you to collect multiple 

pieces of content that you want to place either in the 

same document or in another InDesign document. 

6
CONTENT PLACER TOOL Once you’ve collected your objects with the Content 

Collector Tool, you’ll use the Content Placer Tool to 
place those objects either in the same document or in a 

different InDesign document.

TYPE TOOL
7 This is your basic type tool. Click and drag to create a 

rectangular text box and type away!

8 TYPE ON A PATH TOOL The Type on a Path Tool, on the other hand, types 

around an object. 

LINE TOOL9 This tool creates a line. 

10 PEN TOOL The Pen Tool is  draw by clicking on the point where you 

want to start, and before unclicking, hold and drag the 

cursor to make a curve. Then you click on the next point 

where you’d like to continue your shape, hold and drag 
the cursor, etc. 

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.6.60-62

©
 N

IM
I 

N
O
T
 T

O
 B

E
 R

E
P
U
B
L
IS

H
E
D



102

 S.No                Tool Pic            Funtion of the Tool

11 ADD ANCHOR POINT TOOL The Add Anchor Point Tool is used to add anchor 

points to an object. 

DELETE ANCHOR POINT TOOL
12

The Delete Anchor Point Tool is super helpful for 

perfecting shapes. 

13 CONVERT DIRECTION POINT TOOL The Convert Direction Point Tool is only used for 

changing the curve level of a specific anchor point.

14 PENCIL TOOL The Pencil Tool is used to create a freehand shape.

SMOOTH TOOL
15

The Smooth Tool is used in conjunction with the 

Pencil Tool to smooth out any bumps that might have 

occurred in your vector object.

16 ERASER TOOL The Erase Tool is used to erase parts of an object or 
line.

RECTANGLE FRAME TOOL17 The Frame Tools function just like regular object tools, 

but they’re specially formatted to have photos placed 
in them and need to distinguish which objects are 

meant to have photos placed in them and which ones 

aren’t. Otherwise, regular object in them.

18 Just like the Rectangle Frame Tool, but it’s in the 
shape of an ellipse.

ELLIPSE FRAME TOOL

19 POLYGON FRAME TOOL Just like the Rectangle Frame Tool, but it has however 

many sides you want.
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 S.No                Tool Pic            Funtion of the Tool

20

RECTANGLE TOOL This tool draws a rectangular box. To create a square, 

hold the Shift button as you click and drag.

21

ELLIPSE TOOL This tool draws an oval box. To create a circle, hold 

the Shift button as you click and drag.

POLYGON TOOL

22

To create a box with as many sides as you’d like the 
dimensions you’d as how many sides.

23

SCISSORS TOOL The Scissors Tool cuts a path or an object. 

24

FREE TRANSFORM TOOL This tool lets you take any object or text box and 

transform it freely, scaling and rotating. 

25
ROTATE TOOL This tool is used to rotate objects and text boxes.

26

SCALE TOOL The Scale Tool allows you to scale an object or text 

box. 

27

SHEAR TOOL The Shear Tool allows you to distort your object by 

making it a parallelogram. 

28
GRADIENT SWATCH TOOL The Gradient Swatch Tool creates a gradient! 

GRADIENT FEATHER TOOL
29

Just like the Gradient Feather,Tool creates a gradient 

it ends in transparency.
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30

 S.No                Tool Pic            Funtion of the Tool

NOTE TOOL The note tool is super helpful if you’ve got multiple 
people working on the same file. 

31

COLOR THEME TOOL The Color Theme Tool is super helpful if you’re 
working on a style guide for your blog or business. 

32

EYEDROPPER TOOL The eyedropper tool is super helpful for grabbing 

whatever color you want from the image and making 

it the foreground color. 

33

MEASURE TOOL The measure tool is used to (surprise!) measure the 

image.

34

HAND TOOL This tool allows you to click and drag your artboard 

around.

35

ZOOM TOOL This tool allows you to zoom in or out of your artboard. 

36
COLOR PALETTE The Color Palette is where you determine your object 

or text’s fill and stroke colors. 

Compare	Adobe	Indesign	and	Adobe	Pagemaker
PageMaker is a free desktop publishing software which 

is considered the leading desktop publishing software for 

producing quality, professional-looking and interactive 

content on the Internet.

InDesign company is an all-inclusive desktop publishing 

program designed for making brochures, flyers, 
publications, books, and other promotional materials. 

Projects created with InDesign can be both printed and 

viewed on a computer screen.

PageMaker	&	InDesign	Features:

PAGEMAKER INDESIGN

Tagged PDF support Alternative text forms

Customized templates HTML export

High-resolution stock images Creation of templates

Data Merge feature Access to Creative 

Cloud library

Integration with Adobe's 

programs

Text organization tools

Introduction to Indesign version

InDesign versions can be explain as updated and 

modified format of older software of InDesign and each 
version of this software came time to time with their new 

and improved features as well as working quality. These 

modification might be in user interface of this software for 
making it more user friendly or in tools of tool panel for 

making them more handy or and other important features 

of this software. It was developed on August 31, 1991 by 
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Adobe system and since its initial released adobe made 

many changes for improving its working ability so we 

have number of versions of it.

List of Indesign version

• Discuss some of its version for understanding about 

them starting from latest to previously launched 

one. Its initial version was InDesign 1.0 which was 

launched on August 31, 1999 and you will have all 

versions in the sequence InDesign 1.0, InDesign 

1.0J, InDesign 1.5, InDesign 2.0, and so on.

We will discuss some of its version for understanding 

about them starting from latest to previously launched 

one. Its initial version was InDesign 1.0 which was 

launched on August 31, 1999 and you will have all 

versions in the sequence InDesign 1.0, InDesign 

1.0J, InDesign 1.5, InDesign 2.0, and so on. 

 

InDesign is the successor to Adobe PageMaker, which 

Adobe acquired by buying Aldus Corporation in late 1994. 

(Freehand, Aldus's competitor to Adobe Illustrator, was 

licensed from Altsys, the maker of Fontographer.) By 

1998 PageMaker had lost much of professional market 

to the comparatively feature-rich QuarkXPress version 

3.3, released in 1992, and version 4.0, released in 1996. 

In 1999, Quark announced its offer to buy Adobe[3] 
and to divest the combined company of PageMaker 

to avoid problems under United States antitrust law. 

Adobe rebuffed Quark's offer and continued to develop 
a new desktop publishing application. Aldus had begun 

developing a successor to PageMaker, which was 

code-named "Shuksan". Later, Adobe code-named the 

project "K2", and Adobe released InDesign 1.0 in 1999. 

 

Adobe launched InDesign in the United Kingdom 

through a series of promotional presentations in 

hotels. The marketing concentrated on new software 

architecture—a small central software kernel (about 

2Mb) to which add-ons would be bolted as the 

program's functionality expanded in later versions. 

However, the Postscript printer driver for InDesign 

1.0 was an external app that tended to acquire 

frequent corruption problems, requiring periodic 

reinstallation. Copies of InDesign 1.5 were usually 

given away when it was found that a host of bugs had 

to be corrected. By InDesign 2.0, the temperamental 

printer driver was embedded in the main software. 

The 'kernel' architecture was never mentioned again. 

 

InDesign was the first native Mac OS X windows 
(available on almost all devices) publishing (DTP) 

software. With the third major version, InDesign 

CS, Adobe increased InDesign's distribution by 

bundling it with Adobe Photoshop, Adobe Illustrator, 

and Adobe Acrobat in Adobe Creative Suite. 

 

InDesign exports documents in Adobe's Portable 

Document Format (PDF) and supports multiple 

languages. It was the first DTP application to support 
Unicode character sets, advanced typography 

with OpenType fonts, advanced transparency 

features, layout styles, optical margin alignment, 

and cross-platform scripting with JavaScript. 

 

Later versions of the software introduced new file formats. 
To support the new features, especially typographic, 

introduced with InDesign CS, both the program and its 

document format are not backward-compatible. Instead, 

InDesign CS2 introduced the INX (.inx) format, an XML-

based document representation, to allow backwards 

compatibility with future versions. InDesign CS versions 

updated with the 3.1 April 2005 update can read InDesign 

CS2-saved files exported to the .inx format. The 
InDesign Interchange format does not support versions 

earlier than InDesign CS. With InDesign CS4, Adobe 

replaced INX with InDesign Markup Language (IDML), 

another XML-based document representation.[4] 
 

Adobe worked on the provision of a 'Drag and Drop' 

feature and this became available after 2004 but was 

restricted to dropping graphics and images, not text. 

Adobe developed InDesign CS3 (and Creative Suite 

3) as universal binary software compatible with native 

Intel and PowerPC Macs in 2007, two years after the 

announced 2005 schedule, inconveniencing early 

adopters of Intel-based Macs. Adobe CEO Bruce 
Chizen had announced that "Adobe will be first with 
a complete line of universal applications".[5] The CS2 
Mac version had code tightly integrated to the PPC 

architecture, and not natively compatible with the Intel 

processors in Apple's new machines, so porting the 

products to another platform was more difficult than had 
been anticipated. Adobe developed the CS3 application 

integrating Macromedia products (2005), rather than 

recompiling CS2 and simultaneously developing CS3. 

By this time 'Drag and Drop' of type was made available.

InDesign 2020 (15.1)

• It was released on June 2020 with lots of minor 

and major updates for having best result in its 

performance. Share for Review was its very powerful 

feature and you can find this option in the menu bar 
of InDesign user interface. The advantage of this 

feature is that it sends a document itself to web the 

author for multiple reviews by reviewers directly from 

InDesign and you need not to use export and import 

steps of traditional PDF review workflow. Reviewers 
of the content can give their feedback on the content 

although it is on productions stages and can get 

updated versions without going through any new 

link. Not only had this feature when you go and try 

it you will also see lots of improvement in previously 

used tools and their features.

• These were some series of latest versions of 

InDesign software and i explained all important facts 

and features of these versions so that you can have 

idea about them.

InDesign 2020 (15.1.1)

• In this version the issue of crashing of InDesign 

application while placing of PNG file in the document 
through PDF export has been resolved. Error 
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showing after using of ‘Share for Review’ option 
during PDF export was also problem with previous 

one but this version also got rid of it. Text variable, 

footnote/endnote markers, page numbers replaced 

with ‘ss with World Ready Composers’ features which 
enhanced its working ability.

InDesign 2020 (15.1.2)

• It has improved performance during working with 

two INDD documents which have same fonts in their 

document font folder respectively. There is no such 

issue that hangs InDesign during recover of damaged 

document and after that user can work with different 
project without facing stress in their work and enjoy 

their working. It got rid from crashing itself when we 

try to quit it after auto-activation of Font not only this 

but also during rendering, during launching of proxy 

environment, while working with EPS file, while PDF 
exporting it prevent itself from crashing. Launching 

problem of Script Editor when editing script for Apple 
script was one of the major issues of previous version 

but it becomes easy in this version.

InDesign 2020 (15.1.3)

• Many issue of previous version of 2020 InDesign are 

fixed in this version and the issue was 15.1.2 version 
of InDesign 2020 crashes during opening of some 

type of scenarios and file, it quits automatically during 
launching of proxy environment, it also crashes during 

renaming of any folder when we work with User 

Library Fonts folder and some other important issue 

are fixed. It has improved visibility of cursor during 
working with Light and Medium light interface which 

was big problem for its user in previous version. It 

also has solution for the problem of showing error 

after Inserting HTML code on object and previewing 

of it and after fixing this issue it adds plus point in its 
scripting techniques.

InDesign 2021 (16.0.1)

• Various improvement are done in this version for fixing 
issue of previous version in different part of InDesign 
such as Slider on media panel is now enable for 

making your work easy with this panel and you can 

drag it even through there is no media file available, 
same as ‘Place a Video or Audio button’ of same 
panel is also enabled for working with video or audio 

when you launched InDesign even no document 

is open and Total time duration option of media file 
appears is made disable in Media panel. You will also 

find that there is original file folder for old converted 
and OpenASCopy documents which protect your file 
for being damage.

InDesign 2021 (16.0.2)

• It was launched with improved User experience 

features for Mac OS and in this improvement it offers 
bigger size of icon for Mac OS BigSur.

InDesign 2021 (16.1)

• This is the latest version of InDesign and launched 

by Adobe systems in January 2021 which named as 

InDesign 16.1. You will have number of new features 

and solution for many issues in this version. It has 

many new features such as Content reviewing with 

text annotations that means it has review tools which 

can highlight text, insert text and strike through any 

text during working on any project, Locating colors 

in your document another new feature and with this 

feature you can locate any unused color from your 

document and replace it with other in very smooth 

manner, subject detection and text warping can do 

in more specific way by using feature that offers by 
Adobe Sensei without using Photoshop paths or 

Alpha channel, It use HSB value for setting color 

value in it without using RGB translation and many 

other new features you will find in it when you go with 
it.
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IT & ITES Related Theory for Exercise 1.7.63 - 65

DTPO - Adobe Illustrator

Adobe Illustrator install and working formatting

Objectives: At the end of this lesson you shall be able to
• introduction to Adobe Illustrator

• how to Install Adobe Illustrator

• working with formatting

Introduction to Adobe Illustrator

One of the most famous and popular vector graphics 
programs marketed and developed by Adobe 
Corporation is Adobe Illustrator. The program comes 
with a creative cloud and also can be downloaded as a 
single program from the Adobe website. The program is 
compatible with Windows and Mac Operating Systems.

The following are the minimum system requirements 
to install Adobe Illustrator on the Windows Operating 
system.

• RAM of the System needs to be a minimum of 2GB 
for 32 Bits and 4GB for 64 bits

• The processor recommended is Multicore Intel 
Processor with 32bit or 64-bit support. An AMD 
Athlon 64 processor will also work for installing 
Adobe Illustrator.

• An Operating System with Windows 7 with Service 
pack 1 installed.

• The resolution of the monitor must be 1024 X 768 
minimum.

• Minimum 2GB of Hard disk is required for the program 
installation. A Graphics Card is also recommended 
before installation

• An OpenGL 4.x is also recommended for the smooth 
working of the program.

Install Adobe Illustrator

Below are the steps to install Adobe Illustrator in your 
system. Please check the minimum requirement before 
downloading the software, as if the system does not c                                                                                                                      
omply with the minimum requirements, the product will 
not be downloaded.

• To download and install Adobe Illustrator visit the 
official website of adobe, i.e.https://www.adobe.com/
in/; we need to go to the Creativity & Design Section 
and click on “VIEW ALL PLANS AND PRICING” (Fig 
1) (Fig 2)

• A page will open, which will display the various 
categories available for Individuals, Business, 
Students and Teachers and Students and 
Universities. The page has different subscription 
plans for every category. For Individuals, the 
company offers a Photography Plan, A single App 
Plan, and an All Apps Plan with different pricing.  
Similarly, for Business purposes, it gives All Apps 

Fig 1

Fig 2

Fig 3

Plan and Single App Plan. For students and teachers, 
they offer a Photography Plan and an All Apps Plan. 
For Universities, Adobe offers an All Apps Plan and 
a Single App Plan.(Fig 3) The user can choose any 
program through any medium and purchase the 
License for the same.

©
 N

IM
I 

N
O
T
 T

O
 B

E
 R

E
P
U
B
L
IS

H
E
D



108

• To download Adobe Illustrator, click on Single App 
and then use the Illustrator Option for a monthly plan 
and click on Buy Now.(Fig 4)

Fig 4

• As soon as the user clicks on the BUY Now Option, 
you will be asked the Email Id, and you have to 
“Continue with the Payment.”(Fig 5)

• When the Payment is successful, the browser will 
download a Setup (Fig 6)

Fig 5

Fig 6

Fig 7

• This will start the installation process for installing 
Adobe Illustrator (Fig 8)

Fig 8

Fig 9

• After the Setup is completed, a dialog box will appear. 
This dialog box shows two commands Install and 
Try. If the user has already purchased the program, 
he needs to click on the Install Option, while if the 
user has not yet purchased the program, click on the 
Try Option. (Fig 9)

• When you click on the INSTALL option, a dialog box 
will appear that will ask the user to enter the required 
Email Id.(Fig 10) Click on Sign In for the Installation

• Now, Click on ACCEPT Option for the procedure to 
process.(Fig 11)

• When the Setup has been downloaded, double 
click on the setup and a dialog box will appear. 
Click on the Run Command from the Dialog box.
(Fig 7)
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• After this, a dialog box will appear that will ask 
you the required storage location and a language 
before Installation. Adobe Illustrator is available in 
Deutsch, Italiano, Polish, Nederlands, English, and 
many other languages to modify from. To modify 
the Default Location, you can click on the same and 
change it. (Fig 12) After this, click on Install, and the 
Installation will Begin.

Fig 10

Fig 11

Fig 12

Fig 13

Fig 14

• The system will check the minimum requirements 
and will process the installation.(Fig 13)

• After the installation is complete, the program will 
start to run (Fig 14)           

• Finally, Adobe Illustrator will be installed in your 
system,Use the program to draw and create vector 
graphics and artworks.

Working with formatting

• The point type is a vertical or horizontal line of text 
that begins where we click and expands as we enter 
characters. Space will shrink or grow according to 
our edits.

Step 1: 

Go to the Tools palette and select the Type tool or 
the Vertical Type tool.(Fig 15) 

Fig 15
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Step 2: 

Now, you have to set the text-formatting option in the 
control panel, which is optional.(Fig 16)

Fig 16

Fig 17

Step 3:

Go to your artwork and click from where you want to 
begin your line.

Step 4:

Enter the text in the textbox and press enter to begin 
a new line within the same type object.

Step 5:

After you finished entering the text, click on the 
Selection tool      in the Tools panel to select the type 
object.

Entering text in an Area type

• The area type uses the boundaries of an object to 
control the flow of character, either horizontally or 
vertically. When the entered text reaches a limit, it 
automatically wraps to fit inside the defined area.

Step 1:

First, you have to define the bounding area. Go to 
the Tools panel and select and drag the Type tool       

 or the Vertical Type tool     diagonally.(Fig 17)

Step 2:

After that, draw an object that you want to use the 
bounding area.

Step 3:

You can now set the formatting of the text, which is 
optional.

Step 4:

Now, enter the text and press Enter.

Step 5:

To select the type object, click on the Selection tool
 after entering the text. (Fig 18)

Resize a text area

• To resize the text area, select the type object with the 
help of the Selection tool and then drag a handle on 
the bounding box with a click.(Fig 19) 

Fig 18

Fig 19

Fig 20

Change the margin around a text area

• To change the margin of the text area, Select the 
area type object and choose the Type in the Area 
type option.(Fig 20) Click OK after specifying the 
value for Inset Spacing.
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Create rows and Columns of text

Step 1: 

Go to the artboard and select the area type object 
on the artboard.

Step 2: 

Choose the Type and then select the Area Type 
Option.(Fig 21)

Fig 21

• Span: The span is used to specify the height of 
individual rows and the width of different columns.

• Fixed: It can be used to fix the size of the rows and 
columns.

• Gutter: it can be set to specify the distance between 
rows and columns.

Step 4: 

A new option dialogue box will appear, select the 
Text Flow option to determine the way text flows 
between rows and columns.(Fig 23)

Fig 22

Step 5:

 Finally, hit the OK button.

How to thread text between objects in Illustrator

• Linked type object can be used to tread text from 
one object to the other. All the area type object contains 
the in port and an out port that allows us to link to other 
objects and create a linked copy of the type object. You 
can see an arrow in the image below that indicates that 
the object is linked to another object. The out port can 
be indicated by a red plus sign.

Step 1: 

Go to the Tools panel and select the selection tool to 
choose an area type object.

Step 2: 

After that, click on the in-port or out-port of the 
selected type object. When you click on it, the pointer 
will change to the loaded text icon.(Fig 24)

Step 3:

Now, position your pointer to the type object on the     
artboard.

Step 4: Finally, click on the path to link the objects.(Fig 
25)

Fig 23

• Number: This option can be used to specify the 
number of rows and columns we want inside the 
object.

Step 3: 

Set the following option in the rows and column 
section of the dialogue box.(Fig 22) 
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Removing thread

Step 1:

Open the artboard on which you want to remove the 
threads.

Step 2:

Select the linked type object on the artboard.

Step 3:

Double-click on the port of either end of the thread to 
break the thread between two objects.

Step 4:

If you want to remove all the threads, then choose 
the type object and click on the thread text. After 
that, click on Remove Threading.

Step 5:

The thread will be removed and the text stays in 
place.

Wrap text in Illustrator

• We can wrap the texts around any objects, imported 
image, or the objects we draw in Adobe Illustrator.

Fig 24

Fig 25

Step 1: 

You need to make sure that these conditions are true 
for the object type you want to wrap:

• It should be the area type.

• It should be in the same layer as the wrapped object.

• It should be located directly under the wrapped 
object in the layer's hierarchy.(Fig 26)

Fig 26

Step 2:

Select the object around which you want the text to 
be wrapped.

Step 3:

After selecting the object, click on the Text Wrap.(Fig 
27)

Fig 27

Step 4: 

Finally, click on Make. (Fig 28)

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.7.63 - 65

©
 N

IM
I 

N
O
T
 T

O
 B

E
 R

E
P
U
B
L
IS

H
E
D



113

Fig 28

Type on a Path in Illustrator

Move	or	flip	text	along	a	path
Step 1:

Open the artboard and select the type object. When 
you choose the object type, a bracket will appear at 
the beginning of the Type, at the end of the path, 
or the midpoint between the start and end brackets.
(Fig 29)

Fig 29

Step 2: 

Choose the Type, a dropdown menu wil appear.(Fig 
31)

Fig 30

Step 3: 

Select Type On A Path, a sub-menu will appear.

Step 4: 

Select an effect from the effects available in the sub-
menu. (Fig 32)

Fig 31

Adjusting the vertical alignment

Step 1: 

Open the artboard and select the type object.

Step 2:

Choose the Type, a menu will appear.

Step 3:

Choose the "Type On A Path" option from the menu.

Step 4:

Now, select Type On A Path Option from the sub-
menu.(Fig 33)

Step 5:

From the options, choose one from the Align To Path 
menu to specify the way of aligning all the characters 
to the path. Following are the choices you can see:

• Ascender: It can be used to align the texts along the 
font's top edge.

• Descender: It can be used to align the texts along 

Fig 32

Step 2:

Now, move your pointer over the Type's center 
bracket until a small icon appear next to the pointer.

Step 3:

Drag the center bracket along the path to move text. 
While doing this, hold the control button to prevent 
the Type from flipping to the other side of the path.

Apply	path	type	effects	in	Illustrator
The path type effect allows us to distort the orientation 
of characters on a path.

Step 1: 

Open the artboard and create a type object and 
select it.(Fig 30)
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the font's bottom edge.

• Center: It can be used to align the texts at the point 
halfway between the font's ascender and descender.

• Baseline: It can be used to align the texts along the 
baseline.

Fig 33

Spelling and Language dictionaries

Steps to check spelling

Step 1:

Go to the edit menu and click on Check Spelling.
(Fig 34)

Fig 34

Fig 35

Step 5:

When the Illustrator has finished the spell check, 
click on the Done button on the bottom of the 
dialogue box.

Fonts

• The complete set of characters is known as fonts- it 
consists of letters, numbers, and symbols.(Fig 36) 
All the characters share the common weight, width, 
and style, such as 13-pt Times New Roman Bold

Fig 36

Step 2:

Click the arrow icon at the bottom of the appeared 
dialogue box to set the option for finding and ignoring 
words. (Fig 35)

Step 3:

Click on the start button to begin checking the 
spelling.

Step 4:

Click on Ignore or Ignore All to continue to spell-
checking without changing any word, or you can 
select a word from the suggestions list.

Typeface:

It is the collection of fonts that are designed to use 
overall appearance together, such as Adobe Garamond.

Typestyle:

it is a variant version of an individual font in a font family, 
Such as a Roman or Plain member of a font family is the 
best font. It includes type styles such as regular, bold, 
semibold, italic, and bold italic.

Previewing Fonts

• We can see the sample of the font style in the Font 
menu in the Character Panel. Following are the icons 
that are used to indicate different kinds of fonts:
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• OpenType

• Type 1

• TrueType

• Multiple Master

• Composite

Find and replace fonts

Step 1:

Go to the artboard and choose the Type and then 
click on Find Fonts

Step 2:

After that, select the font that you want to find in the 
top section of the dialogue box.

Step 3:

On the appeared dialogue box, select a replacement 
font in the bottom section.

Step 4:

Click on the Change button to change only one 
occurrence of the selected font.

Step 5:

To find and replace a different font, repeat steps 2 
through 4.

Step 6:

To close the dialogue box, click on the done button.

Change capitalization styles

Step 1:

Select the character that you want to change the 
capitalization of.

Step 2:

After that, Go to the type menu then Change the 
Case submenu. (Fig 37) 

Select any of the following from the appeared list.

Fig 38

• Title Case: It will capitalize the first letter of each 
word.

• Sentence Case: It can be used to capitalize the first 
letter of each sentence.

Creating superscript or subscripts in Illustrator

• It is the reduced-size text that is raised or lowered 
concerning a font's baseline. Adobe Illustrator 
applies a predefined baseline shift value and types 
of size when we create superscript or subscript.

Step 1:

To create superscript or subscripts in regular fonts, 
select the Type you want to change.

Step 2:

Choose the Superscript and subscript inside the 
Character panel menu.(Fig 38)

Fig 37

To create in OpenType fonts

Step 1:

Open the artboard and select the character you want 
to change to superscript/subscript.

Step 2:

After that, select the open type font from the font 
menu.

Step 3:

From the available option from the pop-up menu, 
choose one.

• Default position: It will use the default position for 
the current font.

• Superscript/Superior: It can be used for the raised 
character.

• Subscript/Inferior: It can be used for the lowered 
character.

• Numerator: It can be used to use the character as a 
fraction numerator.

• Denominator: It can be used to use the character 
as a fraction denominator.

• UPPERCASE: It will change all the characters to 
the uppercase.

• Lowercase: It will change all the characters to the 
lowercase.
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IT & ITES Related Theory for Exercise 1.7.66

DTPO - Adobe Illustrator

Features of Illustrator 

Objectives: At the end of this lesson you shall be able to
•	 benefits	of	Adobe	Illustrator

Benefits	of	Adobe	Illustrator
Adobe Illustrators is a vector-based creative program 
designed for those involved with graphic design. Instead 
of using bitmap images to store data, this program 
used algorithms to draw shapes. That is why the vector 
graphics created within Illustrator can be scaled to any 
size without losing their quality or overall resolution.

Because of this unique design, Adobe Illustrator is used 
to make everything from business logos to detailed 
illustrations to animated concepts. It can print layouts, 
create stunning website graphics, and give users 
complete control over their typography.

There are several additional features available to 
customize the graphics being created through the 
program as well.

First designed in 1986, here are some of the advantages 
and disadvantages to consider when using Adobe 
Illustrator.

Advantages of Adobe Illustrator

It provides a helpful user interface.

• With Adobe Illustrator, you have an extra level of 
flexibility when working to customize your overall 
workspace. Your interface allows for custom viewing. 
There is an option to enable space saving as well. 
These processes allow you to work on your project in 
whatever way is most comfortable, while maintaining 
complete control over all the available options.

It allows for in-panel editing.

• You also save a bunch of time when working with 
Adobe Illustrator thanks to its option for in-panel 
editing. You also have the use of multiple artboards 
simultaneously. That allows you to work on multiple 
images in a similar fashion all at once, which makes 
you much more productive than the other programs 
which force you to work on one image at a time.

It is completely scalable.

• You have zero resolution issues when working with 
Adobe Illustrator. Because the graphics are based 
on mathematics equations instead of stored pixels, 
you’re always given sharp, crisp lines that are print-
ready in any dimension. You never lose resolution 
when you’re working with graphics through this 
program, which means you have much more 
versatility when designing multimedia for various 
purposes.

It	creates	files	in	manageable	sizes.
• You’re not stuck with enormous files that are difficult 

to transfer when creating something with Adobe 
Illustrator. Compared to similar platforms, Illustrator 
creates files that are relatively small. You can share 
them quite easily, mail them as an attachment, or use 
them without absorbing a majority of your computing 
resources. You don’t waste a bunch of time syncing 
your massive files to the cloud either to share them 
through a service like Dropbox either.

It works on almost any computer system.

• Although Adobe Illustrator doesn’t work well on 
mobile devices, it does an exceptional job on 
almost any computer system. You can use it on 
Windows PCs or on Apple products. It will even 
work adequately on older computers, even from the 
early 2000s, if you are using an older top-of-the-line 
option. That means most people are going to be able 
to access the benefits of this platform if they have 
their system’s operating system up-to-date.

It creates print graphics and web graphics.

• You can create print-ready graphics with ease thanks 
to Adobe Illustrator. You are also able to create web 
graphics with this platform. It works in any screen 
resolution, offering a tool set that is constantly 
updated, which allows you to create professional 
vector graphics with relative ease.

Disadvantages of Adobe Illustrator

It	offers	a	steep	learning	curve.
• For those familiar with vector-based graphics, 

Adobe Illustrator will feel like an intuitive program 
that is ready to meet your needs. For everyone else, 
there must be a time window granted to train on 
the various features the platform offers. There are 
several video tutorials available from Adobe that can 
help you begin the learning process. For beginners, 
however, it may take up to 6 months to begin being 
comfortable with this program.

It requires patience.

• If you’re planning to create something that is fun, 
inventive, and does not require an aspect of realism, 
then Adobe Illustrator can help you put something 
together in no time at all. If you want to create 
something that feels realistic to others, then you’ll 
need to give yourself plenty of time to work on the 
project. To create a drawing that feels realistic, 
you must have a keen eye for detail and be able to 
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recognize elements of the image that Illustrator will 
not recognize as being out of place.

It has pricing limitations on the Teams edition.

• If you just want to use Illustrator at home, then 
you can access this platform for just $19.99 per 
month, plus tax in some locations. If you’re using 
the Creative Cloud from a business perspective, 
then the minimum cost for Illustrator is $69.99 per 
month, plus tax in some locations. The individual 
subscriptions can be separated to allow for an a la 
carte experience for users who only need to use 
one program. That is not possible from a Teams 
perspective. You’re going to pay 3 times more for 
the service.

It	offers	limited	support	for	raster	graphics.
• Adobe Illustrator is an exception product for those 

who are working with vector graphics. If you’re using 
bitmap images with the dot-matrix data structures 
of pixels, then you’ll find that this platform offers 
very little in the way of support. You are able to 
vectorize your raster images to make use of the 
toolbox offered by Illustrator, though that loses some 
of the information of the graphics and may create 
undesired results.

It requires  a lot of space.

• If you’re using a lower resolution display, then 
you’ll find that the updated user interface for Adobe 
Illustrator will take up a lot of space. At the same 
time, the image tracing it uses is still heavily reliant 
on a confusing set of settings, which makes it difficult 
for some users to get up and running right away. The 
image tracing gives you better results once you learn 
how to maximize it, but not every user will figure out 
how to make it work.

It feels a lot like Photoshop.

• With the updated version of Illustrator, the interface 
feels very similar to Photoshop. Adobe has 
integrated the darker interface to accommodate 64-
bit work, which is a definite advantage. The design, 
however, makes one feel like you’re using other 
Adobe products and the workflows are completely 
different.

• These Adobe Illustrator pros and cons offer vector 
artists an excellent opportunity to create something 
wonderful for a price that is relatively fair. Although 
there are some business limitations to the pricing 
structure, and beginners may find Illustrator to be 
too expensive for their taste, the results produced by 
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IT & ITES Related Theory for Exercise 1.7.67

DTPO - Adobe Illustrator

Adobe Illustrator features and versions 

Objectives: At the end of this lesson you shall be able to
• compare	the	features	of	different	Adobe	Indesign	Versions.

What is Adobe Illustrator

• Illustrator is a vector graphic software developed 
by Adobe Inc. Its development began in 1985 with the 
initial plan to release for Apple Macintosh. The latest 
version of the software is Illustrator CC 2019, which is 
part of Adobe’s Creative Cloud and offered to users on 
monthly/annual subscription packages over the internet.

• Now coming to the interface, on launching Illustrator, 
you are welcomed with numerous artboard sizes to 
choose from for print, web, film & video art & illustration 
based on your needs. You also have the option to create 
a custom-sized artboard. Once you choose an artboard 
of your preference, you will be moved to the drawing 
board, where all the action comes live.

• Here you can make use of various tools and panels 
for modifying the designs of your drawings. The sharing 
and exporting settings in Illustrator are also effortless. 
In addition to the usual options to export, Illustrator lets 
you upload your creations to the creative cloud folder. 
This is in addition to email sharing and publishing on the 
Behance website.

• Later if you feel like refining your artwork using other 
Adobe software like InDesign or Photoshop, you can 
easily do that too. Anything created using Illustrator 
can be resized without losing its clarity or causing 

pixelation. It can be used to create small logowork to 
large billboards. This quality of retaining the quality of 
the artwork makes Illustrator the preferred software to 
create logos.

•  Popular Course in this category

What is Adobe InDesign

• InDesign is an application used in the desktop 
publishing industry, which Adobe launched in 1999. 
It replaced the PageMaker, which was acquired by. 
InDesign CC 2019 is the current version, which is a 
part of Adobe CC. InDesign is the preferred software for 
designing newspapers, magazines, books, posters and 
digital publications like e-books.

• It is great in dealing with designs that contain a huge 
quantity of texts. Another important feature of InDesign 
is that it allows the users to set master page templates 
for a seamless design layout across the pages. The 
numbering system is also automated with the options to 
modify, copy, and swap into multiple pages.

Below are the top 6 comparisons between Illustrator 

vs InDesign:

• Illustrator has an advantage over InDesign when it 
comes to working on single-page projects. Even though 
InDesign too is good for single-page designs, what 

Fig 1
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Fig 2

Fig 3
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sets Illustrator apart is that it offers better control over 
modifying images and fonts. As a result, you can use 
Illustrator to design logos, visiting cards, posters, vector 
images, icons, flyers, cover images, infographics, etc.

• While speaking of multi-page projects, however, 
InDesign takes the cake. Working is easier in InDesign 
with many useful features such as the Master Page 
option. Using this feature, you can edit multiple pages 
rather than each individual page to make a change. 
Another interesting function is the auto-numbering 
of pages which makes work even more organized. 
However, you can add multiple artboards in Illustrator 
for making multi-page designs easier to work on.

Ease of Designing

• Illustrator is more advanced and offers superior 
features for creating design elements. In addition, the 
artboard in Illustrator is optimized well for the users with 

plenty of workplace in offer. The drawback of Illustrator 
is in its inability to edit images as per your requirement.

• In InDesign to you will find some basic drawing tools 
like pencil, shape, and lines. In addition, if you want to 
enhance a page created in InDesign, you can easily 
import artworks from Illustrator. This is very helpful for 
working on multi-page projects.

Creating Logos and Design Manipulation

• Illustrator is the most popular software for creating 
logos as it allows resizing an artwork any number of 
times without losing its original quality. Therefore 
logos created in illustrator can be adjusted to different 
placements and dimensions. Also, by utilizing the 
typesetting feature, you can alter text according to 
your liking. However, using InDesign, you can create 
amazing typographic logos by manipulating the fonts. It 
also lets you make vector designs with the help of tools.

Basis of Comparision Illustrator InDesign

Developer Adobe Systems Incorporated Adobe Systems Incorporated

Initial Release March 19, 1987; 32 years ago August 31, 1999

Application Features Good at creating logos, 
icons, business cards, 
vector images, single-page 
document

Good for multipage documentation 
like newspapers, books, and 
brochures

Operating System Windows and macOS Windows and macOS

Type Vector graphics editor Desktop publisher

Website http://adobe.com/products/
illustrator/

http://adobe.com/products/indesign/

                                           Illustrator vs InDesign Comparison Table
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IT & ITES Related Theory for Exercise 1.7.68 - 69

DTPO - Adobe Illustrator 

Adobe Illustrator various design format 

Objectives: At the end of this lesson you shall be able to
• what is logo design in Illustrator 

• graphic design

• vector graphics

• character design

• What is Logo Design in Illustrator

Logo design is a very important part of a company’s 
identity. It should be used to distinguish the company 
from its competitors and to convey the message 
that the company is different and better than other 
companies in the market.

•  some of the advantages of designing a logo

We will start off with the basics of designing a logo 
in illustrator. There are many ways to design logos 
in illustrator, however, we will focus on using the text 
tools and layer to create our designs. some basic 
styles for creating logos and how you can use them 
for different purposes.

• Adobe Illustrator be used for logo design

 With Adobe Illustrator, you can create a logo that 
stands out. Illustrator gives you the freedom to follow 
your imagination by providing you with all of the tools 
you’ll need to handle any logo design you can think 
of.

•		 Different	types	of	logos	
 A logo is a symbol that represents the product or 

services of an organization. It is used to identify 
the product, service or company. A logo can be in 
different forms and formats.

• Logos designed in illustrator

Due to a vector’s mathematical makeup, each path, 
line or curve looks precise at any size. These complex 
shapes and lines can be produced exclusively in 
vector-based programs, such as Adobe Illustrator or 
Sketch.

• Industries do illustrated logos particularly suit?

Illustrated logos are a strong statement, and they 
are definitely more common in particular industries. 
Generally speaking they suit companies who have a 
more informal identity, or a slightly quirky personality – 
but if one of your USPs is how different you are from the 
competition then an illustrative logo design will really 
help you to say that.

There are also many different styles of illustration – 
some are very cartooney and informal, others are 
more sophisticated. There will be a style that suits your 
company perfectly too.

Sectors that are well suited to illustrative logo 

design:

• Children’s industries – from nurseries to toy factories, 
illustration can convey the friendly and personal feel that 
are so necessary for connecting with the target market.

• Cars

• Fashion – generally the more sophisticated end of 
the illustration spectrum, using artwork to create brand 
identity and style

• Entertainment

• Food

• Pet care

• fitness

Examples of illustrations we’ve done for logo 

designs: (Fig 1)

Fig 1
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Need to know if you want an illustrated logo design

While illustrated logos certainly have their benefits 
they can be restricting too. If you wish to have your 
logo printed into equipment an illustration might make 
that difficult as the complexity of the drawing might not 
transfer onto another medium. However, you can get 
around this by finalising two different versions of your 
logo.

• Graphic Design :

The elements and principles of graphic design include 
line, color, shape, space, texture, typography, scale, 
dominance and emphasis, and balance. Together, 
they work to create visually appealing work that 
conveys a message.

• Line

Lines are present in nearly every design, whether 
they are straight, curved, thin, thick, dashed, long, or 
short. Lines connect any two points. They are useful 
for dividing space as well as directing the viewer’s 
attention in a specific direction.

• Color

Color is perhaps the most important and obvious 
element of a design. It can create impact right 
away, and it is noticed by everyone, even those 
without a design background. Colors can be used 
in backgrounds or within other elements like lines, 
shapes, or typography. Colors create emotions and 
moods. For example, red can represent passion and 
green can represent nature.

• Shape

Shape, also known as form, is the combination of 
lines. Shapes can be circles, squares, rectangles, 
triangles, or other abstract forms. Most designs 
include at least one shape. Similar to color, shapes 
have different associations. A circle may be used to 
represent unity, whereas a square could represent 
structure. The color, style, background, and texture 
of a shape can all influence the viewer’s perception.

• Space

White or negative space is crucial in design because 
it enhances readability for the human eye. Good 
designs will utilize space to give other elements 
room to breathe.

• Texture

Textures are becoming more commonly used, 
replacing single-color backgrounds. Textures can 
include paper, stone, concrete, brick, and fabric. 
They may be subtle or obvious and be used sparingly 
or liberally. Textures can be helpful to create a three-
dimensional appearance.

• Typography

When working with text, Graphic Designers need 
to consider the relationship between how text looks 
and what it says. Typography is the art of arranging 

text in legible and engaging ways. Different moods 
or emotions can be expressed through different type 
choices. Good typography should create a strong 
visual hierarchy, provide balance and set the right 
tone.

• Scale

The scale and size of objects, shapes, and other 
elements can make certain parts of a design more 
dynamic. Scale can be used to create a visual 
hierarchy. Using scale, Graphic Designers can 
create focal points and highlight important areas.

• Dominance and emphasis

Dominance and emphasis create a focal point in a 
design. It helps with the design flow and can guide 
the viewer to other parts of the design.

• Balance

Graphic Designers need to consider how design 
elements are distributed. Balanced designs offer 
stability, while unbalanced designs can be dynamic. 
Balance is achieved through shapes, colors, 
textures, lines, and other elements.

• Harmony

Harmony is one of the main goals of graphic design. 
In a good design, every element needs to work 
together and complement each other. However, 
if everything is the same, a design can become 
monotonous. Designs need to strike a fine balance 
between harmony and contrast

Vector	Graphics
Vector graphics are comprised of paths, which are 
defined by a start and end point, along with other 
points, curves, and angles along the way. A path 
can be a line, a square, a triangle, or a curvy shape. 
These paths can be used to create simple drawings 
or complex diagrams. Paths are even used to define 
the characters of specific typefaces.

Because vector-based images are not made up of 
a specific number of dots, they can be scaled to a 
larger size and not lose any image quality. If you blow 
up a raster graphic, it will look blocky, or "pixelated." 
When you blow up a vector graphic, the edges of 
each object within the graphic stay smooth and clean. 
This makes vector graphics ideal for logos, which 
can be small enough to appear on a business card, 
but can also be scaled to fill a billboard. Common 
types of vector graphics include Adobe Illustrator, 
Macromedia Freehand, and EPS files. Many Flash 
animations also use vector graphics, since they 
scale better and typically take up less space than 
bitmap images.

File extensions: .AI, .EPS, .SVG, .DRW

Usage	of	Vector	files
• Graphic artists, illustrators and designers use vector 

graphics for a variety of reasons, including the 
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following:

• Scalability. Vector formats are good for projects 
that require scalable graphics, including scalable 
type and text. For example, company and brand 
logos are displayed at different sizes; they show up 
in the corner of a mobile application or on a roadside 
billboard. A logo created with vector graphics can be 
scaled up or down without loss of quality or creating 
a large file.

It was the scalability feature of vector graphics that 
resulted in its return, after falling out of favor to 
raster graphics in the 1980s. Vector graphics were 
originally used in computer displays in the 1960s 
and 1970s. World Wide Web Consortium worked 
on Vector Markup Language, which evolved into the 
Scalable Vector Graphics open source language 
that contains vector and raster elements.

• App and web development. Vector graphics are 
useful in application and web development because 
web apps and the graphics they contain must work 
with various screen sizes and device types. For 
instance, Amazon WorkLink is a mobile app that 
enables a fully interactive representation of corporate 
data on an employee's mobile device.

• Animation. Animated images are also usually 
created as vector files, which provide for cleaner and 
smoother images.

• Computer-aided design (CAD). CAD programs 
frequently use vector files for manufacturing, 
engineering and design because of their scalability 
and ease when it comes to editing the mathematical 
formulas.

Raster Graphics

Most images you see on your computer screen 
are raster graphics. Pictures found on the Web 
and photos you import from your digital camera 
are raster graphics. They are made up of grid of 
pixels, commonly referred to as a bitmap. The larger 
the image, the more disk space the image file will 
take up. For example, a 640 x 480 image requires 
information to be stored for 307,200 pixels, while 
a 3072 x 2048 image (from a 6.3 Megapixel digital 
camera) needs to store information for a whopping 
6,291,456 pixels.

 Since raster graphics need to store so much 
information, large bitmaps require large file sizes. 
Fortunately, there are several image compression 
algorithms that have been developed to help reduce 
these file sizes. JPEG and GIF are the most common 
compressed image formats on the Web, but several 
other types of image compression are available.

Raster graphics can typically be scaled down with no 
loss of quality, but enlarging a bitmap image causes 
it to look blocky and "pixelated." For this reason, 
vector graphics are often used for certain images, 
such as company logos, which need to be scaled to 
different sizes.

File extensions: .BMP, .TIF, .GIF, .JPG

Usage	of	Raster	file
Also known as bitmap, raster files work best when you 
need to store and display high-quality photographs. 
Most photos come in the raster file format, whether 
they’re print or digital.

 With software like Adobe Photoshop, you can 
edit individual pixels within a raster file to change 
the appearance of a photograph. However, each 
raster image is limited to its individual dimensions 
and number of pixels, which affects its size and 
resolution. Increasing the size of an image with too 
few pixels can cause pixelation, which isn’t usually 
desirable. That’s why illustrations or logos that need 
to be used across a variety of sizes often come in 
vector form. 

Vector	vs	Raster
• A raster graphics image maps bits directly to a display 

Fig 2

space, also called a bitmap. Raster graphics are 
made up of a fixed number of pixels, which makes 
them less scalable than vector graphics. At a certain 
point, when the raster image is enlarged enough, the 
edges become ragged, and it appears pixelated -- 
i.e., when the pixels become visible. Raster graphics 
cannot be scaled up without sacrificing image quality.

• Vector and raster images can look different. This 
is because vector graphics must have a separate 
shape for each color shade, while raster images can 
have every pixel be a different color, showing subtle 
color gradations and depth more clearly. At larger 
sizes, the edges of raster images become ragged 
and the images pixilate. Vector images are more 
scalable.

• There is also a one-to-one relationship between 
each pixel and the memory raster graphics occupies 
on a computer. Computers must store information 
for every pixel of a raster image, whereas vector 
images only store the series of points that need to 
be connected by lines, curves, etc. Consequently, 
vector files are usually smaller than raster files. 
Vector image files are easier to modify than raster 
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image files for this reason.

• Vector and raster images can be converted into one 
another with the right software. Adobe Illustrator and 
Adobe Photoshop are examples of software that 
enable users to convert one image format to the 
other.

Raster Vector
Comprised of pixels, arranged to form an image Comprised of paths, dictated by mathematical formulas

Constrained by resolution and dimensions Infinitely scalable
Capable of rich, complex color blends Difficult to blend colors without rasterizing
Large file sizes (but can be compressed) Small file sizes
File types include .jpg, .gif, .png, .tif, .bmp, .psd; plus 
.eps and .pdf when created by raster programs

File types include .ai, .cdr, .svg; plus .eps and .pdf 
when created by vector programs

Raster software includes Photoshop and GIMP Vector software includes Illustrator, CorelDraw, and 
InkScape

Perfect for “painting” Perfect for “drawing”

Capable of detailed editing Less detailed, but offers precise paths

• Raster files are particularly good for portraying color 
depth, as each pixel can be a different color. And 
there are more pixels that can be unique colors than 
vectors that can be unique colors. This makes raster 
file formats good for editing digital photographs.

• Certain file types can include vector and raster 
elements -- PDF and SVG files are two examples.

Character Design = Large 

Adobe Illustrator has six different type tools: Type, Area 
Type, Type on a Path, Vertical type Vertical Area Type, 
and Vertical Type on a Path. There are three tools for 
horizontal type, which goes across the screen. Then, 
there are three tools for vertical type that goes top to 
bottom on the screen. This article will teach you how to 
work with type in Illustrator.

The Type Tools

The Type tools are located in the toolbox. You will find 
them here,

You can click and hold on the Type tool to see all the type 
tools grouped with it.(Fig 3)

Fig 3

Type creates type that is not associated with a path. With 
it, you can type along the edge of an open path or inside a 
closed path.

• Area Type creates type that is inside an open or closed 
path.

• Type on a Path will create type along the outer edge of 
an open or closed path.

• Vertical	Type works like the Type tool except the type is 
vertical.

• Vertical	Type	Area works like the Area Type tool except 
that it is vertical.

• Vertical	Type	on	a	Path works like the Type on a Path 
tool except it is vertical.

Create Type with the Type Tool

Let us use the Type tool to start with. Click on a blank area on 
an artboard. You will see a flashing vertical line, just as you 
would in word processing programs. This means that you can 
start typing.(Fig 4)

Fig 4

Once you are finished typing, you can use the Selection tool 
to move the text to another location if you want. Simply click 
on the text. A bounding box will appear around it.(Fig 5)

Fig 5

Now, the text above is small. Before we learn about the other 
type tools, let us learn how to format text in Illustrator.
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Formatting Text 

To format our text, we are going to use the Type panel. Go to 
Window>Type. You will then see these menu options.(Fig 6)

Fig 6

Let us go through these one by one to learn how to format 
our text. First, let us select Character.

Fonts and Font Sizes

Here is where we can change the type of font. Myriad Pro is 
the font type that we are using. However, we can change that 
to a different font. Perhaps Times New Roman.

Let us change the font in our type.

First, drag your mouse over the type to select it.(Fig 7) 

You should still be using the Type tool for this

Now, go to the Character panel and select a new type of font.

We have selected Myriad Pro. (Fig 8)

Fig 8

Fig 7

Fig 9

We are also going to change the size to 31, which you will 
learn about momentarily. (Fig 9)

Fig 10

In the bottom part of the Character panel, we can change 
the font size. It is currently 12 pt. We can also change the 
spacing between lines of type, or the leading. Right now, it is 
14.4 pt.(Fig 11)

Fig 11

Then, we can change the kernel (bottom box on the left). 
The kernel is the space between characters. We can also 
change the tracking (bottom box on the right). The tracking 
is the adjustment of space for groups of characters or blocks 
of text.

Working with Glyphs

Glyphs are hieroglyphic characters or symbols, such 
as the @ sign. To work with glyphs in Illustrator, go to 
Window>Type>Glyphs.

Fig 12

You can then see the Glyphs that you can use.(Fig 12) Scroll 
down within the panel to look at all of them. You can also set 
the font type and style for your glyphs or scroll in or out to 
get a closer look at the glyphs shown in the panel by using 
these buttons.

Click on the place in your document where you want to insert 
a glyph.

Double click on the glyph (in the panel) to insert it.(Fig 13)

We added an exclamation point from the Glyphs panel.

The font is now changed. Click in another area of the art 
board to deselect the text.

Next, we can change the font style, as shown below. We can 
change the type to bold, italics, or back to regular.(Fig 10)
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Type on a Path Tool

The Type on a Path tool allows you to type on a path. Select 
the Type on a Path tool,(Fig 14)

Fig 13

Fig 14

The Vertical Type on a Path tool (Fig 15)

Works the same way, except that the text is vertical.

Fig 15

Fig 16

Fig 17

Fig 18

Fig 19

Remember, to edit text, select it with the Selection tool. 

Text	Effects
• Extrude & Bevel

Step 1: 

Select the Text Tool (type tool) from the left-hand side 
toolbar.(Fig 16)

 Step 2: 

Type the text that you want. Here we select Educba as 
our text. Select the font size to be 40pt and font type as 
“myriad pro.”(Fig 17)

Step 3:

Select the text with the Selection tool and then select the 
effect from the menu bar at the top of the screen.(Fig 18)

Step 4:

 Click on 3D and select Extrude & Bevel effect.(Fig 19)
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Step 5:

You will get a dialog box once you click on extrude & 
bevel. In the dialog box, choose the position as Off-Axis 
Front, Extrude Depth as 50 pt.(Fig 20)

Fig 20

Step 6:

 You will see the Final text with the effect as follows.(Fig 
21)

Fig 21

You can try other positions with a different axis, different 
depths, and angles.

• Pucker	&	Bloat	Effect
Repeat steps 1 to 3 from the previous effect (3D).

Step 4: 

Click on distort & transform and select pucker & bloat.(Fig 22)

Fig 22

Step 6: 

The final text will look like this: (Fig 24)

Fig 24

Fig 23

Step 5: 

Upon clicking pucker & bloat, you will get a dialog box. Select 
the value as 15% and click on OK.(Fig 23)
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IT & ITES Related Theory for Exercise 1.8.70 - 72

DTPO - Adobe Photoshop 

Photoshop & coreldraw features & versions 

Objectives: At the end of this lesson you shall be able to

•	 discuss	the	benefit	of	Photoshop	and	CorelDraw
•	 classify	the	features	of	Photoshop	and	CorelDraw
•	 photoshop	vs	Coreldraw	Latest	Version	Features

Discuss	the	benefit	of	Photoshop	and	CorelDraw
Adobe Photoshop :

Photoshop is one of the most elegantly designed and 

feature-rich image-editing software program developed 

by Adobe Systems for Mac and Windows operating 

systems. It is an excellent application specially designed 

to take your image editing and motion graphics skills to 

a higher level. It is mostly used by graphics designers 

and professional photographers alike.

The software is based on raster graphics system 

meaning it is used to interpret data in pixels. Raster 

means pixel which is a dot matrix data structure which 

is basically a sequence of horizontal lines called pixels.

CorelDraw	:
CorelDraw is a window based graphics design software 

program developed and marketed by Corel Corporation. 

It is basically a vector graphics editor which creates and 

edits digital images through a sequence of commands 

or mathematical equations.

It is mostly used to create vector-based images and 

illustrations and to design logos, business cards, 

pamphlets, barcodes, etc.

Use	of	CorelDraw	and	Photoshop
To successfully work with vector images without the use 

of pixels, you will need CorelDraw which specializes in 

vector art. It is mainly used by creative professional to 

create and edit vector-based illustrations and images 

such as designing logos, arranging print layouts, and 

retouch photographs. It is commonly used to create 

Sr.no Adobe Photoshop Corel Draw

1 This software is pixel-based and creates raster 

images that are used by professionals.

This software is vector-based and creates images using 

a mathematical equation.

2 It is developed by Adobe, and it’s the extended 

version of it.

It is developed by Corel Corporation, so it’s Corel’s 

graphics suite.

3 It read a pixel from the image following layers 

which are used for detailed manipulation of 

images.

This software converts the images to vectored form as it 

doesn’t understand the concept of pixels.

4 This software is mainly used for editing, crop-

ping, resizing, manipulating, and giving special 

effects to the images.

It is used for illustration and for creating business cards, 

barcodes, pamphlets, banners, logos, etc.

5 This is expensive than Corel draw by some 

amount.

The price of this is a bit lower than Photoshop.

logos, business cards, hoardings, banners, pamphlets, 

etc.

All the creative effects are done in Photoshop allowing 
you to work with images layer by layer for detailed effects 
and manipulation of images. It also allows users to crop, 

resize, and correct colors on digital photographs to the 

precise needs and requirements.

CorelDraw	 vs.	 Photoshop:	 Comparison	 Chart 
image editing, such as creating high-quality graphics, 

infographics, touchups, presentations, or even creating 

banners. Photoshop is still one of the best software 

programs to edit images.

CorelDraw, on the contrary, is vector-based graphics 

software meaning it uses mathematical equations to 

create graphics and artwork. It doesn’t understand the 

idea of pixels.

Use	of	CorelDraw	and	Photoshop
To successfully work with vector images without the use 

of pixels, you will need CorelDraw which specializes in 

vector art. It is mainly used by creative professional to 

create and edit vector-based illustrations and images 

such as designing logos, arranging print layouts, and 

retouch photographs. It is commonly used to create 

logos, business cards, hoardings, banners, pamphlets, 

etc.

All the creative effects are done in Photoshop allowing 
you to work with images layer by layer for detailed effects 
and manipulation of images. It also allows users to crop, 

resize, and correct colors on digital photographs to the 

precise needs and requirements.

CorelDraw	vs.	Photoshop:	Comparison	Chart
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6 Adobe Photoshop is nearly the world’s leading 

software for the design and development of 

images.

Its graphics suite 2017 is industry-acclaimed design 

software used for quantity-based work.

7 This is available in English, Dutch, Turkish and 

Swedish languages.

It is available in English, China, Germany, Spain, Japan, 

France, Italy, Dutch, Portugal, and polish languages.

8 In this, only one page can be formed, not like 

Corel Draw.

This software allows you to make multiple pages in a 

single file format.
9 In this, we can’t put the barcode in between the 

image editing.

While editing the image, we can insert the barcode in 

between.

10 Most images for web presentation are used 

from this software.

Mostly the images for banner printing are used from this 

software because once the image has been converted 

to vector for it doesn’t give a blurry look.

Classify	the	features	of	Photoshop	and	CorelDraw

Raster	image	:
• Raster images, also known as bitmaps, are 

comprised of individual pixels of color. Each color 

pixel contributes to the overall image.

• Raster images might be compared to pointillist 

paintings, which are composed with a series of 

individually-colored dots of paint. 

• Raster images are capable of rendering complex, 

multi-colored visuals, including soft color gradients. 

Digital cameras create raster images, and all the 

photographs you see in print and online are raster 

images.

• There are different types of raster files: JPG, GIF, 
and PNG are examples.

• Raster images are ideal for photo editing and creating 

digital paintings in programs such as Photoshop and 

GIMP , and they can be compressed for storage and 

web optimized images.

• How you can use a given raster image depends on 

its size and quality. Quality is often dictated by how 

many pixels are contained in an inch, expressed 

as pixels-per-inch or ppi; as well as the overall 

dimensions of the image,(Fig 1) also expressed as 

pixels.

Vector	image	:
• Raster graphics, which are comprised of colored 

pixels arranged to display an image, vector graphics 

are made up of paths, each with a mathematical 

formula (vector) that tells the path how it is shaped 

and what color it is bordered with or filled by.

• Since mathematical formulas dictate how the image 

is rendered, vector images retain their appearance 

regardless of size. They can be scaled infinitely. 
Vector images can be created and edited in programs 

such as Illustrator, CorelDraw, and InkScape.

• Though vectors can be used to imitate photographs, 

they’re best-suited for designs that use simple, solid 

colors. Vector images are comprised of shapes, and 

each shape has its own color; thus, vectors cannot 

achieve the color gradients, shadows, and shading 

that raster images  vector graphics are comprised of 

line art, sometimes called wireframes, that are filled 
with color.

Fig 1
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Raster Vector

Raster images are also known as Bitmap images and 

are made up of small dots known as pixels.

Vector images are made up of lines, fills, and curves.

In Raster, pixels of the same colour or different colour 
are placed close to each other so that the human eye 

perceives them as pictures but not as dots.

Vector images are collections of elements such as 

lines, rectangles, circles, and square. Each vector 

element has its own coordinates and can be resized.

Raster image knows the colour of each pixel. The vector consists of instructions on where to place its 

components.

Raster has only two colours, black or white. With an 

increase in complexity, it can contain more colours.

Vectors use mathematical formulas in describing 

colours, shapes, and placement.

Graphic Raster formats include JPEG, GIF, PNG, XBM, 

TIFF, PCX, and bitmap fonts.

Vector formats include EPS, PICT, WMF, PostScript, 

TrueType. The last two are created by CAD and GIS 

applications.

Raster has simple output, as long as RIP or printer has 

required memory.

Vectors are small files that contain information on 
Bezier curves that form the drawing.

Raster images have a wide range of colour gradations 

and less scalable than Vector images.

Vector images are much more scalable than Raster 

images.

When the user paints a raster image, it looks similar to 

dipping brush in paint and painting images.

When the user paints a vector image, only the outline of 

the shape is painted. Similar to creating an image with 

different tiles of different shapes and sizes.

On enlarging a raster image without a change in 

pixel count, the image looks blurry. Enlarging file with 
increasing in pixel count, which may produce better 

results comparatively.

On enlarging a vector image, mathematical formulas 

remain the same, scalable to any size.

Raster programs are best suitable for photo editing, the 

creation of a continuous toned image with soft colour.

Vectors are best suitable for drawings, creating logos, 

illustrations, and technical drawings

A huge dimension and fair detailed image produce a 

large size of the image.

Vectors are resolution dependent, can be printed at any 

size or resolution.

Difficult to print raster images using limited spot 
colours.

In vector, the numbers of colours can be increased or 

decreased for printing.

The conversion of raster to vector is time-consuming 

and based on complexity.

A vector image can be easily converted to a bitmap 

image.

Some of the raster programs include photo editing, 

Photoshop, GIMP, paint shop.

Vector programs include Illustrator, Inkscape, 

CorelDraw.

Raster has high processing speed, used from badges 

to posters.

In vector, data volume depends upon the actual value 

of the object.

A kind of Raster file can be easily converted to another. Vectors are difficult to modify or display if not opened in 
programs that understand vector.

File	formats	extension	for	raster: File	format	extension	for	Vector:

.tif .tiff: Tagged Image File Format .eps: Encapsulated PostScript

.jpg .jpeg: Joint Photographic Experts Group .ai: Adobe Illustrator Artwork

.psd: Photoshop Document .cdr: CorelDraw

.gif: Graphics Interchange Format .svg: Scalable Vector Graphics

.png: Portable Network Graphics .pdf: Portable Document Format
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Coreldraw	and	Photoshop	Features	:

CORELDRAW PHOTOSHOP

LiveSketch tool Stroke Smoothing

Enhanced vector previews, handles, and nodes Brushes from Kyle T. Webster

Prominent interactive sliders Better Brush Organization

Custom node shapes Color and Luminance Range Masking

Touch-friendly GU interface Access Lightroom Photos

Powerful stylus enhancements Quickly Share Creations

Import legacy workspaces Quick Share Menu

Font _ltering and search Variable Fonts

Corel Font manager Curvature Pen Tool

Multi-monitor Custom Path Color and Width

Healing clone tools Properties Panel

Copy Curve Segments Paste as Plain Text

Gaussian blur feature 360 Panorama Workflow

Fig 2

Fig 3

Fig 4

	Photoshop	vs	Coreldraw	Latest	Version	Features
Photoshop	Latest	Version	Features	:	
Replace Sky

• This new feature uses an Adobe Sensei, an Artificial 
Intelligence, that automatically determines the sky in 

the image, selects it, and replaces it using the Sky 

Replacement window’s presets.(Fig 2)

• To use this feature, choose Edit	>	Sky	Replacement. 
• You can also quickly select the sky in just two clicks 

by choosing Select > Sky.

Pattern Preview

• Open a file that you want to make into a pattern. 
Then, choose View > Pattern Preview. This view 

option allows you to see the pattern as a whole and 

zoom in/out to a greater perspective.

• To save the pattern, choose Edit	>	Define	Pattern	> 

and enter a name.

Neural	Filters:	Smooth	Skin
• Photoshop’s Artificial Intelligence (AI), Adobe 

Sensei, has a new trick up its sleeve that smoothens 

skins without using the Blur tool. (Fig 3)

• Choose Filter > Neural	Filters > click on the Skin 

Smoothing to toggle on.

Neural	Filters:	Smart	Portrait
• One of them is the Smart Portrait, which allows you to 

change a portrait’s expressions with its Happiness, 

Surprise, and Anger sliders.

• It allows you to change your subject’s appearance 

by altering the Age, Gaze, Hair Thickness, Head 

Direction, and Light Direction.

• A true game-changer for portrait retouching!

• It is important to note that the Smart Portrait filter 
processes itself using the Cloud.(Fig 4)
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Fig 5

Neural	Filters:	Colorize
• Beta Filters, you’ll also discover the new Colorize 

feature that colorizes black and white or sepia 

photos.

• Colorize uses the same Artificial Intelligence (AI) 
technology, called Adobe Sensei, that studies your 

document and applies the appropriate colors to 

breathe life into it.(Fig 5)

Smart	Object	Reset	Transform
• When you want to reset the distortions applied on 

your Smart Object, you will no longer need to press 

the undo command repetitively.

• In this new update, right-click on the Smart	Object	
>	Reset	Transform to remove any transformations 

you previously applied.(Fig 6)

Fig 6

Select	and	Mask	New	Features
• The Select and Mask workspace has been helpful 

for creatives in being able to create accurate masks 

of subjects with intricate details.

Photoshop 2021 Plugins Panel           

• The Menu has a new addition in the form of Plugins.

• Upon selecting Plugins panel and selecting Discover 

Plugins, you will indeed discover useful plugins that 

can simplify or improve your workflow found in the 
vast collection of plugins available on the Creative 

Cloud.

• Live	Shapes
• Line tool is now easier to work with by only having 

two anchor points and an adjustable appearance 

that you can change anytime, similar to the tool in 

Adobe Illustrator.

• This option is also available for the Polygon tool, 

which now allows you to make rounded edges.(Fig 

7)

Fig 7

Discovery Panel

• The new Discover panel replaces the former search 

bar as it allows you to use it for different purposes. 

• First, it allows you to search for tools you can’t find.

• Then, Photoshop will give you directions by 

highlighting the tool with an arrow. 

• Second, when you search for themes such as 

Retouching, it shows you a list of tools related to that 

particular workflow.

Photoshop	2021	Cloud	Document	Version	History
• A Photoshop Cloud Document allows you to work on 

a document with the files saved on the Cloud instead 
of your computer.

• With the Version History update, you can see the 

different versions of the document done at different 
times, change the names, and open both versions 

on different tabs.

Technology Preview

• One Technology Preview is the Content-Aware 

Tracing tool that helps define and enhance the 
details in your image.

• This also leads to creating better Vector Masks or 

Vector Paths.
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• Enhanced	colour	replacement: The new Replace 

Colors tool has been rebuilt from the ground up to 

provide a faster, easier route to flawless photos. 

• Reimagined	 adjustments	 workflow: Take the 

Coreldraw	Latest	Version	Features	:	
Advanced illustration

New precision layout capabilities and the Draw in 

Perspective feature, CorelDRAW Graphics Suite 2021 

makes complicated workflows simple.

Perspective drawing: 

• Draw objects or illustrated scenes in perspective, 

faster and easier than ever. Choose from 1, 2, or 

3-point perspective, draw or add an existing group 

of objects on a shared perspective plane, and move 

and edit objects freely without losing perspective.

Flexible	design	space
• Multipage view: View, manage, and edit all of your 

project’s digital assets in one view. Move objects 

across pages fluidly, compare designs side-by-side, 
and freely move pages around to arrange them as 

you wish. (Fig 8)

Fig 8

• Multi-asset export: When you’re done designing, 
you can create a customised list of page and object 

items to export with one click.

• Symbols workflow enhancements: An enhanced 
Symbols workflow saves you time by enabling you 
to quickly search for symbols within large libraries 

and identify them easier among other objects.

Progressive	image	editing
• Powerful new photo editing features in PHOTO-

PAINT and CorelDRAW 2021 are purpose-built to 

enhance images in fewer steps. 

Fig 9

totally transformed Adjustments workflow in Corel 
PHOTO-PAINT for a spin to apply critical image 

adjustments non-destructively, in real-time, and in 

context, with the Local Adjustment Mode making it 

simple to target a filter to a specific image area.

• HEIF	file	format	support: You can now enjoy support 

for the standard photo format used on iPhone in both 

PHOTO-PAINT and CorelDRAW 2021.

Next	generation	collaboration(Fig	9)
 • Stay connected with colleagues and clients and 

gather real-time comments and annotations from 

one or many contributors from within your shared 

CorelDRAW design file.(Fig 9)

• Live	Comments: The new Live Comments feature 

allows you to comment on and annotate a document 

in CorelDRAW.app  with all feedback instantly 

appearing in the working file in CorelDRAW 2021.

• Dashboard: An in-built new project dashboard acts 

as your collaboration hub, simplifying  the storing, 

organising, and sharing of cloud files.
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Concept	of	font	style
• Open a photo or Photoshop document (PSD).

• From the toolbar, select the Type tool or simply press 

‘T’ to quickly select it.(Fig 1)The Horizontal Type Tool 

with which you can add text horizontally is selected 

by default. If you want to add text vertically, click the 

Type tool again and select Vertical Type Tool from 

the context menu.

Fig  1

• Do you want to add a few words like a heading or 

title? Click anywhere on the canvas to type it. (Fig 2) In 

Photoshop, this is called point text.

The other type of text in Photoshop is called paragraph 

text. (Fig 3) As the name suggests, this is used when 

you want to type a paragraph. Click and drag the cursor 

on the canvas to create a bounding box in which you 

Fig  2

Fig  3

Fig 4

The	options	bar	in	Windows
• Change horizontal text to vertical text and vice-versa 

B. Change font style C. Change font size D. Change 

pixelation of text edge (anti-aliasing) E. Change text 

alignment F. Change text color  G. Cancel changes 

H. Save changes. (Fig 5)

Fig 5

IT & ITES Related Theory for Exercise 1.8.73 - 76

DTPO - Adobe Photoshop

Concept	of	colour	&	font	style
Objectives: At the end of this lesson you shall be able to

• concept of font style

•	 concept	of	color	schemes
can type your paragraph. This helps you efficiently edit 
and align the paragraph later.

• Type your text. To save your changes, click  in the 

options bar or press Esc and you're good to go! (Fig 

4)

• You can also use the Character panel and the 

Paragraph panel to further edit your text.

Create	custom	Styles
The easiest way to customize or create custom Styles 

is to break down (into its individual components) an 

existing Style.Because it’s unlikely that we have the 

same Styles installed on our systems, let’s use a Style 

from the Default palette.

Fig	6
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• From your Styles palette, choose the Style called 

Chiseled Sky (it’s blue and white, and the 13th Style 

from the top).(Fig 7)

• Switch over to the Layers palette and notice that the 

Layer titled “Chiseled Sky” shows the Layer Style 

Effects attached to this Layer. Right-click the Layer 
name (Chiseled Sky), and the Layer/Style submenu 

pops up.

• Click Blending Options, and the Layer Style menu 

opens on the default Blending Options menu.

• You can also right-click the word EFFECTS, and 

when the Layer Style Effects submenu opens, click 
one of the “checked” Blending Options such as Bevel 

and Emboss. Next, the Layer Style menu opens, 

featuring the Bevel and Emboss section.

• Notice how the Bevel and Emboss section is defined. 

Fig 7

the Depth of the chiseled effect (which modifies the 
length of shading) by moving the slide bar between 

1 and 1000. Notice the Preview box on the right side. 

Push the slider all the way to 1000 and notice how 

the chiseled effect changes.

• Experiment with the Direction Up/Down (select 

Down), experiment with the Size from 1 to 250 ( 

select 200), which changes the depth size of the 

Bevel and the Soften feature (from 1 to 16), which 

changes the Bevel from a chiseled look to a puffy, 
pillow look.

• Next, select the Gradient Overlay. Click the arrow 

next to Blend Mode and experiment with different 
Blending options. Adjust the Opacity based on the 

Brightness/Contrast of each Blend Mode.

• Click the Gradient arrow and experiment with several 

different Gradients to change the Style completely. 
Next, choose Style, Angle, and Scale.

Be sure to save your new Style with a unique name: 
Just click the New Style button and enter a Style name.

Fig 8 

• Add some Inner or Drop Shadows, experiment 

with the Inner and Outer Glow effects, try adding 
a Stroke with a Pattern, or a Pattern with a Satin 

or Color Overlay. You can use any image (photos, 

illustrations, graphic designs, positives, negatives, 

etc.) that you can imagine for Patterns. (Fig 9)

 Each of the Style Blending Options and Effects 
has hundreds, even thousands of options. When 

combined, the number of different Styles for text and 
for objects are infinite. 

Apply Styles

• Enter some text on your Photoshop canvas. For this 

exercise, enter several words in separate layers, 

such as, in this example, Christmas, Summer, 

Winter, Autumn, Spring, etc.

• Select (click) the first Layer in the Layers palette: 
Merry. Then choose a Style from the Styles palette.

• Select a different Style for each word/layer to show 
a range of different Styles.

Color	Modes

Fig 9

• Type the words Chiseled	Sky on your canvas and 

select a thick, heavy f  ont such as Articula Display, 

Arial Bold, Bremen Blk-BT, or Swiss Heavy.(Fig 6)

Under Style you can choose from Outer Bevel, Inner 

Bevel, Emboss, Pillow Emboss, or Stroke Emboss. 

(Fig 8)

• Under Technique, you can choose from Smooth, 

Chisel Hard, or Chisel Soft, and then determine 
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Color modes are the settings designers use to show 

colors consistently across devices and materials. 

Commonly used modes are LAB, RGB, CMYK, index, 

grayscale and bitmap, which differ in quality and file 
size. Designers pick modes to optimize images and 

ensure these appear identically across media for brand 

consistency.

 A chieving Color Consistency and More in Screen 

and Print

The designs we create appear on many devices and 

materials, and how we manipulate color greatly depends 

on the medium we use. This is due to differences in 
color spaces (i.e., the specific organization of colors), 
and the two processes for producing color, namely:

• Additive – involving the blending of light. We “create” 

white by mixing all the colors at full intensity; black is the 

total absence of color.

• Subtractive – involving the mixing of physical 

substances (e.g., ink, paint). Each dot/splotch covers 

the medium (e.g., paper). A classic example of mixing 

all paint colors is that curious dark grey-brown hue.

You may have seen how printed-out colors can look 

different from those on-screen. This phenomenon 
happens because the printer’s colors (using the 

subtractive process) didn’t replicate the screen’s (using 

the additive). Such inconsistencies can be easy to 

correct if you choose the right color mode.

•	 LAB
• RGB

•	 CMYK
• Index

• Greyscale

•	 Bitmap	
Illustration	 comparing	 LAB	 (Infinite	 Colors),	 RGB	
(Millions	of	Colors),	CMYK	(4	Printed	Colors),	Index	

(256	Colors),	Greyscale	(256	Shades	of	Grays)	and	
Bitmap	(2	Colors).	(Fig 10)

How	to	Pick	the	Right	Mode	for	the	Context
LAB	–	Also	called	CIELab,	this	mode	is	based	on	how	

humans	 perceive	 color.	 It	 comprises	 one	 channel	
for	lightness	(L,	ranging	from	the	values	0–100)	and	
two for color (A—the Green-Red Axis channel—and 

B,	the	Blue-Yellow	Axis	channel,	ranging	from	+127	
to	 -128).	LAB	color	 is	device-independent,	making	
it	 easy	 to	 achieve	 exactly	 the	 same	 color	 across	
different	 types	of	media	so	your	 (e.g.)	digital	 logo	
appears	identically	on	a	mug,	banner,	etc.	However,	
LAB’s	large	file	sizes	can	delay	load	times.		(Fig 11)

Uses:

•	 Branded	Products	(e.g.,	T-shirts,	banners)
•	 Color	Reference
• Photography

•	 Improving	images	with	a	natural	and	vibrant	look
The LAB color mode, shown in graph form.

RGB – This color mode uses the additive process. It 

comprises Red, Green and Blue hues that combine to 

create extensive color variations. (Fig 12) RGB exists 

exclusively in digital formats (e.g., mobile screens). 

Although RGB is present across most electronic 

devices, the color elements vary across systems and 

models. So, an image can display differently on-screen 
from brand to brand. 

Uses:

• Web & App Design

• Digital Design

• Social Media

The RGB color mode — think of monitors.

CMYK – This subtractive color mode comprises Cyan, 

Fig 10

Fig 11

Fig 12
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Magenta, Yellow and Key (Black), which combine to 

produce a range of hues. (Fig 13) This four-color process 

works for most printers. Printed images are essentially 

a series of layered four-color dots (measured in dots 

per inch) that create different hues and gradations. 
Although CMYK is a standard color model, the exact 

range of colors represented can vary, depending on the 

press and printing conditions. 

Uses:

• Stationery (e.g., business cards)

• Advertising (e.g., posters, flyers, brochures)

• Product Packaging

Tip – Use CMYK mode when preparing an image to be 

printed with process colors, as image conversion from 

RGB to CMYK creates a color separation. If you start 

with an RGB image, it’s best to edit first in RGB and 
then convert to CMYK afterwards. 

The CMYK color mode — think of printers.

Index – This mode produces 8 bit image files with up to 

256 colors. Like RGB, this color mode is exclusively for 

digital formats, on-screen. (Fig 14) When you convert 

an image to index color, a color table gets built to store 

and index the image’s colors. If a color in the original 

image doesn’t appear in the table, the software chooses 

the closest one or uses a dither effect to simulate the 
color 

Uses:

• Websites

• Digital Presentations

• Mobile Applications

While its color palette is limited, index color can reduce 

file size yet maintain the desired visual quality for digital 
presentations, websites and mobile applications. So, 

this mode is ideal for image optimization. For extensive 

editing, it’s best to convert temporarily to RGB mode.

The Index color mode.

Greyscale – This black-and-white-looking mode actually 

comprises various shades of grey within an image. (Fig 

15) You can use it in print and digital formats. In digital, 

each image pixel has a value ranging from 0 (black) to 

255 (white). In print, the values range from 0% (white) 

to 100% (black), representing the amount of black ink 

used. 

Uses: 

• Digital formats, to express a certain tone in your 

designs 

• Print formats, to lower costs and minimize ink usage

The Greyscale color mode.

Bitmap – A.k.a. line art, this mode comprises black and 

white pixels, with no colors or shades of grey. (Fig 16) 

In digital formats, black and white values represent an 

image’s pixels, while black ink dots and the white of the 

paper represent the overall image in print formats.

Uses:
• Print and digital formats, to create a line drawing or 

hand-drawn sketch, or make vintage effects.
 While jagged-edged on-screen, bitmap images 

usually print smoothly with high resolution.

Fig 13

Fig 14

Fig 15

Fig 16
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IT & ITES Related Theory for Exercise 1.8.77

DTPO - Adobe Photoshop 

Photoshop tools 

Objectives: At the end of this lesson you shall be able to

• introduction of tools panel

Introduction of tools panel

Photoshop's toolbar is located along the left of the 

screen:	(Fig	1)

Fig 1

Choosing	a	single	or	double	column	toolbar
By default, the toolbar appears as a long, single column. 

But it can be expanded into a shorter, double column by 

clicking the double arrows at the top. Click the double 

arrows again to return to a single column toolbar:(Fig 2)
Fig 2

The tools layout

Photoshop's toolbar is organized. While it may seem like 

the tools are listed randomly, there's actually a logical 

order to it, with related tools grouped together.(Fig 3)

Fig 3

The toolbar's hidden tools

Each tool in the toolbar is represented by an icon, and 

there are many more tools available than what we see.

A small arrow in the bottom right corner of a tool icon 

means that there are more tools hiding behind it in that 

same spot:(Fig 4)
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Fig 4

Most of the spots in the toolbar hold more than one tool.

To view the additional tools, click and hold on the icon. 

Or right-click (Win) / Control-click (Mac) on the icon. 

A fly-out menu will open listing the other tools that are 
available.

For example, if I click and hold on the Rectangular 

Marquee Tool icon, the fly-out menu tells me that along 
with that tool, theElliptical Marquee Tool, the Single Row 

Marquee Tool and the Single Column Marquee Tool are 

also grouped in with it.(Fig 5)

To choose one of the additional tools, click on its name 

in the list. I'll choose the Elliptical Marquee Tool:

Fig 5

Choosing a hidden tool from the fly-out menu.

The default tool

The tool that's initially displayed in each spot in the 

toolbar is known as the default tool. For example, the 

Fig 6

Fig 7

Rectangular Marquee Tool is the default tool for the 

second spot from the top. But Photoshop won't always 

display the default tool. Instead, it will display the last 

tool you selected.

Notice that after choosing the Elliptical Marquee Tool 

from the fly-out menu, the Rectangular Marquee Tool 
is no longer displayed in the toolbar. The Elliptical 

Marquee Tool has taken its place:(Fig 6 & 7)

Selecting the Rectangular Marquee Tool from behind 

the Elliptical Marquee Tool.

Move and Selection tools
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1

	 S.No																 Tool	Pic											 	Funtion	of	the	Tool

		Move	Tool	*	(	V	)

The Move Tool is used to move layers, selections and 

guides within a Photoshop document. Enable "Auto-

Select" to automatically select the layer or group you 

click on.

		Artboard	Tool	(	V	)

The Artboard Tool allows you to easily design multiple 

web or UX (user experience) layouts for different 
devices or screen sizes.

  Rectangular	Marquee	Tool	*	(	M	)

The Rectangular Marquee Tool draws rectangular 

selection outlines. Press and hold Shift as you drag 

to draw a square selection.

 Elliptical	Marquee	Tool	(	M	)

The Elliptical Marquee Tool draws elliptical selection 

outlines. Press and hold Shift to draw a selection in 

a perfect circle.

  Single Row Marquee Tool

The Single Row Marquee Tool in Photoshop selects 

a single row of pixels in the image from left to right.

   Single	Column	Marque	e	Tool

Use the Single Column Marquee Tool to select a 

single column of pixels from top to bottom.

2

3

  Lasso	Tool	*	(	L	)

With the Lasso Tool, you can draw a freeform 

selection outline around an object.

4

5

6

7

8

  Polygonal	Lasso	Tool	(	L	)

Click around an object with the Polygonal Lasso 

Tool to surround it with a polygonal, straight-edged 

selection outline.

9
 	Magnetic	Lasso	Tool	(	L	)

The Magnetic Lasso Tool snaps the selection outline 

to the edges of the object as you move your mouse 

cursor around it.

  Object	Selection	Tool	*	(	W	)

The Object Selection Tool lets you select an object 

just by dragging a rough selection outline around it.10
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S.No Tool	Pic										 	Funtion	of	the	Tool

  Quick	Selection	Tool	(	W	)

The Quick Selection Tool lets you easily select an 

object simply by painting over it with a brush. Enable 

"Auto-Enhance" in the Options Bar for better quality 

selections.

  Magic	Wand	Tool	(	W	)

Photoshop's Magic Wand Tool selects areas of 

similar color with a single click. The "Tolerance" 

value in the Options Bar sets the range of colors that 

will be selected.

		Crop	Tool	*	(	C	)

Use the Crop Tool in Photoshop to crop an image 

and remove unwanted areas. Uncheck "Delete 

Cropped Pixels" in the Options Bar to crop an image 

non-destructively.

		Perspective	Crop	Tool	(	C	)

Use the Perspective Crop Tool to both crop an image 

and fix common distortion or perspective problems.

 Slice	Tool	(	C	)

The Slice Tool divides an image or layout into 

smaller sections (slices) which can be exported and 

optimized separately.

  Slice	Select	Tool	(	C	)

Use the Slice Select Tool to select individual slices 

created with the Slice Tool.

			Frame	Tool	*	(	K	)

New as of Photoshop CC 2019, the Frame Tool 

lets you place images into rectangular or elliptical 

shapes.

		Eyedropper	Tool	*	(	I	)

Photoshop's Eyedropper Tool samples colors in an 

image. Increase "Sample Size" in the Options Bar for 

a better representation of the sampled area's color.

		3D	Material	Eyedropper	Tool	(	I	)

Use the 3D Material Eyedropper Tool to sample 

material from a 3D model in Photoshop.

11

12

Crop	and	Slice	tools

Measurement	tools

13

14

15

16

17

18

19
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	 S.No																 Tool	Pic											 	Funtion	of	the	Tool

20

21

22

23

  Color	Sampler	Tool	(	I	)

The Color Sampler Tool displays color values for 

the selected (sampled) area in an image. Up to 

four areas can be sampled at a time. View the color 

information in Photoshop's Info panel.

  Ruler	Tool	(	I	)

The Ruler Tool measures distances, locations and 

angles. Great for positioning images and elements 

exactly where you want them.

  Note	Tool	(	I	)

The Note Tool allows you to attach text-based notes 

to your Photoshop document, either for yourself or 

for others working on the same project. Notes are 

saved as part of the .PSD file.

  Count	Tool	(	I	)

Use the Count Tool to manually count the number 

of objects in an image, or to have Photoshop 

automatically count multiple selected areas in the 

image.

24

Retouching and Painting tools

Spot	Healing	Brush	Tool	*	(	J	)
The Spot Healing Brush in Photoshop quickly 

removes blemishes and other minor problem areas 

in an image. Use a brush size slightly larger than the 

blemish for best results.

Healing	Brush	Tool	(	J	) The Healing Brush lets you repair larger problem 

areas in an image by painting over them. Hold 

Alt (Win) / Option (Mac) and click to sample good 

texture, then paint over the problem area to repair it.

Patch	Tool	(	J	)
With the Patch Tool, draw a freeform selection outline 

around a problem area. Then repair it by dragging 

the selection outline over an area of good texture.

Content-Aware	Move	Tool	(	J	)
Use the Content-Aware Move Tool to select and 

move part of an image to a different area. Photoshop 
automatically fills in the hole in the original spot using 
elements from the surrounding areas.

Red	Eye	Tool	(	J	) The Red Eye Tool removes common red eye 

problems in a photo resulting from camera flash.

Clone	Stamp	Tool	*	(	S	)
The Clone Stamp Tool is the most basic of 

Photoshop's retouching tools. It samples pixels from 

one area of the image and paints them over pixels in 

another area.

25

26     
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	 S.No																 Tool	Pic											 	Funtion	of	the	Tool

	Pattern	Stamp	Tool	(	S	) Use the Pattern Stamp Tool to paint a pattern over 

the image.

Eraser	Tool	*	(	E	)
The Eraser Tool in Photoshop permanently erases 

pixels on a layer. It can also be used to paint in a 

previous history state.

Background	Eraser	Tool	(	E	) The Background Eraser Tool erases areas of similar 

color in an image by painting over them.

Magic	Eraser	Tool	(	E	)
The Magic Eraser Tool is similar to the Magic 

Wand Tool in that it selects areas of similar color 

with a single click. But the Magic Eraser Tool then 

permanently deletes those areas.

Blur Tool * The Blur Tool blurs and softens areas you paint over 

with the tool.

Sharpen Tool The Sharpen Tool sharpens areas you paint over.

Smudge	Tool
The Smudge Tool in Photoshop smudges and 

smears the areas you paint over. It can also be used 

to create a finger painting effect.

Dodge	Tool	*	(	O	) Paint over areas in the image with the Dodge Tool to 

lighten them.

Burn	Tool	(	O	) The Burn Tool will darken the areas you paint over.

Sponge	Tool	(	O	)
Paint over areas with the Sponge Tool to increase or 

decrease color saturation.
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	 S.No																 Tool	Pic											 	Funtion	of	the	Tool

Painting tools

Brush	Tool	*	(	B	) The Brush Tool is Photoshop's primary painting tool. 

Use it to paint brush strokes on a layer or on a layer 

mask.

Pencil	Tool	(	B	)
The Pencil Tool is another of Photoshop's painting 

tools. But while the Brush Tool can paint soft-edge 

brush strokes, the Pencil Tool always paints with 

hard edges.

Color	Replacement	Tool	(	B	)
Use the Color Replacement Tool in Photoshop to 

easily replace the color of an object with a different 
color.

Mixer	Brush	Tool	(	B	)

Unlike the standard Brush Tool, the Mixer Brush in 

Photoshop can simulate elements of real painting 

such as mixing and combining colors, and paint 

wetness.

History	Brush	Tool	*	(	Y	)
The History Brush Tool paints a snapshot from an 

earlier step (history state) into the current version 

of the image. Choose the previous state from the 

History panel.

	Art	History	Brush	Tool	(	Y	)
The Art History Brush also paints a snapshot from an 

earlier history state into the image, but does so using 

stylized brush strokes.

Gradient	Tool	*	(	G	)
Photoshop's Gradient Tool draws gradual blends 

between multiple colors. The Gradient Editor lets you 

create and customize your own gradients.

Paint	Bucket	Tool	(	G	)

The Paint Bucket Tool fills an area of similar color with 
your Foreground color or a pattern. The "Tolerance" 

value determines the range of colors that will be 

affected around the area where you clicked.

3D	Material	Drop	Tool	(	G	)
Used in 3D modeling, the 3D Material Drop Tool lets 

you sample a material from one area and then drop 

it into another area of your model, mesh or 3D layer.
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	 S.No																 Tool	Pic											 	Funtion	of	the	Tool

Drawing and Type tools

		Pen	Tool	*	(	P	)

Photoshop's Pen Tool allows you to draw extremely 

precise paths, vector shapes or selections.

 Freeform	Pen	Tool	(	P	)

The Freeform Pen Tool allows you to draw freehand 

paths or shapes. Anchor points are automatically added 

to the path as you draw.

  Curvature	Pen	Tool	(	P	)

The Curvature Pen Tool is an easier, simplified 
version of the Pen Tool. New as of Photoshop CC 

2018.

  Add Anchor Point Tool

Use the Add Anchor Point Tool to add additional anchor 

points along a path.

 Delete Anchor Point Tool

Click on an existing anchor point along a path with the 

Delete Anchor Point Tool to remove the point.

 Convert	Point	Tool

On a path, click on a smooth anchor point with the 

Convert Point Tool to convert it to a corner point. Click a 

corner point to convert it to a smooth point.

   Horizontal	Type	Tool	*	(	T	)

Known simply as the Type Tool in Photoshop, use 

the Horizontal Type Tool to add standard type to your 

document.

 Vertical	Type	Tool	(	T	)

The Vertical Type Tool adds type vertically from top to 

bottom.

 Vertical	Type	Mask	Tool	(	T	)

Rather than adding editable text to your document, the 

Vertical Type Mask Tool creates a selection outline in the 

shape of vertical type.

 Horizontal	Type	Mask	Tool	(	T	)

Like the Vertical Mask Type Tool, the Horizontal Type 

Mask Tool creates a selection outline in the shape of 

type. However, the type is added horizontally rather than 

vertically.
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	 S.No																 Tool	Pic											 	Funtion	of	the	Tool

 Path	Selection	Tool	*	(	A	)

Use the Path Selection Tool (the black arrow) in 

Photoshop to select and move an entire path at once.

 Direct	Selection	Tool	(	A	)

Use the Direct Selection Tool (the white arrow) to select 

and move an individual path segment, anchor point or 

direction handle.

 Rectangle	Tool	*	(	U	)

The Rectangle Tool draws rectangular vector shapes, 

paths or pixel shapes, with sharp or rounded corners. 

Press and hold Shift as you drag to force the shape into 

a perfect square.

 Ellipse	Tool	(	U	)

The Ellipse Tool draws elliptical vector shapes, paths or 

pixel shapes. Press and hold Shift as you drag to draw 

a perfect circle.

   Triangle	Tool	(	U	)

The Triangle Tool draws triangle shapes. Hold Shift to 

draw an equilateral triangle, or use the Radius option to 

round the corners.

   Polygon	Tool	(	U	)

The Polygon Tool draws polygonal shapes with any 

number of sides. Use the Star Ratio option to turn 

polygons into stars.

  Line	Tool	(	U	)

The Line Tool draws straight lines or arrows. Use the 

Stroke color and weight to control the appearance of the 

line.

  Custom	Shape	Tool	(	U	)

Photoshop's Custom Shape Tool lets you select and draw 

custom shapes. Choose from Photoshop's hundreds of 

built-in custom shapes or create your own.

Navigation tools

		Hand	Tool	*	(	H	)

The Hand Tool lets us click and drag an image around on 

the screen to view different areas when zoomed in.

   Rotate	View	Tool	(	R	)
Use the Rotate View Tool in Photoshop to rotate the 

canvas so you can view and edit the image from different 
angles.

  Zoom	Tool	*	(	Z	)

Click on the image with the Zoom Tool to zoom in on a 

specific area. Press and hold Alt (Win) / Option (Mac) 
and click with the Zoom Tool to zoom out.
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IT & ITES Related Theory for Exercise 1.8.78 - 80

DTPO - Adobe Photoshop

Photoshop	menu	bar	
Objectives: At the end of this lesson you shall be able to

•	 Introduction	of	menu	bar

Introduction	to	menu	bar
One of the basic elements of Adobe Photoshop is the 

menu bar, located at the very top of the program. The 

menu bar is used to open and save files, adjust the 
canvas size, access some of the editing tools, open and 

close various windows, and more.

File,	Edit,	Image,	Layer,	Select,	Filter,	Analysis,	3D,	
View,	Window, and Help. Each of those main menus 

has additional submenus for related options.

You can access most of what's available in the menu 

bar in other ways, too, like via keyboard shortcuts, right-

click menus, or with separate menus located within 

other windows like Tools, Layers, Timeline, etc. For 

some options, however, you have to use the menu bar.

These instructions apply to Adobe Photoshop CS5 and 

later. Some menus and items may be different in other 
versions.

Fig 1

File
The File menu in Photoshop is much like the File menu 

in other programs. It's the primary method for making 

new files, opening existing ones, saving files, and 
printing.

For example, if you've just opened Photoshop and you 

want to import a PNG or JPG file, you can use the File 
menu to select Open to browse for the picture you want 

to use. Advanced open operations are supported.

The Open Recent option under the File menu contains a 

list of the 10 most recently opened files. So long as you 
haven't moved the original file elsewhere, you can use 
that option to quickly re-open a file without having to go 
through the normal "open, select, browse" procedure.

It's also the File menu that lets you convert a video into 

frames so that you can edit each frame or turn a video 

into a GIF.

Edit

Fig 2
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With the Edit menu, you can modify objects on the 

canvas, menu items, shortcuts, and more.

For example, you can do simple things like undo or redo 

a recent action, as well as cut, copy, and paste. Those 

are common actions, so you'll find yourself using those 
menu options often, or at least learning their keyboard 

shortcuts.

The Edit menu is also one place where you deal with 

text, so you can find and replace words and phrases 
throughout a document. It's also where you'll find the 
options to Fill selections or add a Stroke along a 

selected path.

Also here are tools for transforming objects. If you have 

an image you want to warp, rotate, scale, distort, or 

flip, use the Edit	>	Transform submenu to find those 
options. The Free	 Transform tool is located here as 

well, letting you adjust the height, width, and orientation.

The Edit menu is how you open Preset Manager to 

view brushes, gradients, swatches, custom shapes, 

and load your own custom ABR brushes.

 This menu is used to locate existing keyboard shortcuts 

and define new ones, too, and to change general 
preferences for how Photoshop works and to show/hide 

which items are visible on the menu bar.

Image

Fig 3

Many options related to changing images in Photoshop 

are available under the Image menu. The first submenu 
let you change the mode of the whole canvas, between 

modes like RGB color, grayscale, CMYK color, 

multichannel, duotone, and more.

Next is a submenu called Adjustments that lets you 

access various tools for changing an image's brightness, 

contrast, levels, exposure, vibrance, hue/saturation, and 

color balance. Also here are the Photo	Filter, Channel	
Mixer, and Color	Lookup tools, among others.

Auto	Tone,	Auto	Contrast, and Auto	Color are options 

that will make changes to how an image looks without 

menus or sliders.

Some important canvas manipulation tools are in the 

Image menu, called Image Size and Canvas	 Size. 

You'd use the Canvas Size option to change the width 

and height of the whole working area to make it the 

exact size it needs to be or to shrink or grow the canvas.

Crop and Trim are two other notable tools in this menu. 

The first resizes the canvas by manually selecting which 
areas should be deleted. The second is for automating 

the resize by removing transparent pixels (or pixels of a 

specific color) from any edge of the canvas.

Layer

Fig 4
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The Layer menu is where you can create new layers, 

duplicate existing ones, delete and rename layers, and 

much more.

Also in this menu are options for creating layer masks, 

adjustment layers, and fill layers. A fill layer, for example, 
is a new layer pre-populated with a specific color, 
pattern, or gradient, which you get to choose when you 

click it.

You can also use the Layer menu to create and edit 

Smart Objects, as well as export their contents to a 

file or replace their contents with that of another Smart 
Object.

Other options in the Layer menu let you group and hide 

layers, lock layers, arrange layers behind or in front of 

other ones, link and merge layers, and flatten the image 
to automatically merge all the layers.

Select

Fig 5

Options pertaining to selections are stored in Photoshop's 

Select menu. You can select everything on the canvas, 

select all the layers, and deselect everything from this 

menu. A couple related and useful tools let you invert 

the selection and re-select a prior selection.(Fig 5)

A Refine Edge tool is in the Select menu. You use it 

to change the edge of a selection. You can adjust the 

smooth, feather, contrast, and shift edge settings to 

define specific selection details.

Grow automatically increases a selection to nearby 

pixels to effectively increase the overall selection area. 
Keep clicking it to get a broader selection.

Use Save Selection and Load	Selection to re-select 

something later. You can save a new selection and then 

load it when you need to re-apply it.

Filter

Fig 6

Adobe Photoshop filters are contained in the Filter 
menu. It's here that you can open Filter	 Gallery to 

preview artistic, brushstroke, distort, sketch, texture, 

and other built-in filters. (Fig 6)

This menu also contains filters for blur, noise, pixelate, 
render, and sharpen. To save or load a custom 

Photoshop filter, go to Filter > Other > Custom and 

use the Load button to locate the ACF file, or the Save 

button to make a new ACF file.

3D

Photoshop isn't just for flat images anymore. Newer 
versions of the software let you create and edit 3D 

objects for both modeling and printing purposes.(Fig 7)

The 3D menu houses the tools you need to modify 3D 

files and make them look as good as possible. If you 
don't have one to start from, you can create 3D objects 

from layers you've already made.

View
The View menu includes tools related to how you see 

things in Photoshop. You can enable a ruler, create 
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Fig 7

guides that you can follow for precise positioning, and 

change over to full-screen mode.

Some common options in Photoshop's View menu are 

for zooming. These settings include zooming in and out, 

auto-fitting the canvas to the same size as the screen, 
showing the actual pixel size, and displaying the print 

size.

Other things you can show or hide from the View menu 

include selection edges, target paths, notes, layer 

edges, edit pins, guides, slices, mesh, pixel grid, and 

brush preview.

Window
Photoshop's Window menu serves two purposes: hiding 

and showing windows and arranging the workspace 

Fig 8

however you like. Since not all available windows are 

visible all the time, use the Window menu to selectively 

show or hide them as you need them.

Use the Window menu to toggle all sorts of windows 

as visible or hidden. Actions,	 Adjustments,	 Brush,	
Channels,	 Color,	 History,	 Layers,	 Notes,	 Paths,	
Timeline, and Tools are a few examples. You won't 

always need them during your projects, so it's a good 

idea to hide them to keep your view from cluttering.
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Use the Arrange and Workspace submenus to adjust 

where the windows are positioned. You can also drag 

and drop windows anywhere you like, even outside of 

Photoshop's main window, but these menus have some 

pre-set options for positioning windows in places that 

are supposed to be easier for certain tasks, like for 

painting and typography.

Fig 9

Help

The Help menu marks the end of Photoshop's menu 

bar. You can see the version of Photoshop you're 

running, get online help, access the Photoshop Support 

Center, learn more about the installed plug-ins, register 

Photoshop with Adobe, and more.
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IT & ITES Related Theory for Exercise 1.8.81- 83

DTPO - Adobe Photoshop

Photoshop	create	and	formatting	document	
Objectives: At the end of this lesson you shall be able to

•	 Create	a	new	document
•	 Formatting	the	document
•	 Edit	and	development	images

Create	a	new	document
• Launch Photoshop.

• Do one of the following:

• Select File > New (or) Ctrl+N

• Click New or Start New in the Start workspace.

• Right-click the tab for an open document and choose 

New	Document from the in-context menu.(Fig 1)

Fig 1

• Click Create. Photoshop opens a new document 

based on the preset.

Modify presets

Before opening a document using the preset, you can 

modify its settings in the right pane.(Fig 3)

• Specify the following options for the selected 

preset:

Width and Height: Specify the size of the document. 
Select the unit from the pop-up menu.

Fig 2

Create	documents	using	presets
• In the New	Document dialog box, click a category 

tab: Photo,	Print,	Art	&	 Illustration,Web,	Mobile, 
and Film	&	Video.

• Select a preset.

• Optionally, change the settings for the selected 

preset in the Preset Details pane on the right. 

Fig 3

Orientation: Specify a page orientation for the 
document: Landscape or Portrait.

Artboards: Select this option if you want your document 
to have artboards. Photoshop adds an artboard while 

creating the document.

Color	Mode: Specify a color mode for the document. 
Changing the color mode converts the default contents 
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of the selected new document profile to a new color.

Resolution: Specify the fineness of detail in a bitmap 
image measured in pixels/inch or pixels/centimetre.

Background contents: Specify a background color for 
the document.

• To specify the following extra options, click Advanced 

Options.(Fig 4)

Color	Profile: Specify the color profile for your document 
from a wide range of options.

Pixel Aspect Ratio: Specify the ratio of width to height 
of a single pixel in a frame.

• Click Create to open a document with the preset 

settings.

Fig4

Formatting	the	document
• JPEG

• JPEG stands for Joint Photographic Experts Group, 

and it’s extension is widely written as .jpg. This most 

used image file format is used to store photos all over 
the world, and is generally a default file format for saving 
images. In fact, most of the images you find online will 

download as .jpg files.

Fig 5

• JPEG files come in different quality levels like 
low, medium and high. Low quality JPEGs are more 

compressed than high quality versions. So, if you 

need a high quality image, you’ll need to choose a less 

compressed JPEG option.

• Most commonly, JPEG images are great for sharing 

on social media, via email and on websites. These files 
are relatively small, so they take up less space on your 

memory cards and computer storage. Beware, though, 

that saving images as JPEGs can compromise the 

quality of that image.

When	to	Use	JPEG	Image	Format:
• Complex images with a lot of different colors, like 

photographs

• To compress highly detailed images

• For print

• PNG

• PNG stands for Portable Network Graphics. It’s an 

important file format that helps a lot in photo editing. You 
can use PNGs for completely transparent backgrounds 

or drop shadows (partial transparency) for the great 

effects.

• This image format will not sacrifice the quality and 

Fig 6

details of the photos, but that means that they are 

typically larger in size than JPEGs. Thus, PNGs are 

best for small images like logos.

When	to	Use	PNG	Image	Format:
• Images with transparency

• Small images, like logos

• Online

• To retain the quality of a detailed image, provided 

that you have storage for a larger file size

• GIF
• GIF stands for Graphics Interchange Format, and 

it’s quite similar to PNG in terms of its image quality 

preservation. With GIF image files, you can also 
create short animations for web.

• This image format has a smaller color range, so it’s 

not suitable for all photos. Like PNG, GIF images 

can be transparent. But, unlike PNG, GIF doesn’t 

support partial transparency, which means you can’t 

use them to preserve shadow effects in your photos.

When	to	Use	GIF	Image	Format:
• For simple images with few colors, like icons

• For animated images

• PSD

• PSD stands for Photoshop Document. When you 

save an image from Adobe Photoshop, the program’s 

default is to save that photo as a PSD file. 

• This file format is not suitable for web, nor is it suitable 

IT	&	ITES	-	DTPO	(NSQF	-	Revised	2022)	-	Related	Theory	for	Exercise	1.8.81	-	83

©
 N

IM
I 

N
O
T
 T

O
 B

E
 R

E
P
U
B
L
IS

H
E
D



154

Fig 7

Fig 8

for clients because it isn’t versatile. However, it is 

one of the best image formats for maintaining the 

quality of your image over a long period of time.

• You should save your edited images as PSDs, 

especially if you intend to revisit them in Photoshop 

for additional retouching. You’ll need to make sure 

that your layers are not merged before you save 

your PSD file, or you’ll lose some of your editing 
capabilities.

When	to	Use	PSD	Image	Format:
• To save images you may edit again in the future

• To retain the quality and detail of images you want to 

print

• TIFF
• TIFF stands for Tagged Image File Format, and it is 

known as the most used file format by photographers 
and designers. Images stored as TIFF files are 
best for post-processing, because they are not 

compressed at all.

Fig 9

Fig 10

This is the best way to edit photos.

My first recommendation is to extra protect your original 
by always creating a first layer that simply duplicates it 
by pressing Ctrl+J (Cmd+J for mac users).

Then you can start adding other layers on top with your 

modifications.

Layers add a lot of flexibility to the workflow because 

you can:

• reorganise them (by click and dragging them);

• rename them by clicking on the layer’s name; 

    (Fig 11)

• modulate their intensity by adjusting their Opacity 

(using the Opacity slide);

• activate and deactivate them to check their effect 
(clicking on the eye icon);

• With TIFF files, you can create all kinds of digital 
images. You can use TIFFs with any photo editing 

software to perfect your photos, and you can re-save 

TIFFs as any other file format. Although TIFF files 
take up more space on your devices, they provide 

you a lot of flexibility.

When	to	Use	TIFF	Image	Format:
• For images you want to store without losing details

• For images you need to print

Edit	and	development	images
•	 Make	 Non-Destructive	 Edits	 With	 Photoshop	

Layers
One of the most powerful editing tools in Photoshop 

(PS) are layers. Layers are like sheets of paper that 

are stacked one on top of the other. There is a panel 

dedicated to layers.

When you open a photo in PS, you will just have the 

Background layer. This corresponds to the original 

photo. (Fig 10)

In Photoshop, if you work directly on your background 

picture, any change you do modifies the pixels of the 
original photo.

Setting up and editing through layers will allow you to 

edit your photo in a non-destructive way. This means 

that you can come back to the original one at any time. 
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Fig 11

• and delete them (dragging them to the trash icon).

• Edit	Pictures	Using	Adjustment	Layers
An adjustment layer is an editing tool that allows you to 

do different types of modifications to your images. You 
can add them in two ways.

Fig 12

Click on the icon in the layer panel and then choose one 

of the adjustment layer options.

Or go to Layer>New adjustment layer and select one of 

the options.  (Fig 13)

The adjustment layer will appear on top of the previous 

ones you have. You can modify the adjustment using its 

properties panel. The changes will affect all the layers 
below. (Fig 14)

Some suitable options that affect the tonal range or the 

Fig 13

colour of your photo are Exposure, Curves, Vibrance or 

Hue/Saturation.

• Select	Areas	of	Your	 Images	With	 the	Marquee	
and	Lasso	Tools

Fig 14
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You can select areas of your images in several different 
ways.  For selecting areas with specific shapes, you can 
use the Marquee tool.

There is a rectangular shaped one. After right-clicking 

on the icon, you can select the Elliptical shape or even 

a single row/column Marquee tool.

Another way of selecting areas is by using the Lasso 

Tool. With this feature, you can select a free area in 

your images.

With the Basic one (Lasso Tool) you can select areas 

by freehand. The Polygonal Lasso allows you to create 

edges by clicking on points. The Magnetic option is 

great to select along edges.

A great feature for selecting big uniform areas is the 

Magic Wand Tool. It is under the Quick Selection Tool, 

so you need to right-click and select it from the menu.

And if you want to remove any selection, you just need 

to press Ctrl+D (or Cmd+D in a Mac).

• Use	Masks	to	Edit	Just	a	Portion	of	Your	Photo
Masks are automatically added with the adjustment 

curves. The mask is the white square next to the 

adjustment layer icon.

When working with masks. you play with the colours 

white and black. White means that the pixel is active, 

so it is affected by the adjustment layer modifications.

Black means that you mask it, meaning that the pixel is 

not affected by the adjustment layer.

There is also another way to create a mask. First, select 

the area you want to mask and while the selection is 

active, create the adjustment layer.

Photoshop will automatically create the mask with the 

selection.

Learn	to	Straighten	a	Crooked	Photo
Straightening a crooked photo in Photoshop is easy. 

First, you need to use the Measure tool. If you don´t 

see it in your palette, it might be hidden under the 

Eyedropper tool.(Fig 15)

To select it you need to right-click on the Eyedropper 

icon. A little menu appears with the other photo editing 

tools hidden behind.

We need to find in our photo a line that was supposed 
to be straight. It might be the horizon, a wall, a table. It 

will depend on the content of your image. Now we need 

to draw a line along with it.

Click on one side of the line and drag over the line until 

you reach to the end and then click again.

Photoshop measures the angle of this line in reference 

to the rest of the image. You can see the result in the 

Options Bar Menu.(Fig 16)

Now select Image>Rotate Canvas>Arbitrary and write 

the angle you obtained. (Fig 17)

Photoshop automatically fills with the obtained 

Fig 15

measurements the options in the Rotate Canvas Menu. 

Just check that they are correct and press OK.

Fig 16

When you straighten an image, it is common that you 

get some white canvas around.

Fig 17

You can get rid of it by cropping the image with the Crop 

Tool.

Click on one corner of the image and drag until ou get 

the area you want to keep.

Then press Enter/Return to crop.

•	 Lighten	 and	Darken	 Just	 Certain	 Parts	 of	Your	
Image

You can use the Dodge tool for making portions of the 

images lighter. This is handy when you don’t like the 

exposure you got straight from the camera.(Fig 18)
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The Burn Tool is hidden under the Dodge Tool. It works 

exactly the same, but it is darkening the image instead 

of lightening it.

Remove	Unwanted	Objects	With	Content-Aware

Fig 18

There are different ways to Photoshop images to 
remove unwanted objects. 

Start by selecting the area with unwanted objects with 

any selecting tool.

Once selected, right-click and choose ‘Fill’.

A panel appears, and I select “Content-Aware” and 

“Normal” in Blending. I keep the Opacity at 100.(Fig 19)

Photoshop is going to fill the area with the content it 
decides on after searching surrounding areas. And 

most of the times it does a pretty good job.

•	 Add	a	Vignette	to	Drive	Attention	to	the	Centre	of	
the	Images

Vignette means darkening the corners of a photo. It 

drives the viewer’s attention to the centre of the image. 

You don’t have to add a vignette to all your images, but 

in some cases, it provides a nice result. 

Select the central area of your image. You are selecting 

the part that won’t have the vignette. Use the Elliptical 

marquee to do it.

Feather the selection to create a gradual darkening 

effect. Go to Select>Modify>Feather.(Fig 20)

Fig 19

Fig 20

Fig 21

Photoshop will blur those pixels, making them blend 

with the background in a more natural way.

Now you need to invert the selection going to 

Select>Inverse.

Then add a curves adjustment layer and play around 

until you get the vignetting effect you like.(Fig 22)

•	 Save	Photos	in	PSD	to	Keep	All	Your	Changes
A very important part of photo editing is saving your file. 
If you want to keep editing later, you can save it as a 

Photoshop file (psd). This file will keep all your edits and 
layers.

Keep in mind that it has a huge file size. Go to File>Save 
and select PSD from all the options.(Fig 23)

Use this option if you want to keep all the quality of the 

Photoshop file. If you want a smaller file, you can save 
your image as TIFF. That is another of the options in the 

“Save as” menu.                                                            

In the Feather Selection menu, you need to write a 

feather radius. It will depend on the image size, and you 

might need some trial and error. In my case, a radius of 

200 pixels worked fine.(Fig 21)
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Fig 22 Fig 23
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IT & ITES Related Theory for Exercise 1.9.84 - 85

DTPO - CorelDraw 

Formatting and system requirement of coreldraw

Objectives: At the end of this lesson you shall be able to

• compare formatting and design operations

• list of system requirements for coreldraw installing

Compare formatting and design operations

Formatting is how your manuscript looks and reads. 

Things like font size, page color, word count, page 

number, line spacing, paragraph breaks–everything 

that goes into the visual appearance.

• Use A Standard Font (Times New Roman or Arial)

The most common print font is the serif font Times New 

Roman. The most common web font is the non-serif 

font Arial. They both work great. Don’t use anything else 

for your manuscript.

• Black Text on White Background

It’s possible to change the defaults on your word 

processor to something other than black text on a white 

background. If you want to do that while you write, cool–

just switch it back to the regular defaults for submission.

• 12 Point Type

The type size is how big the letters are. 12 point is 

usually the default in a word processor because it’s 

easy to read for most people.

• 8.5 x 11 Page Size

 This is a default page size on most word processors.

• One Inch Margins

One inch margins on the border of the document is the 

standard format. This means the right margins are one 

inch, the left margins are one inch, etc.

This used to be a very important formatting convention 

when manuscripts were submitted as printed 

documents. That doesn’t happen much anymore, so 

this is not important. If you keep the word processor 

defaults, you’ll be fine.

•	 Left	Justified	Alignment
Left justified means that left hand text is aligned, while 
the end of the right hand text is jagged. It looks like this:

Again, that is the default on most word processors.

The thing to avoid is Fully Justified, where each line 
looks the same length, like this:

Your final book may be formatted that way, but do not 
format your manuscript like that.

• One Space After Periods

You should have a single space after a period, not two 

spaces.

If you’re under 40 and confused why I would even 

mention this, it’s because you learned how to type on 

computers. Many of us olds learned typing on manual 

typewriters, and the convention for those was to hit the 

space bar twice and add the extra space to have two 

spaces after a period.

• Double-spaced Text Lines

Most editors, regardless of the type of editor they are, 

prefer to edit manuscripts that are double-spaced. 

Double-spacing means there is an extra line between 

each line of text. It looks like this:

• Paragraph Classic Style: indented with no line  

 space

There are two ways to format paragraphs, you can 

choose the one you like. Just don’t mix and match in 

the same manuscript.

Classic style is paragraphs with an indent at the 

beginning, and no space between new paragraphs. It 

tends to be used in novel manuscripts and short stories.

• Paragraph Modern Style: no indents with line  

 space

Modern style is no indents at the beginning of 

paragraphs, and a space between paragraphs. It tends 

to be used in non-fiction. It looks like this:

• Page Breaks Between Chapters

When you finish one chapter and start a new chapter, 
don’t just hit the return key until you get to a new page. 

Instead, use the “page break” function. What that does 

is insert a new page, without inserting a bunch of hard 

returns and space into the manuscript.

• Number Your Pages 

Editors love to see page numbers. This is for many 

reasons, most of which I don’t think apply in a modern 

world with a search function, but they still insist on them, 

so it’s easier to just add page numbers.

• Send Your Entire Manuscript as One Document

You’re welcome to write in as many documents as you 

need. That’s common practice to put each chapter in its 

own document.

As long as, before you submit for editing, combine 

them all into one document. There is no quicker way 

to enrage your editor than send them a folder with 15 

chapters all in different documents.

• Use Style Function To Format Headings

When you want to make a chapter title or chapter 

©
 N

IM
I 

N
O
T
 T

O
 B

E
 R

E
P
U
B
L
IS

H
E
D



160

number or any sort of heading stand out, the best way 

to do it is to make it a larger or bolder font, right?

Yes, but there is a right and wrong way to do that.

The wrong way is to manually do it. This means changing 

the font size, or underlining it, or italicize it, by itself. 

Doing this can get it to “look” right, but you are risking 

being inconsistent, and making the later formatting very 

hard on the interior designer.

The correct way is to use what is called the “style 

function.” What this does is associate the correct 

heading (H1, H2, H3, etc), which makes everything 

consistent and easier for the interior designer. But 

really, it makes sure your book look the way you want.

• Proper Title Page Layout

There are many acceptable ways to layout a Title Page. 

Generally speaking the Title Page is the first page of the 
manuscript, and needs to include the book title, the sub-

title, the word count, your contact information (including 

email and phone number). You can also have a physical 

address as well. This should all be on the first page.

Here is an example of the format we recommend:

List of system requirements for coreldraw installing

• Windows 11 or Windows 10 (Version 21H1 or later), 

64-bit, with latest Updates

• Intel Core i3/5/7/9 or AMD Ryzen 3/5/7/9/

Threadripper, EPYC

• OpenCL 1.2-enabled video card with 3+ GB VRAM

• 8 GB RAM

• 9 GB hard disk space for application and installation 

files

• Mouse, tablet or multi-touch screen

• 1280 x 720 screen resolution at 100% (96 dpi)

• Internet connection is required to install and 

authenticate CorelDRAW Technical Suite and 

access some of the included software components, 

online features and content

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.9.84 - 85
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IT & ITES Related Theory for Exercise 1.9.86-87

DTPO - CorelDraw

Various versions of coreldraw and features 

Objectives: At the end of this lesson you shall be able to

•	 discuss	the	benefits	of	using	coreldraw
• var ious coreldraw versions

Discuss	the	benefits	of	using	coreldraw
Coreldraw 

Coreldraw is a vector graphics designing software that 

is offered by Corel Corporation. It is a multiple functional 
software that is us ed by a number of graphic designers 

for their graphics professional work. 

Benefits	of	Coreldraw
• Coreldraw is Vector graphics editor and designer 

software so it offers us a number of exciting tools 
that make the working of CorelDRAW software easy. 

Coreldraw offers some geometrical shapes as a tool 
that helps you in exploring your idea in your own way 

without any limitations. You can make professional 

logos, brochures, business cards, and other 

advertising elements with the bits of help of these 

tools and can give them different looks according to 
the requirement of your client.

• You will have some artistic tools in features of 

Coreldraw software which will help you in designing 

very complex and eye-catching drawings with 

different types of logical ideas.

• Coreldraw offers you the different types of brushes 
that help you in creating a detailed image with a 

realistic look. 

• In Coreldraw, we have a Layer system also just as 

Illustrator and Photoshop software which helps in 

working with different layers of an image without 
damaging originally of the individual layer.

• Corel Corporation designed Coreldraw in this way 

so that it can work with its other design-oriented 

software that is Corel Photo-Paint. 

• You can also design a 3d object or logo in Coreldraw 

software as a vector image with the help of its 

exciting tools and features which will add plus point 

to your designing works.

• Coreldraw software is also used for making an image 

of PNG and CDR file format which makes that image 
usable for other designing software.

• You can use Coreldraw software for creating QR 

codes, and generation of page layouts with some 

special effects for a particular theme.

• In Coreldraw we have Text Tool also which offers 
you designing of different types of Text logos, helps 
in write designer matter of magazines as well as 

you can make typographical works in Coreldraw 

software.

• Coreldraw software is generally working for printable 

projects. So you can use it for print-oriented work 

with its high-level adjustment features for printed 

items.

Various CorelDraw Versions 

Coreldraw Version 1 (1989)

This first version Of CorelDraw required IBM PC 286 
with 640K RAM, and a hard disk DOS 3.0 graphic card 

& tablets. It was used to add some effect to 2D &3D 
design with AutoCAD import and export effect.

Coreldraw Version 2 (1991)

This allows you to merge text with graphic effects 
and allow you to print them. You can also blend, and 

envelope objects or shapes. The extrusion tool helps for 

distorting objects or models that introduce the concept 

of blending two artworks or objects into one. 

Coreldraw Version 3 (1992)

It was a bundled version that has Corel Photo-Paint, 

CorelShow, Mosaic, CorelTrace, and CorlChart. All of 

these software offers the option of maintaining graphic 
charts and screen presentation creation which supports 

Windows 3.1 devices.

Coreldraw Version 4 (1993)

This Coreldraw best version has photo paint for 

bitmap editing and CorelSHOW for creating on-screen 

presentations. It is one of the common choices of product 

in this CorelDRAW version list. The CorelMOVE for 

animation and the Mosaic with CorelTRACE help you 

to get done amazing artwork. Its multiple capabilities, 

envelope tool, and clone tool help for elastic node 

editing.

Coreldraw X3

It is equipped with the double click crop tool with that 

you can crop vector images at the same time. The 

Chamfer, Fillet, Emboss tool, and Image adjustment 

lab. Performances are fascinating. Its Trace became 

integrated inside DRAW’s PowerTRACE.

Coreldraw X4

This best version of CorelDRAW introduces the concept 

of sharing, table tool, Independent page layer, and live 

text formatt ing. This support for Raw camera files 
makes it a multi-feature editing app. This CorelDraw 

version supported devices Windows XP, Vista, 7, and 8.
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Coreldraw X5 

 It is one of the best choices of product in this CorelDRAW 

all version list. Corel CONNECT introduced it with an in-

built content organizer. It allows you color consistency 

in every platform with PANTONE color profiles. The 
Pixel mode of CorelDRAW GraphicsSuite X5 let users 

create realistic graphics. It supports Windows 7, Vista, 

and XP in 32 and 64-bit editions with up to 512GB RAM.

Coreldraw X6

CorelDRAW Graphics Suite X6 was developed for 

designing large sizes of files. Its styles help you to 
design any art with consistency if you are working to 

create multiple drawings, documents, & text. Through 

this, you can create a layout for a huge project. It 

supports Windows 7 or higher devices and requires 

1GB of space.

Coreldraw X7

In this CorelDRAW version list, this version comes 

under one of the revolutionary art editing apps. 

CorelDRAW X7 Graphic Suite has an easy use and 

a customizable user interface. You have control over 

the text, colors, transition, and every other editing tool. 

Corel PHOTO-PAINT supports PSD files that make it 
easy to get access to the designing files from anywhere. 
The RAW file supports more than 300 types of cameras. 
The digital assets provide users with more than 10000 

ClipArt images, 200 photos, and 600 templates. This 

supports Windows 7, 8, & 8.1 which requires a minimum 

of 2GB RAM.

Coreldraw X8

CorelDRAW Graphics Suite X8 supports 4K displays 

that create designed stuff clearly like comics characters, 
logos, and web graphics. It was quite an advanced 

editing app amongst other CorelDRAW version list. This 

supports Windows 7 to 10 which require 2GB RAM and 

1GB of hard disk space.

Coreldraw Graphic Suite (2017)

This latest version let you design in real-time with a live 

sketching option. It is easy to use on any pen-enabled 

device like a tablet. Live sketch and AI program help 

you to make your design more perfect. You can use its 

premium plugins and extension.

Coreldraw Graphic Suite (2018)

This version improves the speed and workflow of 
designers. An additional option for creating photo 

collages available you can build mosaic tiles with 

Photococktail that transform into amazing collages. 

This was quite a multi-function art and editing app in the 

CorelDRAW version list.

Coreldraw Graphic Suite (2019)

This has a non-destructive effect which makes it easy 
to apply or modify the bitmaps effect. The new form 
of template is easy to control and download easily. 

This supports CDR, PDF, PNG, JPEG, and SVG by 

this you can share your files from any device. Other 
previous features were also upgraded in this version of 

Coreldraw.

Coreldraw Graphic Suite (2020)

It is the upgraded version that is advanced in the form 

of vector illustration, layout, and photo editing, on 

Windows, Mac, or the Web. This was the favorite editing 

and art app of users in the CorelDRAW best version 

list. The one-click image enhancements that make the 

latest in machine learning offer you 10 times faster 
performance. You can get the

Coreldraw Graphic Suite (2021)

This CorelDraw version list updated its image-editing 

and pixel-based design program font variety and 

management tools. The victor to bitmap tracing and 

more than 7000 clipart, more than 1000 digital photos, 

more than 150 templates, and 1000 plus true type with 

open type fonts. It is still in use as the CorelDRAW latest 

version. The CorelDRAW Graphic Suite promo code 

help to let you get this product with a great discount.

Coreldraw Graphic Suite (2022)

The Coreldraw Graphic Suite 2022 is the most recent 

app version launched by Corel Corporation. The latest 

Corel DRAW version list has new adjusted presets, 

multiple view pages, and a face. This offers a multi-
asset export option. It has a user-friendly interface that 

let you customize shortcut keys.

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.9.86-87
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IT & ITES Related Theory for Exercise 1.9.88-90

DTPO - CorelDraw 

Basics of coreldraw and various tools and uses 

Objectives: At the end of this lesson you shall be able to

• explain coreldraw

• coreldraw tools and uses

Introduction Coreldraw :-

CorelDraw is a software program for editing vector 

graphics

Vector graphics are created in graphics packages and 

consist of objects. Each object can be edited separately, 

meaning that the shape, colour, size and position can 

be changed.

Developed by Ottawa-based software company, 

Corel, CorelDraw, styled CorelDRAW, allows users to 

do things like add special effects such as borders to 
images, in addition to allowing for contrast adjustment, 

colour balancing and more.

One of the handy features of the software is that it can 

also work with multiple layers and multiple pages.

Use of Corel Draw

It is used for designing different artwork like poster, 
logo, cards any vector related graphics. We discuss its 

uses below:

Make a poster in Coreldraw

Designing a poster in Corel is a bit different technique 
than any other thing because there are fewer rules 

which are to be followed.

Here we would learn how to create a background in the 

image below; (Fig 1) it shows how to add images, text, 

and logo.

• Create a basic shape for regular need

The basic shapes we need in our daily life like big 

Fig 1

Fig 2

Fig 3

• We can use it to make a small invitation card.

We can use Coreldraw to make small basic invitation  

cards at home as well as if we know how to make 

basic shapes. It is very useful for us as we don’t 

have to go to any shop for it.(Fig 4)

Fig 4

emoji’s, sketches of cartoons for making stickers, 

the sticker of an animal, a sticker of an automobile, 

etc. Basic shapes are much easier to draw in the 

CorelDraw; we just have to drag and drop some 

shapes like circle,  rectangle, ellipse, line, ovule, etc. 

So we can say that with the uses of CorelDraw, it 

is easy to draw basic shapes. (Fig 2)Either we can 

import images for our needs.(Fig 3)
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Fig 6

• Converting Bitmap to Objects

Converting from BITMAP to object is a bit complicated 

work, but Corel provides an easier way of doing it as 

Corel has a good collection of tools through which 

converting makes easier.

We just have to the right click on Bitmap and select 

what we want to do (Fig 5)

• The quick race is a command that will convert from 

Bitmap to Vector object.

• Centerline trace is a command that tries to extract 

the centreline of your Bitmap and removes the rest.

• Outline trace is a command that tries to extract the 

outline of a Bitmap.

• Using CorelDraw with Other Programs

CorelDraw is designed to work with the other 

software’s as well. The other software that the 

Coral Corporation designs is “Coral Photo Paint”, 

which can be incorporated with Coral Draw. As the 

Graphics designed can be edited and recreated with 

Coral Paint.

Fig 5

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.9.88-90

When we save the graphic, it can be saved in other 

formats that are compatible with the other software. 

It can be saved in formats like PNG, CDR, Jpeg 

etc. These images saved can be opened in Adobe 

Illustrator as well. These all the saved formats makes 

a bond with other designers to make alterations in 

design on the device in an easier way.

Coreldraw Tools and uses (Fig 6)

• Pick Tool = To select, resize, and rotate toward 

the image object. (Fig 7)
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Fig 7

Fig 8

Fig 9

Fig 10

Fig 11

Fig 12

image window

• Hand : Adjusts the images that appear in the image 

window

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.9.88-90

• Shape Edit (Fig 8)

• Shape : Editing an image object shape.

• Smudge Brush : Alter / distort the overall picture 

with attractive shorelines.

• Roughen Brush : Alter / distort the overall outline 

shape drawing by attractive shorelines.

• Free Transform Tools : Transform image objects 

using rotation (rotation)free, rotation angle, and 

resize, and also tilt the image shape.

Crop Tool (Fig 9)

• Crop : Eliminate the unwanted parts in the object.

• Knife : Alter / distort the overall picture with attractive 

shorelines.

• Erase : Remove the area in the picture.

• Virtual Segment Delete : Delete an object that is 

part of the intersection (the intersection).

Zoom (Fig 10)

• Zoom : Change the magnification of the image in the 

Curve (Fig 11)

• Freehand : Draw segments or curves in the form of a 

single line

• Bezier : Drawing curves in the form of a single line 

per point (node) (Fig 12)

•  Artistic      Media Tool : Bring up the generator 

function form (pen), such as brush (brush effect with 
a particular pattern of outward appearance), sprayer 

(spray paint effects), calligraphic (calligraphy pen 
effects), and Pressure (pen effects techniques that 
will form the curved edge without lines). (Fig 13)
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Fig 17

Fig 18

Fig 19

Fig 20

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.9.88-90

Fig 13

•  Pen : Drawing curves in a segment point to point 

(node).(Fig 14)  

Fig 14

• Polyline : Drawing lines and curves in preview 

mode.(Fig 15) 

Fig 15

• Interactive Connector : Combining the two objects 

with a line. (Fig 16)                 

Fig 16

•  3 Point Curve : Draw a curve by specifying the start 

and end point, then the center of the curve. (Fig 17)

• Dimension : Draw a vertical line, horizontal, angular, 

and oblique.

• Smart Tools

• Smart Fill : To create objects of an area then fill with 
color or texture.(Fig 18),(Fig 19,20)
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Fig 23

Fig 25                          

Fig 26

Fig 27

Fig 28

Fig 24

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.9.88-90

• Smart Drawing : To change your pointer graffiti 
images to form the basis of its form or shape that is 

more subtle.

• Rectangle

• Rectangle : To establish terms and boxes.(Fig 21 

&22)

Fig 21

Fig 22

• 3 Point Rectangle : To establish terms and arrange 

boxes with point to point. (Fig 23)

• Ellipse 

• Ellipse : To draw an ellipse to a circle. (Fig 24)

• Object   Tools:

• Polygon : To form a polygon and star symmetrically 

(Fig 25)

• Star : To form stars.

• Complex Star : To form stars with more complex 

shapes with intersection angles. (Fig 26)

• Graph Paper : To establish a similar arrangement 

of tables or boxes such as engineering drawings on 

paper.(Fig 27)

• Spiral : To form a spiral (per) is symmetrical and 

logarithmic.(Fig 28)
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Fig 33

Fig 34

Fig 35

Fig 36

Fig 37

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.9.88-90

• Perfect Shapes

Click Shapes tool in Tool Box (Fig 29)

Fig 29

• Basic Shapes : A variety of forms so as octagonal, 

smiley face, until the triangle.(Fig 30)

Fig 30

• Arrow Shapes : To facilitate drawing arrows with 

various forms of variation form, direction, and 

number of arrowheads.(Fig 31)

Fig 31

Fig 32

• Flowchart Shapes : To facilitate drawing flowchart 
shapes (chart).(Fig 32)

• Banner Shapes : To make it easier to draw shapes 

and symbols tape explosion.(Fig 33)

• Callout : To make it easier to draw and label the 

speech bubble shape. (Fig 34)

• Text Tool :

To make the text directly in the drawing area that serves 

as both an artistic and caption text.(Fig 35)

• Interactive Tools

Click the interactive Tool in Tool Box (Fig 36)

• Interactive Blend : To establish terms and boxes 

(Fig 37)
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Fig 38

Fig 39

Fig 40

Fig 41

Fig 42

Fig 43

Fig 44

Fig 46

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.9.88-90

• Interactive Contour : To establish terms and 

arrange boxes with point to point (Fig 38)

• Interactive Distortion : To distort objects in push / 

pull, zipper, and twister. (Fig 39)

• Interactive Drop Shadow :To insert an object into 

the shadow (Fig 40)

• Interactive Envelope : To change the shape of the 

object by dragging a point (node) on the outline (Fig 

41)

• Interactive Extrude : To form the illusion of depth on 

the object. (Fig 42) 

• Interactive Transparency : To insert a transparent 

effect on the object. (Fig 43)

• Eyedropper

• Eyedropper : To select and copy the relevant 

properties of an object, such as color (fill in the object), 
lines, line thickness, size, and effects(Fig44&45)

Fig 45    

• Paintbucket : To implement the related property of 

an object, such as color (fill in the object), lines, line 
thickness, size, and effects; taken by the eyedropper 
tool, to other objects.(Fig 46)
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Fig 49

Fig 50

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.9.88-90

• Outline (Fig 47)

Fig 47

Fig 48

• Outline Pen Dialog : To access the outline pen

dialog box (Fig 48)

• Outline Color Dialog : To access the color settings

dialog box outline

• No Outline : To eliminate the outline of an object.

• ½ Point Outline : To establish the thickness of ½

point line

• 1 Point Outline : To form a line thickness of 1 point

• 2 Point Outline : To form the 2 point line thickness.

• 8 Point Outline : To form the line thickness 8 points.

• 16 Point Outline : To form the 16 point line thickness.

• 24 Point Outline : To form a 24-point line thickness.

• Color Docker Window : To open the docker for

setting color and object outline.

• Fill Tools

• Fill Color Dialog : To access the settings dialog box

of paint (charger interior of the object) of an object

(Fig 49)

• Fountain Fill Dialog : To access the dialog box filler
color and gradation to the object. (Fig 50)

• Pattern Fill Dialog : To access the dialog box filler
patterns into objects.

• Texture Fill Dialog : To access the dialog box filler
into the texture object.

• Post Script Fill Dialog : To access the dialog box

filler image post-script to the object.

• No Dialog : To eliminate the filler element of an
object

• Color Docker Window : To open the docker for

setting color and object outline.

• Interactive Fill : To fill a variety of fill (filler objects)
into an object.(Fig 51 &52)

• Mesh Fill : To apply network lines on an object may

be useful (Fig 53)
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Fig 51

Fig 52

Fig 53

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.9.88-90
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IT & ITES  Related Theory for Exercise 1.9.91-93

DTPO - CorelDraw 

Vector & Bitmap, and colour pattern 

Objectives: At the end of this lesson you shall be able to

•	 difference	between	Vector	and	Bitmap
• explain CMYK, RGB and Pantone Colours

Fig 1

Bitmap

A Bitmap is a type of graphic that consists of small 

elements called pixels. Bitmap graphics are also called 

raster images.

The pixels hold some color and when they are arranged 

together, they form an image. Whenever you look at 

some screen, you see tiny dots called pixels.

Bitmap graphics are resolution-dependent. That means, 

if you scale them too much, you can lose the image 

quality.

If you zoom out the picture too much, you can see the 

blurry edges, and the image becomes jagged.(Fig 1)

So it is advised that you do not scale bitmap images 

too much. Only slight resizing is possible. The term to 

define the resolution of a picture is dots per inch (dpi).

Photographs are bitmap or raster images. Some of 

the most popular bitmap formats are Photographic 

Expert Group (.jpg), Graphics Interchange Format (.gif), 

Portable Network Graphics (.png), and Tagged Image 

File Format (.tiff).

The outputs of printers and scanners are also bitmap. 

The input-output devices like digital cameras, monitors, 

etc produce bitmap images.

The software that is most widely used for editing 

photographs in Adobe Photoshop.

 Vector

A vector graphic is a type of graphic that uses geometric 

shapes like lines, curves, circles, and polygons to 

compose an image. The mathematical formulas 

establish those points on the grid.(Fig 2)

Vector graphics are not resolution-dependent. That 

means, it is possible to scale them without worrying 

about the picture quality because the mathematical 

formulas redraw the image at that required scale.

This feature has a certain advantage over other types of 

graphics. That is why vector graphics are quite popular 

all over the world. They appear smooth at any resolution.

The most commonly used vector formats are Adobe 

Illustrator File (.ai), Scalable Vector Graphics (.svg) and 

Encapsulated PostScript (.esp).

The software used worldwide to make and edit vector 

graphics are Adobe Illustrator, Corel Draw, Adobe 

InDesign, and also CAD Systems. Logos, clip arts, 

posters, and abstract images are all vector graphics.

In the world of graphic design, vector graphics are used 

almost anywhere. Due to their scalable feature, the logo 

can be put on a billboard and it would still have solid 

colors and consistency.

Animations also require vector graphics because of 

the resolution independency. The animation industry 

makes billions every year so vector graphics are always 

in demand.

Fig 2

Main	Differences	Between	Bitmap	and	Vector
Some of the features that differentiate between Bitmap 
and Vector are given below:

• A bitmap is a type of graphics that are made up of 

small elements called pixels while a vector is a type 

of graphics that is made up of lines and curves.

• The commonly used formats for bitmap are .jpg, 

.gif, .png, .psd, .tiff while the commonly used vector 
graphics are .ai, .svg, .ps, .eps, .svf.

• The basic element of bitmap images is pixels 

whereas the basic element of vector graphics is 
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geometric shapes.

• Resizing a bitmap graphic affects the quality of the
picture while resizing a vector graphic does not affect
its quality.

• Bitmap graphics are mostly photographs while vector 

graphics are mostly logos, icons, and clip arts.

• Bitmap images can be edited through Adobe

Photoshop while vector graphics can be edited

through Adobe Illustrator.

• Bitmap images are comparatively larger than vector

images. Vector images have a smaller file size as
compared to bitmap images.

CMYK

CMYK stands for Cyan, Magenta, Yellow and Key. 

In laymen terms, you can think of this as blue, red, 

yellow and black. The CMYK color model is also called 

“process color” or “four color”, and it is a subtractive 

color model, which means as the colors overlap, the 

light wavelengths are absorbed and what you see is the 

Fig 3

Fig 5

Fig 6

Fig 4

visible spectrum of wavelengths that weren’t absorbed. 

(Fig 3)

If you don’t care to know the science, just know CMYK 

uses a mixture Cyan, Magenta and Yellow create the 

whole range of colors. Within CMYK you can adjust the 

levels of each color by percentages to produce different 
colors. (Fig  4)

When using CMYK in graphic design, you’re digitally 

assigning a value for each C, M, Y and K to produce 

the desired color. The printing process then mixes those 

exact values to produce the color in print. 

An important thing to understand about CMYK is 

halftoning. The print process actually overlays tiny dots 

of C, tiny dots of M, Y and K over each other to produce, 

what seems to the human eye, a solid tone. Though up 

close you can see it is indeed pixelated.Rather needing, 

say 20 inks, you can provide all 20 colors with just the 

four CMYK values. Whatsmore, halftones allow for nice 

gradients and transparencies.

RGB

Opposite of CMYK is RGB, and this stands for Red, 

Green Blue. RGB is an additive color model, which 

means it adds the color’s light wavelengths together to 

produce new colors.(Fig 5)

RGB is use for digital and electronic coloring — so TV, 

HTML (websites), digital cameras and so forth are best 

suited for RGB color mode.

RGB is a device-dependent color. This means different 
devices may display the RGB values differently.

Pantone

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.9.91-93

Pantone; also known as, Pantone Matching System 

or PMS is actually a company that has created a 

proprietary color space mostly used in printing. Pantone 

is the standard in color matching and standardization. 
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(Fig 6)

Pantone uses the CMYK method to produce what's 

called a spot color; also known as solid color.

Here's the deal, CMYK can look really different from 
screen to screen , and it can look even more different 
in real life print.Pantone set out to solve this problem 

by producing physical swatches of all the colors and 

assigning a numeric value to them (i.e Pantone 103, or 

panton 365C)

Pantone has dozens of physical swatch books and 

digital books to match so you can use the Pantone 

colors in your digital artwork. 

As well, Pantone comes in coated and uncoated, 

which literally refers to the paper the ink is printing on. 

So when you’re designing for print, be sure to take the 

material into consideration for choosing which PMS 

book you’ll be needing.

Printing in Pantone will always produce sharp, consistent 

colors 

When to use CMYK vs. RGB vs Pantone

CMYK

• Collateral print

• Home printing

• When budget is concern

RGB

• Digital

Pantone

• Screen printing

• Textile/product manufacturing

• When color accuracy is important

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.9.91-93
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IT & ITES  Related Theory for Exercise 1.9.94

DTPO - CorelDraw

Coreldraw Screen and page setup

Objectives: At the end of this lesson you shall be able to

• CorelDraw Basic Screen and Parts

• CorelDraw Page Setup

Basic Screen in Coreldraw

• Coreldraw, the application window opens containing 

a drawing window. Although more than one drawing 

window can be opened, you can apply commands to 

Fig 1

the active drawing window only.

• The Coreldraw application window appears below 

(Fig 1)
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Part Description

1. Toolbox A docked bar with tools for creating, filling, and modifying objects in the drawing

2. Document tab A tab displays for each open document to allow you to quickly move between docu-

ments

3. Title bar The area displaying the title of the currently selected drawing

4. Menu bar The area containing pull-down menu options

5. Toolbar A detachable bar that contains shortcuts to menu and other commands

6. Drawing window The area outside the drawing page bordered by the scroll bars and application controls

7. Property bar A detachable bar with commands that relate to the active tool or object. For example, 

when the text tool is active, the text property bar displays commands that create and 

edit text.

8. Docker A window containing available commands and settings relevant to a specific tool or 
task

9. Rulers Horizontal and vertical borders that are used to determine the size and position of 

objects in a drawing

10. Document palette A dockable bar that contains color swatches for the current document

11. Document navigator The area at the bottom left of the application window that contains controls for moving 

between pages and adding pages

12. Drawing page The rectangular area inside the drawing window. It is the printable area of your work 

area.

13. Status bar An area at the bottom of the application window that contains information about object 

properties such as type, size, color, fill, and resolution. The status bar also shows the 
current cursor position.

14. Navigator A button at the lower-right corner that opens a smaller display to help you move around 

a drawing

15. Color palette A dockable bar that contains color swatches

Coreldraw Document Setup

It’s important to learn how to get your document set 

up properly from the beginning, to help your design 

process flow smoothly.

Set a Page Size and Orientation 

• Click Layout ▶ Page setup.

 The Options dialog box appears with the Page size 

page displayed.

• Perform a task from the following table.

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.9.94
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Dialog Box Option Do the following

Choose a preset page size Choose a paper type from the Size list box.

Match the page size and orientation to the printer 

settings

Click Get page size from printer.

Specify a custom page size Type values in the Width and Height boxes.

Set the page orientation Click the Landscape or the Portrait button.

Set the page size and orientation for an individual page 

in a multipage document

Make sure the page you want to change is displayed 

in the drawing window, choose a page size and 

orientation, and enable the Apply changes to current 

page only check box.

Display the page border Enable the Show page border check box.

Add a frame around the page Click the Add page frame button.

Choose a rendering resolution for the document Choose a resolution from the Rendering resolution list 

box.

This option is available only when the Unit of 

measurement is set to Pixels.

Set a bleed limit Enable the Show bleed area check box, and type a 

value in the Bleed box.

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.9.94
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IT & ITES Related Theory for Exercise 1.10.95

DTPO - Cloud Computing 

Introduction to cloud computing

Objectives: At the end of this lesson you shall be able to

• cloud servers and types of cloud server

• introduction of Cloud storage and its types

Cloud servers and types of cloud server

What is a cloud server?

A cloud server is a compute server that has been 

virtualized, making its resources accessible to users 

remotely over a network. Cloud servers are intended to 

provide the same functions, support the same operating 

systems (OSes) a    nd applications, and offer similar 
performance characteristics as traditional physical 

servers that run in a local data center. Cloud servers 

are often referred to as virtual servers, virtual private 

servers or virtual platforms.

Cloud servers are an important part of cloud technology. 

Widespread adoption of server virtualization has largely 

contributed to the rise and continued growth of cloud 

computing. Cloud servers power every type of cloud 

computing delivery model, from infrastructure as a 

service (IaaS) to platform as a service (PaaS) and 

software as a service (SaaS).

How do cloud servers work?

Cloud servers work by virtualizing physical servers to 

make them accessible to users from remote locations. 

Server virtualization is often, but not always, done 

through the use of a hypervisor. The compute resources 

of the physical servers are then used to create and 

power virtual servers, which are also known as cloud 

servers. These virtual servers can then be accessed 

by organizations through a working internet connection 

from any physical location.

In a public cloud computing model, cloud vendors provide 

access to these virtual servers and storage resources 

in exchange for fees that are typically structured as a 

pay-as-you-go subscription model. Cloud computing 

delivery models that include only virtual servers, storage 

and networking are called IaaS. PaaS products provide 

customers a cloud computing environment with software 

and hardware tools for application development, which 

are powered by cloud servers, storage and networking 

resources. In the SaaS model, the vendor delivers a 

complete, fully managed software product to paying 

customers through the cloud. SaaS applications rely on 

cloud servers for compute resources.

Although private cloud servers work similarly, these 

physical servers are part of a company's private, owned 

infrastructure.

Types of cloud servers

An enterprise can choose from several types of cloud 

servers. Three primary models include:

Public cloud servers. The most common expression 

of a cloud server is a virtual machine (VM) -- or compute 

"instance" -- that a public cloud provider hosts on its own 

infrastructure and delivers to users across the internet 

using a web-based interface or console. This model 

is known as IaaS. Examples of cloud servers include 

Amazon Elastic Compute Cloud (EC2) instances, 

Microsoft Azure instances and Google Compute Engine 

instances.

Private cloud servers. A cloud server may also be a 

compute instance within an on-premises private cloud. 

In this case, an enterprise delivers the cloud server to 

internal users across a local area network (LAN) and, in 

some cases, also to external users across the internet. 

The primary difference between a hosted public cloud 
server and a private cloud server is that the latter exists 

within an organization's own infrastructure, whereas a 

public cloud server is owned and operated outside of 

the organization. Hybrid clouds may include public or 

private cloud servers.

Dedicated cloud servers. In addition to virtual cloud 

servers, cloud providers can supply physical cloud 

servers, also known as bare-metal servers, which 

essentially dedicate a cloud provider's physical server 

to a user. These dedicated cloud servers -- also called 

dedicated instances -- are typically used when an 

organization must deploy a custom virtualization layer 

or mitigate the performance and security concerns that 

often accompany a multi-tenant cloud server.

A comparison between private, hybrid and public cloud 

computing delivery models.

Cloud servers are available in a wide range of compute 

options, with varying processor and memory resources. 

This enables an organization to select an instance 

type that best fits the needs of a specific workload. For 
example, a smaller Amazon EC2 instance might offer 
one virtual CPU and 2 GB of memory, while a larger 

Amazon EC2 instance provides 96 virtual CPUs and 

384 GB of memory. In addition, it is possible to find cloud 
server instances that are tailored to unique workload 

requirements, such as compute-optimized instances 

that include more processors relative to the amount of 

memory.

While it's common for traditional physical servers to 

include some storage, most public cloud servers do 

not include storage resources. Instead, cloud providers 

typically offer storage as a separate cloud service, such 
as Amazon Simple Storage Service (Amazon S3) and 

Google Cloud Storage. An organization provisions and 
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associates storage instances with cloud servers to hold 

content, such as VM images and application data.

Benefits	of	cloud	servers
The choice to use a cloud server will depend on the 

needs of the organization and its specific application 
and workload requirements. Some potential benefits 
include:

Ease of use. An administrator can provision a server 

in a matter of minutes. With a public cloud server, 

an organization does not need to worry about server 

installation, maintenance or other tasks that come with 

owning a physical server.

Globalization. Public cloud servers can globalize 

workloads. With a traditional centralized data center, 

admins can still access workloads globally, but network 

latency and disruptions can reduce performance for 

geographically distant users. By hosting duplicate 

instances of a workload in different global regions, 
organizations can benefit from faster and often more 
reliable access.

Cost	 and	 flexibility. Public cloud servers follow a 

pay-as-you-go pricing model. Compared to a physical 

server and its maintenance costs, this can save an 

organization money, particularly for workloads that 

only need to run temporarily or are used infrequently. 

Cloud servers are often used for temporary workloads, 

such as software development and testing, as well as 

for workloads where resources need to be scaled up or 

down based on demand. However, depending on the 

amount of use, the long-term and full-time cost of cloud 

servers can become more expensive than owning the 

server outright. Furthermore, a full breakdown of cloud 
computing expenses is important to avoid hidden costs.

A comparison between cloud servers and physical on-

premises servers.

Challenges of cloud servers

The choice to use a cloud server may also pose some 

potential disadvantages for organizations.

Regulation and governance. Regulatory obligations 

and corporate governance standards may prohibit 

organizations from using cloud servers and storing data 

in different geographic locations.

Performance. Because cloud servers are typically 

multi-tenant environments, and an admin has no direct 

control over those servers' physical location, a VM may 

be adversely impacted by excessive storage or network 

demands of other cloud servers on the same hardware. 

This is often referred to as the "noisy neighbor" issue. 

Dedicated or bare-metal cloud servers can help an 

organization avoid this problem.

Outages and resilience. Cloud servers are subject 

to periodic and unpredictable service outages, usually 

due to a fault within the provider's environment or an 

unexpected network disruption. For this reason, and 
because a user has no control over a cloud provider's 

infrastructure, some organizations choose to keep 

mission-critical workloads within their local data center 

rather than in the public cloud. Also, there is no inherent 

high availability or redundancy in public clouds. Users 

that require greater availability for a workload must 

deliberately build that availability into the workload.

Considerations

When organizations are evaluating the use of cloud 

servers to satisfy their compute needs, there are a few 

key considerations.

• Virtual cloud servers vs. physical servers.

 While virtual cloud servers can be convenient, easy 

to manage and budget-friendly, their use is indicated 

more for highly variable workloads than data-

intensive workloads. Generally, physical servers are 

more customizable and powerful than virtual servers.

• Types of virtualization.

 Though hypervisor-assisted virtualization is the 

most common, there are other types of server 

virtualization, such as hardware, hardware-assisted, 

paravirtualization and OS-level. 

• Security.

 Security remains a major concern for cloud 

technology. Providers should leave no stone 

unturned when it comes to ensuring they have the 

right security options in place for protecting their 

virtual servers.

When considering any type of cloud service, 

organizations should examine the specific cloud servers 
the provider uses -- such as the type, configuration and 
virtualization technology. While use of cloud servers 

for computing tasks can offer customers many specific 
benefits compared to physical servers, certain use 
cases can favor traditional on-premises servers.

Introduction of Cloud storage and its types

While creating a site backup it is very important for 

the website’s security to store backups in a secure 

location. That is where the Cloud Storage comes in. 

Unfortunately, many businesses rely on outdated 

storage solutions (such as local servers), which may 

cause loss of vital data.

What is cloud storage?

Cloud storage is a service which lets you store data by 

transferring it over the Internet or another network to 

an offsite storage system maintained by a third party. 
There are hundreds of different cloud storage systems 
which include personal storage which holds and/or 

backs up emails, pictures, videos and other personal 

files of an individual, to enterprise storage which lets 
businesses use cloud storage as a commercially-

supported remote backup solution where the company 

can securely transfer and store data files or share them 
between locations.

Storage systems are typically scalable to suit an 

individual’s or organisation’s data storage needs, 
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accessible from any location and are application-

agnostic for accessibility from any device. Businesses 

can select from three main models: a public cloud 

storage service which is suitable for unstructured data, 

a private cloud storage service which can be protected 

behind a company firewall for more control over data and 
a hybrid cloud storage service which blends public and 

private cloud services together for increased flexibility.

What is Cloud Storage

Cloud storage is a digital storage solution which 

utilizes multiple servers to store data in logical pools. 

The organizations buy the storage capacity from the 

providers to store user, organization, or application 

data. In past few years, the cloud storage has grown in 

popularity and has become a direct challenger to local 

storage, mainly due to the benefits it provides:

• Security:

The backups are located across multiple servers 

and are better protected from data loss or hacking.

• Accessibility:

The data stored is accessible online regardless of 

location.

• Amazon S3: 

It enables file storage to multiple servers and offers 
file encryption wherein we can share the data 
publicly.

• Google Cloud:

It offers unlimited storage space. It also has the 
ability to resume the file transfer after a failure.

History of Cloud Storage

Cloud computing was invented by Joseph Carl Robnett 

Licklider in the 1960s with his work on ARPANET that 

connects people and data from anywhere at any time.

In 2006, Amazon Web Services introduced storage 

device AWS S3. In 2009, Google released their 

application systems like Google Docs and Google 

Fig 1

sheets. Hence, the cloud has been around and 

functional for quite some time.(Fig 1)

Cloud storage is based on virtualized infrastructure 

and is like cloud computing in terms of accessible 

interfaces, scalability and metered resources. A cloud-

storage service is utilized from an off-premises service 
(Amazon S3).

It refers to a hosted object storage service, but the term 

has broadened to include other types of data storage 

that are now available as a service, like block storage.

Object storage services like Amazon S3, Oracle Cloud-

Storage and Microsoft Azure Storage, Object Storage 

Software like Open Stack Swift are all examples of 

storage that can be hosted and deployed with cloud-

storage characteristics.

Types of Cloud Storage

There are four types of Cloud-Storage as detailed 

below:

Personal Cloud Storage

It is a subset of public cloud-storage that stores 

individual’s data in the cloud and provides the individual 

with access to the data from anywhere. It also provides 

data syncing and data sharing across multiple devices. 

An example of personal cloud-storage is Apple iCloud.

Public Cloud Storage

It is where the enterprise and storage service provider 

are separate and there aren’t any cloud resources 

stored in the enterprise’s data center. The cloud-storage 

provider fully manages enterprise’s public cloud storage.

Private Cloud Storage

The enterprise and cloud-storage provider are 

integrated in the enterprise’s data center. Private cloud 

storage helps in resolving the potential for security and 

performance concerns while still offering the advantages 
of cloud-storage.

Hybrid Cloud Storage

It is a combination of public and private cloud-storage 

where critical data are stored in enterprise’s private 

Fig 2

cloud while other data is stored in public cloud.

Cloud Storage Providers

Consumers and businesses continue to reduce their 

need to rely on local storage by placing files and 
applications in the cloud. (Fig 2)One has to choose a 
provider who will offer the maximum amount of low-cost 
storage and bandwidth, while still keeping your data 

safe.
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Free Cloud Storage

Below is the list of some top rated Cloud Storage 

providers:

Google Drive

Google is one of the giants in cloud-storage.(Fig 3) It 
offers

Free Data Storage up to 15GB – Google Drive is one 

of the most generous cloud offerings. Google storage 
space is also shared with other Google services 

including Gmail and Google Photos. Mobile apps are 

also available for easy access for iOS and Android 

users.

Fig 3

• Backup and Sync Desktop App – It lets you to 

synchronize files from PC to the cloud.

• G Suit Tools – Includes online office tools for word 
processing, spreadsheets and presentations which 

make sharing files with others effortless.

Fig 4

One Drive

One Drive is particularly for Microsoft Windows users. 

(Fig 4) It allows 5GB of free data storage. It has a great 
integration with Microsoft products. The files can be 
edited without downloading. File sharing in One Drive is 
possible with other users even if they aren’t One Drive 

users.

Dropbox

It has a great storage support for third-party apps with 

web interface that remains streamlined and easy-to-

use.(Fig 5)

Fig 5

Fig 6

Fig 7

Dropbox has 2GB of storage space for new users. 

However there are other ways for boosting this space 

without paying, such as inviting friends (500MB for 
referral), completing getting started guide (250MB), etc.

There are desktop apps for Windows, Linux and Mac, 

and mobile apps including Android, iOS and even 

Kindle.

The web version lets you edit files without the need of 
downloading them.

Business Cloud Storage

The examples of Business Cloud-Storage are as 

follows:

Spider Oak

Founded in 2007, Spider Oak is a collaboration tool, file 
hosting and online backup service. (Fig 6)It allows users 
to access, synchronize and share data using a cloud-

based server.

The main focus in Spider Oak is on privacy and security. 

The tool has a very basic design which makes the 

admin console and all central device management very 

straightforward to use. It also includes drag and drop 

feature for organizing files.

Tresorit

Founded in 2011, Tresorit is a cloud storage 
provider based in Hungary and Switzerland.(Fig 7) It 
emphasizes on enhanced security and data encryption 

for businesses and personal users.

It allows you to keep control of your files through ‘zero-
knowledge encryption’ which means only you and the 

chosen few you decide to share with and see your data.

Egnyte

Founded in 2007, Egnyte provides software for 
enterprise file synchronization and sharing.(Fig 8) It 
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Today, Amazon Drive offers free unlimited photo storage 
with an Amazon Prime subscription or a Fire Tablet 
device, and a paid limited storage service. Launched in 

major countries including the U.S., Canada, Germany, 

France, Italy, Spain, the U.K., Japan, and Australia, it 
also functions in Brazil and China as a free limited 5GB 
storage service.

Google Drive

Google Drive is a personal cloud storage service from 

Google that lets users store and synchronize digital 

content across computers, laptops and mobile devices, 

including Android-powered tablet and smartphone 

devices. Support for Apple devices is provided via 

GDrive, the Google Drive client for iPhone and iPad 

devices.

What is Azure Blob storage?

Azure Blob storage is Microsoft's object storage solution 

for the cloud. Blob storage is optimized for storing 

massive amounts of unstructured data. Unstructured 

data is data that doesn't adhere to a particular data 

model or definition, such as text or binary data.

About Blob storage

Blob storage is designed for:

• Serving images or documents directly to a browser.

• Storing files for distributed access.

• Streaming video and audio.

• Writing to log files.

• Storing data for backup and restore, disaster 

recovery, and archiving.

• Storing data for analysis by an on-premises or 

Azure-hosted service.

Users or client applications can access objects in Blob 

storage via HTTP/HTTPS, from anywhere in the world. 

Objects in Blob storage are accessible via the Azure 

Storage REST API, Azure PowerShell, Azure CLI, or an 

Azure Storage client library. Client libraries are available 

for different languages, including:

• . NET

•  Java

•  Node.js

•  Python

•  Go

•  PHP

•  Ruby

About Azure Data Lake Storage Gen2

Blob storage supports Azure Data Lake Storage Gen2, 

Microsoft's enterprise big data analytics solution for 

the cloud. Azure Data Lake Storage Gen2 offers a 
hierarchical file system as well as the advantages of 
Blob storage, including:

Fig 8

allows businesses to store their data locally and online.

It integrates with applications such as Office 365. This 
allows both remote and internal employees to access 

the files with ease.

Advantages of Cloud Storage

The advantages of Cloud Storage include:

• File Accessibility – The files can be accessed at any 
time from any place so long as you have Internet 

access.

• Offsite Backup – Cloud Storage provides 
organizations with offsite (remote) backups of data 
which in turn reduces costs.

• Effective Use of Bandwidth – Cloud storage uses the 
bandwidth effectively i.e. instead of sending files to 
recipients, a web link can be sent through email.

• Security of Data – Helps in protecting the data 

against ransomware or malware as it is secured and 

needs proper authentication to access the stored 

data.

Disadvantages of Cloud Storage

The disadvantages of Cloud Storage include:

• Dependency on Internet Speed – If the Internet 

connection is slow or unstable, we might have 

problems accessing or sharing the files.

• Dependency on a Third Party – A third party service 

provider (company) is responsible for the data stored 

and hence it becomes an important pre-requisite 

in selecting a vendor and to examine the security 

standards prior investing.

• High Cost for Huge Data – Organizations that 

require a large amount of storage may also find 
costs increase significantly even after the first few 
gigabytes of data stored.

• No/ Minimal Control over Data Storage Framework 
– Since the cloud storage framework is entirely 

managed and monitored by the service provider, the 

customer has minimal control over it .

Amazon Drive

Amazon Drive, formerly known as Amazon Cloud Drive, 

is a cloud storage application managed by Amazon. 

The service offers secure cloud storage, file backup, file 
sharing, and Photo printing. Using an Amazon account, 

the files and folders can be transferred and managed 
from multiple devices including web browsers, desktop 

applications, mobiles, and tablets. Amazon Drive also 

lets their U.S. users order photo prints and photo books 

using the Amazon Prints service.
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•  Low-cost, tiered storage

•  High availability

•  Strong consistency

•  Disaster recovery capabilities

Blob storage resources

Blob storage offers three types of resources:

• The storage account

• A container in the storage account

• A blob in a container

The following diagram shows the relationship between 

Fig 9

these resources.(Fig 9)

Storage accounts

A storage account provides a unique namespace in 

Azure for your data. Every object that you store in Azure 

Type of storage account Performance tier Usage

General-purpose v2 Standard Standard storage account type for blobs, file shares, 
queues, and tables. Recommended for most scenarios 

using Blob Storage or one of the other Azure Storage 

services.

Block blob Premium Premium storage account type for block blobs and append 

blobs. Recommended for scenarios with high transaction 

rates or that use smaller objects or require consistently low 

storage latency.

Page blob Premium Premium storage account type for page blobs only.

 Containers

A container organizes a set of blobs, similar to a 

directory in a file system. A storage account can include 
an unlimited number of containers, and a container can 

store an unlimited number of blobs.

Blobs

Azure Storage supports three types of blobs:

• Block blobs store text and binary data. Block blobs 

are made up of blocks of data that can be managed 

individually. Block blobs can store up to about 190.7 
TiB.

• Append blobs are made up of blocks like block blobs, 

but are optimized for append operations. Append 

blobs are ideal for scenarios such as logging data 

from virtual machines.

• Page blobs store random access files up to 8 TiB in 
size. Page blobs store virtual hard drive (VHD) files 
and serve as disks for Azure virtual machines.

Move data to Blob storage

A number of solutions exist for migrating existing data 

to Blob storage:

• AzCopy is an easy-to-use command-line tool for 

Windows and Linux that copies data to and from 

Blob storage, across containers, or across storage 

accounts.

• The Azure Storage Data Movement library is a .NET 

library for moving data between Azure Storage 

services. The AzCopy utility is built with the Data 

Movement library.

• Azure Data Factory supports copying data to and 
from Blob storage by using the account key, a shared 

access signature, a service principal, or managed 

identities for Azure resources. 

• Blobfuse is a virtual file system driver for Azure 
Blob storage. You can use blobfuse to access your 

existing block blob data in your Storage account 

through the Linux file system.

• Azure Data Box service is available to transfer on-

premises data to Blob storage when large datasets 

or network constraints make uploading data over the 

wire unrealistic. Depending on your data size, you 

can request Azure Data Box Disk, Azure Data Box, 

or Azure Data Box Heavy devices from Microsoft. 

You can then copy your data to those devices and 

ship them back to Microsoft to be uploaded into Blob 

storage.

• The Azure Import/Export service provides a way to 

import or export large amounts of data to and from 

your storage account using hard drives that you 

provide.
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IT & ITES Related Theory for Exercise 1.10.96-97

DTPO - Cloud Computing

Cloud function and web hosting 

Objectives: At the end of this lesson you shall be able to

•  function and Features of Web Server

• explain about Web Hosting and Procedure of Web Hosting

Function and Features of Web Server

What is 'Web Server'

A web server is a computer that runs websites. It's a 

computer program that distributes web pages as they 

are requisitioned. The basic objective of the web server 

is to store, process and deliver web pages to the users. 

This intercommunication is done using Hypertext 

Transfer Protocol (HTTP). These web pages are mostly 

static content that includes HTML documents, images, 

style sheets, test etc. Apart from HTTP, a web server 

also supports SMTP (Simple Mail transfer Protocol) and 

FTP (File Transfer Protocol) protocol for emailing and 
for file transfer and storage.
Features of Web Server

• Virtual hosting.

• Support for large files.
• Bandwidth throttling to regulate network traffic and 

mitigate bandwidth congestion.

• Server-side scripting for the creation of dynamic web 

pages.

• Hardware comes with built-in reliability and is 

designed to suit business critical needs and budget 

constraints.

What is the function of a Web server?

The primary function of a web server is to store, process 

and deliver web pages to clients. The communication 

between client and server takes place using the 

Hypertext Transfer Protocol (HTTP).

Web servers are computers that deliver (serves up) 

Web pages. Every Web server has an IP address and 

possibly a domain name. For example, if you enter 
the URL http://www.webopedia.com/index.html in your 

browser, this sends a request to the Web server whose 

domain name is webopedia.com.

Web server and how it works?

A Web server is software or hardware that uses HTTP 

(Hypertext Transfer Protocol) and other protocols to 

respond to client requests made over the World Wide 

Web (WWW). Web server software controls how a user 

accesses hosted files. All computers that host Web sites 
must have Web server software.

Is Google a Web server?

Google Web Server (GWS) is a proprietary web server 

software that Google uses for its web infrastructure. In 

May, 2015, GWS was ranked as the fourth most popular 
web server on the internet after Apache,nginx and 

Microsoft IIS, powering an estimated 7.95% of active 
websites.

Web Server

A program that uses HTTP for serving files that create 
web pages for users in response to their requests that 

are sent by the HTTP clients of their computer is called 

as a web server.

If any server delivers an XML document to another 

device, it can be a web server. In simple words, a web 

server is an Internet server that responds to HTTP 

requests for delivering content and services.

Let’s take an example, if you are working on your 

computer, browsing your web and a message pop ups 

from your friend that “I had just read a great article at the 

following URL: https://www.milesweb.com/blog”.

So, you will insert this URL into your browser and press 

enter. That’s it!

The web server on which your website is based in the 

world doesn’t matter at all as the page you have browsed 

immediately appears on your computer screen.

A web server is never disconnected from internet. Each 

of the web servers has a unique address that comprises 

of a series of four numbers between 0 and 255. These 
numbers are separated with a period.

With the web server, the hosting providers can manage 

multiple domains (users) on a single server.

A web hosting provider rents the space on a server 

or cluster of servers for people to create their online 

presence with a website.

Types of Web Servers

There are mainly four types of web servers – Apache, 

IIS, Nginx and LiteSpeed.

Apache Web Server

Apache web server (Fig 1) is one of the most popular 
Fig 1
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web servers developed by the Apache Software 

Foundation. Open source software, Apache supports 
almost all operating systems such as Linux, Windows, 

Unix FreeBSD, Mac OS X and more. Approximately, 
60% of the machines run on Apache Web Server.
You can easily customize an apache web server due to 

its modular structure. Since it’s an open source, your 

own modules can be added to the server when you 

want to make modifications to suit your requirements.
It is highly stable as compared to other web servers and 

the administrative issues on it can be resolved easily. 

It is possible to install Apache on multiple platforms 

successfully.

The Apache’s latest versions offer you the flexibility 
to handle more requests when compared to its earlier 

versions.

IIS Web Server

A Microsoft product, IIS is a server that offers all the 
features such as Apache.(Fig 2) Since it’s not an open 
source, adding personal modules as well as modifying 

becomes a bit difficult.
It supports all the platforms that run Windows operating 

system. Additionally, you also get good customer 

support, if there is any issue.

Nginx Web Server

Nginx is the next open source web server after Apache. 

(Fig 3)It comprises of IMAP/POP3 proxy server. 
The significant features offered by Nginx are high 
performance, stability, simple configuration and low 

internet and is a commercial web server.(Fig 4)
When you upgrade your web server to LiteSpeed, you 

will experience improved performance that too with low 

operating cost.

This server is compatible with the most common 

Apache features such as .htaccess, mod_rewrite and 

mod_security.

It has the ability to load Apache configuration files 
directly and work as a drop in replacement Apache with 

almost all the hosting control panels. It can replace the 

Apache within 15 minutes without any downtime.
LSWS replaces all the Apache functions which other 

front-end proxy solutions can’t do to simplify the use 

and make the transition from Apache smooth and easy.

Explain about Web Hosting and Procedure of Web 

Hosting

Web Hosting

Web Hosting is an online service that makes your 

website’s content accessible on the internet. When you 

purchase a hosting plan, you are renting space on a 

physical server to store all the website’s files and data.
Web hosts provide the technology and resources 

required for the effective and secure operation of your 
website. They are responsible for keeping the server 

up and running, implementing security measures, and 

ensuring that data such as texts, photos, and other files 
are transferred successfully to the visitors’ browsers.

In this lesson, you will learn what web hosting is, how it 

works, and what are the different types of web hosting 
available.

How Does Web Hosting Work?

The server that hosts your website is a physical 

computer that runs continuously to make the site 

available for visitors all the time. Buying servers for web 

hosting will alow you to store all the data of your website 

in the those servers of your provider.

Once a user enters your domain name into their 

browser’s address bar, the web host’s server will 

transfer all the files necessary to load your website.
You can host a website yourself, but it requires 

extensive technical skills. Self-hosting entails setting 

up and configuring a web server from scratch, including 
the equipment, infrastructure, hardware, and software. 

Furthermore, you will also have to handle all the ongoing 
maintenance.

A web hosting service provider ensures that your 

website performs optimally and with better security 

protocols. In addition, it simplifies the many complex 
aspects of hosting a website – from software installation 

to technical support.

Fig 3

Fig 4

Fig 2
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resource usage.

No threads are used to handle the requests by Nginx, 

instead a highly scalable event-driven architecture that 

uses small and predictable amount of memory under 

load is utilized. It has become popular recently and 

hosts about 7.5% of all the domains globally. Many web 
hosting companies have started using this server.

LiteSpeed Web Server

A high-performance Apache drop-in replacement, 

LiteSpeed (LSWS) is the 4th popular web server on the 
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Types of Web Hosting Services

With numerous web hosting options available, it can 

be challenging to determine which one is best for your 

website.

Most web hosts offer different hosting packages for 
different types of customers – from business website 
owners to personal blog creators.

Ideally, you should start with the simplest hosting 

solution. Once your site gets more traffic, you can 
upgrade to a more advanced plan.

Let’s take a look at some of the most popular types of 

hosting available.

Shared Hosting

With shared hosting, multiple users share the same 

server resources, including memory, processing power, 

and storage space.

Because of its simplicity and affordability, shared web 
hosting is an excellent solution for small businesses 

and personal websites that do not require advanced 

configuration or higher bandwidth. Hence, shared 
hosting is an excellent choice for beginners that need 

affordable hosting to start.
Pros

• Cost-effective, ideal for small-scale websites
• Technical expertise is not required

• Pre-configured server options
• No need to take care of maintenance and server 

administration

Cons

• Minimal access to server configuration
• Increased traffic on other websites can affect your 

website’s speed

Virtual Private Server (VPS) Hosting

With this web hosting type, your website also shares 

a physical server with other users, but the web host 

creates a virtual partition for each user. Thus, a site 

hosted on a virtual private server get an allocated 

amount of resources.

VPS web hosting is a great option for medium-sized 

sites, eCommerce shops, and large blogs with a rapidly 

growing number of visitors.

Pros

• Dedicated server space

• Increased traffic on other websites has no impact on 
your site’s performance

• Root access to the server

• High customizability

Cons

• Users need technical expertise to manage it

• Even though it’s relatively affordable, some users 
may have to hire a developer to manage the virtual 

server, increasing the overall costs

Cloud Hosting

This web hosting solution uses several virtual servers 

to host sites. Thus, if one server experiences high traffic 
or a problem, the remaining ones will take over and 

maintain the website operating.

Since cloud hosting relies on a cluster of web servers to 

function, businesses with multiple websites and large-

scale sites like eCommerce shops can benefit the most 
from it, as it provides little to no downtime.

Pros

• Reduced likelihood of downtime and hardware 

failure

• Uses load balancing to handle high traffic and 
prevent DDoS attacks

• Scalability – your website is not limited to the 

resources of a single server

Cons

• Root access is not always provided

• It is more expensive than VPS and shared hosting

WordPress Hosting

This type of CMS web hosting service provides a 

WordPress-optimized server environment to help your 

site load faster and minimize potential issues. However, 

other types of web hosting still work for websites based 

on this popular content management system (CMS).

Typically, the best WordPress hosting plans come with 

features such as pre-installed themes, plugins for core 

functions like caching and security, and other tools.

Pros

• Low cost and beginner-friendly

• Optimized performance for WordPress sites

• Customer support team trained in WordPress issues

• Pre-installed WordPress plugins and themes

Cons

• Not an ideal type of web hosting for non-WordPress 

websites

Dedicated Hosting

Dedicated hosting designates a physical server for 

each website. By going with dedicated hosting, you can 

configure the server, choose your desired operating 
system and software, and customize the entire hosting 

environment to your specifications.
Renting a dedicated server is just as powerful as having 

your own on-site server, but with the added benefit of 
getting professional support from your web host. Thus, 

dedicated hosting is ideal for large online businesses 

that deal with heavy traffic.
Pros

• Complete control over the server’s configuration
• High reliability

• Root access to the server

Cons

• High cost, more oriented towards large businesses

• Technical and server management knowledge is 

required
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IT & ITES Related Theory for Exercise 1.10.98-99

DTPO - Cloud Computing

Various online tools in cloud computing 

Objectives: At the end of this lesson you shall be able to

• learn about online tools : Google Forms, Google Sheets and Google Drive

Learn about Online tools : Google Forms, Google 

Sheets and Google Drive

Google Forms

Google Forms is a survey administration software 
included as part of the free, web-based Google Docs 

Editors suite offered by Google. The service also 
includes Google Docs, Google Sheets, Google Slides, 

Google Drawings, Google Sites, and Google Keep. 

Google Forms is only available as a web application. 
The app allows users to create and edit surveys online 

while collaborating with other users in real-time. The 

collected information can be automatically entered into 

a spreadsheet.

Features of Google Form

The Google Forms service has undergone several 
updates over the years. Features include, but are 
not limited to, menu search, shuffle of questions for 
randomized order, limiting responses to once per 

person, shorter URLs, custom themes, automatically 

generating answer suggestions when creating forms, 

and an "Upload file" option for users answering 
questions that require them to share content or files 
from their computer or Google Drive.

In October 2014, Google introduced add-ons for Google 

Forms that enable third-party developers to add new 
features to surveys, while in July 2017, Google updated 
Forms to add several new features. "Intelligent response 
validation" is capable of detecting text input in form fields 
to identify what is written and ask the user to correct the 

information if wrongly input. Depending on file-sharing 
settings in Google Drive, users can request file uploads 
from individuals outside multi-option answers in a table. 

In Settings, users can make changes that affect all new 
forms, such as always collecting email addresses. 

Google Forms features all of the collaboration and 
sharing features found in Docs, Sheets, Slides, 

Drawings, and Sites

Create your form

• Choose an option:

• From forms.google.com, click Blank or choose a 
template.

• From drive.google.com, click New scroll to Google 
Forms. Next to Google Forms, point to the Right 
arrow (Fig 1) and click Blank form, Blank quiz, or 
From a template.

• Name your form: In the top-left corner, click Untitled 

form or the template form name and enter a new 

name.

• (Optional) Do any of the following actions:

• Add a description: Under the form name, add your 

text.

• Add a header, change the theme and background 

Fig 1

color, or font style: Click Customize Theme   and 

then choose your options.

Add questions

If you’re using a template, you can skip to Edit questions 

to edit your form.

Fig 2

Note: Changes are automatically saved. To 

preview your changes any time, at the top 

right, click Preview  

• Click Untitled Question and enter your question. You 

get suggestions based on your type of question.  

(Fig 2)

• (Optional) To change the question type, click the 

Down arrow   and choose an option.

• Add response options (if applicable for your question 

type).

• To add a copy of the existing question, click Duplicate  

• (Optional) To specify if people must answer the 

question, click Required.

• To add a new question, click Add question
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Fig 3

Edit questions

You can add things like images and videos to a question 

at any time. You can also reorder and delete questions.

Select a question and do any of the following actions 

(Fig 3)

• Drag to reorder a question. You can also drag and 

reorder answers.

• Delete a question.

• Click More   to:

• Add a description or hint.

• Shuffle the answer order.

• To shuffle the question order, click Settings. Next to 
Presentation, click the Down arrow   turn on Shuffle 
question order.

• Add an image to a question. You can also add 

images to answers or forms.

• Add a YouTube video.

Choose settings and preview your form

Choose form settings

Decide who can access your form and whether to collect 

email addresses from people. By default, form sharing 

is limited to your organization and email collection is 

turned off.

• Open a form, and at the top of it, click Settings.       

(Fig 4)

• Next to Responses, click the Down arrow   and 

choose from the following options:

• Collect email addresses—Collect respondents’ 

email addresses.

• Send responders a copy of their response—Send 

copies of responses on request or automatically.

• Allow response editing—Let people change their 

answers after submitting them.

Fig 4

• Restrict to users in your organization and its trusted 

organizations —Limit your form’s audience to your 

organization. Turn this setting off to distribute your 
form externally.

• Limit to 1 response—Allow people to complete your 

form only once.

Manage how you present form responses

• Open a form, and at the top of it, click Settings.

• Next to Presentation, click the Down arrow   and 

choose from the following options:

• Confirmation message—You can customize the 
message people get after they submit the form.

• Show link to submit another response—Allow people 

to submit as many form responses as they like.

• View results summary—Let people see a summary 

of everyone’s answers.

Important: After someone fills out your form, they get 
a link to the results. Response summaries show full 

text responses or charts for each question and are 

visible to anyone who can respond to the form.

• Disable autosave for all respondents—You can turn 

this setting off if you don't want respondents' drafts 
to automatically autosave. Drafts remain for 30 days 

from their last edit or until the form is complete.

Let people review and edit your form:

• At the top right, click More   Add collaborators.

• Under Add editors, enter the email addresses of the 

people you want to share with.

• Click Send.

Whoever you invite can edit any part of your form, 

including responses and where they are saved.

Preview your form

While you’re changing your form’s settings, you can 

preview it to see what the changes look like. You’ll also 

want to preview it when you’re done.

• At the top right, click Preview  .

The preview opens in a new window.

• To edit the form, click Edit   or go back to your editing 

window.

Send your form

When you’re ready to send out your form, you can send 

Fig 5
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it by email, copy and paste a link in a chat or email 

message, embed it on a website, or share a link on 

social media.

At the top right of the form, click Send.(Fig 5) If the form’s 
audience is limited to your organization, check the 

Automatically collect respondent’s (your organization) 

email box.

Choose how you want to send the form:

• Email—Click Email  . Enter email addresses in the 

To field. You can customize the subject and message 
contents.

• Link—Click Link  . You can shorten the URL. Click 

Copy and paste the link into a chat, conversation, or 

email.

• Website content—Click Embed  . You can specify 

inline frame dimensions. Click Copy and paste the 

HTML into your website or blog

• Social media—Click one of the social media icons.

Pause or stop response collection

When you create a new form, response collection is 

automatically turned on. You can pause or stop it. For 
example, if you find a mistake after sending out a form, 
you can pause response collection until the error is 

fixed.

• In your form, click Responses.

• Turn off Accepting responses. It changes to Not 
accepting responses.(Fig 6)

Fig 6

• (Optional) Add a message that people see if they try 

to reply. If you’re pausing response collection, you 

might add something like: "This form is currently 

paused. Please try again later."

See responses in Forms

Fig 7

You can see a summary of all responses or look at 

individual responses on the Response tab.(Fig 7)You 
can also view the form questions by clicking on the 

Question tab. To switch between individual responses, 

click the individual’s email.

See responses in Sheets

To analyze your responses further, you can send them 

to a spreadsheet. The spreadsheet is linked to your 

form, so responses appear in real time.

Send responses to a new spreadsheet:

• In Forms, on the Responses tab, click More   Select 
response destination.

• Select Create a new spreadsheet.

• (Optional) To chang    e the name, enter a new one.

• Click Create.

Send responses to an existing spreadsheet:

• In Forms, on the Responses tab, click More   Select 
response destination.

• Select Select existing spreadsheet Select.

• Select your spreadsheet and click Select.
Fig 8

To open your spreadsheet from Forms, next to More, 
click View responses in Sheets✝.The spreadsheet 

opens in a new window. To go back to Forms, click 
Form Show summary of responses or go back to the 
Forms window.

Stop sending responses to a spreadsheet:

• In Forms, on the Responses tab, click More   Unlink 
form. (Fig 8)

• Click Unlink to confirm.

Download	responses	as	a	CSV	file
To export responses for analysis in other programs, you 

can download them as a CSV file.

In Forms, on the Responses tab, click More Download 
responses (.csv).

Print a form and responses

• Open a form and go to the content you want to print.

• If you're printing questions or individual responses, 

at the top, click More   Print.

• If you're printing a summary of responses, from your 

browser, click File Print.

• Choose your settings and then click Print.
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Create a spreadsheet

To create a new spreadsheet:

• Open the Sheets home screen at sheets.google.

com.

• Click New +. This will create and open your new 

spreadsheet.

Edit and format a spreadsheet

You can add, edit, or format text, numbers, or formulas 

in a spreadsheet.

Edit data in a cell

• Open a spreadsheet in Google Sheets.

• Click a cell that’s empty, or double-click a cell that 

isn’t empty.

• Start typing.

• Optional: To add another line within a cell, press �  + 

Enter on a Mac or Ctrl + Enter on Windows.

• When you’re done, press Enter.

Format one or more cells

• Open a spreadsheet in Google Sheets.

• Click a cell, then drag your mouse across nearby 

cells you want to select, or hold �  on a Mac or Ctrl 

on Windows and click another cell.

• To format text or numbers in a cell, use the options in 

the toolbar at the top.

Format your data

Here are some options for formatting your cells or text. 

You can find these options above the document.

•  Undo

•  Redo

•  Bold

•  Italic

•  Strikethrough

•  Change font or font size

•  Change text color

•  Change cell fill color

•  Single color

•  Alternating colors

•  Change cell borders

•  Change border color

•  Change border style

•  Merge cells

• Change horizontal text alignment

• Change vertical text alignment

• Rotate text in a cell

•   Wrap text in a cell

To format part of the text or content in a cell, double-

click the cell, select what you want to format, then select 

a formatting option.

Align & resize objects

Move an object anywhere you want or change its size. 

Lines will appear that show what it lines up with, equal 

space between objects, and when one object is the 

same size as another.

Format numbers & dates in a cell

• Select the cell to be formatted.

• At the top, click Format   Number.

• From the menu that appears, select the format 
option you want.

• If the format option you want isn’t listed: At the bottom 

of the menu that appears, click custom options, such 

as "Custom date and time" and "Custom number 

format."

Add a theme

You can apply changes to the format of an entire 

spreadsheet with themes.

• Open a spreadsheet in Google Sheets.

• At the top, click Format  Theme.

• Choose an available theme or click Customize to 

create your own.

Parts	of	your	spreadsheet	affected	by	theme
• Text font and color of grid text, charts, and pivot 

tables

• Hyperlink color of grid text

• Chart background color

• Color of series in charts

• Pivot table background

Import data sets & spreadsheets

On your computer, open a spreadsheet in Google 

Sheets.

• Open or create a sheet.

• At the top, click File   Import.

• Choose a n on-password-protected file in one of 
these file types:

• .xls (if newer than Microsoft® Office 95)

• .xlsx

• .xlsm

• .xlt

• .xltx

• .xltm

• .ods
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• .csv

• .txt

• .tsv

• .tab

Select an import option. Not all file types have all six 
options:

• Create new spreadsheet: Create a spreadsheet 

from the imported data in a new browser tab.

• Insert new sheets: Adds new sheets with the 

imported data to your existing spreadsheet.

• Replace spreadsheet: Replace the open spreadsheet 

with the data in your imported file.

• Replace current sheet: Replace the current sheet’s 

contents with the imported data.

• Append rows to current sheet: Adds the imported 

data to the current sheet after the last row with any 

data.

• Replace data starting at selected cell: Replace the 

data in a range of selected cells with the imported 

data.

• Optional: If you import a plain text file, like .csv or 
.txt, under "Separator character," you can pick what 

letter or symbol Google Sheets uses to separate 

cells.

• Detect automatically: This will automatically find 
ways to split your data set. For example, it can detect 
fixed-width-formatted files.

• Tab

• Comma

• Custom: Choose a custom character to split your 

data. 

• Click Import.

Format numbers in a spreadsheet

You can format your data in several different ways 
in Google Sheets so that your spreadsheet and its 

contents are displayed how you want them.

Format numbers, dates, and currencies

To format or change the format of numbers, dates or 

currencies in a spreadsheet:

• On your computer, open a spreadsheet in Google 

Sheets.

• Select the range of cells you'd like to format or 

modify.

• Click Format   Number.

• Select the format to apply to the range of cells.

Custom formatting of numbers, dates, and 

currencies

You can apply custom formatting for currencies, dates, 

and numbers. For each of these, you can search in the 

text boxes found in the formatting menus to find the 
format that works for your spreadsheet. If you don’t find 
what you are looking for, you can now create your own 

custom formatting within the menus.

Custom date formatting

To apply a custom date or time format to your 

spreadsheet:

• On your computer, open a spreadsheet in Google 

Sheets.

• Highlight the data you want to format.

• Click Format   Number.

• Click Custom date and time.

• Search in the menu text box to select a format. You 

can also add your own custom date or time format 

into the text box.

• Click Apply.

If you want to add more detailed time or date values to 

your formatting, for example the hour or minute, click 

the down arrow in the right corner of the menu text 

box and select an additional value. You can adjust the 

specific formatting for these values by clicking on the 
arrows in the value and choosing an option. To delete 

a value from your formatting, click the value and select 

Delete.

Custom number formatting

To apply a custom number format to your spreadsheet:

• On your computer, open a spreadsheet in Google 

Sheets.

• Highlight the data you want to format.

• Click Format   Number.

• Click Custom number format.

• Search in the menu text box to select a format. You 

can also add your own custom number format into 

the text box.

• Click Apply.

Use Google Drive for desktop

About Drive for desktop

Drive for desktop is Google’s desktop sync client that 

lets you easily manage and share content across all 

your devices and the cloud. This application enables 

you to access your files and folders in a familiar location. 

You can use Drive for desktop to keep your files in 
sync between the cloud and your computer. Syncing 

is the process of downloading files from the cloud and 
uploading files from your computer’s hard drive. After 
syncing, the files on your computer match the files in the 
cloud. If you edit, delete, or move a file in one location, 
the same change happens in the other location. That 

way, your files are always up to date and can be 
accessed from any device.
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• On a computer, go to drive.google.com/drive/trash.

• Tip: You can sort your trashed files by trashed date 
to find the oldest or newest files trashed.

• Right-click the file you want to recover.

• Click Restore.

• You can find restored files in their original location. 
If the original location no longer exists, look in "My 

Drive."

What	it	means	to	mirror	or	stream	your	files
Mirroring and streaming are two ways to sync your files. 
In both cases, any changes you make to your files on 
one device will be reflected everywhere. 

With mirroring, your files are stored in the cloud and on 
your computer, which takes up hard drive space. You 

can access your files at any time, even when you don’t 
have an internet connection or the Drive for desktop 

app running. You can access files through a folder on 
your computer. 

With streaming, your files are stored in the cloud. Hard 
drive space is only used when you open files or make 
them available offline. Files that are not available offline 
can only be accessed when you’re connected to the in-

ternet. All files, including those available offline, can be 
accessed only when the app is running. You can access 

files through a mounted drive on your computer. 

Note: Recent versions of macOS may have a 

slightly	different	streaming	behavior.
While you can choose whether to mirror or stream your 

My Drive files, other folders on your device can only 
be mirrored. Additionally, files from shared drives, other 
computers, and backed-up USB devices can only be 

streamed.

Options for syncing My Drive

You can stream or mirror My Drive, depending on your 

preferences.

Configure	My	Drive	for	s	treaming	or	mirroring
• Open Drive for desktop.

• Click Settings ⚙ Preferences.

• On the left, click Folders from Drive.

• Under "My Drive syncing options," select Stream 

files or Mirror files.

Switch from mirroring to streaming

When you switch from mirroring My Drive files to 
streaming My Drive files, the location of your files on your 
computer changes. The folder where you previously 

mirrored My Drive files will remain on your computer 
but will no longer sync. To avoid data loss, make sure 

that data has finished syncing before cleaning up these 
folders.

On Windows, you will need to quit Drive for desktop 

before removing the folder from your computer.

In Drive for desktop, you can manage how much local 

storage you use and where your content is located 

by configuring Drive to stream or mirror your files and 
folders.

Manage	files	in	your	Google	Drive	storage
Your storage is shared across Google Drive, Gmail, and 

Google Photos. When your account reaches its storage 

limit, you can’t send or receive emails.

How to clear space

Clear space in Google Drive, Gmail, and Google Photos 

to make room for new items.

To delete your Google Drive files, move them to the 
trash. Files in trash will be automatically deleted after 
30 days. You can restore files from your trash before 
the 30-day time window. You can also permanently 

delete them to empty your trash. If you delete, restore, 

or permanently delete multiple files or folders at once, it 
might take time for you to notice the changes.

Delete	files	by	size	in	Google	Drive
• Use a computer to see your files listed from largest 

to smallest.

• Put files you don't want in your Trash, then 
permanently delete them.

• Within 24 hours, deleted items will show in the 

available space in your Google Drive account.

Permanently delete large emails in Gmail

• In the Search box, type has:attachment larger:10M.

• Click Search.

Note: Replace "10" with a higher number to 

delete	larger	files.
• Select the emails you don't need, then click Delete.🗑

• On the left side of the page, click Menu ⏩ Trash.

• At the top, click Empty trash now.

Permanently delete emails in your Spam folder

• On the left, click Spam. If you don't see Spam, click 

More.

• At the top, click Delete all spam messages now. Or, 

select specific emails, then click Delete forever.

Move photos & videos to Trash

• On your computer, go to photos.google.com.

• Point to an item y   ou want to move to Trash.

• At the top left, click Select ✅.

• At the top right, click Delete 🗑Move to trash.

Restore	files	you	deleted
If you deleted something recently using Google Drive 

or the Google Drive desktop app, you might be able to 

restore the file yourself.

Restore from your Trash

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.10.98-99

©
 N

IM
I 

N
O
T
 T

O
 B

E
 R

E
P
U
B
L
IS

H
E
D



193

Switch from streaming to mirroring

When you switch from streaming to mirroring, My Drive 

will no longer appear in your Google Drive streaming 

location. (Shared drives, other computers, and backed-

up USB devices will still appear.)

Your My Drive files will be downloaded to the folder you 
choose when configuring this option. If there are already 
files in the selected folder, the application will attempt 
to not duplicate files that match what’s already in the 
cloud. Files that are not present in the cloud already will 
be uploaded.

Configure	other	folders	on	your	computer
• Open Drive for desktop.

• Click Settings ⚙ Preferences.

• On the left, click Folders from your computer.

• From this menu, you can Add folders to sync with 
Drive and backup to Photos, and you can edit 

preferences of folders that are already synced.

Sync to Google Drive and back up to Google Photos

You can sync a folder with Google Drive or back it up to 

Google Photos.

• If you sync with Google Drive: Everything in the 

folder will be mirrored. All changes will be synced 

between your computer and Google Drive. You can 

access all your files from any device at drive.google.
com or via the Google Drive app. 

• If you back up to Google Photos: Only photos and 

videos will be uploaded. Changes will not be synced 

between your computer and Google Photos. You 

can view your photos and videos from any device at 

photos.google.com or via the Google Photos app.

Important: If you are storing photos and videos, 

we recommend only backing up to Google Photos. 

If	 you	 choose	 to	 store	 your	 files	 in	 both	 places,	
photos and videos in the folder get uploaded twice, 

which uses more of your Google account storage. 

Upload	files	and	folders	to	Google	Drive
You can upload, view, share, and edit files with Google 
Drive. When you upload a file to Google Drive, it will 
take up space in your Drive, even if you upload to a 

folder owned by someone else.

Types of files

• Documents

• Images

• Audio

• Video

Upload	files	&	folders
On your computer, you can upload from drive.google.

com or your desktop. You can upload files into private 
or shared folders.

• On your computer, go to drive.google.com.

• At the top left, click New    File Upload or Folder 
Upload.

• Choose the file or folder you want to upload.

Drag	files	into	Google	Drive
• On your computer, go to drive.google.com.

• Open or create a folder.

• To upload files and folders, drag them into the 
Google Drive folder.

Use Drive for desktop

• Install the application on your computer.

• On your computer, you'll see a folder called "Google 

Drive."

• Drag files or folders into that folder. They will upload 
to Drive and you will see them on drive.google.com.

Save from Print view 

Important: Make sure you have the Save to Google 

Drive Extension installed. 

• On your computer, open Chrome.

• Open the page, image, or file you want to print.

• On the top, click File   Print.

• In the window, select Save to Drive or click See more   

Save to Drive. 

• Click Print.

Convert documents into Google formats

If you want to upload files like Microsoft Word documents, 
you can change a setting to convert files.

Important: You can only change Google Drive 

settings from your computer.

• Using a computer, go to drive.google.com/drive/

settings.

• Next to "Convert Uploads," check the box.

Upload	files	with	the	same	name
If you upload a file with the same name, Google Drive 
will upload the file as a revision of the file already in 
Google Drive.

To keep both files:

• On your computer, go to drive.google.com.

• Upload a file.

• Click Keep as separate file.

Share	files	from	Google	Drive
You can share the files and folders that you store in 
Google Drive with anyone.

When you share from Google Drive, you can control 

whether people can edit, comment on, or only view the 

file. When you share content from Google Drive, the 
Google Drive program policies apply. 
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Share	a	single	file
• On a computer, go to Google Drive, Docs, Sheets, or 

Slides.

• Click the file you want to share.

• Click Share or Share.

Share	multiple	files
• On a computer, go to drive.google.com.

• On your keyboard, hold Shift and select two or more 

files.

• At the top right, click Share  .

Share	with	specific	people
• Select the file you want to share.

• Click Share or Share  .

• Under "Share with people and groups," enter the 

email address you want to share with. 

• To change what people can do to your doc, on the 

right, click the Down arrow     Viewer, Commenter, or 

Editor.

• Choose to notify people.

• If you want to notify people that you shared a doc 

with them, check the box next to Notify people. If you 

notify people, each email address you enter will be 

included in the email.

• If you don't want to notify people, uncheck the box.

• Click Share or Send.

Share	a	link	to	the	file
You can send other people a link to your file so anyone 
with the link can use it. When you share a link to a file, 
your name and your email will be visible as the owner 

of the file.

• Select the file you want to share.

• Click Share or Share Get link.

• Under “Get Link”, click the Down arrow  .

• Choose who to share the file with.

• To decide what people can do with your file when 
you share it, select Viewer, Commenter, or Editor.

• Click Copy link   Done.

• Copy and paste the link in an email or any place you 

want to share it.

Share	a	file	publicly
• Select the file you want to share.

• Click Share or Share     Get link.

• Under “Get Link,” click Change to anyone with link.

• To decide what people can do with your public link 

when you share it, select Viewer, Commenter, or 

Editor.

• Click Done.

• Copy and paste the link in an email or any place you 

want to share it. 
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IT & ITES Related Theory for Exercise 1.10.100

DTPO - Cloud Computing

Types of online tools and use 

Objectives: At the end of this lesson you shall be able to
• explain Online tools

• google class room, Moodle, Chamilo, Open edX, Totara Learn, Canvas

Google Classroom

Google Classroom is a free blended learning platform 

developed by Google for educational institutions that 

aims to simplify creating, distributing, and grading 

assignments. The primary purpose of Google Classroom 

is to streamline the process of sharing files between 
teachers and students as of 2021, approximately 150 
million users use Google Classroom.

Google Classroom integrates a variety of other Google 

Applications for Education, such as Google Docs, 

Google Sheets, Google Slides,Gmail, and Google 

Calendar into a cohesive platform to manage student 

and teacher communication. Students can be invited 

to join a class through a private "cla ss code" or be 

imported automatically from a school domain. Teachers 

can create, distribute and mark assignments all within 

the Google domain. Each class creates a separate 

folder in the respective user's Google Drive, where the 

student can submit work to be graded by a teacher. 

Assignments and due dates are added to Google 

Calendar, where each assignment can belong to a 

category or topic. Teachers can monitor each student's 

progress by reviewing revision history of a document, 

and after being graded, teachers can return work along 

with comments and grades. 

Features of Google Classroom

Google Classroom integrates several Google 

Applications for Education (GAPPS) such as Google 

Drive, Google Docs, Google Sheets, Google Slides, 

Google Forms, Google Sites, Gmail to help educational 
institutions transition to a virtual, paperless system. 

Google Calendar was later added to help with assignment 

due dates, field tri ps, and class speakers. Students 
can be invited to classrooms through the institution's 

database, through a private code that can then be 

added in the student's user interface or automatically 

imported from a school domain. Each class created 

with Google Classroom creates a separate folder in the 

respective user's Google Drive, where the student can 

submit work to be graded by a teacher.

Assignments

Assignments are stored and graded on Google's suite 

of productivity applications that allow collaboration 

between the teacher and the st0udent or between 

students. Instead of sharing documents that reside 

on the student's Google Drive with the teacher, files 
are hosted on the student's Drive and then submitted 

for grading. Teachers on Google Classroom have the 

option of creating Assignments in various templates and 

formats with different accessibility options: "student can 
view file," "student can edit file," or "make a copy for 
each student". These assignments can be submitted 

for a grade and teacher feedback. Students can also 

choose to attach additional documents from their Drive 

to the assignment. Set assignments appear on the 'To 

do' list.

Grading

Google Classroom supports many different grading 
schemes. Teachers have the option to attach files 
to the assignment which students can view, edit, or 

get an individual copy. Students can create files and 
then attach them to the assignment if a copy of a file 
wasn't created by the teacher. Teachers have the 

option to monitor the progress of each student on the 

assignment where they can make comments and edit. 

Turned in assignments can be graded by the teacher 

and returned with comments to allow the student to 

revise the assignment and turn back in. Once turned in, 

assignments can only be edited by the teacher unless 

the teacher turns the assignment back.

Communication

Announcements can be posted by teachers to the class 

stream which can be commented on by students allowing 

for two-way communication between the teacher and 

students. Students can also post to the class stream 

but won't be as high a priority as an announcement by a 

teacher and can be moderated. Multiple types of media 

from Google products such as YouTube videos and 

Google Drive files can be attached to announcements 
and posts to share content. Gmail also provides email 

options for teachers to send emails to one or more 

students in the Google Classroom interface. Classroom 

can be accessed on the web or via the Android and iOS 

Classroom mobile apps.

Originality Report

Originality report was introduced in January 2020. It 

allows educators and students to see the parts and 

sections of the submitted work which contains the exact 

or similar wording to that of another source. For students, 
it highlights source materials and flags missing citation 
to assist the student in improving their writing. Teachers 

can also view the originality report, allowing them to 

verify the academic integrity of the student's submitted 

work. On G Suite for Education (free), teachers can 

turn on originality report for 3 assignments but have 

limited cloud storage. This restriction is lifted on G Suite 

Enterprise for Education (paid).
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Archive Courses

Classroom allows instructors to archive courses at the 

end of a term or year. When a course is archived, it 

is removed from the homepage and placed in the 

Archived Classes area to help teachers keep their 

current classes organized. When a course is archived, 

teachers and students can view it, but won't be able to 

make any changes to it until it is restored.

Mobile Applications

Google Classroom mobile apps, introduced in January 

2015, are available for iOS and Android devices. The 
applications let users take photos and attach them to 

their assignments, share files from other apps, and 
support offline access, easing accessibility for users.

Moodle

Moodle is a learning platform designed to provide 

educators, administrators and learners with a single 

robust, secure and integrated system to create 

personalised learning environments. You can download 

the software onto your own web server or ask one of our 

knowledgeable Moodle Partners to assist you.

Moodle experience

Every Learning Management System (LMS) has a 

paradigm, or approach, that shapes the user experience 

and encourages a certain kind of usage. An LMS might 

encourage very sequential learning by offering features 
that enforce a given order on each course. It might 

discourage student-to-student interaction by offering few 
features that support it, while encouraging solo learning 

by offering many opportunities for the student to interact 
with the course material.You will learn what Moodle can 

do and what kind of user experience your students and 

teachers will have, using Moodle. You will also learn 

about the Moodle philosophy, and how it shapes the 

user experience. With this information, you'll be ready 

to decide how to make the best use of Moodle's many 

features, and to plan your online learning site.

Install Moodle

Installing Moodle guides you through installing Moodle 

on your web server. It will help you estimate the amount 

of disk space, bandwidth, and memory that you will 

need for Moodle. This can help you to decide upon the 

right hosting service for your needs.

Configure	your	site
Most of the decisions you make while installing and 

configuring Moodle will affect the user experience. Not 
just students and teachers, but also course creators 

and site administrators are affected by these decisions. 
While Moodle's online help does a good job of telling 

you how to install and configure the software, it doesn't 
tell you how the settings that you choose affect the 
user experience.Configuring Your Site, covers the 
implications of these decisions, and helps you configure 
the site so that it behaves in the way you envision.

Create the framework for your learning site

Creating Categories and Courses, takes you through 

creating course categories, and then creating courses. 

Just as you chose site-wide settings during installation 

and configuration, you choose course-wide settings 
while creating each course. This chapter tells you the 

implications of the various course settings so that you 

can create the experience that you want for each course. 

It also shows you how to add teachers and students to 

the courses.

Make decisions about common settings

In Moodle,course material is either a resource or an 

activity. A resource is an item that the student views, 

listens to, reads, or downloads. An activity is an item 

that the student interacts with, or that enables the 

student to interact with the teacher or other students.

In Resources,Activities, and Conditional Access you 

will learn about the settings that are common to all 

resources and activities, and how to add resources and 

activities to a course.

Add basic course material

In most online courses, the core material consists of 

web pages that the students view. These pages can 

contain text, graphics, movies, sound files, games, 
exercises— anything that can appear on the World 

Wide Web can appear on a Moodle web page. Adding 

Resources covers adding this kind of material, plus links 

to other websites, media files, labels, and directories of 
files. This chapter also helps you determine when to 
use each of these types of material.

Make your courses interactive

In this context, interactive means an interaction 

between the student and the teacher, or the student 

and an active web page. Student-to-student interaction 

is covered in a later chapter. This chapter covers 

activities that involve interaction between the student 

and an active web page, or between the student and the 

teacher. Interactive course material includes lessons 

that guide students through a defined path, based upon 
their answers to review question, and the assignments 

that are uploaded by the student and then graded by 

the teacher. Adding Assignments, Lessons, Feedback, 
and Choices, tells you how to create these interactions, 

and how each of them affects the student and teacher 
experience.

Evaluate your students

Evaluating Students with Quizzes, you'll learn how 

to evaluate the students' knowledge with a quiz. The 

chapter thoroughly covers creating quiz questions, 

sharing quiz questions with other courses, adding 

feedback to questions and quizzes, and more.

Make your course social

Social course material enables student-to-student 

interaction. Moodle enables you to add chats and 

forums to your courses. These types of interactions 

will be familiar to many students.  , Getting Social 
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with Chats and Forums shows you how to create and 
manage these social activities.

Add collaborative activities

Moodle enables students to work together to create 

new material. For example, you can create glossaries 
that are site-wide, and glossaries that are specific to a 
single course. Students can add to the glossaries. You 

can also allow students to contribute to and edit a wiki 

in class.

Moodle also offers a powerful workshop tool, which 
enables the students to view and evaluate each other's 

work.

Each of these interactions make the course more 

interesting, but also more complicated for the teacher 

to manage. The result is a course that encourages 

the students to contribute, share, and engage. 

Collaborating with Wikis and Glossaries, and Running 

a Workshop, help you rise to the challenge of managing 

your students' collaborative work.

Manage and extend your courses

Groups and Cohorts, shows you how to use groups to 

separate the students in a course. You will also learn 

how to use cohorts, or site-wide groups, to mass-enroll 

students into courses.

Every block adds functionality to your site or your course. 

Extending your Course by Adding Blocks, describes 

many of Moodle's blocks, helps you decide which ones 

will meet your goals, and tells you how to implement 

them. You can use blocks to display calendars, enable 

commenting, enable tagging, show navigation features, 

and much more.

Take the pulse of your course

Moodle offers several tools to help teachers administer 
and deliver courses. It keeps detailed access logs that 

enable the teachers to see exactly what content the 

students access, and when. It also enables the teachers 

to establish custom grading scales, which are available 

site-wide or for a single course. Student grades can 

be accessed online and can also be downloaded in 

a variety of formats (including spreadsheet). Finally, 
teachers can collaborate in special forums (bulletin 

boards) reserved just for them. 

The Moodle philosophy

Moodle is designed to support a style of learning 

called social constructionism. This style of learning 

is interactive. The social constructionist philosophy 

believes that people learn best when they interact with 

the learning material, construct new material for others, 

and interact with other students about the material. 

The difference between a traditional philosophy and 
the social constructionist philosophy is the difference 
between a lecture and a discussion.

Moodle does not require you to use the social 

constructionist method for your courses. However, it best 

supports this method. For example, Moodle enables 

you to add several kinds of static course material. This 

is the course material that a student reads but does not 

interact with, such as the following:

• Web pages

• Links to anything on the Web (including material on 

your Moodle site)

• A folder of files

• A label that displays any text or image

However, Moodle enables you to add even more 

kinds of interactive and social course material. This is 

the course material that a student interacts with, by 

answering questions, entering text, or uploading files, 
which includes the following:

• Assignment (uploading files to be reviewed by the 
teacher)

• Choice (a single question)

• Lesson (a conditional, branching activity)

• Quiz (an online test)

Moodle also offers activities in which the students 
interact with each other. These are used to create social 

course material, such the following:

• Chat (live online chat between students)

• Forum (you can have none or several online bulletin 
boards for each course)

• Glossary (students and/or teachers can contribute 

terms to site-wide glossaries)

• Wiki (this is a familiar tool for collaboration to most 

younger students and many older students)

• Workshop (these support peer review and feedback 

of the assignments that the students upload)

In addition, some of Moodle's add-on modules add 

even more types of interaction. For example, one add-
on module enables the students and the teachers to 

schedule appointments with each other.

Chamilo

Chamilo is a free software (under GNU/GPL licensing) 

e-learning and content management system, aimed at 

improving access to education and knowledge globally. 

It is backed up by the Chamilo Association, which has 

goals including the promotion of the software, the 

maintenance of a clear communication channel and the 

building of a network of services providers and software 

contributors.

The Chamilo project aims at ensuring the availability 

and quality of education at a reduced cost, through 

the distribution of its software free of charge, the 

improvement of its interface for 3rd world countries 

devices portability and the provision of a free access 

public e-learning campus.

Main features of Chamilo LMS
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• courses, users and training cycles (including SOAP 

web services to manage remotely)

• social network for learning

• multi-institutions mode (with central management 

portal)

• time-controlled exams

• international characters (UTF-8)

• automated generation of certificates

• tracking of users progress

• competence based training (CBT) integrated with 

Mozilla Open Badges

• multiple time zones

• proven support for more than 700,000 users (single 
portal on a single server)

Open edX

Open edX® was created by the joint efforts of Harvard 
University and MIT for the well-known learning platform 

edX. It is an open-source, learning management system 

(LMS) that empowers organizations worldwide to design 

customized and engaging online learning platforms. 

Open edX® enables companies to host MOOCs with 

useful features such as virtual classes and training 

programs.

The Open edX® project by edX caters to higher 

education institutions, government organizations, and 

enterprises of all sizes. The flexibility and diversity of 
Open edX® make online learning a breeze. Since it is 

open-source, it is constantly evolving and improving its 

offerings with the aid of a robust group of technology 
partners.

Open-source platform

Open-source platforms are software whose code is free 

to use and publicly available, and it can be modified 
and redistributed. The biggest advantage of an open-

source learning management system is its flexibility to 
be customized according to the clients’ needs. Open-

source platforms are highly secured and provide the 

ownership of the data with high-quality services.

Currently using Open edX       

Open edX® powers over 380 websites by providing 

an open-source learning management system. As 

discussed earlier, the platform is used by various 

educational institutions and organizations. The following 

type of users use Open edX®:

• Big giants like Google, Microsoft LaaS, McKinsey 

use Open edX® for their employees’ training and 

onboarding process.

• Top universities of North America, the Middle East, 

and China use Open edX® to provide engaging 

and interactive learning content to their students. 

Moreover, Open edX® helps them track the students’ 

progress, and the open-source nature of it helps 

them modify the interface.

• Small and Medium-scale organizations use Open-

edX to meet their specific goals and objectives. 
They can be creative and innovative thanks to Open 

edX®.

Open edX better than others

Open edX® is the only last generation open-source 

platform that has complete features for online learning. 

One of the primary reasons for the success of Open 

edX® is the popularity of learning management systems 

in general. 

Organizations are looking for a better alternative to their 

existing LMS system, and an open-source LMS is a 

perfect alternative as it provides much more powerful 

features. Moreover, organizations can leverage Open 

edX community xBlocks to enhance the functionality 

of their LMS. Open edX LTI tools can be used for 

communicating with external software, making Open 

edX better than many other platforms. Let’s explore the 

possible reasons why Open edX® is used worldwide:

• Adaptive Learning

• Rich Variety of Content

• Self-Paced Progress Dashboard

• Powerful Analytics

Totara Learn LMS

Totara Learn, formerly known as Totara LMS, is a 

learning management system designed for businesses. 

As well as being a platform to host all your e-learning 

content on, it has a host of features that make it the 

quickest, easiest and most reliable way to train staff.

Main features of Totara Learn    

Hierarchies

With Totara’s Hierarchies you can set up any number 

of frameworks that best represent the structure of your 

business.

You can create the specific structures and relationships 
of job positions and different sections within your 
organisation.

Learning can then be mapped to individual job roles, 

management levels, departments, teams and groups.

Learning Plans

Totara Learn enables staff to complete their certifications 
online or even at home. This allows staff to complete 
compliance training and certification in their own time.

It will also prompt them when they need to complete 

specific courses as their certifications expire.

Team Management

Regular team performance check-ins help keep your 

teams working well. The competencies, goals and 

objectives features within Totara Learn enable you to 

plan development across your team.

This makes sure that individual development plans and 
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learning objectives fit with the goals of the wider team 
and the organisation, and that everyone is heading in 

the right direction.

Content Management

Totara Learn has a wide range of content authoring and 

management features, allowing you to create courses 

with a variety of learning content and activities.

Whether you’re adding your own content directly, 

uploading SCORM or IMS-based courseware or 

importing content from an external repository, with 

Totara Learn you have the control.

Offline	and	Blended	Learning
Totara Learn allows you to manage a range of face-to-

face learning events from internal classroom sessions 

to external workshops or small conferences.

Assessment and Achievement

Totara Learn has a range of assessment options from a 

powerful inbuilt quiz engine to more formal assignment 

submissions.

Reporting

All of this is tied together with full graphical reporting 

allowing you to view almost any statistic you need. 

From completion rates and audience data through to 
evaluation responses.

All the reports are exportable and the report builder will 

help you fetch the data you need.

Performance Management

Staff evaluations can also be completed in Totara, 
giving your employees a simple way to self evaluate 

their performance with managers able to view this and 

add their own feedback.

Audience Management

Using Totara’s audiences system, you can arrange staff 
into groups based on department or job role. This means 

you can create training courses for each audience. 

Then, members of that audience will be automatically 

assigned in that training.

Compliance Management

Totara Learn offers a range of tools to assign the 
right learning programs to the right people, automate 

recertification reminders and generate comprehensive 
reports on completions and non-compliance.

Benefits	of	using	Totara	Learn?
Engaged Learners

Learners can quickly and easily access all your 

content—videos, SCORM or AICC e-learning packages, 

webcasts, PDFs, question banks and more—alongside 
instructor-led training to deliver powerful blended 

learning experiences.

Shared Knowledge

Learners can be involved in informal learning using 

chat, wikis and forums.

You can also add Totara Social to enable learners to 

collaboratively share invaluable knowledge and curate 

the best content for future learning programs.

Open Platform

You can tailor the LMS to your own requirements with 

no software licence fees and complete access to the 

source code.

Innovation Network

With Totara Learn you have access to the global Totara 

Partner network, and can tap into a wealth of expertise 

and value-added services.

This means there is always a partner available that best 

suits your organisation and can help you get the most 

out of your learning technology investment.

Canvas

Canvas is an HTML element which can be used to draw 

graphics via scripting (usually JavaScript). This can, 

for instance, be used to draw graphs, combine photos, 

or create simple (and not so simple) animations. The 

images on this page show examples of <canvas> 

implementations which will be created in this tutorial.

Canvas is a web-based learning management system, 

or LMS. It is used by learning institutions, educators, and 

students to access and manage online course learning 

materials and communicate about skill development 

and learning achievement. 

Canvas includes a variety of customizable course 

creation and management tools, course and user 

analytics and statistics, and internal communication 

tools. 

Institutions may provide users with a Canvas account, 

or individual users can try the free version by signing up 

for their own account.

Canvas	Defined
Condensing something as robust as Canvas into a 

simple definition is quite a challenge but we'll try.

Canvas LMS is an open and reliable web-based 

software that allows institutions to manage digital 

learning, educators to create and present online learning 

materials and assess student learning, and students to 

engage in courses and receive feedback about skill 

development and learning achievement.

Additionally, while Canvas is primarily a web-based 

software, any user can access Canvas on a mobile 

device from the Canvas Teacher, Canvas Student, and 

Canvas Parent apps. Learn more about the Canvas 

mobile apps.

Basic Canvas Features

Canvas includes a variety of built-in course construction 

and management tools that can be customized to 

create unique and accessible teaching and learning 

experiences. 
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Instructional designers and instructors may create and 

share course content using Assignments, Discussions, 

Modules, Quizzes, and Pages. They may also choose 

to foster a collaborative learning experience using 

Collaborations, Conferences, and Groups. Depending 

on course settings, students can access these areas in 

Canvas to find learning materials and interact with other 
course users.

Canvas also allows institutions and instructors to add 

state and institutional learning outcomes to rubrics in 

order to measure and track student skill development 

and learning achievement. Additionally course creators 

can use the Course Import Tool to bulk-upload pre 

existing LMS course packages and/or course materials. 

Instructors can provide students with comprehensive 

feedback on assignment and quiz submissions using 

SpeedGrader and manage grade reporting in the 

Canvas Gradebook. They can also facilitate real-time 

course interactions using Chat and communicate course 

news and updates with students using Announcements 

as well as the Calendar and Syllabus.

Instructors and admins can gain greater insight into 

student success and make informed instructional 

decisions using data provided in Canvas Analytics. 

Admins can also access SQL data about their Canvas 

user and usage details form Canvas Data Services. 

Canvas also includes the Canvas App Center, where 

admins, designers, and instructors can enable a variety 

of External Apps (LTI Tools) and services. The ever-

growing app library offers a wide array of interactive 
resources, content repositories, assessment tools, 

social media integrations, and other digital learning and 

teaching resources.

Additional Canvas Features

Institutions may choose to include additional Canvas 

features specifically designed to meet a variety of 
institutional, educational, and learning needs. 

Canvas Catalog is a digital marketplace where students 

can register, enroll, and pay for courses. 

Canvas Studio is an interactive video management 

platform that enhances student engagement and 

collaboration.  

Canvas Commons is a learning object repository where 

teachers can store course content for their own use and 

for collaboration with colleagues both within and outside 

of their institution.

MasteryConnect allows designers and teachers to 

build, deploy, and manage formative and summative 

assessments across an institution. It provides schools 

with actionable data to improve teaching and learning.

Portfolium is an ePortfolio platform that integrates 

directly inside of Canvas. However, students also 

always have access to their Portfolium portfolios outside 

of Canvaseven after they lose access to the LMS.

Canvas Users

Canvas includes the following six standard user roles: 

Admins, Designers, Instructors, Teacher Assistants, 

Students, and Observers. However, institutions may 

create any number of custom user roles with varied 

Canvas access.

A user’s assigned role determines their Canvas access 

and interactions. For example, Canvas administrators 
may have access to create user accounts, add course 

enrollments, and manage institutional grading periods. 

Instructional designers may use Canvas to create and 

manage course content and review course analytics to 

identify areas for improvement in teaching and learning. 

School counselors may use Canvas to review student 

course progress and assess student achievement. 

Parents and guardians may use Canvas to review and 

communicate with instructors about student course 

progress, including assignment submissions and 

grades.
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IT & ITES Related Theory for Exercise 1.11.101-103

DTPO - Publishing Content

Requires publishing content

Objectives: At the end of this lesson you shall be able to

• categories content that requires  publishing

The publishing process comprises: 

• Acquisitions

• Editing

a.  Structural editing

b.  Content editing

c.  Technical editing

• Design and typesetting

• Proofreading

• Printing

• Sales

• Marketing

• Publicity

As you can see, publishing is actually a complex and 

multi-stage process, so you won’t be surprised to learn 

that it can take at least one year to complete. However, 

this time can be shortened if you have an existing 

relationship with a publisher or publishing company and 

some advance interest in your work. First-time authors 

will have a harder time making it through the first step, 
acquisitions, if they are relatively unknown. But once 

you have successfully published and sold one book, the 

length of the publishing process will be shorter for your 

next work.

First Steps: Acquisition and Editing

The first steps of the publishing process are acquisition 
and editing. Acquisition can occur in different ways, but 
generally authors send either a draft of their manuscript 

or a proposal to multiple publishers. If a publisher is 

interested in your work, he or she will call a meeting 

with their acquisitions team to discuss its pros and 

cons. The acquisitions team isn’t just limited to editors. 

It includes people from sales, marketing, and publicity 

departments as well to evaluate how well your book will 

sell in the current market. If they like your proposal or 

your manuscript, they will offer you a contract. However, 
keep in mind that most major publishing houses won’t 

read an unsolicited manuscript. For this reason, many 

aspiring authors seek out publication support services 

or agents to help them shop their work to potential 

publishers.

Once you have achieved a contract, either with the 

help of publication support services or on your own, 

and signed the contract, your book will begin its journey 

through the editing process. As shown above, the editing 

process can be broadly summarized in three steps: 

structural editing, content editing, and technical editing. 

Structural editing focuses on the way your manuscript is 

organized and whether it makes sense. The publishing 

house editors or in-house publication support services 

will make suggestions for big changes, which you will 

be asked to review and accept or reject. After everyone 

is happy with the way your manuscript is organized, the 

publishing process moves on to content editing. This 

reviews your book for factual accuracy as well as flow, 
transitions, wording, and so on. An aggressive content 

editor will revise your work to make sure the style is 

consistent and the content is impeccable.

It is important to recognize that your editors may make 

some suggestions that you find difficult to understand 
or accept based on their knowledge of the current 

publishing market. While you have some control over 

what to accept, in reality, your editor has a lot of power 

as soon as you sign your contract. Remember to be 

flexible and keep the market in mind. Once you have 
accepted the major changes, a technical editor will 

review your work to make sure it is free of grammar, 

punctuation, and spelling errors. Once you have 

reviewed and accepted the changes, this part of the 

publishing process is over.

Next Steps: Design, Typesetting, Printing, 

Proofreading

Now the publisher or their in-house publication support 

services will work with you to make sure that your book 

will look great when it is printed. You will choose a cover 

design, a font, and someone will typeset the book for 

you so that it looks great. A test print will be made and 

then proofread to ensure there are no hidden errors that 

were not caught by the editing process. Once you have 

worked with the publisher to get a beautiful draft of your 

book in print, it is time to move on to the final steps of 
the publishing process.

Final Steps: Sales, Marketing, Publicity

Even the best-written books need marketing and 

publicity to make sure they end up in front of the readers 

who will be interested in them. Major publishers and 

publication support services engage in marketing and 

publicity of promising new books to ensure that sales 

are high, and your new book will be no exception. In 

today’s world, marketing can include a vast number 

of methods. Your book may be marketed via ads in 

newspapers or journals, but you might also be asked to 

market it on podcasts, through interviews, and among 

well-known authors to get your name and the book out 

there. The publication support services offered by your 
publishing team will also hype you as they work with 
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their network of book distributors and convince them to 

acquire your book and sell it. Soon, your book will be 

printed and hit the shelves.

It is important to note that the steps for online journal 

publication are a bit different than those of book 
publishing. Online journals generally do their own 

publicity, sales, and marketing, and without a print 

version, design and typesetting are less involved 

processes as well. Most online journals offer publication 

support services. However, if you are submitting a 

manuscript for online journal publication, you might 

need to seek out publication support or research 

publication solutions that are specifically tailored to 
academics. Regardless of whether you are writing a 

book or an article, knowing the stages of the publishing 

process can help you know what to expect and ease 

your way through.
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IT & ITES Related Theory for Exercise 1.11.104

DTPO - Publishing Content

Classify  publishing  content

Objectives: At the end of this the trainee shall be able to

• classify all requirements of the publication content

Content Production

Publishers have overall responsibility for content 

development and production. They may manage teams 

of editors and designers who review contributions, edit 

manuscripts and prepare layouts for printed or digital 

production, according to the Book Stewards. Publishers 

ensure that the team meets production schedules and 

releases work to the market on time.

• Acquisition

The process whereby an editor or publisher liaises with 

an agency or author, reads the manuscript/s and then 

subsequently makes a decision on whether to take a 

book on or not. Depending on the size of the publishing 

house, this can be a lengthy, involved, process or a 

relatively straightforward and speedy one. Contracts 

will be produced and exchanged. Again, this can be a 

bit of a lengthy back-and-forth process depending on 

the author and the publisher.

• Editing

Unless a manuscript (MS) is 100% print ready (and that 

happens incredibly rarely) it will be subject to various 

editing processes: 

Structural editing This happens if the MS is rather 

“rough” and in need of major plot changes and rewriting 

in terms of a change in tense and/or point of view. It 

should also, broadly speaking, highlight repetition, weak 

writing and clunkiness etc.

Line editing - This is applied to a “finer” grade of MS i.e. 
one that is structurally sound but still needs to be edited 

line by line for plot, character and world consistency, 

flow, grammar and typos.

Copyediting - This is the last step of editing, whereby 

the publisher applies its own “house style” to the text i.e. 

makes changes to various words e.g. ‘t shirt’ to ‘t-shirt’; 

‘realize’ to ‘realise’. Another example: if an American 

publishing house is publishing the work of a UK author, 

they will Americanize all the British spelling.

Proofreading - This is the last read-through of the text 

by another professional (a fresh set of eyes) that will 

weed out the typos that have, as yet, gone unnoticed by 

spellchecker, author and editor.

Its impotant that you dont skip this step

• Typesetting

Typesetting is, in effect, the process of getting an author’s 
MS from a Word document (or other word processing 

file) into a proper book layout. In practice, this will result 
in a PDF which is print ready and compatible with the 

printer’s software. (The printers will go on to add some 

of their own magical jiggerypokery to turn the PDF into 

the final book layout. This is called imposition.) You 
wouldn’t be far off the mark in thinking that, surely, in 
the digital age, typesetting should be a straightforward 

process. However, turning a Word document (which can 

be full of strange, hidden formatting) into text that fits 
neatly into book-sized pages is not simply a one-click 

process. In general, the more messy the typesetting of 

a print (or e-) book, the less time a human has spent 

on it. A traditional publisher will want the typesetting to 

look as professional and stylish as possible, so they will 

employ either the in-house typesetter or an experienced 

freelancer to carry out this task. A typesetter will often 

be the person converting the MS into an ebook too. 

Nowadays, there is also the potential to add all kinds 

of metadata to a book so that various platforms and 

retailers can harvest information from it, which can, in 

turn, make the book more prominent.

• Cover design

Producing a professional-looking cover is no mean 

feat because within milliseconds of a reader picking 

up a book they will have come to various conclusions 

about the book: its production quality and, hence, an 

extrapolated judgement on the writing within They 

will also immediately figure out the book’s genre/
what the book is about and who the book’s intended 

audience is  and unless the author’s name is instantly 

recognizable the reader may well mutter: Never heard 

of them! All from the cover alone.Sometimes traditional 

publishing houses are mocked for their run-of-the-

mill, unimaginative and slave-to-fashion book covers 

however, it would be contrarian to mock the effectiveness 
of the covers’ success in virtually instantaneously 

signalling to the would-be buyer-reader just exactly 

what the book is about. And in a time-strapped world, 

where buying decisions take place within seconds it’s 

crucial to quickly and effectively tell the reader just 
what the book is about. For most readers, a cover that 

doesn’t visually tell them anything useful about the 

writing inside isn’t an intriguing mystery to be solved by 

the purchasing and reading of the book, but merely an 

irritation; an instant disengagement and putting-down 

of the book. Particularly when there are so many other 

more visually decipherable and engaging covers that 

help the would-be purchaser/reader reach their buying 

choice more easily.

Traditional publishers (and professional self-publishers) 

understand the need for a cover that a,b and c) looks 

professional signals to the reader the genre of the book 

who its intended audience is (this can be to do with sex, 
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age, profession or academic specialism), and hence 

they give this important task to either an in-house or 

freelance cover designer who is experienced enough to 

understand the publisher’s remit and can deliver. (The 

cover designer may, in addition, liaise with a specific 
artist if they have a certain image in mind for the cover).

Lastly, the publisher will curate the blurb on the back of 

the book, gather a couple of choice endorsements from 

well-known authors (most likely another one of their 

authors), and, of course, purchase the unique ISBN 

number (along with the ISBN’s barcode) to go on the 

back cover of the book.

• Liasing with printers

Based on sales figures and past experience of 
publishing similar books by similar authors (similar 

in terms of their experience – debut novelist, mid-list 

author, bestselling sensation etc.) the publisher will 

make a calculated decision about the quantity of books 

to print in the first print run. Nowadays, with the advent 
of print-on-demand, it may seem as though there’s no 

real need to print large quantities of books first time 
round, especially when many of them may remain 

unsold and unloved, taking up space in a distributor’s 

warehouse and still costing the publisher in warehouse 

costs. But by lithographically printing a large quantity of 

books upfront, the unit cost of the book goes down and 

hence the potential profit margins (per book) go up. Sell 
virtually all of the many thousand you print and you’ve 

made a good profit. But sell only a fraction of those 
many thousand and you’ve lost money (or have it tied 

up in unsold stock, which is, essentially, dead money). 

So, to ensure the solvency of the publishing house it’s 

crucial that they get this estimate right. Not printing 

enough books first time round can also be a problem 
because it takes time for a printer to print more books, 

and the time lag between a reader wanting a book (but it 

not being available in a shop) to getting more books out 

there may be long enough to discourage the reader and 

hence lose the sale. There’s a fair amount of expertise 

necessary (as well as a goodly dollop of luck) for getting 

this decision as right as possible. Traditional publishers 

stand a better chance of getting this figure right and 
liaising with the printers to ensure that the print copies 

are ready and delivered in good time pre-publication 

date.

• Marketing & publicity

 Traditional publishers usually plan on getting copies 

of books to journalists and literary reviewers for 

newspapers and magazines (also book bloggers and 

reviewers on Amazon etc.) 6 months pre-publication 

date. That’s to give the reviewers enough time to read 

and review the book, and to ensure that those reviewers 

engaged by a magazine or newspaper get their copy in 

on time (traditional print-based media often have long 

lead times for set-in-stone print deadlines). Publishers 

also need to get information about the book to sales reps. 

who will be approaching book shops, retailers, libraries 

etc. with recommendations for “hot books”. Generating 

a “buzz” about a book pre-publication date can often 

make a huge, positive difference to those all-important 
sales in the first week of a book’s publication. Closer 
to the publication date there will be author interviews 

to arrange, articles to write, and launches to organize 

(along with a barrage of canny social media marketing). 

Basically, a traditional publisher will have a marketing 

and publicity team with their fingers in a number of 
media “pies” to ensure that a) they successfully raise 

awareness about the book to the general public and 

b) the ensuing raised awareness results in sales of 

the book. Running a successful marketing campaign 

for a book is a huge amount of work, and like many 

things in life, the more money and time you invest in the 

endeavour, the greater the returns are.

• Selling Rights 

By selling rights in other territories, and media (audio, 

translation, play, TV, film etc.) a publisher can generate 
extra income from a book, buoying the bank balance 

and helping them to stay solvent. This will also allow 

them to recoup costs for books that may not have as 

much potential commercial success in the mass market.

You can help them along by sharing your dream casting. 

They really appreciate that.

• Running the Business

In addition to all the above processes involved in 

producing a book – the core work of a publishing 

house – there will be the other generic business and 

day-to-day administrative tasks to accomplish that are 

necessary to keep the business complying with various 

legal and financial requirements e.g. managing staff, 
upkeep of office space, accounting, tax returns, data 
compliance etc. The bigger the publishing house, the 

more time these tasks will take up. However, even after 

publishing only a dozen or so titles within a few years a 

small press run by only one or two people will soon rack 

up enough admin to keep them permanently busy. Or 

permanently behind with the admin! There is also one 

other vital aspect to running a business: planning for 

the long-term, in terms of finances, as well as making 
important decisions about the direction the business is 

to go if it is to stay solvent.

To summarize: publishers add a huge amount of value 

to a book – meaning, in actuality, that books should cost 

a lot more than they do (more on that later) – and they 

don’t charge their authors for the work. Instead, they 

look to sales of a book to generate income to keep the 

whole unlikely business afloat. Which is why they tend to 
focus on commercial books (aka potential bestsellers), 

with half an eye on literary fiction that will give them 
kudos come awards season (if these books bag any 

big awards they also have the potential to sell lots). 

Professional self-publishers will also ensure that their 

book has all the value added to it that a professional 

publisher would invest, but they have to pay for that 

investment themselves.
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There is a wide variety of technologies that are used 

to print magazines, books, newspapers, stationery, 

posters, packaging, and other print products. The main 

industrial printing processes are:

• Letter Press

•	 Offset	lithography
• Flexography

• Gravure

• Screen printing

Additional printing techniques were developed for 

very specific applications. These include flock printing, 
letterpress, intaglio, pad printing, and thermography.

Fig 1

Why a certain job is better printed using one of these 

processes mentioned can be read on this page about 

choosing a printing process.

Letter Press

letterpress printing,(Fig 1)also called Relief Printing, 

or Typographic Printing, in commercial printing, 

process by which many copies of an image are 

produced by repeated direct impression of an inked, 

raised surface against sheets or a continuous roll 

of paper. Letterpress is the oldest of the traditional 

printing techniques and remained the only important 

one from the time of Gutenberg, about 1450, until the 

development of lithography late in the 18th century and, 

especially, offset lithography early in the 20th.

Originally the ink-bearing surface for printing a page of 

text was assembled from individual types by a typesetter 

or compositor, letter by letter and line by line. The first 
keyboard-actuated typesetting machines, the Linotype 

and the Monotype (qq.v.), were introduced in the 1890s. 

If only a small number of copies is to be made, printing 

can be done directly from the hand- or machine-set 

blocks of type assembled in forms, but for long press 

runs, duplicates—stereotypes or electrotyping (qq.v.)—

are made to prevent wear and damage of the expensive 

types.

Letterpress was originally carried out on platen presses, 

in which the paper is pressed against the flat, inked form 
by a flat platen; later, the platen was replaced by a roller 
in the flat-bed cylinder press; still later, the printing form 
was wrapped around one cylinder and the paper was 

passed between this cylinder and a second, creating a 

rotary press.

Several procedures have been developed for the 

production of line drawings or reproduction of 

photographs in the form of halftone pictures by 

letterpress. The most widely used method of preparing 

a printing plate for such matter is photoengraving.

Letterpress can produce work of high quality at high 

speed, but it requires much time to adjust the press for 

varying thicknesses of type, engravings, and plates. 

Because of the time needed to make letterpress plates 

and to prepare the press.

Offset
In offset lithography, a printing plate, which is most 
often made from aluminum, contains an image of the 

content that needs to be printed. When the plate is 

inked, only this image part holds ink. That inked image 

is subsequently transferred (or offset) from the plate 
to a rubber blanket and then to the printing surface. 

The process can be used to print on paper, cardboard, 

plastic, or other materials, but these have to have a flat 
surface.

Below is a picture (Fig  2) color sheetfed printing press. 
At the far end is the intake where individual sheets of 

Fig 2

paper are automatically fed into the press. The 4 towers 

or printing units each print one color, typically black get 

printed first, followed by cyan, magenta, and yellow. 
The stack of printed sheets is visible on the front of 

the machine, underneath the press console & monitor 

which the press operator uses to control the press.

IT & ITES Related Theory for Exercise 1.11.105-106

DTPO - Publishing Content

Types of printing technology

Objectives: At the end of this the trainee shall be able to

• types of printing Technology
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Fig 3

For higher volume work offset presses use rolls of paper. 
The picture below (Fig 3)shows such a much larger web 

press. It is so fast that the printed paper needs to be 

force dried. The black unit at the end of the press is an 

oven.

Offset is nowadays the most widely used printing 
technique for an extensive range of products such 

as books, newspapers, stationery, corrugated board, 

posters, etc.

There is a trend that printing promotional (Fig 4) 

material is gradually migrating to digital printing while 

some packaging printing is moving to flexo.

Fig 4

You can find more information on the page dedicated to 
offset	printing.

Flexo

In flexography, the content that needs to be printed is on 
a relief of a printing plate, which is made from rubber. 

Fig 5

This plate is inked and that inked image is subsequently 

transferred to the printing surface.  The process can 

be used to print on paper as well as plastics, metals, 

cellophane, and other materials. Flexo is mainly used 

for packaging and labels (Fig 5)and to a lesser extent 

also for newspapers.

Some packaging printing is moving from flexo to digital.

Fig 6

Gravure

Also known as rotogravure, this is a technique in which 

an image is engraved into a printing cylinder. That 

cylinder is inked and this ink subsequently transfers to 

the paper. Gravure printing is used for high volume work 

such as newspapers,  magazines, and packaging.

Gravure is gradually losing (Fig 6) market share to 

offset for publication printing and to flexo for packaging 
applications.

Screen printing

As its name implies, this printing technique relies on a 

screen, which is a woven piece of fabric. Certain areas of 

this mesh are coated with a non-permeable material. In 

the remaining open spaces, ink can be pushed through 

the mesh onto a substrate. The advantage of screen 

printing is that the surface of the recipient does not have 

to be flat and that the ink can adhere to a wide range 
of materials, such as paper, textiles, glass, ceramics, 

wood, and metal.

The image below (Fig 7)shows a screen printing press 

that is used to print t-shirts.

Fig 7

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.11.105-106

Increasingly screen printing is being replaced by digital 

printing.

• Block printing – This technique resembles potato 

printing, (Fig.8) which is a popular pass time for 

kids. A hand-carved wooden block is inked and 

pressed on the substrate. Additional blocks can be 

used to add more colors. Block printing is a slow 

and laborious process that is still used for printing on 
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fabric in oriental countries.

• Flocking – used to add a (colored) velvet-like texture 

to paper, textiles, etc.

• Heat transfer printing – A special paper is printed 

using inkjet (or another technique) and then this 

print is transferred to another surface using heat and 

pressure. The most well-known use case is iron-on 

decorations for t-shirts but the process is also used 

for industrial applications.

• Intaglio – nowadays mainly used for stamps and 

paper currency.

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.11.105-106

Fig 8
• Letterpress – This relief printing technique 

dominated the industry until the early 20th century. 
Nowadays it is mainly an artisanal process used for 

upscale business cards and wedding invitations, fine 
editions of books, limited-run art projects,…

• Pad printing – This is also called tampography. An 

image is transferred from an engraved printing plate 

onto a three-dimensional surface using a silicone 

pad. Pad printing is limited to small surfaces and 

used to print watch dials, gadgets, toys, car parts, 

etc.

• Roller or cylinder printing – Sometimes called 

machine printing, this is a gravure printing process 

used for printing on textiles.

• Rotary screen printing – This is a very fast printing 

technique in which ink pours out of the holes of a 

perforated cylindrical tube directly onto the substrate. 

This technique only lends itself for printing repetitive 

patterns and is used for printing wallpaper and 

textiles.

• Thermography – This is more of a finishing process 
than an actual printing process. It produces raised 

lettering on the printed side of the paper and is used 

for wedding invitations, letterheads, business cards.
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Traditional publishing.

Most traditional publishers require a formal submission 

from a literary agent who typically takes a percentage 

of your advance and sometimes also a cut of your 

royalties. Should a publisher choose to accept a 

manuscript, they acquire its rights (or ownership). At this 

point, they may or may not offer an advance payment 
to the author. Despite popular misconception, advances 

are typically only a few thousand dollars at most. While 

dreamy six-figure advances are not unheard of, they are 
extremely unlikely. In fact, it’s becoming more common 

for publishers to not offer advances at all, or to delay 
payment until a certain sales value has been reached.     

When it comes to royalty payments, less than 5% is 

typical. Many new authors’ jaws drop when they learn 

average book sales for any book—traditional, self, or 

hybrid—is 250 copies in the first year and roughly 3,000 
throughout its lifetime.  

Lastly, in terms of editing and marketing, traditional 

publishers have full control. Some first-time authors 
may be surprised if their editor changes their book’s 

direction, but the publisher does “own” the book, after 

all. And while some publishers may ask for input for 

your cover, their word is final. While it’s not guaranteed 
your title will sit at the front of every Barnes and Noble in 

the country, it certainly could. (Keep in mind, publishers 

pay big money for those positions; popularity can be 

purchased!) 

Self-publishing.  

Though once heavily-stigmatized, self-publishing has 

recently grown in popularity, particularly with companies 

such as Amazon and Book baby offering their own 
services. Self-publishing is exactly what it sounds like; 

a self-published author is their own publisher and is 

responsible for securing and financing their own editing, 
design, marketing, and production. While this does have 

some great benefits to the author—100% royalties and 
full creative control—it also opens the author up to a 

greater number of risks. For example: 

• Errors. Self-published books are infamous for 

containing typos. Some self-published books are never 

edited, while others are edited poorly. It’s true that many 

self-publishing companies offer editing services, though 
oftentimes they are lack-luster or, in some cases, those 

“editors” are actually computer systems. If choosing 

the self-publishing route, it’s best to find an editor with 
credible references.  

• Unprofessional design or production. Just because 

your Aunt Hilda likes to draw, doesn’t mean she should 

design your cover. We often meet authors who self-

published their first book and either designed their own 
cover, or paid a friend very little to design it for them. Truth 

be told, unprofessional design looks unprofessional and 

can block the sales of your book. People will judge your 

book by its cover, so be sure to leave your design and 

illustration to the professionals.

Hybrid publishing. 

That brings us to the hybrid model—a cross between 

traditional and self-publishing. As with self-publishing, 

hybrid publishing requires a monetary investment, 

however, authors maintain 100% of the rights to their 

books and also have input into their editing, design, and 

marketing. A hybrid publisher ensures the final book 
is as polished and professional as possible. Not to be 

confused with “vanity publishing,” many hybrids will not 

accept just any manuscript. 

In a hybrid model, royalties are split between author 

and publisher. Warren Publishing authors receive 

anywhere from 100% (if sold from the author’s personal 

book inventory), to 50% (if sold in a retail avenue) of 

royalties. Hybrid publishers provide professional editing 

and design services, and most will provide some level 

of marketing support.  

At Warren, we describe ourselves as publishing 

“partners.” It’s our goal to create books that meet or 

exceed our authors’ visions while positioning them to 

thrive in the marketplace. Our marketing efforts are 
custom-tailored to each book and we encourage our 

authors to help spread the word. Sales for our authors 

have ranged anywhere from several hundred books 

to hundreds of thousands, and Warren books can be 

found across the country and overseas.  

These are the very basics, but we are always happy 

to chat with aspiring authors. If you are thinking about 

getting your book published or just considering your 

options, give us a call. We’d be happy to answer your 

questions.  

IT & ITES Related Theory for Exercise 1.11.107

DTPO - Publishing Content

Types of publishing content

Objectives: At the end of this the trainee shall be able to

•	 different	types	of	publishing	content
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Digital printing can be done in various ways. Two 

technologies dominate the industry:

• Inkjet – In an inkjet printer, the image that needs to 

be printed is created by small droplets of ink that are 

propelled from the nozzles of one or more print heads. 

Inkjet devices can print on a wide range of substrates 

such as paper, plastic, canvas, or even doors and floor 
tiles. Inkjet printing is used a lot for posters and signage. 

It is also economical for short-run publications such as 

photo books or small runs of books. In-line inkjet printers 

are sometimes combined with other types of presses to 

print variable data, such as the mailing addresses on 

direct mail pieces.  The press shown (Fig 1) below is the 

HP Page Wide C500, meant for printing on corrugated 

board.

Fig 1

• Xerography – In xerographic printers, such as laser 

printers, the image that needs to be printed is formed 

by selectively applying a charge to a metal cylinder 

called a drum. The electrical charge is used to attract 

toner particles. These particles are transferred to the 

media that is being printed on. To make sure the toner 

is fixed properly, the substrate passes through a fuser 
that melts the toner into the medium. Laser printers are 

not only used in offices but also for small run printing of 
books, brochures, and other types of documents. These 

printers are also used for transactional printing (bills, 

bank documents, etc) and direct mail.

In 2009 both techniques jointly accounted for around 
15% of the total volume of print.

Digital printing is increasingly utilized for print jobs that 

were previously printing using offset, flexo or screen 
printing.

• In short-run small format (A3 size) printing, digital 

is taking over from offset for both color and B&W 
printing. Quick printers and copy shops print digitally 

on presses from vendors like Xerox, HP, Canon, and 

Konica Minolta.(Fig 2)

• Labels are also increasingly being printed digitally.

• Billboard and point-of-sale or point-of-purchase jobs 

Fig 2

are being done by wide-format inkjet devices.

• There is a wide range of small format printers used 

to print on phone cases, mugs, and other products.

• In book printing publishing companies start to rely 

more on print-on-demand. The Espresso Book 

Machine pictured below is well suited for that job.

Espresso Book Machine

There are a number of other digital printing processes 

that are geared towards specific niche markets:

• Dye-sublimation is a printing process in which heat 

is used to transfer a dye onto the substrate. Dye-

sub printers are mainly used for printing on textiles, 

for proofing and for producing photographic prints. 
Some printers can print on a variety of materials 

such as paper, plastic, and fabric.

• In the direct thermal printing process heat is used 

to change the color of a special coating that has 

been applied to paper. This process is used in cash 

registers but also to add markings, such as serial 

numbers, to products. For this, a transparent ink is 

used that changes color when a laser applies heat to 

it.

• In the thermal ink transfer printing process heat is 

used to melt print off a ribbon and onto the substrate. 
It is used in some proofing devices but seems to be 
gradually disappearing off the market.

Concerning Requirements :

Speed

Quite often when looking to print promotional materials 

you will be faced with a very tight deadline to not only 

design the graphics but also print them. Turning this 

IT & ITES Related Theory for Exercise 1.11.108-109

DTPO - Publishing Content

Incorrect versions of publishing

Objectives: At the end of this the trainee shall be able to

• incorrect versions of content 
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around to meet a specified deadline can be a challenge 
and so the speed at which your printer can get this done 

and delivered is crucial.

Compared to other methods of print like the screen 

printing process, digital printing offers a quick turnaround 
time due to the lack of set up and manual intervention 

required.

Any good print provider will also be able to turn this 

around in a short amount of time, many within days 

and some within 24 hours. However, it is always best 
to check with your print provider, how long they need to 

get the job done.

Quality

Arguably the most important aspect of any print process 

is the quality of output. Digital printing guarantees a 

great standard, complete with full colour and gradation. 

Indeed, digital is favoured by many because of its perfect 

registration of colours. It remains the only method that 

provides this.

As a result, colours appear vibrant and clear, opening 

up all manner of design possibilities. Even white ink can 

be utilised.

Better still, it’s very easy to apply the likes of glossy 

finishes or embossed effects, enhancing the design 
further.

Cost

Digital printing is a cost-effective option due largely 
to the lack of setup required. Preparation is greatly 

reduced given there is no need for printing plates or 

colour matching. This means everything happens in 

one, single process, lessening man hours. As a result, 

the price of digital printing projects is typically far 

cheaper than the screen printing equivalent.

Better For The Environment

Digital printing is better for the environment in that it 

uses less ink. That is to say ink is only ever injected 

into areas of the design requiring it – a stark contrast to 

traditional methods. This results in far less waste and a 

quicker clean-up operation generally.

Elsewhere digital printers are proven to produce less in 

the way of CO2 emissions. Some professional printers 
even choose to deploy polymer-based inks, which 

come without hazardous air pollutants (HAPS). Instead 

they consume less energy and emit fewer greenhouses 

gases, certainly compared to solvent-based inks or the 

UV-curable variety.

Finally, the ability to print short-runs allows customers to 

‘try before they buy’. The upshot of this is savings can 

be made on packaging for bulk orders that don’t come 

out as planned.

Greater Choice

One of the clear advantages of digital printing is the fact 

substrates don’t have to be held in place quite so firmly. 
Consequently, greater customisation can be realised in 

the form of different materials.

Digital flat bed printers are known to print onto materials 
up to 50mm thick. This allows for applications others 

print processes simply could not entertain. In short, 

you can print onto just about any material. That’s why 

digitally printed items range from posters to outdoor 

signage.

You Can Print in Lower Quantities

If you are looking to print in lower quantities, digital 

printing can be much more cost effective and offers the 
equivalent of a  ‘print on demand’ service, which is ideal 

if you are looking to print just a couple of posters, 1 or 

2 display boards or a small number of pull up banners.

As a result of the minimal set up process, there is rarely 

a minimum number of units required by printers and 

often, you won’t be charged extra if you only want a 

couple of prints, or a short print run.

Improvements

Digital printing is ever evolving. The technology is 

greatly improved from its emergence in the early 1990s. 

Another 30 years from now, it will be capable of even 

more.

More	Accurate	Proofing
Getting to see an example of your design before 

committing to printing 100s of units is crucial and can 

make the difference between having a perfect design 
and making a mistake that will last forever, potentially 

costing your business money!

One of the beauties of digital printing is that you get 

picture perfect, accurate proofing before committing 
to print. The proof, which will often be presented as a 

PDF, will offer an opportunity to see the final design and 
give you a chance to review and identify any changes 

in design, typos or errors in judgement. All this can be 

done in the confidence that you haven’t wasted your 
print budget. It's particularly helpful when producing 

business cards for instance.

A digital printing press also has the ability to produce 

each and every unit in a way that ensures each unit 

looks exactly the same.

Issues :

Limited Colour Matching Capability

Despite the constant improvements in digital printing, 

it can unfortunately still be difficult to match Pantone 
colours exactly when adopting this method. This is 

due to the differences in inks, rasterization techniques 
and toners with each printing machine, causing slight 

differences in colour finish when printed.

While quality prints are certainly achievable, digital 

printing cannot replicate metallic and fluorescent colours 
within design. This is far from ideal if you are looking 

to achieve something slightly more eye catching. If you 

are looking to print a design with fluorescent or metallic 
colours, screen printing would be a more suitable 

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.11.108-109
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method as it gives much greater flexibility in terms of full 
colour options.

Material Options

When large format print first entered the print arena 
limitations of materials were endless. These days with 

the huge improvements in ink and material technology it 

is possible to print successfully onto a host of materials 

ranging from woods, plastics, glass and PVC’s. There 

are of course some material such as some polyesters 

and polycarbonate where screen print wins hands 

down for ink key. Custom apparel for example is better 

realised this way.

Durability

Digital printing offers a reasonable standard of durability 
particularly those who offer UV curable inks. Whilst it 
cannot be said that ink fade will never happen if the 

correct materials for the project are used as a rule a 3-4 

years life can be expected on externally exposed items.

Summarize the consequences of publishing 

incorrect versions of content

In this tech-world, people first check the review of a 
product before investing their penny in it. Reviews are 

the credibility of a product. They affect the thought 
process of the customer and influence his/her decision 
in buying the product. Especially in books, no one wants 

to spend several hours reading a story which turns out 

bogus in the end. Readers crave good stories, they 

select their storybooks according to their interest in the 

genre. Once they find out their book, they go for the 
reviews! There are high chances of getting influenced 
by reviews and deciding not to buy that book in the 

end.  Fake reviews growing globally and becoming the 

hard part to deal with. There are different softwares 
that produce high-quality fake reviews. Those reviews 

are hard to detect. Big online marketing platforms like 

Amazon also forced to deal with fake reviews.   

IT & ITES - DTPO (NSQF - Revised 2022) - Related Theory for Exercise 1.11.108-109
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IT & ITES Related Theory for Exercise 1.12.110-112

DTPO - Publish Content in Bilingual

Need for publishing content in media 

Objectives: At the end of this lesson you shall be able to

•	 different	types	of	media

The goal of media is to convey an advertising message 

to the audience through the most appropriate media 

channel for their product. 

In general, you can classify media in three main 

categories.

Print Media

This type of news media used to be the only way of 

delivering information to the public. For the generations 

of the 80s and 90s, print media was the only media of 

entertain. People relied on newspapers and magazines 

to learn everything, from recipes and entertainment 

news to important information about the country or the 

world. Print media includes:

• Newspapers – printed and distributed on a daily or 

weekly basis. They include news related to sports, 

politics, technology, science, local news, national 

news, international news, birth notices, as well as 

entertainment news related to fashion, celebrities, 

and movies. 

• Magazines – printed on a weekly, monthly, quarterly, 

or annual basis. It contains information about 

finance, food, lifestyle, fashion, sports, etc.
• Books – focused on a particular topic or subject, 

giving the reader a chance to spread their knowledge 

about their favorite topic.

• Banners – used to advertise a company’s services 

and products, hung on easily-noticed sights to attract 

people’s attention.

• Billboards – huge advertisements created with the 

help of computers. Their goal is to attract people 

passing by.

• Brochures – a type of booklet that includes everything 

about one company – its products, services, terms 

and conditions, contact details, address, etc. They 

are either distributed with the newspapers or hand 

over to people. 

• Flyers – used mostly by small companies due to 

the low cost of advertising. They contain the basic 

information about a company, their name, logo, 

service or product, and contact information, and they 

are distributed in public areas. 

Broadcasting Media

Broadcasting media includes videos, audios, or 

written content that provides important or entertaining 

information shared by different methods:
• Television – in the past, there were a few channels 

sharing various types of content, whereas now we 

have hundreds of TV channels to choose from. Each 

channel delivers a different type of content, so you 

have a separate channel for news, drama, movies, 

sports, animation, nature, travel, politics, cartoon, 

and religion. It’s the number one broadcasting media 

due to its reach to the audience.

• Radio – uses radio waves to transmit entertaining, 

informative, and educative content to the public. 

Due to its high reach to the audience, radio is widely 

used for advertising products and services. Radio is 

one of the oldest means of entertainment, and today 

people often hear it to find out the weather and traffic 
while commuting. 

• Movies – film, motion picture, screenplay, moving 
picture, or movie has world-wide reachability. It’s 

the best type of mass media to promote cultures 

and spread social awareness. Movies have always 

played a huge part in the entertainment world.

Internet Media

Nowadays, we are relying on the Internet to get the 

news a lot more often than traditional news sources. 

Websites provide information in the form of video, text, 

and audio. We can even choose the way we want to 

receive the news. 

Types of Internet media include:

• Social networks or websites – including Facebook, 

Instagram, Twitter, YouTube, Tumblr, LinkedIn, 

Snapchat, Quora, Reddit, Pinterest, etc. They are 

user-friendly and widely used by people around the 

world. Although we can find any news here, they may 
be misleading because of the lack of regulations on 

the content shared.

• Online forums -  an online place where we can 

comment, message, or discuss a particular topic. 

Forums allow us to share knowledge with other 

people with the same interest. That’s why it’s 

regarded as the best platform to seek support and 

assistance.

• Podcast – a series of audios focused on a particular 

topic or theme. We can listen to them on a computer 

or a mobile phone. It’s a platform that allows anyone 

to share their knowledge and communicate with the 

world. You can browse some podcast hosting sites 

to see what fits your needs best.
 We use different types of media to find - out news, 

learn new things,and entertain ourselves with the 

advance in technology, we can choose the type of 

media we want to use, no matter the time or place 

so we can hear the radio while driving to work, we 

can watch our  favorite show on our phone, an we 

can find out any information and news on our laptop 
or mobile device,thanks to the internet who knows 

where technology can lead us in the feature.
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Publication

Publication refers to distributing printed copies of a work 

for the public. This is a technical term, and it is important 

to Copywrite legislation. The author is the initial owner 

of any work, and he/she has the exclusive right to 

publish that work. This includes publishing newspapers, 

magazines, journals and catalogues, which include 

visual, text or images. The author of a work has the 

freedom to decide whether to publish the work or not. If 

it’s not published, it is identified as an unpublished work.

Types of Publication Based on Content

• Monograph – lengthy research publication that is 

written by a single person

• Brochure – also known as a leaflet or pamphlet. This 
is a document used for advertising

• Tract – a booklet based on political or religious views 

of a single person and distributed freely

Types of Publication Based on Material

• Newspaper – a publication of several pages printed 

with news, information, sports, and advertising. They 

are published and distributed daily, weekly, monthly 

or annually (Fig 1)

Fig 1

• Journal- a newspaper or a similar publication

• Newsletter- a bulletin, pamphlet, leaflet or newspaper 
distributed to a specific audience

• Leaflet- a single sheet of paper printed on both sides

• Bulletin- brief information written on a flyer or inside 
another publication

• Broadside- a large single sheet one-sided printed 

paper that is designed to be plastered onto walls

• Flyer – also known as a handbill. A small sheet of 

paper printed on one side that is distributed free of 

charge

Journal

A journal is a scholarly publication that includes various 

articles written by professors, researchers, and other 

experts. They are also called serials or periodicals.  

Journals focus on a specific field and are aimed at the 
academic or technical audience.

Examples of Journals

• Medical journals

• Scientific journals

• Law journals

• Journals on humanities

Journals are generally on current topics and 

developments. All journal articles are based on original 

research and are peer-reviewed before publishing. They 

contain citations and a bibliography as well.  Journals 

are published monthly, quarterly, or annually. They can 

be published online or in print, or both ways. They are 

usually sequentially numbered. Each jo            urnal copy 

is identified as an ‘issue’, and a collection of issues is a 
volume.

Types of Journal Articles

• Letters  – short descriptions of important research 

findings

• Articles – usually, around 5-20 pages and they are 

complete descriptions of original research findings

• Research Notes – short descriptions that are less 

urgent when compared to letters and contain 

information on current research findings by a 
researcher

• Supplemental Articles – mostly consist of a large 

volume of details based on the results of current 

researches

• Book – a collection of pages between two covers

• Booklet – a leaflet that is like a book

• Magazine – a book with front and back paper 

covers that has information on various topics and 

advertisements. Some magazines are published and 

distributed every week or every month

• Pamphlet – similar to a leaflet or booklet

IT & ITES Related Theory for Exercise 1.12.113

DTPO - Publish Content in Bilingual

Method of publishing content

Objectives: At the end of this lesson you shall be able to

• various methods of publishing content.
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• Review Articles – do not cover original research but 

include results of multiple articles on a particular field 
or topic, and give information about the subject and 

mentions journal references to the original research

Difference	Between	Publication	and	Journal
The key difference between publication and journal 
is that publications are for the general public while 

journals are for the academic or technical audience. 

In addition, publications are published daily, weekly, 

monthly, quarterly or annually, but journals are usually 

not published on a daily or weekly basis.

A publication is distributing printed copies of a work for 

the public. They are aimed at the general public and 

contain articles on almost any topic in various fields. A 
journal is a scholarly publication that includes various 

articles written by professors, researchers and other 

experts. They are also called serials or periodicals. They 

are sequentially numbered, and each journal is called an 

issue. Journals are based on original research findings 
and contain different types of journal articles such as 
letters, articles, research notes, supplemental articles 

and review articles.  
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Multilingual means many languages. While content 

marketing is a marketing stratergy used to attract and 

engage users through the promotion of content such as 

blog posts, articles, videos, podcasts, and more. Thus, 

multilingual content marketing is marketing content to 

consumers who speak different languages. 

A list of the best tools for creating & managing 

multilingual content 

• Email

You need to communicate with your translation vendor 

and email is by far the best way to do this. You can 

send your English content as an attachment and specify 

Fig 1

all of the project details in the body of the email. Once 

translated, the content will be delivered back to you by 

email. (Fig 1)

This makes email by far the most essential tool you 

will need for creating and managing your multilingual 

content, as it allows you to communicate with your 

project team quickly and efficiently.

Outlook is a great email tool. 

Additionally, written communication is vital for 

project record keeping. If a question ever comes up 

about project instructions or the project needs to be 

revisited for updating or revisions in the future, written 

communication is the best and clearest way to retrace 

the project’s life cycle.

E mail is not meant for all communication. If you need to 

transmit files that are large in size or contain confidential 
information, email is not the best way to do it. Use FTP 

or secure email in such cases.

• FTP

FTP, also known as File Transfer Protocol, is a great 

way to transmit large files that cannot be sent by email 
due to size restrictions. It’s also great for secure file 
transfer. 

Fig 2

FileZilla FTP can be used to transmit files that are too 
large for email. (Fig 2)

Once you finish transmitting and receiving all the files 
via FTP, don’t forget to delete them from the server. 

This will free up hard drive space for more files to be 
transmitted later.

• Notepad

Notepad is one of the simple tool that can open just 

about any file out there and display its contents. If you 

just need to view and edit plain text without any fancy 

formatting, Notepad is the way to go. (Fig 3) 

You can basically view and edit files in their raw form 
without worrying about losing markup. Very basic, easy 

to use and comes standard with almost every operating 

system out there.

• Unicode Fonts

If you’re going create any multilingual content, stick with 

Unicode fonts. When you’re creating content in English, 

Fig 3

IT & ITES Related Theory for Exercise 1.12.114-116

DTPO - Publish Content in Bilingual

Tools for multilingual content

Objectives: At the end of this lesson you shall be able to

• tools for creating and managing multilingual content.
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you probably won’t think twice about the technical 

aspect of the fonts you’re using. 

Here is why it’s important that you use Unicode fonts 

for multilingual content: Each font character has a 

unique number associated with it which conforms to 

an international standard for all systems. This makes 

it easy to distribute all sorts of content across different 

platforms, programs and languages.

Microsoft	Office
Almost all translators and language translation 

companies work with Word, Excel and PowerPoint.  

(Fig 4)

These applications are also designed with other 

languages in mind, so font compatibility and usage is 

rarely an issue.

Perhaps the most critical part of all is that the files you 
save in these applications can be edited.

It’s much easier to translate content when you can 

easily edit it. If your content can’t be edited (such as a 

scanned PDF file), it has to be recreated from scratch 
in an editable format, adding unnecessary costs to the 

project.

Word, Excel & PowerPoint can all be used to create and 

edit multilingual content.

• PDF Reader/Creator

Portable Document Format (PDF) files are used 
everywhere in business to present documents and other 

content in a quick and efficient matter. What makes PDF 
great is that, like Unicode fonts, it’s cross-compatible 

across different platforms and operating systems.

Fig 4

PDF files are great for showcasing your multilingual 
documents once they’re created. Content created 

in Word, if you save your multilingual content in PDF 

format, even readers who don’t have a specific font 
installed on their computer can usually see the text 

displayed correctly, as it is generally preserved in PDF 

format. (Fig 5)

PDF is a good way to save costs as well. Instead 

of printing thousands of user manuals in different 
languages, you can now provide digital copies to your 

customers in PDF format.

• Adobe Creative Cloud

Fig 5

Fig 6

If you’re thinking of creating great visual content and 

anything that requires advanced formatting, Adobe 

InDesign and Illustrator are a must. These two 

applications are now more accessible than ever before, 

through the Adobe Creative Cloud subscription.

A brochure that was translated into Japanese and 

Fig 7

typeset in Adobe InDesign (Fig 6)

• Translation Memory

when you engage a translation vendor to work on your 

translation project, make sure using a TMS.

Translated content exported from memoQ TMS in a 

bilingual table. (Fig 7)

Since quality is important to you, a TMS is a must-have 

tool in your multilingual content creation process. It 
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tracks and leverages previously translated material, and 

helps to maintain quality and consistency throughout 

your content. Inconsistencies in translation can lead to 

customer confusion, and it goes downhill from there.

If you decide to implement a TMS in your organization’s 

localization department, give memoQ a try. This tool is 

easy enough to use for beginners and has capabilities 

for most advanced users.

• WordPress

WordPress is by far the most popular content 

management system in the world. And it’s one of the 

best ways to showcase your digital content on the web.

WordPress leverages the Unicode standard to make 

multilingual content creation as easy as possible.

This blog and website are both powered by WordPress. 

(Fig 8)

There are plenty of other great content management 

systems out there, such as Joomla and Drupal. From 

the ease-of-use perspective and ongoing support, 

WordPress is the way to go.

• Social Media

Your multilingual content won’t do you any good if your 

target audience is not exposed to it. Social media is a 

great way to spread the word about your content and 

engage your audience. But before you use Facebook, 

Twitter or any other social networks, make sure they’re 

right for you.

Don’t waste your time promoting multilingual content on 

random social networks if you are not certain people 

will get your message. Communicating via social media 

with your audience is important, but must be done right.

Create dedicated social media communities for specific 
languages and cultures, like McDonald’s did here. Be 

prepared to communicate with your customers in their 

languages.

 For project communication, you have mail and FTP, 

for multilingual content creation, you have notepad, 

unicode fonts, microsoft office, PDF reader/creator and 
adobe creative cloud. If you can live without one tool. 

It's the TMS, since yourr transaction vendor should 

be using on their end. Publish your multiligual content 

using wordpress and social media.  

Fig 8
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IT & ITES Related Theory for Exercise 1.12.117-119

DTPO - Publish Content in Bilingual

Types of binding process

Objectives: At the end of this lesson you shall be able to

• binding and types of binding and process

A comparison of binding types for printed matter

Bookbinding turns loose pages and folded sheets into a 

usable print product. There is a varied selection of bind-

ing types and not all bindings are equally well-suited for 

a given project. Production costs, durability, page count 

and the application of a printed product are the most 

important criteria for choosing a binding type. To make 

sure you pick the right binding for your requirements, 

this article will look into the most popular binding tech-

niques and highlight their advantages and disadvantag-

es. This will enable you to easily determine the correct 

binding type for your next creative project.

Types of Binding

• Saddle stitch binding

• Perfect binding

• Glued fold binding

• Glued pad binding

• Thread sewn binding

• Spiral or wire binding

• Sewn Binding 

Fig 1

Saddle stitch binding

Saddle stitching, also called stapled binding, is a very 

popular and easy binding method in which pages are 

folded, creased and stapled together. It is often used for 

the following products. (Fig 1)

• magazines

• different types of advertising material

• brochures

• catalogues

Saddle stitch binding refers to the bookbinding meth-

od in which folded sheets of paper are stapled together 

along the spine edge in one workflow. Usually, the wire 
is punched through the spine from the outside in two 

places and is bent flat on the inside. After it has been 
bound, the document is trimmed on three sides.

This binding method is both economical and quick. 

Moreover, it is highly durable and the pages open com-

pletely flat so that printed content is not lost in the gutter 
(the center of the printed product when opened).

Saddle stitch binding only works with page counts 

that can be divided by four; individual pages are not 

Fig 2

possible. Fold-in pages on the cover or inside pages 

are the only exception.

Perfect binding

With this bookbinding technique, the pages of a printed 

product are glued together to produce a durable result. 

Perfect binding is ideal for

• sales catalogues

• magazines

• brochures with a high page count

• paperbacks

• advertising brochures

In perfect binding, sections of folded sheets are collated 

to form the inside of the printed product. Their spines 

are trimmed off and roughed up to improve bonding with 
the glue and the paper dust produced in this process is 

removed. Next, the glue is applied to the spine using 

rollers or nozzles and the wrap-around cover is pressed 

onto the still wet glue. Then the product is trimmed on 

three sides, and voilà, the perfect bound product is fin-

ished. This method uses either hot-melt or PUR adhe-

sives. (Fig 2)
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Book with PUR adhesive binding

Hot-melt adhesive, the more affordable solution, has 
limited durability and is therefore particularly well suited 

for simple and short-lived products.

Perfect binding with PUR adhesives cost more but are 

also more durable, making them ideal for long-lasting, 

superior prints and high page counts.

The spine must be at least several millimetres thick for 

perfect binding to be an option. Therefore, products with 

few pages and low paper weights are generally not eli-

Fig 3

gible. But it is possible to include single pages and dif-

ferent papers in the inside section.

Glued fold binding

A low-priced binding method, a glued fold is used for 

simple advertising products when durability is not a pri-

ority. The number of pages is limited and no cover can 

be added. Typical fold-glued products include. (Fig 3)

• leaflets with few pages

• advertising mail

• direct mail marketing

• inserts

Thin	leaflet	with	a	glued	fold
This binding method uses glue that is applied to the 

crease lines. First the sheets are glued to each other, 

then folded and trimmed. Depending on the folding 

type, documents with eight, twelve and sixteen pages 

can be implemented via sheet-fed offset printing. We 
offset printing is suitable for longer print runs. The paper 
weight should range between 80 and 135 gsm. In addi-

tion to sheet-fed offset, this binding method is also used 
in web offset printing to produce cost-efficient print runs 
starting from about 50,000, usually via in line production 

(all steps of the manufacturing process take place on 

the same machine).

Glued pad binding

This pad binding technique is both simple and econom-

ical. It is often used to bind short-lived print material to 

allow tearing out individual pages. This makes glued 

pad binding ideal for the following products:

• notepads and writing pads

• carbonless copy paper

• writeable desk pads

• training documents

• coupons, vouchers and event tickets

Fig 4

Glued notepad to easily tear out pages

In glued pad binding, adhesive is applied to the spine 

only. First the sheets to be glued are trimmed. Assem-

bling the individual sheets is only necessary if there are 

different designs within one pad and when offset print-
ing is used. With digital printing, different designs are 
possible without collating the individual sheets. A stabi-

lising chipboard backing and a cover can optionally be 

glued on the outside. To allow tearing out the sheets, 

low-tack adhesives are used. (Fig 4)

Different paper types may be combined within one pad: 
Uncoated papers are particularly well suited. High pa-

per weights and too many pages can cause premature 

glue failure and result in loose pages.

Fig 5

Thread sewn binding

A very strong and durable binding, thread sewn bind-

ing uses thread to sew sheets together. However, this 

binding method is more complex and therefore more 

expensive, making it ideal for high-quality publications. 

Typical products which are thread sewn include. (Fig 5)
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• illustrated books

• bibles

• art books

• fiction books

• catalogues

In thread sewn binding, individual sheets are folded first 
which are then assembled and sewn together. The re-

sulting book block is glued on the spine and trimmed on 

three sides. Next the thread-sewn book block can be 

glued to the cover. Thread sewn binding allows a vari-

ety of covers (e.g. hard covers) to be implemented. The 

further processing thus depends on the type of cover.

A thread-sewn notebook

To add colour, you can choose the colours of the end-

band or headband, bookmark and thread from a broad 

colour palette. Moreover, a wide selection of fabrics and 

materials is available for the cover and different paper 
stocks for the inside section. No other binding method 

is compatible with such a wide variety of different mate-

rials. Also, there are virtually no limits to the number of 

pages: More than 1,000 pages can be bound together 

with this long-lasting and stable binding technique.

Fig 6

Spiral binding

This binding method is also known as twin loop, double 

loop, double-o, duo-wire or simply wire binding. It uti-

lizes a wire or pre-formed pairs of wire loops which are 

inserted through holes that have been punched through 

the book’s cover and pages. Wire binding is very pop-

ular and is often used for the following products.(Fig 6)

• calendars

• cookbooks and music books

• training manuals

• writing pads

• sales documents

• brochures

In spiral binding, holes are punched through the book’s 

cover and pages through which a wire or wire loops 

are inserted. The wire ends are folded in to prevent the 

sheets from getting loose.

Open notepad with wire-o binding

No other bookbinding method opens as conveniently. 

The pages open flat and can even be turned over com-

pletely. The maximum number of pages depends on the 

spiral diameter and on the paper weight. With sufficient-
ly large spiral diameters and low paper weights, sever-

al hundred pages are no problem. Different print sub-

strates and individual sheets can be mixed in a spiral 

bound document. The spirals are available in different 
colours and materials. There is a gap when opening the 

pages, causing designs that run across the spine to be 

broken up.

Sewn binding

Sewn binding is a method of book binding using 

what looks like a traditional sewing machine. The 

flat collated pages are sewn down the centre into the 
cover or case. This is then folded over to produce the 

finished book. Sewn binding has many advantages both 
practically and stylistically.(Fig 7)

Fig 7
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